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1 GAFmap® Express - Overview 

1.1 About GAFmap® Express  

GAFmap® Express is a free software that allows you to open and reuse GIS projects that have 

been processed and created with the licensed Desktop GIS Software GAFmap® and the corres-

ponding extension Pack&Go ("Pack&Go Container"). These GIS projects usually contain a 2D 

and/or 3D visualization of geographically located data, which you can view interactively, ana-

lyze in a simple way, and supplement with your own graphics and labels. 

To use a 3D visualization in a team or to dive into the 3D world even more realistically, 

GAFmap® Express has a Multi User Mode and interfaces to various Virtual Reality Headsets. 

Pack&Go Container 

With GAFmap® Express exclusively Pack&Go Container created with GAFmap® can be read 

(*.cmp or *.cmpaux). In such a container all data that the project contains is stored next to 

the prepared GAFmap® project (*.xmp).  

The project stored in the container and the contained data cannot be changed with GAFmap® 

Express, but only read. If you, however, e.g. add your own graphics, de/activate the on-the-fly 

functions or the display of data, you can save these customized adjustments separately. 

Therefore a sidecar file is created and stored next to the container. If you reopen the project, 

you can select your own sidecar file (*.cmpaux) or the original project file (*.cmp). 
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1.2 Software Requirements 

1.2.1 System and Hardware Specifications 

Minimum requirements for GAFmap® Express 2D/3D: 

• Microsoft Windows 10/11, 64bit 

• CPU: 2 GHz Dual Core 

• Memory: 4 GB 

• Graphics Card: the 3D Viewer requires a DirectX 11, Shader Model 5 compatible gra-

phics card (any current NVIDIA, AMD, or Intel, dedicated or CPU-integrated GPU). 

The visual quality in the 3D Viewer directly scales with the performance of the graphics 

card, so a faster graphics card is always better. 

• Screen resolution min. 1024x768  

Please note that docking windows (see chapter 2.2.4) is not possible if you work with two 

or more screens with different DPI scaling! 

Recommendations for a great 3D Viewer experience: 

• Microsoft Windows 11, 64bit 

• CPU: 3 GHz Quad Core 

• Memory: 16 GB 

• Storage: SSD 

• Graphics Card: 

o 4 GB dedicated video memory 

o 2000 GFLOPS Single Precision Computing Power (GAFmap® only uses SP, not DP) 

o Examples: NVIDIA GTX 1060 or AMD Radeon RX 480 

Recommendations for a great Virtual Reality (VR) experience: 

• Microsoft Windows 11, 64bit 

• CPU: 3.5 GHz Quad Core 

• Memory: 32 GB 

• Storage: SSD 

• Graphics Card: 

o 8 GB dedicated video memory 

o 8000 GFLOPS Single Precision Computing Power 

o Examples: NVIDIA RTX 3070 oder AMD Radeon RX 6700 XT 
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Please also note the VR hardware manufacturers' system & hardware requirements! 

Regarding the Multi User component: 

Here, a simple communication server (GAF.View3D.MultiUser.Server.exe, UDP application, 

Dedicated Server) is created and used.  For the communication server, certain UDP ports (User 

Datagram Protocol) may have to be enabled for Windows and/or firewalls. By default, the 

communications server uses the UDP ports 9050 and 9051. 

 

1.2.2 Installation 

GAFmap® Express does not require an installer. Simply save the (unzipped) program folder to 

any mobile, local, or central drive where you have full read permissions; write permissions are 

not required to run the program. The software can then be started directly from the program 

folder (see chapter 2.1). 

More detailed information on the installation and help with any error messages that may oc-

cur can be found in the installation guide included with the software package. 
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2 Getting Started with GAFmap® Express  

2.1 Starting the Program 

GAFmap® Express is started via the application file GAFmapExpress64.exe in the program fol-

der or a corresponding (desktop) shortcut:  

 

Figure 1: Content of the GAFmap® Express program folder. RunGAFmapExpress*.exe application starts the pro-
gram. 

When starting the application, the splash screen appears for some seconds, then the Open 

Project dialog opens (see chapter 3.1.1). Note that GAFmap® Express cannot be opened emp-

ty and will close again if no Pack&Go Container (*.cmp or *.cmpaux) is selected. 

Alternatively, you can start GAFmap® Express by double-clicking a *.cmp or *.cmpaux file in 

your file browser. Note, if different GAFmap® applications are available on your PC (e.g. 

GAFmap® Desktop and GAFmap® Express): A Pack&Go container will always be opened with 

the GAFmap® application that was last used for this file type. 

 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  5 

2.2 User Interface 

The GAFmap® user interface mainly consists of the following components: 

 

Figure 2: GAFmap® Express User interface 

General information on the user interface, i.e. on the elements mentioned above as well as 

on (context) menus, dialogs, properties and settings windows, etc., can be found in the follow-

ing chapters, information on all functions available in GAFmap® Express starting with chapter 

3. 
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2.2.1 Main Window 

2.2.1.1 Menu Bar / Main Menus 

 

Figure 3: GAFmap® Express Menu Bar 

Via the Menu Bar at the top of the User Interface, you can access the (main) menus available 

in GAFmap® Express. They include: 

• Menu File (see chapter 3.1) 

o Save and load projects 

o End program 

• Menu Window (see chapter 3.2) 

o Link map viewers  

o Save and load window layouts 

o View the list of open map viewers 

• Menu GPS (see chapter 3.3) 

o Connect/disconnect and configure GPS  

o Center map on current position 

• Menu Extras (see chapter 3.4) 

o Open general settings 

o Change language 

• Menu Help (see chapter 3.5) 

o Open About GAFmap® Express 

o Open GAFmap® Express Manual 

You can find information on all functions that can be accessed via the main menus in the 

chapters given above. 

All menus and commands in menus are opened with a simple (left) click. 
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2.2.1.2 Toolbars 

 

Figure 4: GAFmap® Express Toolbars  

By default, the toolbars are located above the map viewer area in the main window; the 

Graphics Toolbar is located at the bottom.  

By default, the toolbars are structured as follows: 

• Main Toolbar (see chapter 4.1) 

 

o Save and load projects  

o Adjust map extent (Pan, Zoom etc.) 

o Undo/redo Actions 

o Query layers and perform simple analyses 

o Update visible extent in 3D Viewer 

• Toolbar for Features (see chapter 4.2) 

 

o Select and query features  

• Toolbar for Feature Search (see chapter 4.3) 

 

o Find features with specific attributes 
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• Toolbar for Layer Effects (see chapter 4.4) 

 

o Temporarily hide layers in different ways 

• Graphics Toolbar (see chapter 4.7) 

 

o Create and edit graphics 

o Create auxiliary graphics for sight analyses 

o Include multimedia objects 

o Set default symbology for graphics 

You can find information on all functions available in the toolbars in the chapters given 

above. 

In addition to the toolbars mentioned above included in the main window, there is also a 

toolbar attached to each map window and 3D window. This Map / 3D Viewer Toolbar contains 

functions that directly and exclusively affect the respective Map/3D Viewer. For more infor-

mation, see chapters 2.2.2.3 and 2.2.3.3 or 4.5 and 4.6. 

Open/Activate Functions 

All tools/functions in toolbars are opened with a single (left) click on the respective button. 

Depending on the function, an action is then performed directly (e.g. Save or Clear Selection) 

or the button / the respective tool is activated; the action must then be executed/initiated 

manually (e.g. Zoom or add a new graphic).  

If a tool is active, the respective button is framed in blue: 

 

Figure 5: An activated button is framed in blue; the respective action must then be executed manually (here: 
click into the map to zoom or draw a zoom rectangle) 

An activated tool remains active until the button is deactivated by clicking it again or until 

another tool is activated. If you use a function in between that is executed directly, the acti-

vation status of the tool does not change. 
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Split Buttons 

Small black  arrows next to buttons mark so called Split Buttons, i.e. buttons behind which 

additional functions are "hidden" in addition to the displayed function. A single (left) click on 

a split button arrow opens a selection menu:  

 

Figure 6: Split Button 

If you select one of the functions in the menu, it is activated or executed directly and the menu 

is closed again. The split button always shows the function that was executed last. The dis-

played function can be activated/executed by a simple click on the button. 

Adjust Toolbars 

You can customize the toolbars as desired via the general settings, e.g. if you want to simplify 

the user interface or optimize it for special workflows. For example, you can hide or move 

individual buttons within a toolbar or restructure complete toolbars or create new ones. Also, 

various menu functions can be integrated into toolbars.  

Customized toolbars are saved in the user settings. If necessary, they can be exported as an 

XML file and thus e.g. be passed on to other users. Note that the structure of the manual is 

based on the standard format of the toolbars. 

For more information on custom toolbars, see chapter 3.4.1.6. 

 

2.2.1.3 Status Bar 

The Status Bar (Footer) is located on the bottom edge of the program window. 

 

Figure 7: GAFmap Status Bar 
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Here, the following additional information is displayed in the given order: 

• X/Y-coordinates of the current mouse position 

You can specify the display format in the general setting under Viewing > Status Bar 

(see chapter 3.4.1.3).  

If you move the mouse pointer slowly over the coordinate system in the Status Bar, a 

tool tip shows more detailed information. 

• Elevation at the current mouse position (optional) 

You can specify whether the elevation is displayed or not in the general settings under 

menu Extras > Settings > Viewing > Status Bar (see chapter 3.4.1.3). The elevation 

refers to the base DEM (see chapter 5.3.4) If no DEM is available at the current mouse 

position, no elevation is displayed. 

• Additional Information (optional) 

You can specify whether and which additional information is displayed in the Status 

Bar in the general settings under Other > Handling (see chapter 3.4.1.8). Available are 

e.g.  

o the GPS status, 

o the number of layers selected (in the TOC), or 

o the size of the selected features. 

• Information on currently executed actions/functions 

For various functions, information is displayed in the status bar, e.g. about the success 

of an action, e.g. the number of selected features for Select Feature (see chapter 

4.2.3.1). 

A right-click on the info section of the status bar opens the Log of last 20 messages. It 

shows the date, time, and type of each action (for a maximum of 20, if existing): 

 

Figure 8: Log of last 20 massages 

• Information about the duration of the drawing process in the map viewer [ms] 
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2.2.2 Map Window 

Only available if the project contains a 2D window 

The map window is the main component of each GAFmap® project. Here, all (geo) data con-

tained in the project, i.e. all vector data, rasters, graphics, etc., are displayed: 

 

Figure 9: Map window with map viewer (map), TOC and Map Viewer toolbar  

Each map window contains:  

• a Map Viewer (1)  

Here, the map with all data activated (checked) in the TOC is displayed graphically (see 

chapter 2.2.2.1). 

• a TOC (Table of Content) (2) 

It shows a listing of all data contained in the project. By activating/deactivating (check/ 

uncheck) you can control which data is displayed in the map viewer (see chapter 

2.2.2.2). 

• a Map Viewer Toolbar (3):  

It contains functions that refer directly and exclusively to its map window (see chapter 

2.2.2.3). 
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Each GAFmap® project contains at least one map window, but it can also contain multiple map 

windows and/or a 3D window (see chapter 2.2.3). For more information see chapter 2.2.2.4. 

Note that in GAFmap® Express you can neither close map/3D windows nor add new ones.  

 

2.2.2.1 Map Viewer 

The map viewer is part of the map window (see chapter 2.2.2). Here, the map is displayed 

graphhically with all (geo) data activated (checked) in the TOC; data not activated (unchecked) 

in the TOC is hidden.  

Note that even activated data is only displayed in the map viewer if it is within the currently 

visible map extent and is not obscured by other data. If necessary, adjust the map extent (see 

chapter 4.1.3 et seqq.). 

The current map scale is displayed in the title bar of the map window.  

 

2.2.2.2 TOC (Table of Content) 

The TOC (Table of Content) is part of the map window (see chapter 2.2.2). It shows a listing of 

all (geo) data contained in the project, i.e. of all vector and raster layers, tables, graphics, etc. 

added to the project or newly created in the project, in tree structure. 

Activate/deactivate elements in the TOC 

By activating/deactivating (= checking/unchecking) individual elements in the TOC you can 

control which data is shown in the map viewer: checked elements are displayed, unchecked 

elements are hidden. If you deactivate groups, all contained elements are hidden; the sub-

ordinated check boxes are then"blued out": 

 

Figure 10: Deactivated Group  

Note that even activated data is only displayed in the map viewer if is is within the currently 

visible map extent and is not obscured by other data. If necessary, adjust the map extent (see 

chapter 4.1.3 et seqq.). 
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Order of the Elements in the TOC / Drawing Order in the Map Viewer 

The order of the elements in the TOC directly affects the order in which the data is drawn in 

the map viewer: data that is on top in the TOC is also on top in the map viewer.  

Within a vector layer (see chapter 5.3.2), the drawing order depends on the order of the fea-

tures in the attribute table in the current sorting (see chapter 5.3.2.1): Features that are higher 

up in the table are drawn first and are therefore at the bottom in case of overlaps. 

Selecting Elements in the TOC 

With a simple left-click on an element in the TOC (on a layer icon or name) you can select it; 

it is then highlighted in blue: 

 

Figure 11 Element selected with the TOC 

Multi selection is possible e.g. by pressing the Ctrl or Shift key.  

For selected elements you can then perform various actions, e.g.: 

• activate, deactivate, or switch them (collectively), e.g. by pressing the X key (see e.g. 

chapter 5.2.1.8). 

• open their (common) context menu by right-clicking a selected element (see chapter 

5). 

• open their (common) properties, e.g. via the corresponding context menu command 

(see the respective subchapters of chapter 5, e.g. 5.2.1.10, 5.3.2.5, or 5.3.3.6). 

• for a single selected element: rename it by clicking (again) on the layer name and then 

typing the new name (only possible for self-created graphics). 

Main Groups (Group Map, Graphics, Layers) 

The main group Map activates/deactivates the entire map in the map viewer. Below the map, 

a strict distinction is made between Graphics and Layers:  

• Graphics are simple (vector) geometries, symbols, and shapes of all kinds, which are 

located in the map via coordinates. They are usually stored directly in the project file 

(*.xmp).  
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If you add additional graphics yourself (see chapter 4.7.3 et seqq.), these are marked 

with a  green star in the TOC. Unlike elements that are part of the original Pack&Go 

Container, such graphics can be changed or deleted as wished. 

For more information, see chapter 5.2. 

• Layers refer to an external dataset, e.g. a vector or raster file. Only the data connection 

and all display options are stored in the project file.  

For Pack&Go projects, the dataset is usually stored in the container in addition to the 

project file (i.e. the layer usually refers to a dataset in the container). 

For more information, see chapter 5.3. 

Layer Icons / Symbols in the TOC 

Based on the layer icons (symbols) you can usually directly identify the individual elements in 

the TOC: 

  Main group Map 

  Main group Graphics 

  AOI 

  Reference Point 

  simple Point/Line/Rectangle/Polygon/Ellipse Graphic* 

  simple Text Label 

 3D Point  

 3D Text Label 

 3D Model 

 View Point 

  simple Image 

  Multimedia Object 

  Auxilliary Grid 

 Flight Line 

  Sight Line 

  Graphics Group 
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  Main group Layer 

   Vector Layer (Point Layer)* 

  Vector Layer (Line Layer)* 

  Vector Layer (Polygon Layer)* 

  Vector Layer (geometry collection)* 

  Raster Layer (multi-channel) 

  Raster Layer (single-channel) 

  Raster Layer (single-channel, DEM (Digitale Elevation Model)) 

  Point Cloud 

  Table 

  Layer Group 

* The layer icons of vector geometries (for graphics and vector layers) always corres-

pond exactly to the icon with which the vector objects are displayed in the map viewer.  

For explanations on the individual graphic and layer types, see chapter 5. 

Additionally to the layer icons, a number of overlay icons can appear in the TOC, which are 

drawn over the layer icon and allow conclusions on certain layer properties. Examples of such 

overlay icons are: 

•   Viewshed: the Point is used as Viewshed Point. 

•   Not selectable: the graphic / vector layer is not selectable in the map viewer.        

•  Z: the graphic / vector layer is z-aware / is 3D capable. 

•  editable: the graphic is self-created / not part of the Pack&Go container and can  

      therefore be deleted or edited. 

The various overlay icons are mentioned in the manual at the respective function/property. 
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Expanding/Collapsing Layers 

Via the   in the TOC you can expand main groups, groups as well as a number of layers or 

collapse them via the    and thus switch between a detailed and a compact TOC display: 

 

Figure 12: TOC display with collapsed or expanded groups  

Depending on the Renderer Type (see chapter 5.3.2.5 or 5.3.3.6), different details are dis-

played when vector and raster layers are expanded, for vector layers e.g. specified unique 

values or classes, for raster layers e.g. unique values, classes, a corresponding raster statistic 

or band mapping or, in the case of mosaic layers (see chapter 5.3.6), the contained single 

rasters: 

 

Figure 13: TOC display, examples of expanded vector layers: unique values (left) and classes (right) 
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Figure 14: TOC display, examples of expanded raster layers (from left to right): unique values for a classification 
raster, band mapping for a color image, raster statistics Min/Max for a DEM with colormap, single raster for a 
mosaic layer 

Show/hide/undock TOC  

The TOC is a fixed part of the map window but can be undocked or hidden for a better project 

layout using the corresponding buttons in the Map Viewer toolbar. For more information, see 

chapter 2.2.4.4 and 4.5.1 et seqq. 

 

2.2.2.3 Map Viewer Toolbar 

The Map Viewer Toolbar is part of the map window (see chapter 2.2.2). All functions con-

tained in the toolbar directly and exclusively affect the map window to which it is pinned. 

• Via the Map Viewer Toolbar you can  

 

o Dock/undock and hide/show the TOC of the map window  

o Activate/deactivate various on-the-fly analyses in the map viewer 

o Show/hide visual hints in the map viewer 

o Export the current map extent as raster 

For more information on all functions contained, see chapter 4.5 et seqq. 

Unlike the toolbars in the main window (see chapter 2.2.1.2) the Map Viewer toolbar is fixed 

to its map window and cannot be moved or adjusted via the general settings. 
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2.2.2.4 Projects with multiple map windows 

The Multi Window Technique of GAFmap® allows for working with any number of map win-

dows (see chapter 2.2.2) in parallel within one project. The content, i.e. the layers and graphics 

in the TOC including their order, structure, and properties, is the same for all map window, as 

are all cross-map settings such as the map spatial reference. However, the activation status of 

the layers and graphics (visible / not visible), the displayed map section, and/or the activation 

status of the on-the-fly analyses and visual hints available in the Map Viewer toolbar may 

differ in the individual windows. This allows you e.g. to display the same map section with 

different contents and/or different sections of the same maps in parallel. 

 

Figure 15: Project with multiple map viewers, example 1: same map section with differently activated layers (Link 
map viewers, see chapter 3.2.1) 

Included map windows cannot be closed, but can be rearranged if desired.  

Via the Menu Window, you can always  

• determine whether and how the individual map viewers are linked to each other (see 

chapter 3.2.1)  

• show/hide a multi cursor (see chapter 3.2.2), and 

• view a list of all current map viewers (see chapter 3.2.5). 
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Overview Windows 

To provide a better overview with multiple map viewers open, a map window can be defined 

as overview. In this overview, all other map viewers are then displayed as a rectangle (see 

chapter 4.5.8). 

 

Figure 16: Project with multiple map windows, example 2: different sections of the same map with overview 
(bottom left) 

 You can tell whether a map window is an overview by the (grayed-out) button Enable/ 

Disable Overview (see chapter 4.5.8): for overviews, it is activated (i.e. framed in blue).  

Active Map Windows 

If the project contains multiple map windows, one of the windows is always active. This 

window is marked with a >> shift sign in front of the map window name in the window title 

and is usually also highlighted in blue when the map window is docked: 

 

Figure 17: Active map viewer 
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If you click into a map window, it gets activated automatically; i.e. the map window in which 

an action was last performed is usually active.  

Usually, the activation status of the map windows not relevant. However, it is important e.g. 

for various functions that directly affect the map section displayed in the map viewer such as 

Pan or Zoom (map extent) (see chapter 4.1.3 et seqq.), or those that affect the activation 

status of the layers in the TOC, e.g. Toggle (Layer) (see chapter 4.4.2). 

If a function only affects the active map window, this is stated in the corresponding chapter 

of the Manual. 

Additional 3D Window 

In addition to one or more map windows, a project can contain a 3D window (see chapter 

2.2.3). For this window, the above described applies analogously. 

 

2.2.3 3D Window 

Only available if the project contains a 3D window 

The structure of the 3D window corresponds to that of the (2D) map window (see chapter 

2.2.2): 
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Figure 18: 3D window 

The 3D window contains:  

• the 3D Viewer (1)  

Here, all data activated (checked) in the 3D TOC are visualized in 3D space (see chapter 

2.2.3.1). 

• the 3D TOC (Table of Content) (2) 

It shows a listing of all data contained in the project. By activating/deactivating (check/ 

uncheck) you can control which data is displayed in the 3D viewer; here, a distinction 

is made between 3D data and textures (see chapter 2.2.3.2). 

• the 3D Viewer Toolbar (3):  

It contains functions that refer directly and exclusively to the 3D window (see chapter 

2.2.3.3). 

Each GAFmap® project contains at least one map window (see chapter 2.2.2) or a 3D window, 

but it can also contain one or multiple map viewers and a 3D window (see chapter 2.2.2.4). 

Note that in GAFmap® Express you can neither close map/3D windows nor add new ones.  
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2.2.3.1 3D Viewer 

The 3D viewer is part of the 3D window (see chapter 2.2.3). Here, all layers and graphics that 

are activated (= checked) in the 3D TOC are visualized in 3D space. A distinction is made bet-

ween 3D data and textures (see  chapter 2.2.3.2). 

You can adjust the data extent that is displayed in the 3D viewer using the buttons Start 3D 

Viewer or Start 3D Viewer with Current Map Extent (see chapter 4.1.15). Depending on the 

amount/size of data and hardware, reducing the size of the displayed section can significantly 

increase performance in the 3D Viewer, i.e. image buildup and movement speed. 

The 3D viewer can optionally also be output stereoscopically or via a VR headset ("virtual rea-

lity") (see chapter 5.1.7, paragraph Stereoscopic Views). 

For information on the 3D Viewer controls, see chapter 7. 

 

2.2.3.2 3D TOC / Distinction Between 3D Data and Textures 

The 3D TOC is part of the 3D window (see chapter 2.2.3). Here, all data contained in the pro-

ject are listed. The 3D TOC contains the same elements as the 2D TOC, including their struc-

ture/order. The functionality also corresponds to that of the 2D TOC - except for the special 

features mentioned below. For more information on the TOC, see chapter 2.2.2.2. 

In the 3D Viewer only graphics and layers are displayed that are activated (= checked) in the 

TOC. Here, a distinction is made between 3D data and textures (see below). You can adjust 

the activation status of the elements in the TOC as you wish. 

Show/hide/undock 3D TOC  

The 3D TOC is a fixed part of the 3D window but can be undocked or hidden for a better project 

layout using the corresponding buttons in the 3D Viewer Toolbar. For more information, see 

chapters 2.2.4.4 and 4.6.1 et seqq. 

Distinction Between 3D Data and Textures 

For the visualization of data in the 3D space, it is to be distinguished whether these are 

represented as 3D objects ("3D data") or as texture: 

• 3D Data can themselves be displayed as three-dimensional objects located in space. 

The height information necessary is usually stored directly in the dataset. For the 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  23 

visualization of the 3D data, especially the properties under category 3D Symbology 

are decisive (see chapter 5). 

The 3D data includes 

o digital elevation models (DEMs and 3D surfaces) (see chapter 5.3.4) 

o 3D models 

o vector layers with and without Z coordinates  

o various 3D capable graphics elements 

Not all layers can be visualized as 3D object. Whether a layer is  3D capable or not 

depends on the type. 

• Textures cannot be visualized by themselves in space, but need another object on 

which they are drawn as image/raster. In GAFmap® all layer textures are exclusively 

placed on the base terrain (i.e. on DEMs, see below and chapter 5.3.4).  

All layer textures in the 3D Viewer are visualized with the set 2D Symbology (especially 

properties under category Symbology, see chapter 5). 

All layers can be displayed as textures, as long as base terrain is loaded and activated 

as "texture base". Vector data is rasterized for texturing. 

Any number of layers can be activated as texture simultaneously. They are then com-

bined on-the-fly as an (overall) raster and placed as a (top) texture on the DEM. If tex-

tures cover each other, the texture that is higher up in the TOC has higher priority and 

is drawn (as in the (2D) map viewer, see chapter 2.2.2). 

The 3D TOC reflects the distinction mentioned above for data visualization: In addition to the 

checkbox in front of a layer, by which it can be enabled/disabled as 3D object, you can find 

another checkbox behind the layer in the column Tex to activate it as texture: 

 

Figure 19a: Polygon layer visualized as 3D object (front checkbox) 
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Figure 19b: The same polygon layer visualized as texture on an underlying terrain/DEM (back checkbox) 

Note that a texture is also only activated if all groups above the layer are checked (incl. parent/ 

main groups): 

 

Figure 20: A layer is only activated when all groups above are checked. 

A layer can also be displayed as 3D object and texture at the same time, e.g. if some features 

of a vector layer contain height information and others do not: 
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Figure 21: Polygon layer, for which not all features contain height information, visualized as 3D object (front 
checkbox) and texture (back checkbox) 

If a layer is not 3D capable (e.g. multi-channel rasters or simple graphics), the front checkbox 

is missing. These layers can only be used as texture: 

 

Figure 22: For layers/graphics that are not 3D capable, the checkbox in front is missing. They can only be used as 
texture. 

Special Case "RPC Textures" 

Simple layer textures are applied as "top textures" to the base terrain / DEM, i.e. they are 

placed vertically from above on the DEM and are distorted accordingly if the terrain is inclined 

and/or reliefed. 

In addition to simple layer textures, GAFmap® supports RPC textures. These are satellite 

images that contain exact information about the acquisition geometry and therefore can be 

applied to the terrain exactly opposite to the direction of acquisition. This way, they can even 

used for vertically sloping side surfaces if the acquisition angle is sufficiently inclined ("RPC 

based sight views). For more information, see chapter 5.3.5. 
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2.2.3.3 3D Viewer Toolbar  

The 3D Viewer Toolbar is part of the 3D window (see chapter 2.2.3). All functions contained 

in the toolbar directly and exclusively affect the 3D window. 

• Via the 3D Viewer Toolbar you can  

 

o activate/deactivate various on-the-fly analysis and visual aids, 

o start, pause or stop animations and 

o configurate the 3D Viewer and the 3D controls. 

o change into the stereoscopic, VR or Multi User mode, 

For more information on all functions contained, see chapter 4.6 et seqq. 

Unlike the toolbars in the main window (see chapter 2.2.1.2) the 3D Viewer Toolbar is fixed to 

the 3D window and cannot be moved or adjusted via the general settings. 

 

2.2.4 Window Layout 

The Window Layout in GAFmap® Express is variabel, i.e. you can determine to a certain extent 

whether, where, and how certain windows are anchored/docked in the main window (see 

chapter 2.2.1 and 2.2.4.3) or how the windows are structured/arranged. 

• The term floating is used for all windows and dialogs that are not docked, but float 

"above" the main window and can thus be positioned freely and independently on the 

screen(s). All windows and dialogs are (initially) opened floating, including dockable 

windows. 

For more information, see chapter 2.2.4.1. 

• Dockable Windows, especially the map windows and the 3D window (see chapter 

2.2.2 and 2.2.3 as well as 2.2.4.4) can be anchored and/or embedded in the main win-

dow after opening. Not all windows are dockable. 

For more information, see chapter 2.2.4.2 et seqq. 

Tips and notes: 

• Please note that docking windows is not possible if you work with two or more screens 

with different DPI scaling! 
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2.2.4.1 Floating Windows 

Usually windows/dialogs are opened floating, i.e. by default they are not docked in the main 

window or in any other window and can be positioned freely and independently on the 

screen(s).  

 

Figure 23: Floating window 

All floating windows can be closed via the x button in the top right of the title bar, some of 

them, e.g. all dockable windows (see chapter 2.2.4.2) can be minimized separately or maxi-

mized to the screen. Exceptions are map windows and 3D window: they can never be closed. 

All floating windows are listed seperately in the Windows taskbar next to the GAFmap® main 

window and can be opened there again at any time, e.g. if they have been moved to the 

background or have been minimized while working. 

 

Figure 24: Windows Taskbar using the example from above: the GAFmap® Express main window and the floating 
window are listed seperately (display depends on the Windows settings) 

Dockable windows can be used floating after opening or be anchored in other windows (see 

chapter 2.2.4.2). 
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2.2.4.2 Dockable Windows 

Dockbable Windows can be anchored ("docked") in the main window (see chapter 2.2.4.3) as 

well as in other dockable windows. The windows then share a common, superior window and 

close neatly and space-saving with each other in it. Common borders can be easily moved/ad-

justed with the mouse and remain even if e.g. the size or aspect ratio of the superior window 

changes.  

You can tell that a window/dialog is dockable if docking navigation elements appear when you 

grab it by the header bar and drag it to another dockable window (see below); for non-dock-

able windows, the navigation elements do not appear. 

Docking windows / anchoring in other windows 

Docking of windows is done via drag & drop and with the help of navigation elements/crosses, 

which appear as soon as you grab a dockable window by (left-)clicking the header bar and drag 

it to another dockable window: 

 

Figure 25: Control cross for anchoring a window within another window 

While moving, the potential new position of the window is displayed as a semi-transparent 

blue rectangle. If you move the mouse pointer across one of the navigation element icons, the 

window preview jumps to the corresponding docking position. If you release the mouse but-

ton, the window is positioned as displayed in the preview. 
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Example from above: 

If you release the mouse button next to the navigation cross symbols (as displayed in the figure 

above) or press the Ctrl key while releasing it, window 2 is not anchored, but remains floating 

(see chapter 2.2.4.1).  

If you move window 2 to one of the outer navigation cross symbols of window 1, it is anchored 

respectively left/right or top/bottom within window 1.  

 

 

Figure 26: Control cross/element to anchor a window inside another window - moving a window to outer sym-
bols 

If you move window 2 to the center navigation cross symbol of window 1, it is included as a 

tab in window 1: 
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Figure 27: Control cross/element to anchor a window inside another window - moving a window to the center 
symbol 

You can then switch between the windows by clicking on the respective map title. You can 

adjust the order of the tabs subsequently via drag & drop, i.e. by grabbing a tab title with the 

mouse button, moving it to the desired position, and releasing it there again. 

In this way you can anchor as many other windows as you like in one window, regardless of 

whether it is floating (as in the example above) or docked itself. Note that docking is only 

possible in other dockable windows and in the main window. 

 

Figure 28: Anchoring a window within another docked window 

Undock windows / detach from other windows 

You can undock/release an anchored window at any time by grabbing it with a (left) click at 

the window/tab title, dragging it out of the other window and releasing the mouse button; it 

is then floating again.  
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Close dockable windows 

Open windows can be closed at any time with the x button. For dockable windows, depending 

on the layout, it is located either in the top right corner (for floating windows or windows 

anchored to the outside of the main window; see also chapter 2.2.4.3) or at the tab title (for 

windows anchored to the inside of the main window). 

 

Figure 29: Working with multiple map windows - close map window 

If multiple windows are anchored in a floating window, the x button in the superior title bar 

closes all contained windows. If you only want to close a single window, use the blue x button 

in the respective (single) window title. If a window is included as a tab in a floating window, it 

must first be released (see above) before it can be closed individually. 

Note that map windows and the 3D window cannot be closed. 

Open hidden, covered and/or minimized windows 

To all open, dockable windows applies: If they are called up again by clicking the respective 

button or command in the interface, they are brought up and activated (highlighted in blue). 

This way, you can e.g. "find again" windows that have been moved to the background, mini-

mized or hidden while working. 

Map windows and 3D window can be opened via the List of Map Windows in the menu Win-

dow (see chapter 3.2.5), separated TOCs via the button Activate TOC in the respective map/3D 

window (see chapters 4.5.3 and 4.6.3). 
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Tips and notes: 

• Please note that docking windows is not possible if you work with two or more screens 

with different DPI scaling! 

• Since the size of dockable windows must be flexible, there is no limitation in size for 

them. Note that this also means that they can be minimally reduced. They can always 

be maximized again: 

 

Figure 30: Minimally reduced dockable window 
 

2.2.4.3 Dockable Areas within the Main Window 

Within the main window (see chapter 2.2.1), you can anchor dockable windows either in the 

central map window area or above/below or to the side outside of the map window area: 

 

Figure 31: Dockable areas within the main window 
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If you now drag a dockable window (e.g. the Identify window; see chapter 4.1.11) into the 

main window, the following anchoring variants are offered via navigation elements: 

 

Figure 32: Dock/anchor window within the main window  

If you drag the window onto the navigation cross in the middle it is anchored in the central 

map window area as described in chapter 2.2.4.2, if you drag it onto one of the outer naviga-

tion element symbols, it is docked accordingly above/below or laterally outside the map win-

dow area.  

You can tell whether a window is anchored inside or outside the map window area by the 

window title (header): centrally docked windows always have a tab map title at the top (even 

individual ones), externally docked windows have a simple title line. Within the map window 

area the window titles of tabs are always at the top, outside the map window area they are 

always at the bottom. 
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Figure 33: Window title of the Identify window: left: when anchored in the central map window area, centered/ 
right: when anchored on the outside as tab 

If/where a window is docked has no influence on the functionality, but it may lead to a diffe-

rent structuring: Thus, for example, in the Identify window (see chapter 4.1.11) the two win-

dow areas are displayed side by side if they are floating or anchored centrally in the main 

window, and below each other if they are anchored on the outer side in the main window.  

Note that map windows and 3D window in the main window can only be docked in the central 

map window area, but not on the outer side in the main window (see also chapter 2.2.4.4). 

Automatically hide windows docked to the outer side in the main window ("Auto Hide") 

If you anchor a window to the outer side in the main window (see above), it is "pinned" by 

default, i.e. it is always visible as long as it is not actively closed. If you click the pin button in 

the top right corner of the header bar, the window is released and "hidden" at the edge of the 

main window: 

 

Figure 34: Window 1, docked in the main window on the outer left, hidden (with Auto Hide) 

The window is always hidden at the edge where it is docked (top/bottom/left/ right). It can be 

called up again at any time by clicking on the window title. Via the pin button the window can 

be pinned again at any time. 

If you release the pin in a window that contains multiple window tabs (see chapter 2.2.4.2), 

all are pinned and listed individually at the edge: 
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Figure 35: Windows 1-3, docked in the main window at the bottom outside, hidden (with Auto Hide) 

Tips and notes: 

• Note that windows can also be (unintentionally) "hidden", e.g. if the main window is 

subsequently reduced in size and there is no longer enough space for all anchored 

windows. The windows can then always be called up again via the arrow button in the 

top right corner. 

 

Figure 36: Automatically hidden windows 

• To all open, dockable windows applies: If they are called up again by clicking the re-

spective button or command in the GAFmap® Express interface, they are brought up 

and activated (highlighted in blue). This way, you can always find again "lost" windows. 

• Note that multiple window layouts can be stored in the project (see chapter 3.2.4). 

 

2.2.4.4 Special Case Map/3D Window and TOC 

Map windows (see chapter 2.2.2) and 3D window (see chapter 2.2.3) can only be anchored 

inside the main window in the central map window area, but not outside (see chapter 2.2.4.3). 

Alternatively you can use it floating (see chapter 2.2.4.1), e.g. if you want to maximize it out-

side the main window on a second screen. 

Undocking the TOC 

The TOC (see chapters 2.2.2.2 and 2.2.3.2) is an integral part of each map window; it is em-

bedded in its map window by default (i.e. fixed integrated on the left side).  

  Via the button Separate/Embed TOC in the Map Viewer toolbar the TOC can be released 

from its map window (see chapters 4.5.1 and 4.6.1). It is then opened in a separate, initially 

floating, dockable window. The title of the TOC window always corresponds to that of the 

associated map/3D window: 
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Figure 37: TOC separated from map window (floating) 

As long as the button is activated (framed in blue), the TOC remains separated from its map 

window. By clicking it again, the button can be deactivated at any time and the TOC can be 

embedded in its map window again. 

Like all dockable windows, a separate TOC can be anchored anywhere in the main window or 

in other dockable windows (see chapter 2.2.4.2 et seq.) or closed separately.  

 

Figure 38: TOC separated from map window, docked above an overview inside the main window 
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Figure 39: TOC separated from map window, docked on the outside left above the properties window in the main 
window 
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Figure 40: 4 TOCs separated from map window, docked in the main window on the outer left, with Auto Hide 
(see chapter 2.2.4.2) 

  If the TOC is separated, you can activate/reopen it at any time via  the button Activate 

TOC in the respective map window (see chapters 4.5.3 and 4.6.3), e.g. if it was moved to the 

background, minimized, hidden or closed while working. The TOC is then brought up and high-

lighted in blue. 

 Note that an embedded TOC can also be "hidden" via the button Show/Hide TOC (see 

chapters 4.5.2 and 4.6.2); the button is then activated (framed in blue). Click the button again 

to deactivate it and show the TOC again. 

Tips and notes: 

• Note that multiple window layouts can be stored in the project (see chapter 3.2.4). 

 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  39 

2.2.4.5 Saving Behavior / Window Layouts 

The window layout, i.e. the opening status (open/closed) and the last position of all dockable 

windows is saved in the project. If you load an existing project, the window layout is the same 

as when it was last saved. Among other things, this means: If a GAFmap® project was packed 

with open dockable windows, these are also open when you load the resulting Pack&Go 

container, regardless od whether the windows are docked or floating. 

Load Project Window Layout lets you always restore the (original) project window layout (see 

chapter 3.2.3). 

If you save a Pack&Go project with own changes (see chapter 3.1.3), a changed window layout 

is also stored. Note that the "Project Window Layout" is then also replaced. 

Tips and notes: 

• Note that multiple window layouts can be stored in the project (see chapter 3.2.4). 
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3 GAFmap Menus 

See the following chapters for a description of all functions in GAFmap® Express  menus. 

  

Figure 41: GAFmapExpress Menu Bar 

 

3.1 Menu File 

3.1.1 Open Project 

In GAFmap Express: Menu File 

Open Project lets you search and open a(nother) GAFmap® Pack&Go Container (*.cmp or 

*.cmpaux). The following dialog appears: 

 

Figure 42: Open project dialog 

Tabs: 

• Recent: Here, a list of GAFmap® Pack&Go containers you had opened last is displayed 

(sorted chronologically). You can load one of the listed projects by selecting it and 

pressing the Open button or by double-clicking it.  
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Note that this way only containers can be loaded that have not been renamed or 

moved since the last opening. If you try to open a container file that is no longer at the 

specified location with the same name, you get a corresponding error message. 

The list of recently opened projects is stored in your user profile. 

• Local and Central: Here, you can directly access your default directory for locally / cen-

trally stored GAFmap® Pack&Go containers. Here, all *.cmp or *.cmpaux files are dis-

played that are stored in the default directory. You can load one of the displayed 

projects by selecting it and pressing the Open button or by double-clicking it. 

You can set the default directories in the general settings (under menu Tools > Settings 

> Other > Directories; see chapter 3.4.1.8). If the set default directory no longer exists, 

you receive an error message when you open the Local / Central tab. 

In the general settings, you can specify which tab (Recent/Local/Central) is pre-selected in 

the Open Project dialog (under Settings > Other; see chapter 3.4.1.8). 

• The Browse button opens a file browser via which you can search and load any *.cmp 

or *.cmpaux file. 

Open confirms the selection and the corresponding project is loaded. Cancel takes you back 

to the currently opened project. 

Tips and notes: 

• If you want to open a project with self-created, saved changes, do not start the original 

container (*.cmp), but the created sidecar file (*.cmpaux). For information also see 

chapter 3.1.3. 

• Possibly not all data was stored directly in the Pack&Go Container when the project 

was created, but connection details to external data sets instead. If you do not have 

access to this data, or if it has been moved, renamed or deleted, the corresponding 

layers cannot be loaded and displayed in the project. You can manually reconnect to 

the missing records. If this is not possible, please contact the creator of the project. 

• If you open a project that contains data that require credentials (e.g. certain WMS 

layers or linked data from a cloud directory), these are requested when you open the 

project and then stored in your user profile. If you enter no or incorrect access data, 

the layer cannot be loaded. If you do not know the correct access data, please contact 

the creator of the project. 

Note that incorrectly entered credentials are also saved. They will then not be reques-

ted again when you reopen the project and affected layers can (again) not be loaded.  
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All access data stored in your user profile are listed in the general settings in the tab 

Credentials (see chapter 3.4.1.7). They can there by viewed, edited/corrected, or dele-

ted again at any time. 

• Note if the project contains a 3D window:  

o The 3D Viewer puts high demands on the hardware, especially on the graphics 

card (see chapter 1.2.1). If your system requirements are significantly lower than 

those of the project creator and the performance in the 3D Viewer (i.e. movement 

speed and rendering) is insufficient, it is recommended to reduce the data section 

displayed in the 3D Viewer (see chapter 4.1.15) and/or deactivate as many layers 

as possible (if possible also in the (2D) map viewer). 

If the 3D Viewer cannot be displayed performant even then, please contact the 

creator of the project. 

o If you open a GAFmap® project with a 3D window for the first time, at first the (3D) 

Edit Configuration dialog appears (see chapter 4.6.19). All values are first deter-

mined automatically here and can usually be taken over unchanged. 

• Note when you Start GAFmap® Express: The program cannot be started empty and will 

be closed again if no Pack&Go container is selected. 

 

3.1.2 Browse Project 

In GAFmap Express: Menu File 

Browse Project lets you load a(nother) GAFmap® Pack&Go Container (*.cmp or *.cmpaux). 

For this purpose a file browser opens. Select the desired project there and confirm with Open. 

 

3.1.3 Save Project / Save Project As 

In GAFmap Express: Menu File 

Save Project lets you save the project including your changes. A sidecar file with the extension 

*.cmpaux is then created and stored next to the Pack&Go Container (*.cmp). All your changes 

are saved in this file, the original *.cmp remains unchanged. 

When you save the project for the first time, a dialog appears where you can enter a name 

attachment for the sidecar file: 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  43 

 

Figure 43: Save Project dialog 

The sidecar file is always stored in the same directory as the respective *.cmp file. Its file name 

is always 

• [name *.cmp file]_[entered name extension].cmpaux 

 

Figure 44: Pack&Go Container with sidecar file 

Note: 

• If you want to reopen the project with your changes, you must open the sidecar file 

(*.cmpaux). If you directly open the Pack&Go Container (*.cmp), always the original 

project is opened. 

• The link between the sidecar file and the Pack&Go Container is made via its storage 

location ("next to the container") and the file name. If the file name of the *.cmp or 

the *.cmpaux is changed, or if both files are in different folders, the link cannot be 

restored. 

Save Project As always opens the dialog above. This way you can create any number of sidecar 

files with different name extensions. 

Shortcuts, Key Commands, etc.: 

• Ctrl+S: Save Project 

 

3.1.4 Exit 

In GAFmap Express: Menu File 

Exit closes GAFmap® Express including all open product components.  
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3.2 Menu Window 

The multi-window technique of GAFmap® provides the possibility to work with any number 

of map viewers and a 3D Viewer in parallel within one project. Via the menu Window you can 

link map viewers and save and recall window layouts at any time: 

Tips and notes: 

• For general information on the map window and working with multiple map windows, 

see chapter 2.2. 

 

3.2.1 Link Map/3D Viewers 

In GAFmap Express: Menu Window 

Only active if the project contains multiple map windows or an additional 3D window 

All commands and tools for adjusting the visible map extent within a map viewer, e.g. Move 

or Zoom (see chapter 4.1.3 et seqq.), only affect the active map window, i.e. the one high-

lighted in blue / marked with >>. Linking the map windows causes the view in all other map 

viewers to change accordingly, so that always the same area of the map is visible in all map 

viewers.  

You can choose between the following linking types: 

• With Link Extent, center coordinate and map scale are adopted in all map viewers. I.e. 

you always see the same map extent in all map viewers. If the size or aspect ratio of a 

map viewer differs from the active one, the visible map extent in this map viewer is 

cropped or expanded accordingly. 

• With Link Center, the center coordinate is adopted in all map viewers; the map scale 

can be set individually. I.e. you always see the same "spot" in all map viewers, but 

possibly in different zoom levels.  

• If no link is active, center coordinate and map scale can be set individually in all map 

viewers. There is no automatic adjustment. 

Select the desired linking type by clicking the corresponding command in the menu Windows. 

The active link is then displayed with a check mark in the menu: 
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Figure 45: Menu Window - active link Link Extent 

You can always detach an active link by clicking the command again. 

If the project contains a 3D window in addition to one or multiple (2D) map windows, the 

command Link 3D Viewer is also displayed in the menu. If activated, the map viewers are 

automatically centered to the current viewing position when you move around in the 3D 

viewer. The viewer's position in 3D (= the apex of the open triangle used to indicate the 

viewer's position, viewing direction and viewing angle in the map viewer) is then always at the 

center of the map viewer(s). If you move the map in a map viewer, the viewing position in the 

3D viewer does not change, i.e. not even if the windows are linked. 

If a map windows serves as Overview (see chapter 4.5.8), an active link has no effect for this 

window.  

Tips and notes 

• For general information on the map window and working with multiple map windows, 

see chapter 2.2. 

 

3.2.2 Show Multi Cursor 

In GAFmap Express: Menu Window 

Only active if the project contains multiple map windows or an additional 3D window 

If Show Multi Cursor is enabled, the current mouse position is displayed in all map viewers 

when you move the mouse cursor over any map viewer. This makes it easier to find the same 

spot in all map viewers, even if the map content or scale differ: 
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Figure 46: Multi Cursor  

If the project contains a 3D window in addition to one or multiple (2D) map windows, the multi 

cursor is displayed there as vertical red line: 

 

Figure 47: Multi Cursor in the 3D Viewer 

You can enable Show Multi Cursor by clicking the corresponding command in the menu 

Windows; it is then marked checked. It can always be disabled by clicking it again. 
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Tips and notes 

• You can adjust the symbol the multi cursor is displayed with in the general settings 

under Viewing (see chapter 3.4.1.3). 

• For general information on the map window and working with multiple map windows, 

see chapter 2.2. 

 

3.2.3 Load Project Window Layout 

In GAFmap: Menu Window 

Load Project Window Layout lets you reset the window layout to the layout stored in the 

project. This is either the original window layout stored in the Pack&Go project, or, if you have 

saved the project with own changes (see chapter 3.1.3), the layout when the project was last 

saved. Note that your current window layout is directly discarded and the action cannot be 

undone. 

Tips and notes: 

• For general information on window layouts in GAFmap®, see chapter 2.2.4. 

 

3.2.4 Load Saved Window Layout 

In GAFmap: Menu Window 

Only active if the project contains saved window layouts  

The command Load Saved Window Layout opens a submenu listing all window layouts saved 

in the project. If you click on one of the saved layouts, the corresponding window layout is 

directly taken over. Note that your current window layout is directly discarded and the action 

cannot be undone. 

Tips and notes: 

• For general information on window layouts, see chapter 2.2.4. 
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3.2.5 List of Map Viewers 

In GAFmap Express: Menu Window 

The last section of the menu Window shows a list of all map windows in the project. If a map 

window is e.g. minimized or hidden behind another window as tab, you can bring it up again 

at any time by clicking on it in the list. 

Tips and notes: 

• For general information on the map window and working with multiple map windows, 

see chapter 2.2. 

• For general information on window layouts, see chapter 2.2.4. 

 

3.3 Menu GPS 

GAFmap® supports integrated GPS modules (Windows Location Provider) and external GPS 

devices (via NMEA protocol). If a GPS receiver is connected/available, you can configure and 

connect it via the GPS menu and then center the map on the current GPS location. 

 

3.3.1 Connect/Disconnect 

In GAFmap Express: Menu GPS 

Connect activates the GPS connection. If in the general settings under Other the option GPS 

is selected as Additional Status Bar Info (see chapter 3.4.1.8), you are now shown there if a 

GPS signal is received and if so, the number of currently available satellites incl. PDOP value 

(Position Dilution Of Precision), which indicates the position accuracy: 

 

Figure 48: GPS information in status bar (top: GPS disconnected; middle: GPS connected, but no GPS signal is 
received; bottom: GPS connected, GPS signal is received) 

A GPS connection can only be established if the connection parameters for the connected/ 

available GPS receiver are set correctly in the GPS settings (see chapter 3.3.2 or 3.4.1.2), taking 

into account the manufacturer's specifications. The connection can be checked directly there. 
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If no GPS connection can be established, e.g. because no GPS receiver is connected or the 

connection parameters are incorrect, you receive a corresponding error message. 

If a GPS signal is received, your current GPS position including the viewing direction is dis-

played on the map: 

 

Figure 49: GPS position displayed on the map (including GPS height) 

The (point) symbol that is used to display the GPS position on the map and whether the GPS 

height is additionally displayed can be defined in the GPS settings. 

If the project contains a 3D window, you can also display your GPS position in the 3D viewer. 

With Disconnect an existing GPS connection is disconnected again. 

 

3.3.2 Settings 

In GAFmap Express: Menu GPS 

Settings takes you to the GPS tab of the general settings (Tools > Settings > GPS menu). There 

you can e.g. configure and test the GPS connection. 

For more information, see chapter 3.4.1.2. 
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3.3.3 Center on Position/Stay centered on Position 

[Menu Extras > Extensions > Location Services > GPS Connection] 

In GAFmap: Menu GPS 

If you execute Center on Position, the map viewer is centered (once) on the current GPS posi-

tion.  

If Stay Centered on Position is enabled, the map viewer is continuously centered on the cur-

rent GPS position; the menu item is then then marked checked. Centering can always be dis-

abled again by clicking the menu item anew. 

 

3.4 Menu Extras 

3.4.1 Settings 

3.4.1.1 Settings for Search Layers 

In GAFmap Express: Menu Extras > Settings 

Under Search Layers all sources are listed that are generally available for the Feature Search 

(see chapter 4.3). These include all loaded vector layers and geocoding services (by default 

OSM and GeoNames, can be extended with your own if required). 
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Figure 50: Settings for Search Layers 

The Feature Search searches all layers/services for which the check mark is set in the column 

Use for Search. Layers/services for which the check mark is not set are ignored. 

For vector layers, you can control which attribute fields are to be included in the search via 

the column Search Fields. You can reduce/adjust the search fields for each layer by clicking 

into the corresponding Search Fields cell. A field selection panel then opens. Check all the 

attribute fields that are to be searched and/or uncheck those that are not to be searched, and 

confirm with OK. Under Search Fields, only the checked fields that are actually taken into 

account are then listed. 

Via the setting Use Regex at the top of the tab, you can control whether regex ("regular ex-

pression") is used for the search (On) or not (Off). For more information on this, see chapter 

4.3. Please note 

• that this setting not only affects the Feature Search, but also the search in the attribute 

table (Find command; see chapter 5.3.2.1.1). 

• that an online search is not possible with regex. If regex is activated, the geocoding 

services are deactivated and the corresponding area in the tab cannot be operated. 
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At the bottom of the tab / settings window you can find the following buttons: 

• Restore: sets the geocoding services back to default. Settings for vector layers remain 

unchanged. The command has to be confirmed before it is executed. 

• Add: here, you can insert additional geocoding services. An entry New Service appears. 

See https://gdal.org/doxygen/ogr__geocoding_8h.html for information on how to 

enter the service parameters 

• Delete: deletes selected geocoding services (highlighted in blue) from the list. Multi-

selection is possible when pressing the Ctrl key. The command has to be confirmed 

before it is executed. 

•  Export/Import: saves selected geocoding services (highlighted in blue) as *.xml file / 

opens a file browser to browse for and load exported geocoding services. 

OK or the X button in the upper right corner of the window close the settings window. All 

changed settings are directly applied. 

 

3.4.1.2 Settings for GPS 

In GAFmap Express: Menu Extras > Settings 

If a GPS device is available (when using GAFmap® on a mobile device, e.g. a laptop or Surface 

tablet), either in the form of an integrated GPS module or a connected, external GPS device, 

you can use the settings under GPS to configure it, make certain user-defined settings for 

position recording in GAFmap® and adjust the GPS display options (symbology). 

Category GPS: 

• Provider Type: specifies the provider type. Available are ComPort (for external GPS 

devices connected via a COM port) and WindowsLocation (for integrated GPS modu-

les). 

• COM Port (only available for Provider Type = ComPort): specifies via which COM port 

the GPS device is connected. 

• Baud Rate (only available for Provider Type = ComPort): specifies the baud rate of the 

GPS device. If unknown, please refer to the GPS device's manual. 

• WGS84 Ellipsoid Height (only available for Provider Type = ComPort): specifies if the 

height above the WGS84 ellipsoid is recorded (On) or the geoidal height. Not all GPS 

devices support ellipsoid heights. 

• Use GGA Dilution (only available for Provider Type = ComPort): specifies which tag of 

the NMEA protocol is used to determine the values for the position accuracy (HDOP 

https://gdal.org/doxygen/ogr__geocoding_8h.html
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and PDOP). If Off, the exact values from the GSA (Satellite Status) tag are used; if On, 

the HDOP value from the GGA (Global Positioning System Fix Data) tag is used for both 

instead. Skipping the (more precise) GSA tag only makes sense for special NMEA pro-

tocols that do not contain this tag. 

• Position Update Frequency [s]: determines the time interval in seconds at which the 

current GPS position is to be stored. 

• Position Invalidation Time [s]: determines the time span in seconds within which a 

GPS signal must be received for a position to be considered valid. If the time is ex-

ceeded, the position is discarded. 

• Signal Timeout Time [s]: determines how long the GPS connection is maintained with-

out a signal. If the time is exceeded, the GPS connection is disconnected. 

• Max PDOP: determines the maximum PDOP value for a position to be considered valid. 

If the value is exceeded, the point is discarded. 

The PDOP (Positional Dilution of Precision) indicates how strongly the measured values 

scatter. The higher the value, the less reliable the GPS position. Commonly, values > 10 

are considered unreliable (see e.g. Wikipedia - Dilution of Precision (Navigation)). 

Category Symbology: 

• GPS Position Symbol: specifies the point symbol used to indicate the GPS position in 

the map viewer. 

 opens the Point Symbol dialog (see chapter 6.1) 

• GPS Position 3D Symbol (only shown if your GAFmap® license includes the 3D Viewer 

extension and this extension is activated): specifies the 3D point symbol used to indi-

cate the GPS position in the 3D viewer. 

 opens the 3D Point Symbol dialog (see chapter 6.6) 

• GPS Height Label: specifies the label style with which the GPS height is labeled in the 

map viewer. 

 opens the Labeling dialog (see chapter 6.4) 

• Show GPS Height: determines whether the GPS heights are shown in the map viewer 

(On) or not (Off). 

Using the Test button, you can check whether a GPS signal is being received. The NMEA data 

received is then displayed in the box below. If no data is received, the box remains empty. The 

test can always be ended with Stop button.  

https://en.wikipedia.org/wiki/Dilution_of_precision_(navigation)
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Figure 51: Test image for GPS signals 

At the bottom of the tab / settings window you can find the following buttons: 

• Restore: sets all settings within the tab back to default. The command has to be con-

firmed before it is executed. 

OK or the X button in the upper right corner of the window close the settings window. All 

changed settings are directly applied. 

The settings in this tab are stored in your user profile. They are uploaded from your profile 

when you open GAFmap® Express and written back when you close it. So when working with 

multiple GAFmap® Express instances, be careful in which order you close them to avoid 

overwriting changed settings unintentionally.  

 

3.4.1.3 Settings for Viewing 

In GAFmap Express: Menu Extras > Settings 

Under Viewing, various basic settings can be made for the visualization of data in the map 

viewer / on the screen ("rendering options"). 

Category General 

• Anti Aliasing: specifies an anti-aliasing effect applied on vector data and graphics on 

screen. If enabled, inclined lines appear less pixelated. This effect is visible using large 

scales and/or broad lines. 

Category Status Bar 

• Coordinate Display Format: If you move the mouse pointer over the map viewer, its 

X/Y coordinates are displayed in the status bar (see chapter 2.2.1.3). With this setting 

you can influence the display format.  
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If you select Custom, the spatial reference entered below at Custom Spatial Reference 

is used .  

• Custom Spatial Reference: specifies your preferred spatial reference. It is e.g. used as 

Coordinate Display Format if you select Custom (see above), and is suggested as Other 

Spatial Reference when you use Go to Coordinate (see chapter 4.1.8). 

• Show Z-Coordinate: if Off, only the X/Y coordinates of the mouse pointer are displayed 

in the status bar when you move it over the map viewer. If On, additionally the (terrain) 

height is displayed. 

 

The height is derived from the base DEM (see chapter 5.3.4). For areas for which no 

DEM is available, no height can be displayed. 

Category Symbology 

• Background Color: specifies the background color of the (2D) map viewer. 

 opens the Color Picker dialog (see chapter 6.5) 

• Selection Color: specifies the color in which features are selected. 

 opens the Color Picker dialog (see chapter 6.5) 

• Multi Cursor Symbol: specifies the point symbol used for the multi cursor (see chapter 

3.2.2). 

 opens the Point Symbols dialog (see chapter 6.1) 

• Drag Rectangle Symbol: specifies the (sketch) line symbol used when dragging a rect-

angle. 

 opens the Line Pen dialog (see chapter 6.2) 

• Overview Extent Symbol: specifies the line symbol used to indicate the other map 

viewer in an Overview map. 

 opens the Line Pen dialog (see chapter 6.2) 

• Overview Extent Label: determines whether the other map viewers are labeled with 

their names in an Overview map (On) or not (Off). 

• Highlight Point Symbol: specifies the point symbol used to highlight (selected) features 

in the map viewer. 

 opens the Point Symbols dialog (see chapter 6.1) 
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• Highlight 3D Point Symbol (only available if the project contains a 3D window): speci-

fies the 3D Point symbol used to highlight (selected) features in the 3D Viewer. 

 opens the 3D Point Symbols dialog (see chapter 6.6) 

• Highlight Line Symbol: specifies the line symbol used to highlight (selected) features 

in the map viewer. 

 opens the Line Pen dialog (see chapter 6.2) 

• Highlight Label: specifies the label style used to highlight text labels in the map viewer. 

 opens the Labeling dialog (see chapter 6.4) 

• Highlight Fill Symbol: specifies the fill symbol used to highlight (selected) features in 

the map viewer. 

 opens the Fill Symbols dialog (see chapter 6.3) 

• Small Cross Symbol: specifies the point symbol used to indicate "small crosses". 

 opens the Point Symbols dialog (see chapter 6.1) 

• Big Cross Symbol: specifies the point symbol used to indicate "big crosses". 

 opens the Point Symbols dialog (see chapter 6.1) 

Category Anaglyph 

• Anaglyph Shift [px]: determines the shift between the two images (normally a red and 

a green one) calculated for the anaglyph that have to overlay each other to cause the 

3D effect. The unit of the shift is presented in pixels and the default value is 30. An 

anaglyph shift with more than 30 pixels leads to a higher exaggeration and causes a 

stronger 3D effect. 

• Anaglyph Area of View: determines whether the anaglyph depth is adjusted to the 

area of view (On) or to the full extent of the dataset (Off). 

Category Viewshed 

• Eye Height [m]: determines the default eye height used for viewshed calculations (see 

chapters 4.5.6 and 4.6.6) or sight lines (see chapter 4.7.15) (= starting height). 

• Target Height [m]: determines the default target height used for viewshed calculations 

(see chapters 4.5.6 and 4.6.6) or sight lines (see chapter 4.7.15). 

• Viewshed Quality: determines the accuracy with which the 2D viewshed is performed. 

The higher the selected quality, the better the pyramid level used and its reconstruc-

tion within the map viewer and the more sampling steps are carried out outside the 

visible map extent. 

For more detailed information, see chapter 4.5.6. 
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Please note that a higher quality has a negative effect on the performance, i.e. on the 

image build-up in the map viewer. 

This setting has no effect on the 3D viewshed (see chapter 4.6.6). 

Category Scalebar 

Settings of this category affect the scalebar that can be switched on/off via the map viewer 

toolbar. For more information, see chapter 4.5.9. 

• Line Style: specifies whether the scalebar is drawn as a classical bar (Off) or as a simple 

line (On). 

• Color: specifies the color of the scalebar. 

 opens the Color Picker dialog (see chapter 6.5) 

• Background Color: specifies the background color of the scalebar. 

 opens the Color Picker dialog (see chapter 6.5) 

• Scalebar Labeling: specifies the font style for the labeling of the scalebar. 

 opens the Labeling dialog (see chapter 6.4) 

Category Labeling 

• Prevent Overlaps: if On, it is checked across all layers whether labels overlap. If this is 

the case, it is searched for a "free" space within the Maximum Shift and the Shift Step 

Size specified below and the label is moved there. 

If no free space is found within the maximum permissible shift or if a labeling shift on 

layer level is suppressed, overlapping labels are not drawn (i.e. the feature concerned 

is not labeled). 

Note the following priorities when shifting/drawing labels: The further up in the TOC, 

the higher the priority of a layer and the further down in the attribute table in the 

current sorting, the higher the priority of a feature (analogous to the drawing order of 

the feature geometries; see chapter 2.2.2.1 or 5.3.2.1). 

• Adjust Label Positions: determines whether the caption of features that exceed 

beyond the visible map extent is always shifted into the visible map extent (On) or not 

(Off). 

• Shift Step Size [px]: determines the step size (in screen pixels) used when searching 

for a free space for the label (i.e. how coarse/fine a label is shifted). Note that placing 

the label in small steps may take a long time. Choose a compromise if necessary. 
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• Maximum Shift [px]: determines the maximum distance a label can be shifted when 

searching for a free space (in screen pixels). If no free space is found within this radius, 

the label is not drawn. 

Category Symbology for new Graphics 

Settings in of this category are, if applicable, automatically applied to all newly created 

point, line, and polygon graphics and text labels. 

• Point Symbology: specifies the default symbology for newly created point graphics. 

 opens a window with all symbology properties of point graphics. For more inform-

ation, see chapter 5.2.4.2. 

If the project contains a 3D window, the default symbology for 3D points is also set 

under Point Symbology. For more information on 3D point properties, see chapter 

5.2.12.1. Also note the following: 

o Generate 2D Point Symbol from 3D Point Symbol: if On, 3D points are displayed 

by default with an image of the 3D point symbol in the (2D) map viewer. If Off, 

3D points are displayed by default with the default point symbol for (2D) point 

graphics in the (2D) map viewer. 

A 3D point is always listed with the 2D point symbol determined for it in the TOC. 

o Set New Symbol as Default: if On, the symbology applied to a 3D point in the Add 

3D Point dialog is used as default symbology, i.e., Set as default point symbology 

is checked by default in the dialog (see chapter 4.7.11). If Off, the box is not 

checked by default in the dialog. 

You can always check or uncheck the option in the dialog if the default symbology 

is to be replaced or not replaced by the symbology in the dialog.  

The default 2D symbology of 3D points (2D point Symbol, 2D labeling including label 

style etc.) corresponds to the default symbology for (2D) point graphics.  

• Line Symbology: specifies the default symbology for newly created line graphics. 

 opens a window with all symbology properties of line graphics. For more infor-

mation, see chapter 5.2.5.4. 

• Polygon Symbology: specifies the default symbology for newly created polygon 

graphics (incl. circle/ellipse and rectangle graphics). 

 opens a window with all symbology properties of polygon graphics. For more infor-

mation, see chapter 5.2.7.2. 
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• Label Symbology: specifies the default symbology for newly created text labels. 

 opens a window with all symbology properties of text label graphics. For more infor-

mation, see chapter 5.2.9.2. 

The label text can be edited any time later via Text in the Graphic Properties (see e.g. 

chapter 5.2.4.2). 

If the project contains a 3D window, the default symbology for 3D text labels is also set 

under Label Symbology. For more information on 3D text label properties, see chapter 

5.2.13 or 5.2.12.1. 

The default 2D symbology of 3D labels (i.e. the style of the text on the labeling panel) 

corresponds to the default symbology for (2D) labels. 

• Viewshed Point Symbology (only with extension Data Analysis > Viewshed Visuali-

zation): specifies the default symbology for newly created viewshed point. 

 opens a window with all symbology properties of point graphics. For more infor-

mation, see chapter 5.2.4.2 

If the project contains a 3D window, the default symbology for 3D viewshed points is 

also set under Viewshed Point Symbology (analog to 3D point, see above). 

The default symbology for newly created graphics can also be specified via the button 

Symbology in the Graphics Toolbar (see chapter 4.7.17). Settings that are made there are 

automatically applied here and vice versa. The symbology of graphics can be adjusted any 

time later via the Graphic Properties. For more information, see chapter 5.2. 

At the bottom of the tab / settings window you can find the following buttons: 

• Restore: sets all settings within the tab back to default. The command has to be 

confirmed before it is executed. 

OK or the X button in the upper right corner of the window close the settings window. All 

changed settings are directly applied. 

The settings in this tab are stored in your user profile. They are uploaded from your profile 

when you open GAFmap® Express and written back when you close it. So when working with 

multiple GAFmap® Express instances, be careful in which order you close them to avoid over-

writing changed settings unintentionally. 
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3.4.1.4 Settings for Editing 

In GAFmap Express: Menu Extras > Settings 

Under Editing, you can make various settings relating to the capture and editing of new/own 

graphics (see chapter 4.7). 

Category General 

• Show Measurement: If On, the current length of lines is displayed while a line is crea-

ted or edited, the area size is displayed while creating or editing areal graphics. The 

displayed unit depends on the Length Unit and the Area Unit specified below.  

The measuring method corresponds to that of the Measure tool (see chapter 4.1.13.1). 

• Length Unit: determines the displayed length unit for measurements when creating or 

editing Graphics (see e.g. chapter 5.2.5.4). Select the desired unit from the drop-down 

list. If you choose Automatic, the unit is automatically adjusted depending on the 

current length of the sketch line.  

The unit is always metric, independent of the used coordinate system. If no spatial 

reference is set for the map, metric is assumed. 

• Area Unit: determines the displayed area unit for measurements when creating or edi-

ting Graphics (see e.g. chapter 5.2.7.2). Select the desired unit from the drop-down list. 

If you choose Automatic, the unit is automatically adjusted depending on the current 

area of the sketch polygon. 

The unit is always metric, independent of the used coordinate system. If no spatial 

reference is set for the map, metric is assumed. 

Category Sketch 

Settings of this category affect the symbology of the edit sketch.  

• Sketch Line Symbol: specifies the line symbol used for edit sketches. It affects, amongst 

others, the line sketch and the outline of the polygon sketch. 

 opens the Line Pen dialog (see chapter 6.2) 

• Sketch Fill Symbol: specifies the fill symbol used for sketch polygons when creating / 

adding area. 

 opens the Fill Symbols dialog (see chapter 6.3) 

• Vertex Symbol: specifies the point symbol used for the vertices in vertex editing mode. 

 opens the Point Symbols dialog (see chapter 6.1) 
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• Delete Vertex Symbol: specifies the point symbol used for the highlighted vertex in 

vertex editing mode. 

 opens the Point Symbols dialog (see chapter 6.1) 

• Insert Vertex Symbol: specifies the point symbol used for an indicated new vertex in 

vertex editing mode. 

 opens the Point Symbols dialog (see chapter 6.1) 

Category Snapping 

Settings of this category affect the snapping to existing vertices or edges in general, as well 

as the display of the symbols that indicate snapping.  

• Snapping Distance [monitor pixels]: defines the maximum distance at which an exis-

ting vertex or line segment is snapped. Regardless of the entered distance, you can 

always temporarily disable the snapping function by holding the N key. 

• Snap to Sketch: if On, sketch vertices are snapped while editing if they fall below the 

snapping distance. If Off, the sketch geometry is excluded from snapping.  

• Snap Symbol Vertex: specifies the point symbol used to indicate vertex snapping. 

 opens the Point Symbols dialog (see chapter 6.1) 

• Snap Symbol Line: defines the line symbol used to indicate line snapping. 

 opens the Line Pen dialog (see chapter 6.2) 

• Snap Symbol Auxiliary Line: specifies the line symbol used to indicate snapping to an 

auxiliary line. 

 opens the Line Pen dialog (see chapter 6.2) 

• Show Snap Hint Label: if On, snap hints are shown in the map viewer during editing: 

the layer that is snapped to and where. Possible are: 

o layer_xyz : Vertex (when snapping to a vertex) 

o layer_xyz : Line (when snapping to a line segment) 

o layer_xyz : Intersection (when snapping to an intersection of line segments with-

out vertex) 

o layer_xyz : Intersection at Vertex (when snapping to a vertex at an intersection of 

lines/rings or to a common vertex) 

If Off, no snap hints are shown. 

Alternatively, the snap hints can be enabled/disabled in the map viewer with Ctrl+G. 
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The labeling style for the description can be customized via Snap Hint Labeling. 

 opens the Labeling dialog (see chapter 6.4) 

Category Tracing 

• Toggle Tracing for All Tools: if On, tracing is activated/deactivated for all suitable tools 

at once when using the set keyboard command (F4 by default). If Off, tracing is only 

toggled for the one tool that is currently active, i.e. framed in blue.  

You can tell that tracing is activated for a tool by the tracing hint (t) above the mouse 

pointer: 

 

• Tracing Across Multiple Features: determines whether lines are traced across features 

(On) or whether only a single feature or graphic is traced (Off). 

If Off, the start and end points for line tracing must be set on the same line or polygon 

feature. For line tracing across features, an intermediate vertex must then be set at 

each feature transition. 

• Maximum Lines Count (only available if tracing across multiple features is enabled): 

specifies the maximum number of line objects allowed within the currently visible map 

extent for line tracing to be performed. For (multipart) lines, each line part counts as 

one line object; for polygons, each ring counts as one line object.  

The number can be increased as needed. However, please note that this will reduce 

the performance! 

• Tracing Hint Label: specifies the labeling style used for the tracing hint (t) above the 

mouse pointer: 

 opens the Labeling dialog (see chapter 6.4) 

Category Digitizing Halo 

• Digitizing Halo Radius: determines the radius of the halo around the mouse pointer in 

meters. You can also specify multiple halos separated by semicolons (e.g. 50;100;150). 

The halo(s) can always be toggled on/off with the set key command (Ctrl+H by default), 

e.g. during feature capture. 

Digitizing Halo Line: specifies the line symbol used for the halo. 

 opens the Line Pen dialog (see chapter 6.2). 
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Category Tolerances 

• Sticky Move Tolerance [monitor pixels]: specifies the distance that has to be exceeded 

once before a self-created graphic can be moved.  

At the bottom of the tab / settings window you can find the following buttons: 

• Restore: sets all settings within the tab back to default. The command has to be con-

firmed before it is executed. 

OK or the X button in the upper right corner of the window close the settings window. All 

changed settings are directly applied. 

The settings in this tab are stored in your user profile. They are uploaded from your profile 

when you open GAFmap® Express and written back when you close it. 

 

3.4.1.5 Settings for Shortcuts 

In GAFmap Express: Menu Extras > Settings 

In the tab Shortcuts you can look up and customize shortcuts for various functions/com-

mands. 

Up to two shortcuts can be applied for each listed function. Possible shortcuts are single keys 

or key combinations.  

You can enter new ones or change already applied shortcuts by clicking on the corresponding 

field (Key 1 /Key 2) twice and entering the new key(s). If you want to enter a key combination 

like Ctrl+Shift+S, you have to press all desired keys at once. You are warned if an entered 

shortcut is already applied to another function. A set shortcut can be deleted by double-click-

ing the corresponding field and pressing the assigned key or, in the case of key combinations, 

pressing any key twice in succession. 

At the bottom of the tab / settings window you can find the following buttons: 

• Reset Selected / Reset All Shortcuts: sets the shortcuts for selected (highlighted in 

blue) / all functions back to default.  

! Please note that the reset cannot be undone. 

• Export/Import: saves selected shortcuts (highlighted in blue) as *.xml file / opens a file 

browser to browse for and load exported shortcuts. If you press the Ctrl key while 

exporting, a list of all assigned shortcuts (predefined and custom) is played out as *.csv. 
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OK or the X button in the upper right corner of the window close the settings window. All 

changed settings are directly applied. 

Custom shortcuts are stored in your user profile. They are uploaded from your profile when 

you open GAFmap® Express and written back when you close it. 

 

3.4.1.6 Settings for Toolbars 

In GAFmap Express: Menu Extras > Settings 

Under Toolbars you can customize the toolbars in the user interface according to your needs. 

For this purpose, you can either show, hide, or move individual functions in existing toolbars, 

or create and organize new toolbars from scratch. 

The Command column always shows a complete list of functions, which are assigned to but-

tons (in the main window). These functions cannot be deleted, but can be unchecked and thus 

hidden and/or rearranged if desired. 

The Map Viewer toolbar and the 3D Viewer toobar cannot be adjusted or rearranged, as the 

contained functions always refer to the associated (2D) map / 3D window and are therefore 

permanently assigned to it (see chapter 4.5). This toolbar and all the contained functions are 

therefore missing in the list. 

Toolbars under Top/Bottom Panel are arranged in the GAFmap® Express main window above/ 

below the map window area, those under Left/Right Panel to the left/right of the map window 

area. The individual buttons/functions appear in the toolbar under which they are sorted, 

optionally grouped under split buttons or separated with separators (see below). The order of 

the toolbars and the functions within a toolbar in the list determines their order in the user 

interface, in each case "in reading direction" from top left to bottom right.  

You can reorganize entire toolbars as follows: 

• show/hide it by checking/unchecking it. 

• move it via drag & drop to the required position (also across panels). 

• rename it by clicking onto a selected toolbar and entering the new name. 

• create a new toolbar by calling up Add Toolbar in the panel's context menu. You can 

then move the toolbar to the required position and/or rename it. 
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Figure 52: panel context menu  

• remove a toolbar by calling up Remove in its context menu. 

 

Figure 53: toolbar context menu: remove toolbar 

Note that a toolbar can only be removed if it does not contain any functions. 

• separate toolbars with line breaks to make the panel easier to read. To do this, call up 

Add Line Break in the panel's context menu. The line break can then be moved to the 

desired position via drag & drop. 

You can remove a line break by calling up Remove in its context menu. 

You can reorganize individual functions/commands in a toolbar as follows: 

• show/hide it by checking/unchecking it, 

• move it via drag & drop to the required position (also across toolbars), 

• group them by moving them under a split button folder. 

 

Figure 54: example of a split button 

A split buttons can be added by calling up Add Split Button in a toolbar's context menu 

and moved via drag & drop. 

 

Figure 55: toolbar context menu 
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You can remove a split button by calling up Remove in its context menu. Note that a 

split button can only be removed if it does not contain any functions. 

• divide them with vertical separators to make the toolbar easier to read. 

 

Figure 56: examples of separators 

A split buttons can be added by calling up Add Separator in a toolbar's context menu, 

moved via drag & drop, and removed by calling up Remove in its context menu. 

At the bottom of the tab / settings window you can find the following buttons: 

• Restore: resets the toolbars to default.  

! Please note that the reset cannot be undone. 

• Export/Import: saves the toolbar settings as *.xml file / opens a file browser to browse 

for and load exported toolbar settings. 

OK or the X button in the upper right corner of the window close the settings window. All 

changed settings are directly applied. 

Custom toolbars are stored in your user profile. They are uploaded from your profile when 

you open GAFmap® Express and written back when you close it. 

Tips and notes: 

• Changes to toolbars made directly in the user interface (via drag & drop) are only tem-

porary. When GAFmap® is started, the toolbar order will always be restored according 

to the settings in this tab. 

 

3.4.1.7 Settings for Credentials 

Under Credentials you can view, edit, or delete all stored credentials. The list includes all cre-

dentials that you have entered yourself and that are stored in your user profile, as well as any 

additional credentials that are stored in the software itself. The latter are user-independent 

and cannot be deleted. 

If you open a project that contains data that require credentials, e.g. certains web servics or 

linked data from cloud directories, these are requested once and are then stored in your user 
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profile. All credentials from your user profile are listed for you in the general settings under 

Credentials and, as long as they are not deleted there, are automatically reused when you 

recall the directory / service.  

Please note that incorrect access data is also stored. If you enter, for example, an invalide 

password, you will not be able to connect to the directory/service until you correct the cre-

dentials in the general settings. You will get an error message when trying to connect (e.g. 

"The remote server returned an error: (401) Unauthorized"); the credentials are not e.g. re-

quested again. 

 

Figure 57: Settings for Credentials ("Credential Store") 

On the right side of the tab you can find the following buttons: 

•  Edit: opens the input window for the selected (blue highlighted) credentials; there, 

the required parameters can be changed/corrected. The access data is then reset ac-

cordingly. 

•  Remove/Reset: deletes all selected credentials from the list (and thus from your 

user profile) or resets changed credentials stored in the software to default setting. 

•  Export: exports all selected credentials individually as an encrypted *.crdntl file. A 

folder browser opens where you can select the target directory.  

•  Import: allows for loading access exported credentials. A file browser opens. Here 

you can search and open the required *.crdntl file. 
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! Please close any other open GAFmap® instances before adding, deleting, or resetting cre-

dentials in the tab, as otherwise the changes may not be correctly written back to your user 

profile and will then not be available when you open the software anew. 

OK or the X button in the upper right corner of the window close the settings window. All 

changed settings are directly applied. 

 

3.4.1.8 Other Settings 

In GAFmap Express: Menu Extras > Settings 

Within the tab Other general (program) settings can be made. 

Category General 

• Check for update on program start: determines whether it is checked for software 

updates whenever GAFmap® Express is started (On) or not (Off). 

• Default Open Project Dialog Tab: determines which tab (Recent/Local/Central) is pre-

selected in the Open Project dialog. 

Category Handling 

• Zoom Factor: determines by which factor the map scale changes when using the zoom 

buttons (see chapter 4.1.4). A factor of 1.5, for example, changes the scale with each 

click as follows: 1:6.667, 1:10.000, 1:15.000 etc. 

• Pan Factor: specifies the factor the map is moved within the map viewer when using 

the arrow keys. A pan factor of 0.5 for example results in the map being shifted by half 

the visible extent within the map viewer. 

• Mouse Wheel Up is Zoom In: if On, the map extent is enlarged when rolling the mouse 

wheel upwards (zoom in) and shrunken when rolling the mouse wheel downwards 

(zoom out). If Off, the rolling direction is inverted. 

• Zoom To Flight Duration [s] (only relevant if the project contains a 3D window): deter-

mines the duration of the flight animation that is performed when zooming to a layer 

in the 3D viewer (see chapter 5.2.1.1 or 5.3.1.1). 

• Include Background in Layer Select (affects function Select Layer; see chapter 4.1.10): 

if On, when you drag a selection rectangle in the map viewer, all layers that lie within 

the rectangle or are intersected are selected in the TOC. If Off, only vector layers and 

graphics are taken into account. Raster layers can then only be selected with a simple 

left click in the map viewer. 
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• Open Identify for Feature Search Result: if On, features found with Features Search 

(see chapter 4.3) are listed in the Search dialog, which corresponds to the Identify win-

dow (see chapter 4.1.11). If Off, the found features are only selected. 

• Always Keep Scale when Switching Features: if Off, the map is always zoomed to the 

feature(s) headed for, for example if you jump from feature to feature by using Show 

Attributes (chapter 4.2.1) or by double-clicking rows/features in the Attribute Table 

(chapter 5.3.2.1). The map scale only remains constant if you hold the Alt key while 

switching features. If On, the map scale is always kept when switching features. 

• Specific Map Scale (1 : x): defines the map scale that is applied when pressing the Z 

key (shortcut for Zoom to Specific Map Scale). 

• Prompt Graphics Name: if Off, newly created graphics are given a default name in the 

TOC that reflects their type (e.g. AOI, Rectangle, Point etc.). If On, you are prompted 

to enter a name for newly created graphics. 

• Show Column with Number of Selected Features: Here, you can enable a column on 

the right side of the TOC showing the number of selected features per vector layer / 

group. 

 opens a drop-down list 

For more information on feature selection, see chapter 4.2.3.1. 

• Additional Status Bar Info: determines, which additional information is displayed in 

the status bar (see chapter 2.2.1.3). Available are: 

o Disabled: if selected, no additional information is displayed. 

o GPS: if selected, the GPS status is displayed. 

o Selected Layers Count: if selected, the number of layers currently selected (= high-

lighted in blue) in the TOC is diplayed.  

o Selected Feature Measurement: if selected, the size of the currently selected 

feature is displayed. The unit (m²/ha/km² or m/km) depends on the predefined 

area or length unit (see chapter 3.4.1.4). If multiple features are selected, no size 

is displayed, i.e. the size is not, for example, added up. 

 opens a drop-down list 

Category Raster Settings 

• Show Message Dialog on Raster Read/Write Error: if On, you get an error message in 

the form of a dialog if an error occurs while reading raster data. If Off, the error mes-

sage is only displayed briefly in the status bar (see chapter 2.2.1.3).  
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• Only Show Used Bands in Pixel Info and Raster Inspector: If On, only those bands of a 

raster that are currently in use (i.e. visible in the map viewer) are taken into account 

when querying pixel values with Pixel Info (see chapter 4.1.12). If Off, all bands are 

taken into account; please note that the query may then take a long time for multi-

band raster stacks.  

If you hold the Ctrl key while clicking into the raster with Pixel Info, the setting is 

temporarily inverted. 

For more information on the band mapping/usage, see chapter 5.3.3.6. 

Category Proxy Settings 

• Use Proxy: determines whether a proxy is used for web requests or not (Disabled). If 

the System Proxy is used, custom credential (i.e. login and password) can be entered 

if necessary. If you choose Custom Proxy, the address of this proxy has to be entered 

additionally. You can also decide whether this proxy should be bypassed on local 

requests. 

Category Cache Settings 

• Raster Cache (MB): determines the size of cache for rasters. By default, 10% of the 

main memory size is entered. 

• Layer Cache (MB): determines the size of the cache for all drawn layers. By default, 7% 

of the main memory size is entered.  

Please note that performance problems can occur if the set cache size is too small, and an 

Out of Memory error if the size is too big.  

Category Directories: 

• TMS Cache Directory: determines the cache directory for online map services, i.e. the 

directory where called raster tiles of WMS/WMTS/TMS are (temporarily) stored.  

• Temp Directory: determines the directory for temporary files created with GAFmap® 

Express. 

• Local/Central Projects Directory: determines the default directory for locally/centrally 

stored projects. 

Please note: All directories listed here require rights for reading, the directories for TMS 

Cache and temporary files also for writing. 

At the bottom of the tab / settings window you can find the following buttons: 

• Manage TMS Cache: lets you empty the TMS Cache Directory (see above) completely 

or partially, i.e. you can delete locally (temporarily) stored raster tiles of WMS, WMTS, 
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and TMS or 3D tiles. Note that these raster tiles are then no longer available when a 

service is called again and must therefore be re-downloaded if required. This can 

significantly increase the loading time, especially with a slow (Internet) connection, 

and offline use is no longer possible. 

A window opens in which all cached raster tiles (*. cache) and 3D tiles (*.3dcache) are 

listed, separated by online service and including cache size. With the delete button you 

can delete the saved data for the listed services individually. 

• Restore: sets all settings within the tab to back to default. The command has to be 

confirmed before it is executed. 

OK or the X button in the upper right corner of the window close the settings window. All 

changed settings are directly applied. 

The settings in this tab are stored in your user profile. They are uploaded from your profile 

when you open GAFmap® Express and written back when you close it. 

 

3.4.2 Language 

In GAFmap Express: Menu Extras 

Via Language you can change the language used for the user interface. GAFmap® Express is 

available in English and German. 

Please note that GAFmap® Express has to be restarted for a language change. 

The selected language is stored in your user profile. 

 

3.4.3 Open User Folder 

In GAFmap Express: Menu Extras 

Via the submenu Open User Folder you can access your GAFmap® user profile (Roaming, Local 

or directly Log). If you select one of the three commands, the standard file browser / explorer 

opens at the corresponding location. 
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3.5 Menu Help 

3.5.1 About GAFmap Express 

In GAFmap Express: Menu Help 

Here, you can check the following basic software information: 

• used software version 

• copyright 

• product code 

• short description of GAFmap® Express 

Licenses and Acknowledgments takes you to the directory that holds all (third-party) licenses 

and acknowledgements that are binding when using the software. 

 

3.5.2 Help 

In GAFmap Express: Menu Help 

Use Help to go to the front page of the software manual. 
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4 GAFmap Toolbars 

4.1 Main Toolbar 

4.1.1 Save Project 

In GAFmap Express: Main Toolbar 

 Corresponds to Save Project from the Menu File. See chapter 3.1.3. 

 

4.1.2 Open Project 

In GAFmap Express: Main Toolbar 

 Corresponds to Open Project from the Menu File. See chapter 3.1.1. 

 

4.1.3 Pan 

In GAFmap Express: Main Toolbar 

Only active for (2D) map windows 

 Pan lets you change the currently visible map extent. Therefore, activate the Hand, grab 

the map with a left-click on the map viewer, hold the mouse button, move the map to the 

favored position and release the mouse button.  

Shortcuts, Key Commands, etc.: 

• Pressed mouse wheel while another tool is active: grab and move map 

• Space while another tool is activated: temporarily activate Hand   

• Arrow keys: move map by one step in the corresponding direction. You can customize 

the pan factor in the general settings (see chapter 3.4.1.8). 

• Back/Insert: go to last/next extent 

• For more shortcuts, see chapter 4.1.4 
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4.1.4 Zoom In / Zoom Out 

In GAFmap Express: Main Toolbar 

Only active for (2D) map windows 

  Zoom In / Zoom Out lets you scale the currently visible extent up / down. Every left-

click in the map viewer changes the scale by one step. The step size (zoom factor) can be 

adjusted in the general settings (see chapter 3.4.1.8). 

Using Zoom In you also have the possibility to choose the new display extent by dragging a 

corresponding rectangle within the map viewer. 

Shortcuts, Key Commands, etc.: 

• Home: zoom to full extent 

• Z: zoom to specific map scale 

• Mouse wheel: zoom extent 

• Ctrl + mouse wheel: zoom extent with 1/5 of the zoom factor 

• Alt + left-click on selected layer(s)/group(s) in the TOC: zoom to layer(s)/group(s) 

• Back/Insert: go to last/next extent 

• For more shortcuts, see chapter 4.1.3  

 

4.1.5 Go to Last/Next Extent 

In GAFmap Express: Main Toolbar 

  Go to Last Extent lets you go back to previous extents step by step while Go to Next 

Extent lets you restore undone extents. 

Undone/restored are the Center and the Extent of the extent visible in the map viewer, e.g if 

the extent has been moved or zoomed with the mouse wheel or by using the corresponding 

buttons in the toolbar, not e.g. (size) changes to the map viewer itself or the activation status 

of layers in the TOC. 

Note that an undone extent can only be restored if it has not been adjusted manually in the 

meantime. 

If multiple map viewers are open, the extent is undone/restored across all windows step by 

step in the respective order, i.e. regardless of which window is active. Note that the extent in 

other map viewers is also changed if the center or the extent of the windows is linked (see 

chapter 3.2.1).  
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Shortcuts, Key Commands, etc.: 

• For shortcuts, see chapter 4.1.3 and 4.1.4 

 

4.1.6 Zoom to Full Extent 

In GAFmap Express: Main Toolbar 

 Zoom to Full Extent zooms the extent visible in the map viewer to the full extent of all 

loaded datasets, regardless of whether the layers are activated/checked in the TOC or not. 

If the project contains multiple map windows, only the extent of the active window is adjusted. 

Note that the extent in other map viewers is also changed if the center or the extent of the 

windows is linked (see chapter 3.2.1).  

Shortcuts, Key Commands, etc.: 

• For shortcuts, see chapter 4.1.3 and 4.1.4 

 

4.1.7 Map Scale 

In GAFmap Express: Main Toolbar 

Only active for (2D) map windows 

 In the scale field, the current map scale is displayed. You can always adjust 

the scale by either selecting one of the predefined scales from the drop-down list or by typing 

in any scale and confirming with Enter. The map viewer is then zoomed accordingly.  

If the project contains multiple map windows, the scale refers to the active (highlighted) map 

window, and changes only affect this one. Note, however, that the map viewers in the other 

map windows are also adjusted if the extent is linked (see chapter 3.2.1). 

The scale of the map displayed on the screen depends on the size of the screen and its reso-

lution. The calculation in GAFmap® presumes a pixel density of 96 dpi (at 100% DPI scaling in 

Windows). If your screen has a different resolution, the scale displayed on the screen deviates 

accordingly from the entered scale. 

Shortcuts, Key Commands, etc.: 

• For shortcuts, see chapter 4.1.3 and 4.1.4 
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Tips and notes: 

• The desired map scale can also be set via Set Map Scale in the map context menu (see 

chapter 5.1.2). 

 

4.1.8 Go to Coordinate 

In GAFmap Express: Main Toolbar 

Only active for (2D) map windows 

 Go to Coordinate lets you center the map viewer on any entered coordinate. The coor-

dinate can be specified as follows: 

 

Figure 58: Dialog Go to Coordinate 

• Geographic: if selected, the coordinates can be entered in the fields Lon/Lat as 

Decimal Degree, Degree-Minute, or Degree-Minute-Second. 

• Map Spatial Reference X/Y: if selected, the coordinates can be entered for the current 

map coordinate system in the fields X/Y. 

• Other Spatial Reference X/Y: if selected, you can browse for another spatial reference 

the coordinates are to be entered in. The input fields are then adapted to the chosen 

coordinate system. 

 opens a file browser 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  77 

If you have entered a Custom Spatial Reference in the general settings (see chapter 

3.4.1.3), this reference system is preselected by default. 

• MGRS (= Military Grid Reference System): The coordinate can be entered in the MGRS 

field in the respective syntax. 

•  Add Point: A point is created at the currently entered coordinate. It is added to the 

TOC as graphic named Ref. Point. 

Apply centers the map in the map viewer on the entered position. The coordinate is briefly 

marked with a red cross. Close closes the dialog without further action. 

If multiple map viewers are open, only the active window is centered on the entered coordi-

nate. Note that the extent in other map viewers is also changed if the center or the extent of 

the windows is linked (see chapter 3.2.1). 

Shortcuts, Key Commands, etc.: 

• For shortcuts, see chapter 4.1.3 and 4.1.4 

Tips and notes: 

• The display format of the coordinates in the status bar (see chapter 2.2.1.3) can be 

adjusted in the general settings (see chapter 3.4.1.3). 

 

4.1.9 Undo / Redo 

In GAFmap Express: Main Toolbar 

 Undo lets you gradually undo all actions performed in GAFmap®, while Redo lets you 

gradually redo undone actions. This applies to all actions but the following exceptions:  

• Changes to the program window (e.g. changing size, rearranging toolbars, etc.)  

• Activation status of buttons in toolbars 

• Arranging map viewers 

• Changes to general settings (under menu Extras) 

• Panning and zooming the map extent. These actions can be undone/redone with Go 

to Last/Next Extent (see chapter 4.1.5). 

The tooltip of the Undo/Redo-button tells you which action will be undone/redone next. 
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Note that undone actions can only be redone if no new action has been performed in the 

meantime. 

Shortcuts, Key Commands, etc.: 

• Ctrl+Z/Ctrl+Y: undo/redo changes 

 

4.1.10 Select Layer 

In GAFmap Express: Main Toolbar 

 Select Layer lets you select all layers (incl. graphics) in the TOC that are shown at a certain 

position in the map viewer, e.g. to deactivate them ("turn them off") with X, or simply to check 

which layers are located at this position. The latter can be helpful especially if the TOC contains 

a lot of layers and/or if layers overlap / cover each other in the respective map section. 

You can select layers by clicking/activating the button and then 

• dragging a selection rectangle in the map viewer. All layers that intersect this rectangle 

are selected (highlighted in blue) in the TOC. 

• clicking into the map viewer. All layers that intersect the mouse pointer are selected in 

the TOC. 

• clicking into the map viewer while holding the Alt key. The topmost layer that inter-

sects the mouse pointer is selected in the TOC. 

Note that only activated (i.e. checked/visible) layers are included in the selection. 

 

Figure 59: Select Layer by a rectangle in the map viewer 
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Selecting layers in the 3D Viewer 

In the 3D Viewer, you can select single graphics or layers by clicking them (or in case of vector 

layers: by clicking a single feature). Note that only 3D objects/layers can be selected, but not 

textures (see chapter 2.2.3.2). 

Shortcuts, Key Commands, etc.: 

• Ctrl when selecting: add selection to current selection. Already selected layers will be 

deselected when they are selected twice. 

• Ctrl + Shift when selecting: add selection to current selection. Already selected features 

are not deselected when they are selected twice. 

• Shift when selecting: Already selected features are deselected when they are selected 

twice. Other features are not added to the current selection. 

• Alt while dragging a selection rectangle: create square 

• Alt when selecting by click: select only topmost layer 

• Ctrl+A within TOC: select all layers 

• X: toggle layer(s) selected in TOC (with multiple map windows only in the active one) 

• C: toggle layer(s) selected in TOC globally (with multiple map windows in all windows ) 

Tips and notes: 

• For general information on (selected) layers, see chapter 5. 

• You can exclude background layers (i.e. raster) from the selection when dragging a 

selection rectangle (see chapter 3.4.1.8). 

• Special case mosaic layer (see chapter 5.3.6): A collapsed mosaic layer is interpreted 

as a single raster and accordingly selected as a whole. If the mosaic layer is expanded, 

individual rasters are identified and selected. 

 

4.1.11 Identify 

In GAFmap Express: Main Toolbar 

 Identify lets you detect all layers and features within a certain extent / on a certain 

position  

• by dragging a rectangle on the map. All layers/features that are within the rectangle or 

intersect it are listed. 

• by a left-click on the map. All layers/features that intersect the pointer are listed. 
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All active (i.e. checked/visible) layers are taken into account. 

 

Figure 60: Identify window: List of all identified layers and features within a certain extent 

To the left side of the window, all identified layers and features are listed. The selected layer 

/feature is highlighted in light green in the map viewer. To the right side all layer properties 

or features attributes of the layer/feature selected on the left are shown.  

In the footer of the Identify window, the X/Y-coordinates of the clicked location and, if en-

abled, the terrain height there are displayed. The display corresponds to that in the footer of 

the main window (see chapter 2.2.1.3). Is can be specified in the general settings under menu 

Extras > Settings > Viewing (see chapter 3.4.1.3).  

By clicking on the footer of the Identify window, you can copy the X/Y/(Z) coordinates to the 

(Windows) clipboard: 
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Figure 61: Identify window: Copy coordinates to Clipboard 

If you use Identify in the 3D window, additionally the distance of the clicked point to the 

viewer is displayed in the footer. 

Tips and notes: 

• The Identify window is dockable. For more information, see chapter 2.2.4. 

• Special case mosaic layer (see chapter 5.3.6): A collapsed mosaic layer is interpreted 

as a single raster and accordingly listed in the Identify window. If the mosaic layer is 

expanded, individual rasters are identified and listed. 

 

4.1.12 Pixel Info 

In GAFmap Express: Main Toolbar 

 Pixel Info lets you query gray-scale values of single pixels by selecting them within the 

map viewer with the cursor. The Pixel Info window lists the following information about the 

hit pixel(s): 

• name of the source raster and band 

• gray-scale value of the pixel 

• if applicable: the stretched value in brackets (see below) 

• pixel coordinate (as file coordinate) 

For multi-channel rasters, the value of the pixel hit is listed individually for each band. By 

default, only bands used / displayed in the map viewer are taken into account (see chapter 

5.3.3.6). However, all bands can be included by changing the corresponding general setting 

under Other (see chapter 3.4.1.8) or pressing the Ctrl key when querying the pixel. 

If raster layers overlap, the values of all hit pixels are listed. 
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Figure 62: Pixel Info window 

The clicked location is marked in the map viewer with a green cross. In the footer of the Pixel 

Info window, the corresponding X/Y coordinates are displayed. The display format corres-

ponds to that in the status bar of the program window (see chapter 2.2.1.3). It can be specified 

in the general settings (see chapter 3.4.1.3). 

By clicking on the footer of the Pixel Info window, you can copy the X/Y coordinates to the 

(Windows) clipboard: 

 

Figure 63: Pixel Info window: Copy coordinates to Clipboard 

If rasters are stretched with a custom transfer function (see chapter 5.3.3.6), the stretched 

value (i.e. the value as visible on screen) is shown in brackets in addition to the original gray-

scale value. 

 

Figure 64: Pixel Info window - Example with stretched values (only for Custom Transfer) 
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Shortcuts, Key Commands, etc.: 

• Ctrl when when querying the pixel: include all / only used bands for multi-channel ras-

ters (depending on the general setting; see chapter 3.4.1.8). 

 

4.1.13 Split Button Measure 

4.1.13.1 Measure 

In GAFmap Express: Main Toolbar > Split Button Measure 

 Measure lets you retrieve lengths/distances and area sizes from the map 

• by drawing a measuring sketch freehand in the map viewer; the length or area of the 

sketch is then returned. 

To do this, simply activate the button and then draw a measuring line (for distance 

measurement) or a measuring polygon (for area measurement) with any number of 

vertices in the map viewer. As soon as the first/second vertex is set, the length/area of 

the sketch is determined on-the-fly and displayed at Distance/Area.  

The sketch can be completed with a double-click or F2. Up to this point, set vertices 

can be undone step by step with the right mouse button. A completed measuring 

sketch remains until you start a new sketch or the Measure button is deactivated. 

• by selecting one or multiple line or polygon features; their length or area is then re-

turned. If multiple features are selected, their length or area is summed up. 

To do this, simply select one or multiple line or polygon features (e.g. with Select Fea-

ture; see chapter 4.2.3.1) and then check the For selected features option in the Mea-

sure dialog. The (summed) length or area of the selected features is then displayed at 

Distance/Area. 

The length or area unit to be shown can be selected via the adjoined drop-down list.  
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Measuring Distances 

 

Figure 65: Measure window if measuring a distance 

If you choose Distance, you can measure distances/lengths by drawing a measuring line in the 

map viewer or by selecting one or multiple (line) features. The (summed) length is then dis-

played at Distance. 

You can choose from these three measurement options: 

•   Measure horizontally: the length of the (measuring) line is determined on a 

horizontal plane; height differences are not taken into account in any case. 

•   Measure directly (please consider the notes on the height below!): the length 

of the (measuring) line is determined, height differences at the vertices are taken into 

account. (I.e. the direct connection between the vertices in 3D space is measured). 

•   Measure vertically (please consider the notes on the height below!): the 

height difference between the highest and the lowest vertex of the (measuring) line is 

determined; the length of the line is irrelevant. 

• Azimuth [°]: shows the angle of the last drawn line segment in degrees from true north. 

• For selected features: the summed length of all selected features is displayed.  

Note that selected polygons are also included in the length calculation; the decisive 

factor is their perimeter, i.e. the length of the ring(s). 

•   Create Graphic: adds the measuring line as graphic to the TOC. 
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•   Reset: deletes the measuring line and clears all measurements in the dialog. 

Note for direct and vertical measurement with regard to the height: 

• If you measure with a measuring line, the height component neeed for direct and verti-

cal measurement is interpolated for each vertex based on the base DEM (see chapter 

5.3.4). If a vertex of the measuring line is not covered by the DEM, a height of 0 is 

assumed for it.  

Also note that the height is not always determined based on the full DEM resolution, 

but on the pyramid level displayed in the active map viewer; thus, the full resolution is 

only used if pyramid level 0 is actually visible there. This means that the calculation of 

the length for direct or vertical measurements is usually more accurate the closer you 

zoom into the dataset. 

• If you measure selected features, the Z-coordinate of the feature vertices is used as 

height component. If vertices do not have a Z coordinate, a height of 0 is assumed. 

Note that the lengths of multiple selected features are always summed up, also when 

measuring vertically. I.e. in the case of vertical measurement, the height difference is 

not, for example, determined between all vertices, but per feature; these height diffe-

rences are then added up. 

Measure areas 

 

Figure 66: Measure window if measuring an area 
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If you choose Area, you can measure area sizes by drawing a measuring polygon in the map 

viewer or by selecting one or multiple (polygon) features. The (summed) area is then displayed 

at Area, and the (summed) length of the ring(s) is displayed at Perimeter. 

• Azimuth [°]: shows the angle of the last drawn line segment in degrees from true north. 

• For selected features: the summed area or perimeter of all selected features is dis-

played. 

Note that selected lines are also included in the calculation of the perimeter; the deci-

sive factor is their length. Lines are not included in the area calculation. 

•   Create Graphic: adds the measure polygon as graphic to the TOC. 

•   Reset: deletes the measure polygon and clears all measurements in the dialog. 

Measuring in the 3D Viewer 

Only relevant if the project contains a 3D window 

When measuring distances in the 3D viewer, you receive the same result as in 2D. When crea-

ting the measuring line, the height for each set vertex is taken from the base terrain (see chap-

ter 5.3.4) and is used for the measurement as well as for the display of the measuring line. 

Regarding the three measurement options: 

•   Measure horizontally: the horizontal measure line is placed on the height 

level of the highest vertex. 

•   Measure vertically: the vertical measure line is always based on the lower 

vertex and is perpendicular to the terrain. 

•   Measure directly: the direct measure line always shows the  distance between 

two vertices (i.e. shortest connection). 

When measuring areas in the 3D viewer, you also receive the same result as in 2D, since areas 

are also measured on a horizontal plane. Height values are only used for the visualization of 

the measure polygon. 

Note that in 3D the vertices of the measuring sketch can only be placed on a surface, i.e. on 

DEMs, 3D models, three-dimensional graphic elements, or (extruded) features etc., and not 

into "empty space". If there is no 3D dataset on the screen at the clicked position, no vertex is 

created. 

http://www.dict.cc/englisch-deutsch/distance.html
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Method / Spatial Reference 

The spatial reference for the measurement is always the defined or currently applicable UTM 

zone. If you work in a geographic reference system or a non-equidistant projection, the data 

is projected to UTM when measuring (in background!); for this, the vertices are densified to 

0.1° or 10000m. If you measure distances or areas that exceed two UTM zones, the measure-

ment is ellipsoidal. If a selected multipart feature is measured, each geometry part is first 

regarded individually and the measurement result is then summed up. 

 The used reference system is displayed in an info 

field at the bottom of the Measure dialog. If the reference system is unknown, e.g. because 

no spatial reference is defined for the map, the info field remains empty. 

If the projection is not Transverse Mercator or Lambert Azimuthal, the measurement is made 

in UTM because e.g. Web Mercator has too much distortion. 

Shortcuts, Key Commands, etc.: 

• Right-click while drawing the measuring sketch: undo last vertex 

• Esc while drawing the measuring sketch: cancel 

• F2 while drawing the measuring sketch: finish sketch 

• F4 while drawing the measuring sketch: enable/disable tracing 

Tips and notes: 

• You can adjust the symbology of the measurement line in the general settings (Sketch 

Line/Fill Symbol; see chapter 3.4.1.4). 

 

4.1.13.2 Measure Length 

In GAFmap Express: Main Toolbar > Split Button Measure 

Only active for (2D) map viewers 

 Measure Length lets you measure distances directly in the map. To do this, simply activate 

the button and then draw a line with any number of vertices in the map. After the first vertex 

is set, the resulting length is displayed directly at the mouse pointer and updated on-the-fly. 

A double click, F2, or Esc ends the measuring and the sketch disappears. 
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Figure 67: Measure Length, Example  

The displayed unit can be changed in the general settings (see chapter 3.4.1). The measuring 

method corresponds to that of the Measure tool (see chapter 4.1.13.1). 

Shortcuts, Key Commands, etc.: 

• Right-click while drawing the measuring sketch: undo last vertex 

• Esc or F2 while drawing the measuring sketch: end/cancel measuring 

Tips and notes: 

• Activate Show Measurement in the general settings if you want the length of line fea-

tures to be displayed directly while capturing (see chapter 3.4.1.4). 

• You can adjust the symbology of the measurement line in the general settings (Sketch 

Line Symbol; see chapter 3.4.1.4). 

 

4.1.13.3 Measure Area 

In GAFmap Express: Main Toolbar > Split Button Measure 

Only active for (2D) map viewers 

 Measure Area lets you measure areas directly in the map. To do this, simply activate the 

button and then draw a polygon with any number of vertices in the map. After the second 

vertex is set, the resulting area is displayed directly at the mouse pointer and updated on-the-

fly. A double click, F2, or Esc ends the measuring and the sketch disappears.  
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Figure 68: Measure Area, Example 

The displayed unit can be changed in the general settings (see chapter 3.4.1). The measuring 

method corresponds to that of the Measure tool (see chapter 4.1.13.1). 

Shortcuts, Key Commands, etc.: 

• Right-click while drawing the measuring sketch: undo last vertex 

• Esc or F2 while drawing the measuring sketch: end/cancel measuring 

Tips and notes: 

• Activate Show Measurement in the general settings if you want the area of polygon 

features to be displayed directly while editing (see chapter 3.4.1.4). 

• You can adjust the symbology of the measurement line in the general settings (Sketch 

Line/Fill Symbol; see chapter 3.4.1.4). 

 

4.1.13.4 Measure Distance to Selected Features 

In GAFmap Express: Main Toolbar > Split Button Measure 

Only active for (2D) map viewers 

 Measure Distance to Selected Features lets you measure the shortest distance from a 

certain point to one or multiple selected features. To do this, first select the feature(s) to which 

the distance is to be measured (see chapter 4.2.3) and then press the button to open the 
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measure window and/or activate the measure tool. If you now click into the map viewer, the 

shortest distance from the mouse pointer to each selected features is displayed: 

 

Figure 69: Measure Distance to Selected Features, Example 

As long as you press the mouse button, the distance to the mouse pointer is updated on-the-

fly, if you release the mouse button, the measured values are fixed.  

The following information is displayed in the measure window for each measured feature: 

• Layer: the name of the layer from which the feature originates. 

• Features: the FID of the feature. 

• Distance: the shortest distance from the mouse pointer to the feature. 

In addition, in the status bar of the measure window: the mouse pointer position on which 

the measurement is based (in map coordinates) 

Method 

For the measurement, it is first determined which point of the feature is closest to the mouse 

pointer ("Closest Point"). This closest point is determined in the current map projection. Note 

that the closest point may differ slightly from the actual closest point, depending on the pro-

jection distortion. The measuring method for the distance measurement then corresponds to 

that of the Measure tool (see chapter 4.1.13.1). 

Tips and notes: 

• You can adjust the symbology of the measurement line in the general settings (Sketch 

Line Symbol; see chapter 3.4.1.4). 
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4.1.13.5 Measure Angle 

In GAFmap Express: Main Toolbar > Split Button Measure 

 Measure Angle lets you measure angles directly in the map. To do this, simply activate 

the button and then define a line segment in the map with two points/vertices. If you now 

move the mouse, the resulting angle between the set and the next line segment is displayed 

and updated on-the-fly. A third click, F2, or Esc ends the measuring and the sketch disappears.  

 

Figure 70: Measure Angle, Example 

Always the smaller angle is displayed. The measuring method corresponds to that of the 

Measure tool (see chapter 4.1.13.1). 

Shortcuts, Key Commands, etc.: 

• Right-click while drawing the measuring sketch: undo last vertex 

• Esc or F2 while drawing the measuring sketch: end/cancel measuring 

Tips and notes: 

• You can adjust the symbology of the measurement line in the general settings (Sketch 

Line Symbol; see chapter 3.4.1.4). 
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4.1.14 Create Profile 

In GAFmap Express: Main Toolbar 

 Create Profile lets you quickly and easily visualize a height profile, i.e. a terrain section, 

based on a digital elevation model (DEM) and a (profile) line. For this, the height values under 

the (profile) line are captured, interpolated, and transferred to an height diagram: 

 

Figure 71: Create Profile, Example: (profile) line in the map viewer and resulting height profile 

The calculation of the profile is based on the background DEM (see chapter 5.3.4). If no DEM 

lies under the profile line, all fields in the profile dialog remain empty; if only sections of the 

line are covered by the DEM, the profile is only created for the covered areas.  

Proceed as follows to create a height profile: 

• Activate the Create Profile button. The dialog opens. 

• Draw a (profile) line with any number of vertices at the desired position in the map 

viewer. As soon as you set the second vertex, the height profile under (scetch) line is 

displayed. The display is constantly updated while drawing. Vertices are displayed as 

vertically dashed, red lines. 

• Complete the (profile) line with a double-click. It is then added to the TOC under Gra-

phics as a simple line graphic. 

• As long as the Profile dialog remains open or the Create Profile button is activ, you can 

draw further (profile) lines at any time. The display in the dialog is always adapted to 

the current (profile) line.   
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Alternatively, you can create a height profile by using any existing line graphic. To do this, 

simply start the command Create Height Profile in the context menu of the graphic (see chap-

ter 5.2.5.3). The Profile dialog then opens directly: 

 

Figure 72: Create Profile dialog 

Diagram Field  

In the Diagram Field the height profile/terrain section is displayed graphically. If you move the 

mouse cursor across the profile, the current mouse position is displayed on the heigt curve as 

well as in the map viewer. This makes it easier to e.g. find a certain position in the height 

profile on the map. 

The height at the current mouse position is displayed in the middle field in the bar to the left 

of the diagram field (see below). 

A right-click in the diagram field opens the context menu. If you select Transfer to Map, a 

point graphic is created at the currently marked position on the (profile) line in the map viewer 

and added to the TOC under Graphics: 
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Figure 73: Create Profile - current position: Transfer to Map 

Profile Dialog, Top Bar 

• Total Length [m]: shows the total length of the (profile) line (measured horizontally). 

• Ascent [m] / Descent [m]: shows the number of vertical meters the terrain below the 

(profile) line ascends/descends in total. 

The profile is always displayed in full length in the diagram field. You can adjust the vertical 

position and extent with Maximum/Minimum Height or Exaggeration: 

Profile Dialog, Left Bar 

• Maximum Height (top field) / Minimum Height (bottom field): determines the abso-

lute height of the top/bottom edge of the diagram field and therefore how the profile 

is vertically positioned in the field and/or shrunk or stretched.   

By default, the profile is displayed so that the maximum height corresponds to the 

highest derived height value and the minimum height to the lowest. Consequently, the 

pre-entered values correspond to the highest/lowest height below the (profile) line.  

Edit: if checked, you can manually change the Maximum/Minimum Height. The height 

of the top/bottom edge in the diagram field is then adjusted and the profile in the field 

shifted vertically and/or shrunk/stretched accordingly (also depending on whether the 

Exaggeration is automatically determined or fixed; see below).  

Note that the profile is not or not completely visible in the diagram field if the entered 

Maximum/Minimum Height is smaller/larger than the highest/lowest height. 

• Height at current mouse position (middle field): displays the height at the current 

mouse position in the profile.  
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Profile Dialog, Bottom Bar 

• Exaggeration: determines the factor the derived heights are multiplied with and there-

fore whether and to what extent the profile is stretched or shrunk ("exaggerated"). 

Automatic: if checked, the exaggeration is determined automatically so that the profile 

is displayed with the highest possible vertical extent in the diagram field. The corres-

ponding factor is displayed in the adjacent field. It is adjusted continously, e.g. while 

you are creating the profile line or when changing the Maximum/Minimum Height or 

the aspect ratio of the dialog. 

If unchecked, you can manually enter a fixed exaggeration. The profile is then enlarged 

or reduced in the diagram field with a constant aspect ratio if e.g. the line length or the 

field size changes. 

• Immediate update from map (not available if the height profile has been opened via 

the context menu of a line graphic): the terrain section is already displayed while you 

create the (profile) line in the map viewer. If this option is unchecked, the profile is 

updated as soon as a vertex is set, i.e. as soon as a line segment is "fixed". If checked, 

it is updated on-the-fly, i.e. while you are positioning a line segment.  

• Show slope between vertices: if checked, the average slope per section is displayed in 

% in the diagram field. Both, gradients (positive values) and slopes (negative values) 

are displayed. 

 

Save lets you save the height profile including all data displayed in the dialog as *.jpg.  

Close closes the dialog. (Profile) lines not completed by double-click are then deleted. Note 

that the dialog is also closed when the Create Profile button is deactivated (e.g. because you 

click it again or activate another button).   

If you want to visualize the Profile of a closed (profile) line again, you can reopen it at any time 

via Create Height Profile in the context menu of the line (see chapter 5.2.5.3). 
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Shortcuts, Key Commands, etc.: 

• Right-click while drawing: undo last vertex  

Tips and notes 

• The symbol used to display the current mouse position within the diagram in the Map 

Viewer can be adjusted in the general settings (see chapter 3.4.1.4). The display of the 

point symbol in the 3D Viewer (size/color) also depends on this setting. 

• You can see/check the base DEM if you uncheck the Map in the TOC and then enable 

the on-the-fly lighting/shading (see chapter 4.5.4 and 5.3.4). 

 

4.1.15 Start 3D Viewer / Start 3D Viewer with current Map Extent 

In GAFmap Express: Main Toolbar 

Only available if the project contains a 3D window 

   Start 3D Viewer lets you extend a reduced map extent visible in the 3D viewer to the 

total extent of all data contained in the project and reduce/update the total/map extent 

visible in the 3D viewer to the map section currently visible in the (2D) map viewer with Start 

3D Viewer with current Map Extent. With both buttons you can reopen/maximize a mini-

mized 3D viewer. 

Note that the button  Start 3D Viewer with current Map Extent is only available if a (2D) map 

viewer is active (= highlighted); for multiple map viewer, it always refers to the active one. If 

the 3D Viewer is active or if the project does not contain a map viewer, the button is grayed 

out. 

Alternatively, you can reduce/update the map extent visible in the 3D viewer to that of an AOI 

graphic. Therefore, use the command Start 3D Viewer in the AOI context menu (see chapter 

5.2.2.1). 

Loading a Reduced Map Extent 

If the 3D viewer is started for a map extent only, data outside this extent are not only not 

displayed in the 3D viewer, but are not loaded into the 3D viewer at all. Depending on data 

quantity/size and hardware, this can significantly increase the performance in the 3D viewer, 

i.e. the rendering and the frame rate. 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  97 

Raster layers are then (virtually) clipped, i.e. cut to the extent, vector data/features and 

3D models are only taken over if they lie completely or partially within or intersect the loaded 

map extent. If a complete layer is outside the loaded area, this layer is not available in the 3D 

viewer and therefore grayed out in the 3D TOC: 

 

Figure 74: Grayed out layer/graphics in the 3D TOC are outside the loaded area  

If the map extent is adjusted/updated so that it contains a previously grayed out layer again, 

this layer is available again in the 3D TOC. 

 

4.2 Toolbar for Features 

4.2.1 Show Attributes 

In GAFmap Express: Toolbar for Features 

Show Attributes lets you check the attributes of (selected) vector features, or browse (selec-

ted) features within a vector layer using the arrow buttons. 

 

Figure 75: Attributes window 
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Show attributes 

If you want to check feature attributes, select at least one feature (see chapter 4.2.3.1) and 

click Show Attributes (in this order). In the opening Attributes window all attributes of the 

(first) selected feature are listed. 

If features from different vector layers are selected, a separate window opens for each layer. 

•   Previous/Next Feature: switches between features one by one as follows: 

o If at least two features are selected before clicking Show Attributes, the attributes 

of all selected features are shown in turn. While browsing, the initial selection does 

not change. 

o If a single feature is selected, the attributes of all features within the layer are 

shown in turn. While browsing, the selection changes to the currently shown 

feature. This way you can browse all features within the layer. 

After the last feature in the queue, the display automatically jumps back to the first 

feature. The order in which the features are browsed corresponds to the order of the 

features in the attribute table in the current sorting (see chapter 5.3.2.1) or with selec-

ted features to the selection order. 

Within the map viewer, the map is always zoomed to the extent of the currently shown 

feature. In the general settings, you can determine whether the map is to be centered 

only on the feature geometry (see chapter 3.4.1.8). If you hold down the Alt key while 

changing features, the map is also just centered instead of zoomed. 

•  Highlight this feature: highlights the geometry of the currently shown feature 

within the map viewer in light green. 

Shortcuts, Key Commands, etc.: 

• Alt when switching features: center map on feature geometry (instead of zoom to) 

Tips and notes: 

• The Attributes window is dockable. For more information, chapter 2.2.4. 

• You can also check feature attributes directly via the attribute table. For this and for 

general information on features attributes, see chapter 5.3.2.1. 
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4.2.2 Show Coordinates 

In GAFmap Express: Toolbar for Features 

 Show Coordiantes lets you display a list of all vertices and their coordinates for a single 

selected feature: 

 

Figure 76: List of all feature vertices and their coordinates (Example: polygon feature without Z-coordinates) 

The left box holds a list of all geometry parts (in case of multipart features) and all inner rings 

(in case of polygons with holes). A double-click on a list item zooms or centers the map extent 

to/on the respective geometry part / ring.  

In the footer of the window, the vertex count of the geometry part selected in the left box 

above (including all its inner rings) or of the selected inner ring as well as the feature's total 

vertex count are displayed. 

The table on the right lists all vertices of the chosen (i.e. highlighted in blue) list item, including 

their ID and coordinates, and in the following order:  

• Line: starting at the start point (ID=0) and listing each vertex consecutively to the end 

point (ID=max), depending on the drawing direction. 

• Polygon: start and end point are always coincident. The numbering for the outer ring 

is always clockwise, for the inner ring counterclockwise, regardless of the direction of 

digitization.  

The vertex selected in the list (highlighted in blue) is highlight in red within the map viewer.  
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Shortcuts, Key Commands, etc.: 

• Alt when double-clicking a list item in the Coordinates window: Pan to geometry part 

/ ring (instead of zoom to) 

 

4.2.3 Split Button Selection 

4.2.3.1 Select Feature 

In GAFmap Express: Toolbar for Features > Split Button Selection 

 Select Feature lets you select vector features 

• by dragging a selection rectangle in the map viewer. All features that are within the 

rectangle or intersect it are selected. 

• by clicking in the map viewer. All features that are hit by the mouse pointer are selec-

ted. 

• by holding down the Alt key and clicking in the map viewer or dragging a selection 

rectangle. In this case, only the topmost* feature is selected (e.g. if features overlap). 

* The drawing order in the map viewer is decisive here. The following applies: Features that higher up 

in attribute table in the current sorting are drawn first and are therefore at the bottom in the map viewer 

(see also chapter 5.3.2.1).  

Selected features are bold-framed in the given selection color (cyan by default) in the map 

viewer, and highlighted in blue in the attribute table (see chapter 5.3.2.1).  

   

Figure 77: Selected feature (FID=1) highlighted in map viewer and Attribute Table 

If desired, you can always change the selection color in the general settings (see chapter 

3.4.1.3). 

Please note that by default an existing selection is discarded / replaced by the new one, if you 

select features. 
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Add to / Reduce Selection 

If you hold down the Ctrl key while selecting features, you can add features to an existing 

selection or reduce it by re-selecting already selected features. This applies regardless of how 

the selection is made (i.e. by clicking or using a selection rectangle). If you additionally hold 

down the Shift key, the selection is only extended but not reduced (if features are re-selected), 

if you only hold the Shift key, the selection is only reduced: 

 

 

 

Figure 78: Add to / reduce selection (key commands) 

Clear Feature Selection 

You can clear a feature selection by 

• clicking Clear Selection (see chapter 4.2.4) in the toolbar for Feature Editing, 

• another left-click in the map viewer next to the selected feature(s), 

• "reselecting" selected features while pressing Ctrl or Shift, or 

• executing the respective command in the layer context menu (see below). 
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Selectable Features / Layers 

Select Feature always selects all intersected features in all vector layers if 

• the layer is visible, i.e. checked in the TOC and 

• the layer is set selectable (see chapter 5.3.2.5). 

 

Figure 79: Layer property Features Selectable = On 

Features in not activated or non-selectable layers are not selected.  

If the property Features Selectable is turned Off for a vector layer, then this is indicated with 

the non-selectable icon next to the layer icon: 

 

Figure 80: non-selectable icon in the TOC 

Submenu Selection in the Vector Layer Context Menu 

The submenu Selection in the vector layer context menu contains several commands with 

which you can, for example, select or deselect all features of the source layer, or clear the 

selection of all layers but the source layer (see chapter 5.3.2.3). 

Selected Features in the Attribute Table 

Within a single layer, you can also select or deselect features via their attribute table, or ma-

nage the feature selection. For more information on this, see chapter 5.3.2.1. 

Number of Selected Features 

The total number of all selected features is shown in the Status Bar: 

 

Figure 81: Message in the status bar after clicking Select Features 
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Via the general settings, you can add the column Selected Features to the TOC that shows the 

number of selected features per layer. For more information, see chapter 3.4.1.8. The number 

of currently selected features per layer will then be displayed. 

 

Figure 82: Column Selected Features in the TOC (only visible if enabled in the general settings) 

Shortcuts, Key Commands, etc.: 

• Ctrl when selecting: add selection to current selection. Already selected features are 

deselected when they are selected twice. 

• Ctrl + Shift when selecting: add selection to current selection. Already selected features 

are not deselected when they are selected twice. 

• Shift when selecting: Already selected features are deselected when they are selected 

twice. Other features are not added to the current selection. 

• Alt when selecting: select only topmost feature in the map viewer 

 

4.2.3.2 Select with Polygon (Intersects) 

In GAFmap Express: Toolbar for Features > Split Button Selection 

Only active for (2D) map windows 

 Select with Polygon lets you select vector features by drawing a sketch polygon in the 

map viewer. All features are then selected that lie within the selection polygon, are cut, or 

touch it (= spatial relation "intersect"; see chapter 5.3.2.1.3). 

Right-clicking on an existing polygon uses this polygon as selection polygon. If multiple poly-

gons overlap at the clicked position, the polygon lying on top in the map viewer is used as 

selection polygon (i.e. across layers the polygon from the topmost layer in the TOC, and within 

a layer the feature listed last in the attribute table in the current sorting). By default, only 

selectable layers are considered (see chapter 5.3.2.5); with Alt + right-click, all activated/visi-

ble layers are considered. 
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Shortcuts, Key Commands, etc.: 

• Right-click on existing polygon: use polygon as selection polygon (and ignore non-selec-

table layers) 

• Alt+right-click on existing polygon: use polygon as selection polygon (and consider non-

selectable layers) 

• Ctrl when selecting: add selection to current selection. Already selected features are 

deselected when they are selected twice. 

• Shift when selecting: Already selected features are deselected when they are selected 

twice. Other features are not added to the current selection. 

• Ctrl+Shift when selecting: add selection to current selection. Already selected features 

are not deselected when they are selected twice. 

Tips and notes: 

• Use the function Select by Location for more complex spatial selections and/or other 

relations (see chapter 5.3.2.1.3). 

• For general information on feature selection, see chapter 4.2.3.1. 

 

4.2.3.3 Select with Polygon (Completely Within) 

In GAFmap Express: Toolbar for Features > Split Button Selection 

Only active for (2D) map windows 

 The functionality of Select with Polygon (Completely Within) corresponds to that of Se-

lect with Polygon (Intersects), with the only difference that here only features are selected 

that lie within the selection polygon (i.e. the spatial relation "completely within" is used in-

stead of "intersect"). 

For more information on the Select with Polygon function see chapter 4.2.3.2, for information 

on the different spatial relations see chapter 5.3.2.1.3. 

 

4.2.4 Clear Selection 

In GAFmap Express: Toolbar for Features 

 Clear selection lets you deselect all selected features at once. 
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Tips and notes: 

• For general information on feature selection, see chapter 4.2.3.1. 

 

4.2.5 Zoom to Selection 

In GAFmap Express: Toolbar for Features 

 Zoom to Selection automatically adjusts the display extent so that all selected features 

are visible in the map viewer as close as possible. This also applies if features are selected but 

currently not visible, because the layer is deactivated in the TOC. 

Shortcuts, Key Commands, etc.: 

• For shortcuts to adjust the display extent, see chapter 4.1.3. 

Tips and notes: 

• For general information on the topic feature selection, see chapter 4.2.3.1. 

• For general information on zooming, see chapter 4.1.4 et seqq. 

 

4.3 Toolbar for Feature Search 

 

Figure 83: Toolbar for Layer Effects 

Feature Search lets you search selected vector layers, tables, and/or geocoding services for a 

specific search expression, more precisely a specific alphanumeric character string. Simply 

type the search string into the text field and confirm with Enter. All features whose attributes 

contain the search string are then returned. 

In the Search Layer tab in the general settings, you can specify which vector layers / tables 

and (attribute) fields and which geocoding services are to be searched for the string (see chap-

ter 3.4.1.1).  

 directly opens the tab Search Layer of the general settings 

Via Open Identify for Feature Search Result in the Other tab of the general setting (see chap-

ter 3.4.1.8), you can control how the features containing the search string are returned: 
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• if On, the found features are listed in the Identify window (see chapter 4.1.11). 

• If Off, the found features are selected. 

In both cases, the map extent is zoomed to the found features. If the search is unsuccessful, a 

corresponding message appears. 

If the search expression is found in a geocoding service (e.g. in the OSM or GeoNames data-

base), the relevant features are automatically downloaded and also listed or selected. 

General Notes on The Search 

The search is always carried out across the entire attribute set of a feature or, more precisely, 

across all fields that are selected as Search Fields in the general settings (see chapter 3.4.1.1). 

For this purpose, the attribute values in all search fields are combined (in the background) to 

form a text line. If the search expression is found in this text line, the feature is returned as a 

"match". 

When forming the text line, the individual attribute values are "framed" with #. Example:  

[Field1] contains the attribute value Value1, [Field2] the attribute value Value2, and [Field3] 

the attribute value Value3. Provided that all three fields are selected as search fields, the text 

line used for the search is formed as follows: #Value1##Value2##Value3#.  

Please note when searching: 

• The search is independent of individual (attribute) fields; it is always performed across 

the entire attribute set of a feature (i.e. across all search fields; see above). 

• The search is case-insensitve, i.e. upper/lower case is not taken into account. 

• Numbers and dates are not recognized as such, but are interpreted as simple alpha-

numeric characters, i.e. as individual digits from 0-9, including the formatting with 

which they are currently displayed in the table. If, for example, 1,000.1 is displayed, 

then only 1,000.1 results in a match and not, for example, 1000,1 etc. 

• If in the attribute table display names are shown (see chapter 5.3.2.1), what is currently 

visible in the attribute table is also decisive. 

• A | between characters/strings means "or"; i.e. with e.g. ab|cd all features containing 

the character string ab or cd are returned. 

• * serves as wildcard/placeholder; i.e. a*c finds e.g. ac, abc, Acre, or Arch, but also, for 

example, features with the value A in [field1] and the value C in [field2].  

• The # cross sign, with which the individual attribute values are framed when forming 

the text line (see above), can be integrated into the search. For example, if you want 
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to find features with the attribute value Crop and exclude those with Cropland, you 

can enter #Crop# as search string. (Only Crop would also return a match for cropland). 

• Empty fields can be found with e.g. ### 

Using Regex 

By default, the search is performed as described above. Alternatively, you can search with 

regex ("regular expression"). You can then perform a somewhat more complex (text) search, 

e.g. to find all values starting with an upper case letter and ending with a digit. For this, activate 

the setting Use Regex under menu Extras > Settings > Search Layers (see chapter 3.4.1.1). 

Information on Regex can be found e.g. under the following links: 

• Regular expression - Wikipedia 

• RegexOne - Learn Regular Expressions - Lesson 1: An Introduction, and the ABCs 

• GitHub - ziishaned/learn-regex: Learn regex the easy way 

Please note in particular when searching with regex: 

• Unlike the search without regex, the search with regex is case-sensitive. 

• When searching with regex, .* serves as wildcard/placeholder instead of * 

( . means "any character" in regex, * means "zero or more repetitions"; i.e. a*c finds 

e.g. c, ac, aac, aaac etc.; a.*c finds e.g. ac, abc, acre, or arch; [aA].*c finds e.g. ac, 

abc, Acre, or Arch). 

• In regex, . is a reserved character (see above). If you search for numbers with decimal 

separator . (e.g. 1.2), the escape character \ must be added before the . . To find exactly 

1.2, you must therefore search for 1\.2 

(As the . means "any character" in regex and the . in 1.2 is in fact any character, 1.2 is 

found with the search expression 1.2, but also 132, 1,2, or 1n2 etc.) 

! Please note that an online search is not possible with regex. If regex is activated, the geo-

coding services are deactivated and the corresponding area in the tab cannot be operated. 

Tips and Notes: 

• Use the Find command in the attribute table to find cells containig a specific value / 

character string (see chapter 5.3.2.1.1). 

• Alternatively, you can use Select by Attribute to find/select features with specific attri-

butes or attribute combinations within a layer. There, you can explicitly address the 

https://en.wikipedia.org/wiki/Regular_expression
https://www.regexone.com/
https://github.com/ziishaned/learn-regex/tree/master
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individual attribute fields, i.e. you can, for example, find features for which the charac-

ter string Arch appears specifically in the field [BuildType]. For more information, see 

chapter 5.3.2.1.2. 

 

4.4 Toolbar for Layer Effects 

 

Figure 84: Toolbar for Layer Effects 

Via the Toolbar for Layer Effects you can (temporarily) hide specific graphics, layers, or groups 

in the map viewer in various ways, so that the underlying layers become visible. This allows 

you to compare overlapping data more easily, for example.  

Layer effects are always applied to the graphics, layers, and/or groups that are selected in the 

drop-down list on the left: 

 

Figure 85: Drop-down list for Layer Effects 

Use the Ctrl key to select multiple list items. 

 

4.4.1 Flicker 

In GAFmap Express: Toolbar for Layer Effects 

 If you click the Flicker button, the layer(s)/element(s) selected in the drop-down 

list is/are automatically switched between on and off (shown/hidden) in the current map 

viewer until the button is clicked again. The time (measured in milliseconds) for which the 

layer(s) is/are visible can be set in the box to the right of the Flicker button. 
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Shortcuts, Key Commands, etc.: 

• Ctrl+A within TOC: select all layers 

• X: toggle layer(s) selected in TOC (with multiple map windows only in the active one) 

• C: toggle layer(s) selected in TOC globally (with multiple map windows in all windows) 

Tips and notes:  

• Alternatively, you can toggle between individual and/or grouped layers or graphics 

selected in the TOC by pressing the X or C key. In this case, the layers do not constantly 

switch, but are shown/hidden each time you press the button. If necessary, this short-

cut can be edited in the general settings (see chapter 3.4.1.5).  

 

4.4.2 Toggle 

In GAFmap Express: Toolbar for Layer Effects 

 Toggle lets you toggle the layer selection in the drop-down list, i.e. elements activated in 

the TOC are deactivated and deactivated elements are activated. If multiple map viewers are 

open, the function Toggle refers to the currently active map viewer. 

Shortcuts, Key Commands, etc.: 

• Ctrl+A within TOC: select all layers 

• X: toggle layer(s) selected in TOC (with multiple map windows only in the active one) 

• C: toggle layer(s) selected in TOC globally (with multiple map windows in all windows) 

 

4.4.3 Transparency 

In GAFmap Express: Toolbar for Layer Effects 

Only active for (2D) map windows 

Transparency lets you change the degree of transparency of the selected layer(s)/element(s). 

Just move the slider up or down to set a value between 0 (opaque) and 100 (transparent / not 

visible). 
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Figure 86: Adjusting the transparency of a selected vector layer group. 

Tips and notes:  

• The Transparency effect can be combined with the Flicker or Swipe effects. 

 

4.4.4 Swipe 

In GAFmap Express: Toolbar for Layer Effects 

Only active for (2D) map windows 

Swipe lets you briefly "swipe away" the selected layer(s)/element(s). To do so, click the 

Swipe button, click anywhere in the map viewer, and then swipe away the layer(s)/ element(s) 

by holding the mouse button and dragging the mouse-pointer in the desired direction. As soon 

as the mouse button is released, the layer(s)/element(s) jump back to their original extent. 

The direction the layer(s)/element(s) are swiped to (horizontally from right/left or vertically 

from top/bottom) is indicated by an arrow as soon as the mouse pointer hovers over the map 

viewer.  
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Figure 87: Selected vector layer group is temporarily "swiped away" 

  

4.4.5 Timeline 

In GAFmap Express: Toolbar for Layer Effects 

Only available if the project contains a layer with time stamp 

 Time Line lets you display vector and/or raster layers animated with regard to a time 

stamp, i.e. show and hide them successively and in chronological order in the map viewer. So, 

depending on the data basis, you can simulate various events that have taken place or are 

expected over a longer observation period in the map viewer, e.g. the growth of cities or infra-

structure over several years (e.g. with vector data) or the expected weather conditions (e.g. 

with raster stacks). 

Additionally or alternatively, you can simulate the lighting situation "on site" over a certain 

period of time in the map viewer, e.g. over the course of a day or year. When the time line is 

operated, the position of the virtual light source is then automatically set so that it corres-

ponds to the position of the sun at the time currently displayed, and the lighting or shadows 

cast in the visible map extent are adjusted accordingly. 

If the project contains a 3D window, the animation can also be executed in 3D. 

Prerequisite / Requirement for Layers (not) to be Animated 

The time line is only available for layers with a Time Stamp(s). A time stamp can either be 

assigned to the layer as a whole or to individual features (for vector layers) or bands (for raster 
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layers). When operating the time line, the layers, vector features, and/or raster bands are then 

shown/hidden in the map viewer one after the other in the order of their time stamps.  

If a layer is enabled for the time line, and, if so, how the time stamps are stored can be viewed 

in the layer properties under Time Line ((see chapter 5.3.2.5 for vector layers or chapter 

5.3.3.6 for raster layers). 

Layers that are not enabled for the time line or that are not in the Layer Group to be animated 

(see below) are not affected by the time line. Their activation status remains unchanged du-

ring the animation, i.e. they remain shown/hidden if they are checked/unchecked in the TOC. 

Time Line Control 

 A click on the Time Line button opens the Time Line dialog: 

 

Figure 88: Dialog Timeline Control  

! Please note: As long as the dialog is open, the elements of the selected Layer Group that are 

enabled for the time line are "filtered" in all existing map viewers according to their time 

stamp, i.e. they are only displayed if their time stamp corresponds to the currently displayed 

time or is older (depending on the Incremental option, see below). This also applies if no ani-

mation is running! 

The time line / animation can be controlled via the dialog as follows: 

• Layer Group: Here, you can select the layer group to be aminated. All layers within the 

selected group, including those in sub-groups, are affected by the time line, but only if 

they are enabled for the time line (see above). 
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 opens a layer selection panel 

 refreshes the selected layer group, e.g. if layers under the have been changed sub-

sequently 

As soon as a group is selected or refreshed, all the time stamps of all the layers it con-

tains are read ou,t and the time steps on the time line are set accordingly. 

• Add Custom Time Steps: By default, i.e. if unchecked, the time steps on the time line 

correspond to the time stamps provided by the selected layer group (see above). 

If checked,  custom time steps are inserted, either in addition to those read from the 

group or instead of them 

 opens a properties window. Here, you can define the custom time steps as follows: 

o Start/End Date: specifies the time at which the custom time steps begin/end. En-

ter the desired date in the format dd.MM.yyyy hh:mm:ss or select it from the ca-

lendar 

 opens a calendar 

o Interval (Unit): specifies the time interval in which the custom time steps are set 

between the start and end date. 

 opens a drop-down list 

Tip: If start date = 31.01. and interval unit = month, always the last day of the 

month is inserted. 

o Exclusive: If On, the time line only contains the custom time steps. If Off, the cus-

tom time steps are inserted in addition to the time steps read from the layer group. 

Tip: You can also insert and use custom time steps if the project does not contain any 

layers with a time stamp. This lets you Set Lighting independently of layers (see below). 

• Time Line: The time line contains all accessible time steps. The slider marks the cur-

rently displayed time; the label above the time line shows the exact time.  

! Please note that all times are interpreted as UTC as long as no other information is 

stored in the dataset itself!  

The currently displayed time can be changed manually by dragging the slider with the 

mouse to any time step. A click on the time line moves the slider five steps forwards 

or backwards.  
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Additionally, the following buttons are available: 

  starts the animation; all time steps are then run through in sequence, starting at 

the currently displayed time. 

  pauses the animation. 

  skips to the previous or next time step. 

The elements of the selected layer group are only displayed if their time stamp corres-

ponds to the currently displayed time or is older (depending on the Incremental op-

tion, see below). 

• Runtime [s]: determines the runtime of the animation in seconds. The events are dis-

tributed over this time span according to their time markers (proportional or constant, 

depending on the Equal time steps option, see below). 

Please note: When playing the animation, the map viewer is refreshed at each time 

step, which takes a few milliseconds (visible in the status bar, see chapter 2.2.1.3). If 

many time steps are displayed in a short time and/or if the map viewer is very complex, 

e.g. if it contains many layers or features, the rendering time can exceed the time inter-

val between successive events. In this case, the actual runtime exceeds the entered 

runtime. 

•  : if checked, the animation is repeated until it is manually paused or stopped. 

• Incremental (only relevant with Time Stamp Type = Layer or Attribute): if unchecked, 

when a time stamp is reached, only those layers or features are displayed that have 

been assigned exactly this time stamp. Layers or features with other time stamps, also 

older ones, are hidden. 

If checked, layers or features are shown when reaching their time stamp and are not 

hidden again until the end of the animation. Thus, the displayed data grows over time 

until all layers or features are visible at the end of the animation. 

• Equal time steps: if unchecked, the distance between the time steps is calculated 

based on the time stamps, i.e. the events are displayed with realistic time distance 

(scaled to the runtime). 

If checked, the events are displayed with a constant time interval, independent of the 

time stamps. The time stamps then only influence the order of the events. This can be 

useful, for example, if some events are close together (e.g. a few days), while others 

have a large time distance (e.g. a year). The events are then distributed evenly over 

the runtime and overlong pauses are avoided.  
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• Set Lighting (only relevant in association with on-the-fly lighting or shadows): if 

checked, you can use the time line to simulate the lighting or shading situation "on 

site" over a certain period of time, e.g. over the course of a day or year. The time line 

then influences the lighting settings in the map properties, more precisely the Lighting 

Direction (i.e. the position of the virtual light source, see chapter 5.1.7). If you check 

the box, the From Date/Time property is switched on and the currently displayed time 

is adopted as Date [UTC] and Time [UTC]. When operating the time line, the lighting 

direction is then updated with each time step.  

In 2D, the lighting settings only affect the on-the-fly lighting and shadows (see chapter 

4.5.4 et seq.). If they are enabled, they are recalculated with each time step. 

The changes to the lighting properties are temporary. If you close the time line dialog, 

they are reset to the previously valid values. 

If Set Lighting is unchecked, the time line does not affect the lighting properties. 

• Display Local Time: if checked, the UTC or stored time is converted to your local time, 

i.e. the system time. If unchecked the UTC / stored time shown. 

•   Show Diagram for Map Position (only for raster layers ): activates the diagram 

tool. If you now click in the map viewer in (a) raster(s) with a time stamp, the course 

of the pixel values over the entire event period is displayed graphically for this position. 

For this purpose, a separate diagram window opens: 

 

Figure 89: Graphic representation of the pixel values at the selected position over time 
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The Y-axis shows the pixel values, the X-axis the time. The vertices of the curve, i.e. the 

individuals pixel values by time stamp, can be shown/hidden seperately. 

With each additional click in the raster(s), a new curve is added to the diagram and 

numbered in ascending order. All clicked positions are marked in the map viewer with 

a point and a corresponding number. These points are temporary and will be deleted 

again when the diagram window is closed. 

For more information on the diagram window, see chapter 5.3.2.1.7. 

Tips and notes: 

o Note that the X-axis (just like the Y-axis) is labeled regularly, i.e. the labeling usually 

does not correspond to the time stamps 

o For multi-channel rasters with Time Stamp Type = Band, the values from band 1 

are output. 

o If you need a tabular list of all the curve vertices (= i.e. the individuals pixel values 

by time stamp at the sampled point), then click with the Pixel Info tool (see below) 

on the same point in the map viewer. The coordinates list, which can be called up 

via the context menu of the line, is not suitable for this purpose. 

•  Show Values for Map Position (only for raster layers): activates the Pixel Info tool. 

If you now click in the map viewer in (a) raster(s) with a time stamp, the values of all 

raster pixels located at this position are listed in tabular form including their time 

stamp: 

 

Figure 90: List of raster values at the selected position for all times 

Rasters without a time stamp are ignored. 

For more information about the Pixel Info window see chapter 4.1.12. 
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Timeline Animation in the 3D Viewer  

Only relevant if the project contains a 3D window 

For 3D-capable data (incl. DEMs), a time line animation can also be executed in the 3D viewer; 

for raster textures, this is not possible. The Set Lighting also affects the 3D viewer. 

For more information on the difference between 3D-capable data <> raster texture and light-

ing in 3D, see GAFmap® 3D Viewer manual, chapter 2.2.3.2 and chapter 5.1.7. 

Tips and notes: 

• During the animation you can freely navigate in the map viewer and use almost all 

functions, tools, etc. without affecting the animation and vice versa. 

! Note for vector layers with Time Stamp Type = Attribute in particular: During the 

time line animation, the features are temporarily filtered according to their time 

stamps. Like with a definition query (chapter 5.3.2.5), filtered features are not only 

hidden in the map viewer, but they are also missing in the attribute table. You can 

identify filtered layers (in the TOC) by the  filter icon above the layer icon and in the 

attribute table by the additional information "number of unfiltered features" in the 

footer. 

• If multiple map windows are opened, the animation runs in all windows (incl. 3D win-

dow). 

• The Time Line dialog is dockable. For more information, see chapter 2.2.4. 

 

4.5 Map Viewer Toolbar (2D) 

Only available if the project contains a (2D) map window 

The Map Viewer toolbar is located on the left edge of each (2D) map viewer; all contained 

functions refer exclusively to the map viewer to which it is attached. 

 

Figure 91: Buttons in the Map Viewer toolbar 

All contained analysing functions are on-the-fly functions, which means that 

• they apply only to the map extent currently visible in der map viewer,  

• they apply to all data currently visible in der map viewer, and 

• they directly and exclusively affect the output on the screen. 
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All data remains unchanged and no new data is produced. A preprocessing ist not necessary. 

If you activate e.g. lighting (see chapter 4.5.4), it is calculated directly for the map extent 

currently visible in the corresponding map viewer. All data within the map viewer are then 

shaded on the screen. If the visible map extent changes, the shading is recalculated according-

ly. In all other possibly open map viewers the data is not shaded (unless the button is activated 

there as well). 

 

4.5.1 Separate/Embed TOC 

In GAFmap Express: Map Viewer Toolbar (2D) 

Only available if the project contains a (2D) map window and only if the TOC is not hidden (see 

chapter 4.5.2) 

 Separate/Embed TOC lets you detach the TOC (table of content, see chapter 2.2.2.2) from 

its map window or attach it again.  

If you activate the button, the TOC is separated from its map window and opened in a 

separate, initially floating, dockable window. The title of the TOC window always corresponds 

to that of the associated map window: 

 

Figure 92: TOC, embedded in its map window (left) and separated from its map window (right) 

As long as the button is activated (framed in blue), the TOC remains separated from its map 

window. Like any dockable window, it can then be anchored in the main window or in other 

dockable windows (see chapter 2.2.4.2 et seq.) 

By another click, the button can always be deactivated and the TOC can be embedded in its 

map window again. 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  119 

For more information and examples see chapter 2.2.4.4. 

Tips and notes: 

• You can always activate/call up a separated TOC with Activate TOC in the associated 

map window (see chapter 4.5.3), e.g. if it has been forced into the background, mini-

mized, or hidden while working. The TOC is then brought up and highlighted in blue. 

 

4.5.2 Show/Hide TOC 

In GAFmap Express: Map Viewer Toolbar (2D) 

Only available if the project contains a (2D) map window and only if the TOC is embedded (see 

chapter 4.5.1) 

 Show/Hide TOC lets you show or hide the TOC (table of content; see chapter 2.2.2.2) if it 

is embedded in its map window (see chapter 4.5.1). 

As long as the button is deactivated, the TOC is shown at the left edge of the map window. If 

you activate the button by clicking it, the TOC is hidden; the button is then framed in blue. The 

TOC remains hidden until the button is deactivated again by another click.  

 

4.5.3 Activate TOC 

In GAFmap Express: Map Viewer Toolbar (2D) 

Only available if the project contains a (2D) map window and only if the TOC is separated from 

its map window (see chapter 4.5.1) 

 Activate TOC lets you call up the TOC (table of content; see chapter 2.2.2.2) if it is separa-

ted from its map window (see chapter 4.5.1). This can be necessary if, for example, it has been 

forced into the background, minimized, or hidden while working. If called up, the TOC is 

brought up and highlighted in blue. 
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4.5.4 Enable/Disable Lighting 

In GAFmap Express: Map Viewer Toolbar (2D) 

Only available if the project contains a (2D) map window 

 Enable/Disable Lighting lets you display the current map view with shading. The shading 

causes surfaces facing the light to appear lighter and those facing away from the light to ap-

pear darker, which creates a better three-dimensional impression and helps to identify rela-

tive differences in height more easily.  

The calculation of the lighting/shading is performed on-the-fly, i.e. in the background for the 

map extent currently visible in the map viewer. 

 

Figure 93: Map section with disabled Lighting (left) and enabled Lighting (right) 

The calculation of the on-the-fly lighting / shading is based on 

• the base DEM / DEM mosaic (see chapter 5.3.4) and 

• a virtual light source. The position and intensity of this light source can be defined/ad-

justed in the map properties under Lighting Direction and Lighting (see chapter 5.1.7). 

For areas in the map for which no DEM is available, no shading can be calculated. 

Shortcuts, Key Commands, etc.: 

• L: Enable/Disable Lighting 
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Tips and Notes: 

• You can see/check the base DEM if you uncheck the Map in the TOC and then enable 

the on-the-fly lighting/shading (see also chapter 5.3.4): 

 

Figure 94: Display of the base terrain / DEM mosaic on which the calculation is based 

• With the Time Line, you can simulate the change in lighting over a certain period of 

time, e.g. over the course of a day or year. When the time line is operated, the position 

of the virtual light source is then automatically set so that it corresponds to the position 

of the sun at the time currently displayed, and the lighting in the map viewer is ad-

justed accordingly. For more information, see chapter 4.4.5. 

 

4.5.5 Enable/Disable Shadows 

In GAFmap Express: Map Viewer Toolbar (2D) 

Only available if the project contains a (2D) map window 

 Enable/Disable Shadows lets you display the current map view with shadows. This en-

hances the three-dimensional impression of the captured terrain or surface, and allows you 

to analyze the shadows cast, e.g. to determine whether or when a specific target object is 

shadowed by other objects. 

The calculation of the shadows is performed on-the-fly, i.e. in the background for the map 

extent currently visible in the map viewer. 
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Figure 95: Map section with disabled Shadows and Lighting (left), with enabled Shadows (center), and with 
enabled Shadows and Lighting (right) 

The calculation of the on-the-fly shadows is based on 

• the base DEM / DEM mosaic (see chapter 5.3.4) and 

• a virtual light source. The position and intensity of this light source can be defined/ad-

justed in the map properties under Lighting Direction and Lighting (see chapter 5.1.7). 

For areas in the map for which no DEM is available, no shadows can be calculated. 

Shortcuts, Key Commands, etc.: 

• Ctrl+L: Enable/Disable Shadows 

Tips and Notes: 

• You can see/check the base DEM if you uncheck the Map in the TOC and then enable 

the on-the-fly lighting/shading (see chapter 4.5.4 and 5.3.4). 

• With the Time Line, you can simulate the change in shadows over a certain period of 

time, e.g. over the course of a day or year. When the time line is operated, the position 

of the virtual light source is then automatically set so that it corresponds to the position 

of the sun at the time currently displayed, and the shadows in the map viewer are 

adjusted accordingly. For more information, see chapter 4.4.5. 
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4.5.6 Enable/Disable Viewshed 

In GAFmap Express: Map Viewer Toolbar (2D) 

Only available if the project contains a (2D) map window 

 Enable/Disable Viewshed lets you display the visibility of the terrain from one or more 

locations in the map viewer. The calculation/analysis is performed on-the-fly, i.e. in the back-

ground for the map extent currently displayed in the map viewer. 

The calculation of the on-the-fly viewshed is based on 

• the base DEM / DEM mosaic (see chapter 5.3.4) and 

• at least one viewshed point (VSP), which defines the location of the virtual observer 

and thus forms the starting point for the analysis. 

The on-the-fly viewshed can always be enabled by activating the corresponding button. All 

areas visible from the VSP are then colored in green in the map viewer, non-visible areas are 

colored in red: 

 

Figure 96: Example of enabled viewshed rendering, based on a single VSP: green = visible, red = non-visible 

As long as no VSP is set and activated, the entire visible map extent is displayed as "non-vi-

sible" (red). The same applies to areas within the map extent for which no DEM is available. 

Another click on the button deactivates the viewshed again. 
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Viewshed Points (VSPs) and their Properties 

A VSP defines the location of a virtual observer and thus forms the starting point for the on-

the-fly viewshed. The analysis can be carried out with any number of VSPs (limiting factor here 

is only the performance; see below). If multiple VSPs are set and activated, the union set is 

displayed, i.e. all areas that are visible from one of the VSPs are displayed as "visible" (in green) 

(not, for example, the areas that are visible from all points). Areas colored in red are not visible 

from any of the VSPs. 

 

Figure 97: Example of enabled viewshed rendering (green = visible, red = non-visible) 

VSPs can be set via the Graphics toolbar (see chapter 4.7.14). Always all VSPs that are activa-

ted, i.e. checked in the TOC, are considered. VSPs that are not activated are ignored. 

A self-created VSP can alternatively be deactivated by switching Use for Viewshed in its pro-

perties to Off. (see chapter 5.2.12.1 and 5.2.17). In the TOC, the viewshed icon ( ) next to the 

point symbol is then hidden. Such a point is no longer used as VSP, even if it is checked in the 

TOC. 

In addition to the location of a VSPs, the following VSP properties are also significant for the 

on-the-fly viewshed (see also chapter 5.2.12.1 and 5.2.17): 

• Height [m]: specifies the eye height of the virtual observer (= starting height for the 

analysis). As default, the height defined as Eye Height in the general settings under 

menu Extras > Settings > Viewing > Viewshed (see chapter 3.4.1.3) is entered. If you 
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enter a value higher than the average eye height of 1.75m, you can analyze the visibility 

of the terrain from an elevated position (e.g. a tower or even a satellite). 

• Relative to Ground: if On, the (eye) height is measured relative to the ground (i.e. 

above the base DEM). If Off, it is measured in absolute terms. 

• Minimum/Maximum Sector Angle [°] (only available if Use for Viewshed = On): deli-

mits the sector angle to be analyzed for the viewshed, e.g. to simulate a certain viewing 

direction and angle. For this, the min/max geographical angle has to be entered (mea-

ning North = 0°, East = 90° etc.). You can also enter negative angles or angles >= 360°; 

they are the directly converted to the valid value range. If the angles entered match, 

the entire circle is analyzed.  

 

Figure 98: Example of viewshed with different Sector Angles (green = visible, red = non-visible) 

• Maximum Viewing Distance (only available if Use for Viewshed = On): delimits the ra-

dius of the area to be analyzed. If the field is left empty, the analysis is performed 

without distance limitation. 

In addition to the VSP properties mentioned above, the general setting Target Height under 

menu Extras > Settings > Viewing > Viewshed has influence on the on-the-fly viewshed (see 

chapter 3.4.1.3). 0 corresponds to the ground surface, values > 0 to the corresponding area 

above the ground surface. With values > 0, you can, for example, check whether objects with 

a certain height are visible from the viewer's point of view. 

A VSP can also be located anywhere outside the visible map extent and outside the area co-

vered by the base DEM. However, please note in this case, that no height information is avail-

able for areas not covered by the DEM. Depending on the situation, this can make the result 

of the analysis useless, e.g. if the terrain between the VSP and the map extent not covered by 

the DEM is elevated and the vertical viewing angle is flat. 

The curvature of the earth is precisely taken into account for the calculation of the viewshed; 

it is based on the WGS84 ellipsoid. 
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Viewshed Quality / Performace 

The on-the-fly viewshed is always calculated for the map extent currently visible in the map 

viewer. Alongside the initial accuracy of the DEM, the accuracy of the viewshed depends large-

ly on the following factors:  

• how closely meshed and at what resolution the DEM is sampled within the map viewer. 

The resolution is higher the further you zoom into the map, as then a higher resolution 

DEM pyramid level is displayed and used. It is then also decisive how closely meshed 

the pyramid level used is sampled: the finer the mesh, the more accurate its recon-

struction. 

• for VSPs outside the map viewer: how closely meshed and at what resolution the DEM 

between the SAP and the visible map extent is sampled. 

The DEM is sampled along the "visual rays" from the VSP to the visible map extent in a 

certain number of steps, at a DEM pyramid level that matches the length of the visual 

rays and the number of steps. I.e. the closer the VSP is to the visible map extent and 

the higher the number of sampling steps, the more detailed the measurement. 

You can control the accuracy of the viewshed via the general setting Viewshed Quality under 

menu Extras > Settings > Viewing > Viewshed (see chapter 3.4.1.3). The higher the selected 

quality, the better the pyramid level used and its reconstruction within the map viewer and 

the more sampling steps are carried out outside the visible map extent. 

! Note that the calculation of the viewshed is very demanding, especially if you work with 

many VSPs and/or high quality. The image build-up in the map viewer then takes a correspon-

dingly long time. So, an appropriate compromise must be found between accuracy and per-

formance. Usually, the default setting (Quality = Normal) produces good results. Increase the 

quality, for example, if the result changes significantly in areas that are far away from the VSP 

when you move the maps (at a large scale). In this case, too few sampling steps are carried 

out between the VSP and the visible map extent and view obstructions are therefore not "hit" 

reliably enough. 

Regardless of the used viewshed quality, it is always advisable to deactivate VSPs that are not 

required in order to improve performance! 
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Tips and Notes: 

• If you only want to analyze whether a certain target point is visible from an observer's 

position, use Add Sight Line (see chapter 4.7.15).  

• Regarding the curvature of the earth: The calculation of viewshed is based on the 

WGS84 ellipsoid. However, if your DEM has geoidal heights, this makes hardly a diffe-

rence in terms of accuracy. Since the analysis is about relative heights, the quality of 

the DEM has a much (!) greater influence on the result than an earth radius that de-

viates by a few meters due to undulation. 

• You can see/check the base DEM if you uncheck the Map in the TOC and then enable 

the on-the-fly lighting/shading (see chapter 4.5.4 and 5.3.4). 

 

4.5.7 Enable/Disable Anaglyph Rendering 

In GAFmap Express: Map Viewer Toolbar (2D) 

Only available if the project contains a (2D) map window 

 Enable/Disable Anaglyph Rendering lets you display the current map view as an anaglyph 

image (= red-green image). With suitable red-green glasses, you will then get a three-dimen-

sional impression of the data.  

The calculation is performed on-the-fly, i.e. in the background for the map extent currently 

visible in the map viewer. 

 

Figure 99: Map section with disabled Anaglyph Rendering (left), enabled Anaglyph Rendering (middle), and en-
abled Anaglyph Rendering plus Lighting (right) 
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The calculation of the on-the-fly anaglyph rendering is based on the base DEM / DEM mosaic 

(see chapter 5.3.4) only. For areas in the map for which no DEM is available, no anaglyph 

rendering can be calculated. 

Anaglyph shift and depth, which influence the 3D perception, can be adjusted in the general 

settings (see chapter 3.4.1.3). 

Shortcuts, Key Commands, etc.: 

• K: Enable/Disable Anaglyph Rendering 

Tips and Notes: 

• You can see/check the base DEM if you uncheck the Map in the TOC and then enable 

the on-the-fly lighting/shading (see chapter 4.5.4 and 5.3.4): 

 

Figure 100: Display of the base DEM (here with anaglyph rendering)  
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4.5.8 Enable/Disable Overview 

In GAFmap Express: Map Viewer Toolbar (2D) 

Only relevant if the project contains multiple map windows 

 Based on the always grayed out button Enable/Disable Overview in GAFmap® Express 

you can see whether a map windows is an Overview or not.  

For an Overview, the button is activated, i.e. framed in blue. The map viewer then shows the 

visible extents of all other map windows. These extents are displayed as black-yellow dashed 

frames (according to the settings under Viewing, see chapter 3.4.1.3) and labeled with the 

name of the corresponding map windows. 

 

Figure 101: Example for Enable/Disable Overview: active Overview Window is bottom right 

An overview is never linked to the other map windows, regardless of the settings in the menu 

Window (see chapter 3.2), i.e. the visible extent in the overview never changes unless you 

zoom/move it consciously. 

If the button is not activated (does not have a blue frame), the map window is not an overview. 
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4.5.9 Show/Hide Scalebar 

In GAFmap Express: Map Viewer Toolbar (2D) 

Only available if the project contains a (2D) map window 

 If you activate the button Show/Hide Scalebar, a scalebar is shown at the lower edge of 

the map viewer. The length unit (in m or km) is automatically adapted to the current map 

scale; it is always metric, independent of the map coordinate system. 

You can adjust the appearance of the scalebar (as bar or line, color and background) in the 

general settings (see chapter 3.4.1.3). 

If you deactivate the button, the scale bar is hidden again. 

Shortcuts, Key Commands, etc.: 

• B: Show/Hide Scalebar 

 

4.5.10 Show/Hide Grid 

In GAFmap Express: Map Viewer Toolbar (2D) 

Only available if the project contains a (2D) map window 

 Show/Hide Grid lets you activate or deactivate an on-the-fly coordinate grid for the map 

viewer. The appearance of the grid depends on the settings in the Grid Properties (see chapter 

4.5.11).  

On-the-fly means that the grid is calculated in the background for the currently visible map 

extent and is only displayed on the screen; thus, no "object" such as a graphic element is crea-

ted. 

Shortcuts, Key Commands, etc.: 

• G: Show/Hide Grid  
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4.5.11 Grid Properties 

In GAFmap Express: Map Viewer Toolbar (2D) 

Only available if the project contains a (2D) map window 

 Via Grid Properties you reach the Properties window where all essential properties of the 

on-the-fly coordinate grid (see chapter 4.5.10) are listed:  

Symbologie 

• Line Pen: specifies the symbol used to display the grid lines. 

 opens the Line Pen dialog (see chapter 6.2) 

• Show Label: determines whether the coordinate grid is labeled (On) or not (Off). If On, 

the following properties are available for the labeling: 

o Labeling: here, the label style can be customized. 

 opens the Labeling dialog (see chapter 6.4) 

o Vertical Labeling: if On, parallels are labeled vertically; if Off, they are labeled 

horizontally.  

Note: The grid can only be labeled horizontally or vertically. The Rotation property 

in the Labeling dialog (see chapter 6.4) has no effect here. 

o Labels on X/Y-Axis: determines whether the medians/parallels are labeled on 

Both sides of the map viewer or only on the Top or Bottom / the Left or Right. 

• Grid mode: determines whether continuous grid lines (Lines) or only Ticks are dis-

played in the map viewer, or whether the coordinates are only displayed on the edge 

of the map viewer (On Edge). If you select Ticks or On Edge, you can specify the size of 

the markers at Tick Size . 

• Tick Size [px] (only available for Grid Mode = Ticks / On Edge): determines the size of 

the (grid line) markers. Enter negative values if you want the markers to be drawn in-

wards for On Edge. 

Coordinate Grid 

• Use Map Spatial Reference: if On, the map coordinate system is used for the coordi-

nate grid; if Off, you can specify a different Spatial Reference. 

• Automatic Step Size: if On, depending on the map scale, a suitable step size for the 

coordinate grid is automatically identified and applied. If Off, you can specify a fixed 

Step Size in X/Y direction. The unit depends on the coordinate system set for the coor-

dinate grid. 
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The above-mentioned display options always and only refer to the corresponding map viewer, 

i.e. you can display different grids in different map viewers. 

 

4.5.12 Export Map 

In GAFmap Express: Map Viewer Toolbar (2D) 

Only available if the project contains a (2D) map window 

 Export Map lets you export a defined map extent as image file, including all currently 

activated (= visible) layers and graphics. So in a broader sense you create a (localized) screen-

shot of the currently visible map extent. 

The funcion Export Diagram, with which you can export field statistics or a scatter plot, uses 

the same dialog (see chapter 5.3.2.1.7 or 5.3.2.1.8).  

 

Figure 102: Dialog Export Map 

• Output File: specifies storage location, name, and file type for the output image. The 

following output formats are supported: PNG, JPG and EMF. 

 opens a file browser 

• Size: determines the resolution of the output file. 1x corresponds to the current display 

of the map on the screen. If you want to export the currently visible map extent in a 
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higher resolution, select 2x or 4x. The display for Pixel Size and Raster Size is updated 

accordingly.  

• Cell Size: determines the pixel size of the output raster. If you want to export the 

current map extent in a higher resolution, for example the full resolution of a raster, 

you can specify it directly. 

• Raster Size [Pixel]: shows the size of the output image in pixels. It is automatically cal-

culated from Pixel Size and Extension. 

• Symbol Scaling [%]: determines how strongly symbols such as vector data, labels, and 

graphics are scaled. If you use a higher resolution (= Pixel Size), increase the value to > 

100% if necessary. This prevents the symbols from becoming too small. 

• Draw Selections: if checked, any existing feature selection is also visible in the output 

image. Otherwise, no selection is displayed in the output file. 

• Transparent Background (only available if the output file type supports transparencies, 

e.g. for *.png): if checked, the map viewer is exported with a transparent background, 

regardless of the Background Color selected in the general settings (see chapter 

3.4.1.3). If unchecked, the map viewer is exported with the selected background color. 

• Extent: determines the map extent to be exported. The exported area always corres-

pondes to that of the entered rectangle. Preentered is the currently visible extent. 

However, you can define any other extent by Drag Rectangle, manually entering the 

edge coordinates, or Select Layer (= extent of a selected layer).  

Click OK to export the specified map extent or Cancel to close the dialog without further ac-

tion. 

 

4.6 3D Viewer Toolbar  

Only available if the project contains a 3D window 

The 3D Viewer Toolbar is located at the left edge of the 3D window; all functions contained 

there exclusively refer to 3D viewers.  

It includes 

• various on-the-fly analyse functions (see also chapter 4.5),  

• functions to save views and to display views and movements ("flights") in the 3D 

viewer, 

• the basic settings for the 3D viewer ("configuration"), and 

• buttons to start stereoscopic views, VR, and the Multi User mode. 
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4.6.1 Separate/Embed TOC 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window and if the 3D TOC is not hidden (see chapter 

4.6.2) 

 Separate/Embed TOC lets you detach the 3D TOC (see chapter 2.2.3.2) from the 3D win-

dow or attach it again.  

If you activate the button, the TOC is separated from the 3D window and opened in a separate, 

initially floating, dockable window: 

 

Figure 103: 3D TOC, embedded in the 3D window (left) and separated from the 3D window (right) 

As long as the button is activated (framed in blue), the TOC remains separated from the 3D 

window. Like any dockable window, it can then be anchored in the main window or in other 

dockable windows (see chapter 2.2.4.2 et seq.) 

By another click, the button can always be deactivated and the TOC can be embedded in the 

3D window again. 

For more information and examples see chapter 2.2.4.4. 

Tips and notes: 

• You can always activate/call up a separated 3D TOC with Activate TOC in the 3D win-

dow (see chapter 4.6.3), e.g. if it has been forced into the background, minimized, or 

hidden while working. The TOC is then brought up and highlighted in blue. 

 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  135 

4.6.2 Show/Hide TOC 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window and only if the 3D TOC is embedded in the 

3D window (see chapter 4.6.1) 

 Show/Hide TOC lets you show or hide the 3D TOC (see chapter 2.2.3.2) if it is embedded 

in the 3D window (see chapter 4.6.1). 

As long as the button is deactivated, the TOC is shown at the left edge of the 3D window. If 

you activate the button by clicking it, the TOC is hidden; the button is then framed in blue. The 

TOC remains hidden until the button is deactivated again by another click.  

 

4.6.3 Activate TOC 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window and only if the 3D TOC is separated from 

the 3D window (see chapter 4.6.1) 

 Activate TOC lets you call up the 3D TOC (see chapter 2.2.3.2) if it is separated from the 

3D window (see chapter 4.6.1). This can be necessary if, for example, it has been forced into 

the background, minimized, or hidden while working. If called up, the TOC is brought up and 

highlighted in blue. 

 

4.6.4 Enable/Disable DEM Shading 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window 

 Enable/Disable DEM Shading lets you activate/deactivate an on-the-fly shading for the 

DEM mosaik / base terrain (see chapter 5.3.4) in the 3D viewer. Shading causes all surfaces 

facing the light source to appear lighter, and all surfaces turned away from the light source to 

appear darker. This enhances the spatial impression and the perceptibility of smaller differen-

ces in heights. 

The terrain is also shaded when it is overlayed with textures. 
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The virtual light source is specified for the entire scene in the map properties (see chapter 

5.1.7). 

Influence of Azimuth and Elevation  

If you change the position of the virtual light source ("sun") via Azimuth and Elevation or From 

date and time in the properties of the Map (see chapter 5.1.7), you can simulate and analyze 

e.g. the lighting situation "on site" at different sun positions: 

 

Figure 104: Same DEM extent under different lighting conditions (Map properties Azimuth and Elevation) 

If you use the Background Mode SkyBox Textures (see chapter 5.1.7), the virtual light source 

is displayed as "sun in the sky" at the right position. 

Shortcuts, Key Commands, etc.: 

• L: Enable/Disable DEM Shading 

 

4.6.5 Enable/Disable Shadows 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window 

 Enable/Disable Shadows lets you activate/deactivate on-the-fly shadows for all three-di-

mensional objects, 3D models, point clouds, and digital elevation models. The direction and 
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length of the shadows depends on the direction from which the virtual light source ("sun") 

shines, i.e. on Azimuth and Elevation.  

The virtual light source is specified for the entire scene in the map properties (see chapter 

5.1.7). 

Shadows lets you analyze the shadow cast by the terrain and all three-dimensionally displayed 

layers and graphics at different "sun positions", e.g. to find out if and when certain areas or 

objects are shaded by others: 

  

Figure 105: Same DEM extent, Shadow at different times (Map property From date and time) 

Note that objects only cast a shadow  

• if Shadows/View Obstruction is activated in their properties (see e.g. chapter 5.2.1.10, 

5.3.2.5, or 5.3.4.1). 

• if they appear as bodies in the 3D Viewer. This excludes e.g. point clouds that are 

visualized with the point symbols Point, Cross, or Quad (see chapter 5.3.7.1). 

• if they are not visualized with the Symbol Size Unit Pixel or Scene. 

• The (auxiliary) geometries View Point, Flight Line, and Sight Line never cast shadows. 

Note also that the calculation of shadows involves a large computing effort and places high 

demands on the graphics card. If the performance in the 3D Viewer decreases significantly 

when activating Shadows, you can reduce their quality step by step in the Edit Configuration 

dialog (see chapter 4.6.19). The shadows are then accordingly displayed with a lower reso-

lution. 

Shortcuts, Key Commands, etc.: 

• Ctrl + L: Enable/Disable Shadows 
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4.6.6 Enable/Disable Viewshed 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window 

 Enable/Disable Viewshed lets you display the visibility of the terrain from one or more 

locations in the 3D viewer. The calculation/analysis is performed on-the-fly, i.e. in the back-

ground for the data extent currently displayed in the 3D viewer ("on-the-fly viewshed"). 

The calculation of the 3D viewshed is based on 

• the base terrain (see chapter 5.3.4) and/or any other 3D capable data (see chapter 

2.2.3.2) 

• at least one viewshed point (VSP), which defines the location of the virtual observer 

and thus forms the starting point for the analysis (see chapter 4.5.6). 

The 3D viewshed can always be enabled by activating the corresponding button. All areas 

visible from the VSP are then colored in green in the map viewer, non-visible areas are colored 

in red. 

 

Figure 106: Result of an on-the-fly viewshed in 2D (with activated Shading; left) and of an on-the-fly viewshed in 
3D (right) 

For more information on viewshed and viewshed points (VSPs), see chapter 4.5.6. 
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Special Features for Viewshed in 3D 

While the viewshed in 2D is performed exclusively based on DEMs, all 3D capable data are 

considered as "view obstructions" in 3D. This includes DEMs as well as 3D surfaces, 3D models, 

point clouds, extruded vector layers (polygons, lines, points), and 3D capable graphics.  Prere-

quisite is,  

• that the property Shadows/View Obstruction is enabled on the layer level (see e.g. 

chapter 5.2.1.10, 5.3.2.5, or 5.3.4.1) and 

• that the objects are not displayed with the Symbol Size Unit Pixel or Scene, but  a "real" 

size in meters is given (see e.g. chapter 5.2.1.10 or 6.6.1). 

Layers and graphics for which Shadows/View Obstruction is disabled or which do not have 

this property (e.g. view points or 3D text labels), and those that are displayed with the Symbol 

Size Unit Pixel or Scene, are ignored when applying the 3D viewshed. 

Note that the result of the viewshed is also only displayed on the surface of elevation models 

and objects for which Shadows/View Obstruction is enabled.  

You can activate up to eight VSPs in the 3D TOC and thus use for 3D viewshed. When attemp-

ting to activate a ninth VSP, the VSP that is bottommost in the TOC is automatically deacti-

vated. 

The 3D viewshed is very calculation-intensive and places high demands on the hardware, es-

pecially on the graphics card. Depending on what data and hardware you are using, there can 

be a significant decrease in performance when viewshed is activated. Usually, it a reasonable 

compromise has to be found between a result that is as exact as possible and a result with the 

highest performance possible: 

• The setting Shadow Map and Viewshed Quality in the dialog Edit Configuration (see 

chapter 4.6.19) lets you influence the quality of the viewshed. The following applies: 

The higher the quality, the more accurate the viewshed, but the worse the perfor-

mance. 

! The setting Viewshed Quality under menu Extras > Setting > Viewing > Viewshed has 

no affect an the 3D viewshed! 

• Activate as few VSPs as possible to obtain a viewshed with the highest possible reso-

lution. The graphics memory intended for 3D viewshed is split between activated VSPs, 

i.e. the resolution per VSP is automatically reduced when activating additional VSPs.  

• Reduce the area for the viewshed by loading only a section of the entire data extent 

into the 3D viewer (see chapter 4.1.15), for example, or by reducing the Maximum 

Viewing Distance or the Sector Angle to be analyzed (see chapter 5.2.12.1) 
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The quality of the 3D viewshed depends significantly on the DEM properties Mesh Simpli-

fication and Level of Detail (see chapter 5.3.4.1). The following applies: the less the DEM is 

simplified and the higher the level of detail, the more accurate the viewshed, but the worse 

the performance. 

Usually, Dynamic LOD is selected at Level of Detail, since this setting leads to a good com-

promise between performance and recognizable details and is therefore generally recommen-

ded. Especially with regard to the viewshed, a fixed LOD should be set, as Dynamic LOD (auto-

matically) leads to different and, when moving, constantly changing LODs. 

Shortcuts, Key Commands, etc.: 

• Alt+click on the layer name of a VSP in the 3D TOC: zoom to layer 

 

4.6.7 Enable/Disable Anaglyph Rendering 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window 

 Enable/Disable Anaglyph Rendering lets you start or stop an on-the-fly anaglyph render-

ing (red-green display) for the 3D viewer. With a suitable pair of red-green glasses you will 

then get a better three-dimensional impression of the data. 

The anaglyph rendering can be configured in the Map properties under Stereoscopic View 

(see chapter 5.1.7). 

 

4.6.8 Enable/Disable Direct X Stereo 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window and if Direct X Stereo support is enabled 

(see chapter 4.6.19) 

 Enable/Disable DirectX Stereo lets you start/end the 3D visualization for DirectX Stereo. 

The display can be configured in the Map properties under Stereoscopic View (see chapter 

5.1.7). 
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4.6.9 Enable/Disable Oculus Rift 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window, if Oculus Rift support is enabled (see chap-

ter 4.6.19), and if a suitable VR headset is connected and ready for operation 

 If you have a virtual reality headset connected and ready for operation that is addressed 

via the Oculus Rift interface, e.g. an Oculus Rift S headset, you can always switch to VR mode 

via the Enable/Disable Oculus Rift button or Map Properties > Stereoscopic View > Technique 

Oculus Rift (see chapter 5.1.7). The 3D viewer is then output on the displays of the headset 

until you disable the button or stereoscopic technique again. 

The VR display can be adjusted in the Map Properties under Stereoscopic View (see chapter 

5.1.7), and you can define whether and in which way the headset displays are mirrored on the 

screen in the configuration dialog under Monitor Mirror Mode (see chapter 4.6.19). 

For more information on Virtual Reality mode (general notes, controls, possible actions, etc.), 

see chapter 8. 

 

4.6.10 Enable/Disable SteamVR 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window, if SteamVR support is enabled (see chapter 

4.6.19), and if a suitable VR headset is connected and ready for operation 

 If you have a virtual reality headset connected and ready for operation that is addressed 

via the SteamVR interface, e.g. a HTC Vive (Pro) headset, you can always switch to VR mode 

via the Enable/Disable SteamVR button or Map Properties > Stereoscopic View > Technique 

SteamVR (see chapter 5.1.7). The 3D viewer is then output on the displays of the headset until 

you disable the button or stereoscopic technique again. 

The VR display can be adjusted in the Map Properties under Stereoscopic View (see chapter 

5.1.7). 

For more information on Virtual Reality mode (general notes, controls, possible actions, etc.), 

see chapter 8. 
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4.6.11 Enable/Disable OpenXR 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window, if OpenXR support is enabled (see chapter 

4.6.19), and if a suitable VR headset is connected and ready for operation 

 If you have a virtual reality headset connected and ready for operation that is addressed 

via the OpenXR interface, e.g. Windows Mixed Reality headset, you can always switch to VR 

mode via the Enable/Disable OpenXR button or Map Properties > Stereoscopic View > Tech-

nique OpenXR (see chapter 5.1.7). The 3D viewer is then output on the displays of the headset 

until you disable the button or stereoscopic technique again. 

The VR display can be adjusted in the Map properties under Stereoscopic View (see chapter 

5.1.7). 

For more information on Virtual Reality mode (general notes, controls, possible actions, etc.), 

see chapter 8. 

 

4.6.12 Save Current View Point 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window  

 Save Current View Point lets you save your current view in the 3D window, e.g. to recall 

it at a later time. A view point is then created automatically whose height and viewing angle 

exactly match your current viewing position and direction.  

For more information on view points, see chapter 5.2.15. 

 

4.6.13 Start/Pause Animation 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window and only if a single flight line or view point 

is selected in the 3D TOC 

Start Animation starts the flight along a selected flight line or the flight from your current 

view to a selected view point. To start the flight, simply select a flight line or a view point in 

the 3D TOC and press the button. 
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• If a flight line is selected, the view jumps to the start point of the flight line and the 

flight is then executed according to the flight line properties.  

For more information on flight lines, see chapter 5.2.16. 

• If a view point is selected, a flight starts that leads you directly from your current view 

to the view stored in the view point. 

For more information on view points, see chapter 5.2.15. 

 You can always pause a running flight animation with Pause Animation and resume a 

paused animation with Start Animation. 

Note that once a flight animation has been started, it remains active until it has been com-

pleted, it is stopped (see chapter 4.6.15), or the project is closed. As long as an animation is 

active, no other animation can be started.   

You can tell that an animation is active by the fact that the Stop Animation button in the 3D 

Viewer toolbar is active, or by the play or pause icon in front of the affected flight line / view 

point in the 3D TOC: 

 

Shortcuts, Key Commands, etc.: 

• Alt + click on a View Point's or Flight Line's layer name in the 3D TOC: start animation 

• Key 1-9 while the 3D Viewer is aktiv: fly to 1st-9th View Point in the TOC 

• Ctrl + Key 1-9 while the 3D Viewer is aktiv: start 1st-9th Flight in the TOC 

• Esc while animation: stop animation 

 

4.6.14 Jump Forward/Backward 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window 

 Jump Forward/Backward let you jump forward or back in a started flight animation, 

regardless of whether it is currently running or paused (see chapter 4.6.13). The size of the 

jumps depends on the total duration of the animation, i.e. the flight time. 
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4.6.15 Stop Animation 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window and if a flight animation is active 

 Stop Animation ends a running or paused flight animation (see chapter 4.6.13). The pause 

or play icon in front of the affected flight line / view point is then replaced by the regular layer 

icon again and the Stop Animation button is grayed out. 

If an animation is completed, it is automatically ended.  

Shortcuts, Key Commands, etc.: 

• Esc while animation: stop animation 

 

4.6.16 Create Screenshot 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window 

 Create Screenshot lets you create a screenshot of the 3D viewer / current 3D view: 

 

Figure 107: Dialog Create Screenshot in the 3D Viewer 

• Output File: determines storage location, name and file type for the output raster. 

Available output formats are PNG and JPG.  

 opens a file browser 
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• Resolution: determines the resolution of the output file in pixel width x pixel height. 

Enter the values manually for Width and Height or use one of the following buttons. 

At 1x the resolution corresponds to the current display of the 3D Viewer on the screen, 

at 2x, 4x and Max it is scaled accordingly. 

Please note that the aspect ratio is not automatically maintained when you manually 

adjust the Width or Height. If the aspect ratio of the output file does not match the 

one of the map viewer, the vertical field of view stays the same and the horizontal field 

of view is reduced or increased accordingly. 

• Performance Rating: Specifies the number of DEM blocks shown at once (see chapter 

5.3.4.1). Increase the value, for example, to ensure a higher level of detail in the screen-

shot. If the values differ, the performance rating specified in the configuration dialog 

(see chapter 4.6.19) is overridden for the screenshot. 

 

4.6.17 Show Controls 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window 

 Show Controls opens an information window listing all shortcuts and controls available 

to move within the 3D viewer when using keyboard or mouse. This window automatically 

updates if you customize shortcuts in the general settings (see chapter 3.4.1.5).  

For general information on 3D viewer controls, see chapter 7. 

 

4.6.18 Edit Input Configuration 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window 

 Edit Input Configuration opens a dialog with setting options for the 3D viewer controls:  
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Figure 108: Dialog Input Configuration.  

• Move Speed: defines the speed used when moving linearly within the 3D viewer. The 

higher the value, the higher the speed. You can also adjust the move speed by scrolling 

the mouse wheel while navigating within the 3D viewer (see chapter 7.1). 

• Turn Speed: defines the speed used when rotating within the 3D viewer. The higher 

the value, the higher the speed. You can also adjust the rotation speed by pressing Ctrl 

and scrolling the mouse wheel while navigating within the 3D viewer (see chapter 7.1). 

Touch Gestures (First Person Mode) 

The following setting are only relevant if First Person Mode is activated (see chapter 4.6.20). 

For more information, also see chapter 7.6.  
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• Stay on same height for forward/backward movement: if disabled, you can use the 

pinch/spread-gesture (see chapter 7.5) to move the camera's position forward or back-

ward along its viewing direction. Enable this option if you want to move the camera's 

position horizontally forwards or backwards instead. 

• Forwards/backwards on vertical move gesture: if disabled, you can use the drag-

gesture (see chapter 7.5) to move the camera's position vertically up and down. Enable 

this option if you want to move the camera's position forwards or backwards along its 

viewing direction instead. 

If you enable both Horizontal Touch Movement and Two Finger Pan Up is Forward, you can 

use the drag-gesture to move the camera's position horizontally forwards or backwards.  

Controller Input 

The following settings apply if you use an X-Input Controller (see chapter 7.4) in order to move 

within the 3D Viewer. 

• Stay on same height for forward/backward movement: This option affects the left 

stick and both triggers. If enabled, the camera's position only moves horizontally with-

out changing its height. If disabled, the camera's position moves forward or backward 

along the camera's viewing direction. 

• Swap forward/backward with up/down movement: This option affects the left stick 

and both triggers. If enabled, forward/backward movements swap with upward/ 

downward movements. 

• Invert vertical turn rotation: This option affects the right stick. If disabled, the camera's 

viewing direction turns upwards/downwards if you press the stick forward/backward. 

If enabled, the camera's viewing direction turns the other way round, i.e. downwards/ 

upwards instead. 

 

4.6.19 Edit Configuration 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window 

 Edit Configuration opens the 3D viewer configuration dialog. Most settings directly de-

pend on the used graphics card. Usually, you can work with the default settings automatically 

detected for each graphics card. 
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Figure 109: Dialog Edit Configuration. 

• Drop-down list for selecting the graphics card (only visible if more than one graphics 

card is available): determines the graphics card used for the 3D Viewer. 

• Reset: resets the settings in the dialog to the automatically determined default values 

for the used graphics card. 

• Performance Rating: specifies the number of DEM blocks that are displayed at once 

(see chapter 5.3.4.1). The value can be increased, for example, to achieve a higher level 

of detail for 3D visualization. How high the value can be set depends mainly on the 

speed of the graphics card. The preentered reference value is determined automa-

tically (for the selected graphics card) when you start the 3D viewer on a computer for 

the first time or when you Reset the settings in the dialog (see above). 

• Fullscreen Monitor: determines on which monitor the 3D viewer is displayed in full 

screen display.  

• Enable Direct X Stereo support: if checked, the data output for DirectX Stereo is sup-

ported, providing that the required hardware (e.g. shutter glasses/emitter/display, a 

corresponding 3D TV or a stereo station) is available and installed. In the 3D Viewer 

toolbar the button Enable/Disable DirectX Stereo is then shown (see chapter 4.6.8) and 

in the map properties Technique DirectX Stereo is added under Stereoscopic View 

(see chapter 5.1.7). 
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• Enable Oculus Rift support: if checked, the Oculus Rift interface is activated for VR 

output. The Enable/Disable Oculus Rift button is then added to the 3D Viewer toolbar 

(see chapter 4.6.9) and the technique Oculus Rift is added to the Map properties under 

Stereoscopic View (see chapter 5.1.7). 

With the following settings you can then customize the VR view for Oculus: 

o Monitor Mirror Mode: determines if and how the headset's displays are mirrored 

on the screen. You can choose between Disabled (displays are not mirrored on the 

screen), SingleEye (one display is mirrored on the screen, free of warp), and 

WarpedBothEyes (both displays are mirrored on the screen, warped). The effect 

is only visible when the headset is connected and activated in the 3D viewer. 

o Pixel Density Factor: defines the displayed resolution of the VR display. A higher 

value (1.2 - 2) leads to a sharper display but reduces performance. 

Tip: If you increase the pixel density factor, you should reduce the Performance 

Rating to achieve a constant performance as compensation. Always make sure you 

have enough FPS (frames per second) for a smooth display. 

o Use mipmaps for SwapChain textures: if checked, rendered images are filtered at 

the peripheral area of the VR display to avoid aliasing. This option is recommended 

if a high pixel density factor is entered, but might reduce performance. 

• Enable SteamVR support: if checked, the SteamVR interface is activated for VR output. 

The Enable/Disable SteamVR button is then added to the 3D Viewer toolbar (see chap-

ter 4.6.10) and the technique SteamVR is added to the Map properties under Stereo-

scopic View (see chapter 5.1.7). 

• Enable OpenXR support: if checked, the OpenXR interface is activated for VR output. 

The Enable/Disable OpenXR button is then added to the 3D Viewer toolbar (see chap-

ter 4.6.11) and the technique OpenXR is added to the Map Properties under Stereo-

scopic View (see chapter 5.1.7). 

For Oculus Rift (S) headsets, the Oculus Rift interface in GAFmap® is recommended, and for 

Windows Mixed Reality (WMR) headsets, the OpenXR interface. For most other VR head-

sets, SteamVR will probably give the best results. 

For more information on how to enable VR mode, see chapter 5.1.7, and for other infor-

mation on virtual reality (general notes, controls, possible actions, etc.), see chapter 8.  

Cache Options 

• Graphics Cache [MB]: determines the volume of data loaded to the graphics card. If 

you use a graphics card with small memory or if "out of memory" errors occur, the 
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value should be reduced. As a guideline, a value slightly below the dedicated video 

memory of the graphics card is recommended. 

• Texture Compression: determines whether textures are compressed on-the-fly to re-

duce the graphics memory usage (On) or not (Off). A compression of textures can be 

useful if a graphics card with little memory or 3D models with large textures are used. 

Note, however, that compressing can slow down the streaming significantly. 

o DEM: if checked, the textures of elevation models (DEMs) are compressed. 

o Model: if checked, the textures of 3D models are compressed. If the textures are 

already in a compressed DDS format, they do not need to be compressed again 

and can be loaded directly onto the graphics card. 

Other Options 

• Multi Sample: specifies the used anti-aliasing mode. Anti-aliasing reduces unwanted 

optical effects (artifacts) that can occur when creating a graphic due to the limited 

resolution of the pixel raster. 

• Shadow Map and Viewshed Quality: determines how high resolved terrain and object 

shadows as well as the result of the on-the-fly viewshed are displayed in the 3D viewer. 

The higher the selected quality, the better the resolution. Note, however, that a high 

resolution has a negative effect on the performance (especially the frame raste) and 

that depending on the hardware (especially the graphics card) used the quality level 

should not be too high. The preentered value is determined automatically depending 

on the graphics card used. With the button Reset (see above), the default value can be 

restored at any time. 

For more information on Shadows, see chapter 4.6.5, for information on the 3D view-

shed, see chapter 4.6.6. 

• Present Interval: determines how often a raster image is rendered. If One is set (re-

commended), rendering is limited to the monitor's refreshing rate. 

• Frame Limit per Second: here, you can limit the frame rate (frames per second). If you 

enter e.g. 30, a maximum of 30 frames per second is displayed during a camera move-

ment. Limiting the frame rate can be useful e.g. if you use monitors with G-SYNC or 

FreeSync, because ideally you should stay just below the possible refresh rate of the 

monitor. If 0 is entered, the frame rate is not limited. 

Show frames per second: if checked, the frame rate is displayed in fps (frames per 

second) in the top right corner of the 3D viewer whenever the camera is moving. At 

e.g. 60 fps, 60 frames per second are displayed. For smooth movements, the frame 

rate should be at least 30 fps. 
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• Default Exaggeration: determines which exaggeration factor is entered by default. The 

Exaggeration can be checked and adjusted in the Map properties (see chapter 5.1.7). 

• Default DEM Culling Mode: determines which culling mode is selected by default for 

digital elevation models (i.e. for DEMs and 3D surfaced; see chapter 5.3.4.1).  

• Flight Recording Interval [s] (not relevant for GAFmap® Express): determines the re-

cording time interval when recording a flight, i.e. the time difference between the flight 

points.  

 

4.6.20 Toggle First Person Mode 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window 

 Toggle First Person Mode determines whether the standard mode (see chapter 7.1) is 

active for the mouse controls or the First Person Mode (see chapter 7.2). 

Tips and notes: 

• The activation status of the button is saved in your user profile. 

 

4.6.21 Multi User 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window 

 Multi User lets you create a multi user server yourself or connect to the multi user server 

of another user (see chapter 9.2). 

If you are already connected to a multi user server (session), a dialog with a participation list 

of the current session opens (see chapter 9.2.3). 
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4.6.22 Show Help 

In GAFmap Express: 3D Viewer Toolbar  

Only available if the project contains a 3D window 

 Show Help opens the software help for the 3D viewer. 

 

4.7 Graphics Toolbar 

4.7.1 Edit Graphics 

In GAFmap Express: Graphics Toolbar 

 Edit Graphics lets you select all graphic elements and modify self-created graphics. For 

this, activate the black arrow from the graphics toolbar and select the required graphics within 

the map viewer or the TOC. Depending on type and number of the selected graphic elements, 

various editing options are available (directly or in context menus). 

Selecting Graphics 

You can select a graphic by a left-click in the map viewer on the geometry/object or by choo-

sing the corresponding layer within the TOC. Multi-selection is possible if you press Ctrl while 

selecting. 

Alternatively, you can drag a selection rectangle within the map viewer. All graphics that are 

within the rectangle or intersect it are selected. 

If you select graphic within the map viewer or the TOC, they are always highlighted in cyan in 

the map viewer and dark blue in the TOC. This means, they are always selected in map viewer 

and TOC at the same time.  

Note that a graphic cannot be selected with the Graphics Edit Tool if the property Selectable 

is turned off (see chapter 5.2.1.10). The graphic is then marked in the TOC with the correspon-

ding  overlay icon. Via the TOC a graphic can always be selected, i.e. independent of this 

property. 
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Moving Graphics 

Only possible for self-created graphics and only within the (2D) map window 

As soon as one or multiple graphics are selected, the mouse pointer turns into a move arrow. 

To move the selected elements, grab them by a left-click in the map viewer, hold the mouse 

button, drag them to the desired position, and release the mouse button. 

 

Figure 110: Moving a graphic using Edit Graphics 

Activating / Deactivating Graphic Vertices 

Only possible for self-created graphics and only within the (2D) map window 

You can activate the vertices of a single selected graphic by  

• a double-click on the geometry in the map viewer or 

• pressing F2 after selecting the graphic.  

You can deactivate the vertices by  

• a left-click next to the geometry in the map viewer or 

• pressing F2. 

Editing Graphic Vertices 

Only possible for self-created graphics and only within the (2D) map window 

After activating the graphic's vertices, you can select and modify single vertices.  

Please note: If you edit graphics of the type AOI, rectangle, circle/ellipse, and image, you can 

only change their extent, but not single vertices. If you want to change single vertices of a 

rectangle or circle/ellipse anyway, convert it to a polygon first (see chapter 5.2.6.1 and/or 

5.2.8.1). 
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Copy Graphics 

As long as the Graphics Edit Tool is active, you can always copy/paste selected graphics using 

Ctrl+C/Ctrl+V. 

Graphics Context Menu 

In context menus, various options to change and organize selected graphics are available. You 

can call up the context menu of selected graphics by a right-click in the map viewer with the 

Edit Graphics pointer or by a right-click on the corresponding layer within the TOC. The content 

of the context menu depends on type and number of selected graphics. It only shows functions 

that are suitable for the current selection. 

For more information on graphic context menus, see chapter 5.2. For more information on 

show (vertex) coordinates, see chapter 4.2.2. 

Shortcuts, Key Commands, etc.: 

• Ctrl when selecting: add selection to current selection. Already selected graphics are 

deselected when they are selected twice. 

• Ctrl + Shift when selecting: add selection to current selection. Already selected graphics 

are not deselected when they are selected twice. 

• Shift when selecting: Already selected graphics are deselected when they are selected 

twice. Other graphics are not added to the current selection. 

• Alt while dragging a selection rectangle: create square 

• Alt when selecting by click: select all (overlapping) layers 

• Delete after selection: delete all selected graphics (only for self-created graphics). 

• Shift when moving a graphic element: show auxiliary line 

• F2 when a graphic is selected: switch to vertex display mode / end vertex display mode 

(only for self-created graphics) 

• Esc while editing: cancel 

• Ctrl+C/Ctrl+V: copy/paste selected graphic 

• Ctrl+Z/Ctrl+Y: undo/redo changes 

• Ctrl+S: save changes 
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4.7.2 Rotate Selected Graphics 

In GAFmap Express: Graphics Toolbar 

Only possible for self-created graphics and only within the (2D) map window 

 Rotate Selected Graphics lets you rotate one or multiple selected graphics around a self-

selected center point.  

Select the feature(s) to be rotated and determine the center of rotation with a left-click in the 

map viewer. It is indicated by a cross. The cross is visible while the rotation is active. The cur-

rent rotation angle is displayed in degrees. End the rotation with a second click: 

 

Figure 111: Rotate Selected Graphics, Example. Center of rotation (cross) with rotation angle 

You can also enter the desired rotation angle. To do so, open the context menu with a right-

click after setting the center of rotation, and select Set Angle. Enter the desired relative 

rotation angle in geographic degrees (i.e. "clockwise") and confirm with OK. 

If you want to cancel Rotate Selected Graphics, press Esc. All selected features then retain 

their original orientation and location. 

Note that graphics of the type rectangle and circle/ellipse are automatically converted to 

polygons when rotated. For more information, see e.g. chapter 5.2.6.1:  
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Figure 112: Rotate Selected Graphics, Example. Rotation an ellipse 

The shape of the geometry remains unchanged but geometrical properties and edit behaviour 

alter.  

The exact position of the rotated geometry/geometries can always be adjusted using e.g. the 

Graphics Edit Tool (see chapter 4.7.1). 

Shortcuts, Key Commands, etc.: 

• Esc while rotating: cancel  

• Right mouse button while rotating: open context menu for entering the angle  

 

4.7.3 Add AOI 

In GAFmap Express: Graphics Toolbar 

Only possible within the (2D) map window 

 Add AOI lets you create new AOIs ("Area Of Interest"; see chapter 5.2.2). To do this, simply 

activate the button, left-click into the map viewer, hold the mouse button, and drag the de-

sired rectangle. Hold down the Alt key to create a square.  

Each AOI is initially displayed with the AOI default symbology as simple red frame, but you can 

always change its symbology via the AOI properties (see chapter 5.2.2.4 and 5.2.1.10). 

Shortcuts, Key Commands, etc.: 

• Alt while dragging the rectangle: create square 

• Double-click on layer icon in TOC: open Fill Symbols dialog (see chapter 6.3) 

• Alt + double-click click on layer icon in TOC: open Line Pen dialog (see chapter 6.2) 

• For more shortcuts, see chapter 4.7.6  
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Tips and notes: 

• Please note that AOI graphics are not 3D-capable and are therefore only available as 

textures in the 3D Viewer (see chapter 2.2.3.2). 

• For more tips and notes, see chapters 4.7.5 and 4.7.7. 

 

4.7.4 Add Reference Point 

In GAFmap Express: Graphics Toolbar 

 Add Reference Point lets you create new Reference Points (see chapter 5.2.3). To do this, 

simply activate the button and click into the map viewer. Each left-click on the map creates a 

new Reference Point at the corresponding position.  

By default, a reference point's height is set to 0 above ground. If you hold Ctrl while creating 

a new reference point, the absolute height is entered instead. The prerequisite is that the 

reference point is placed on a digital elevation model (DEM; see chapter 5.3.4) from which the 

height can be interpolated. If multiple rasters are defined as DEM, always the DEM lying on 

top is used. This is also true if this DEM is disabled in the TOC. NoData areas and single-channel 

rasters that are not defined as DEM are not taken into account. 

Each reference point is initially displayed with the Reference Point default symbology as little 

red cross, but you can always change its symbology via the Reference Point properties (see 

chapter 5.2.3.2 and 5.2.1.10). 

Shortcuts, Key Commands, etc.: 

• Ctrl when setting the Reference Point: interpolate absolute height from DEM 

• Double-click on layer icon in TOC: open Point Symbols dialog (see chapter 6.1) 

• For more shortcuts, see chapter 4.7.6  

Tips and notes: 

• Each Reference Point is marked with a  over layer icon. 

• For more tips and notes, see chapter 4.7.5. 
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4.7.5 Add Point 

In GAFmap Express: Graphics Toolbar 

 Add Point lets you create new points (see chapter 5.2.4). To do this, simply activate the 

button and click into the map viewer. Each left-click on the map creates a new point at the 

corresponding position. 

Each point is initially displayed with the default symbology set for new graphics (see chapter 

4.7.17), but you can always change its symbology via the point properties (see chapters 5.2.4.2 

and 5.2.1.10). 

Shortcuts, Key Commands, etc.: 

• Double-click on layer icon in TOC: open Point Symbols dialog (see chapter 6.1) 

• For more shortcuts, see chapter 4.7.6  

Tips and notes: 

• For general information about graphics in GAFmap® Express, see chapter 5.2. 

• Newly created graphics are added separately to the main group Graphics. If any gra-

phic groups (subfolders) exist, they are added to the group that is currently active, i.e. 

selected in the TOC/ highlighted in blue. 

• The default symbology of graphics can be modified using the Symbology button in the 

Graphics Toolbar (see chapter 4.7.17) or via the general settings under Viewing (see 

chapter 3.4.1.3). 

• By default, new graphics are named after the geometry type. If you want the names 

for newly created graphics to be queried, activate the corresponding option in the 

general settings under Other (see chapter 3.4.1.8). A text input field then opens each 

time. 

• Self-created graphics can be modified at any time using the Graphics Edit Tool (see 

chapter 4.7.1). 

• Please note that simple point graphics are not 3D-capable and are therefore only avail-

able as textures in the 3D viewer (see chapter 2.2.3.2). Consider adding a 3D point if 

needed (see chapter 4.7.11). 
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4.7.6 Add Line 

In GAFmap Express: Graphics Toolbar 

 Add Line lets you create new lines (see chapter 5.2.5). To do this, simply activate the 

button, draw a line with any number of vertices in the map viewer, and then end the edit 

sketch with a double-click or F2. 

Each line is initially displayed with the default symbology set for new graphics (see chapter 

4.7.17), but you can always change its symbology via the line properties (see chapters 5.2.5.4 

and 5.2.1.10). 

Shortcuts, Key Commands, etc.: 

• Right-click while drawing: undo last vertex 

• F2 while drawing: finish geometry 

• F3 while drawing: set the length/angle of the next line segment, or the coordinates of 

the next vertex 

• F4 while drawing: enable/disable tracing 

• F6 while drawing: flip digitizing direction 

• Esc while drawing: cancel 

• Shift while drawing: enable sanpping auxiliary line 

• N: temporarily deactivate snapping 

• Ctrl+Z/Ctrl+Y: Undo/Redo 

• Double-click on layer icon in TOC: open Line Symbols dialog (see chapter 6.2) 

• For shortcuts to adjust the display extent, see chapter 4.1.3  

Tips and notes: 

• Press the F3 key while drawing the sketch to set the length/angle of the next line 

segment, or the coordinates of the next vertex, the F4 key to enable/disable tracing. 

• Please note that line graphics are not 3D-capable and are therefore only available as 

textures in the 3D Viewer (see chapter 2.2.3.2). 

• For tips and notes, see chapter 4.7.5. 
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4.7.7 Add Rectangle 

In GAFmap Express: Graphics Toolbar 

Only possible within the (2D) map window 

 Add Rectangle lets you create new rectangles (see chapter 5.2.6). To do this, simply acti-

vate the button, left-click into the map viewer, hold down the mouse button, and then drag a 

rectangle. Press and hold the Alt key to create a square. 

Each rectangle is initially displayed with the default symbology set for new graphics (see chap-

ter 4.7.17), but you can always change its symbology via the rectangle properties (see chapters 

5.2.6.2 and 5.2.1.10). 

Shortcuts, Key Commands, etc.: 

• Alt while dragging the rectangle: create square 

• Double-click on layer icon in TOC: open Fill Symbols dialog (see chapter 6.3) 

• Alt + double-click click on layer icon in TOC: open Line Pen dialog (see chapter 6.2) 

• For more shortcuts, see chapter 4.7.6  

Tips and notes: 

• Rectangle graphics are always upright. If you need a rotated rectangle, you can e.g. 

rotate the rectangle graphic afterwards (see chapter 4.7.2) or create a polygon graphic 

with right-angled corners (with F3 key; see chapter 4.7.8). 

• With Convert to Polygon in the context menu of the Rectangle you can convert it into 

the graphic type polygon. The shape of the geometry does not change when converted, 

but its geometrical properties and editability (see chapter 5.2.6.1). 

• Please note that rectangle graphics are not 3D-capable and are therefore only available 

as textures in the 3D Viewer (see chapter 2.2.3.2). 

• For more tips and notes, see chapter 4.7.5.  
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4.7.8 Add Polygon 

In GAFmap Express: Graphics Toolbar 

 Add Polygon lets you create new polygons (see chapter 5.2.7). To do this, simply activate 

the button, draw a polygon with any number of vertices in the map viewer, and then end the 

edit sketch with a double-click or F2. 

Each polygon is initially displayed with the standard symbology set for new graphics (see chap-

ter 4.7.17), but you can always change its symbology via the polygon properties (see chapters 

5.2.7.2 and 5.2.1.10). 

Shortcuts, Key Commands, etc.: 

• Double-click on layer icon in TOC: open Fill Symbols dialog (see chapter 6.3) 

• Alt + double-click click on layer icon in TOC: open Line Pen dialog (see chapter 6.2) 

• For more shortcuts, see chapter 4.7.6  

Tips and notes: 

• Press the F3 key while drawing the sketch to set the length/angle of the next line 

segment, or the coordinates of the next vertex, the F4 key to enable/disable tracing. 

• Please note that polygon graphics are not 3D-capable and are therefore only available 

as textures in the 3D viewer (see chapter 2.2.3.2). 

• For more tips and notes, see chapter 4.7.5. 

 

4.7.9 Add Circle/Ellipse 

In GAFmap Express: Graphics Toolbar 

Only possible within the (2D) map window 

 Add Circle/Ellipse lets you create new circles or ellipses (see chapter 5.2.8). To do this, 

simply activate the button, left-click into the map viewer, hold down the mouse button, and 

then drag the circle. Press and hold the Alt key to create an ellipse. The radius in X-direction 

and the radius in Y-direction are displayed temporarily while digitizing. The center of the 

circle/ellipse is displayed as a cross. It can be hidden via the Circle properties (see chapter 

5.2.8.2). 
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Each ellipse is initially displayed with the default symbology set for new graphics (see chapter 

4.7.17), but you can always change its symbology via the Ellipse properties (see chapters 

5.2.8.2 and 5.2.1.10). 

Shortcuts, Key Commands, etc.: 

• Alt while dragging the circle: create ellipse 

• Double-click on layer icon in TOC: open Fill Symbols dialog (see chapter 6.3) 

• Alt + double-click click on layer icon in TOC: open Line Pen dialog (see chapter 6.2) 

• For more shortcuts, see chapter 4.7.6  

Tips and notes: 

• With Convert to Polygon in the context menu of the circle/ellipse you can convert it 

into the graphic type polygon. The shape of the geometry does not change when 

converted, but its geometrical properties and editability (see chapter 5.2.8.1). 

• Please note that circle/ellipse graphics are not 3D-capable and are therefore only avail-

able as textures in the 3D viewer (see chapter 2.2.3.2) 

• For more tips and notes, see chapter 4.7.5. 

 

4.7.10 Add Text Label 

In GAFmap Express: Graphics Toolbar 

 Add Text Label lets you create new text labels (see chapter 5.2.9). To do this, simply acti-

vate the button and click into the map viewer where you want the text to be anchored. An 

input window opens. Type in the desired text and confirm with OK. You can still change the 

text later via the graphics properties and/or determine how it is positioned relative to the 

anchor point (see chapter 5.2.9.2). 

Each text label is initially displayed with the default symbology set for new graphics (see chap-

ter 4.7.17), but you can always change its symbology via the text label properties (see chapters 

5.2.9.2 and 5.2.1.10). 

Shortcuts, Key Commands, etc.: 

• Double-click on layer icon in TOC: open Labeling dialog (see chapter 6.4) 

• For more shortcuts, see chapter 4.7.6  
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Tips and notes: 

• Please note that simple text labels are not 3D-capable and are therefore only available 

as textures in the 3D viewer (see chapter 2.2.3.2). Consider adding a 3D text label if 

needed (see chapter 4.7.12). 

• For tips and notes, see chapter 4.7.5. 

 

4.7.11 Add 3D Point 

In GAFmap Express: Graphics Toolbar 

Only available if the project contains a 3D window 

 Add 3D Point lets you create new 3D points (see chapter 5.2.12). Just activate the button 

and click at the desired target position in the (2D) map viewer or the 3D viewer. Each click 

creates a new 3D point with the set default symbology (see chapter 4.7.17).  

Note that in 3D the points can only be placed on a surface, i.e. on DEMs, 3D models, three-

dimensional graphic elements, or (extruded) features etc., and not into "empty space". If there 

is no 3D dataset on the screen at the clicked position, no point is created. 

If you create the 3D point in 2D, 0 above ground is entered as Height by default. In 3D, the 

height is taken from the hit (terrain) surface and entered as absolute height. Thus, the point 

always sits exactly on the hit surface. 

All 3D points are displayed in the TOC with the 2D point symbol defined for them. 

Via the properties of a self-created 3D point, you can adjust its height, the position, and the 

(2D/3D) symbology including the labeling at any time (see chapter 5.2.12.1). 

Dialog Add 3D Point 

If you add 3D points in the 3D viewer, a dialog opens, where you can adjust the symbology of 

the last added 3D point: 
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Figure 113: Add 3D Punkt dialog 

• Position: shows the X/Y/Z coordinates of the 3D point in the map coordinate system. 

If desired, you can manually adjust the coordinates and move the 3D point into the 

"empty space" (e.g. above the terrain). 

• Name and Symbol: determines the name and (2D) point symbol for the 3D point. The 

3D point is listed with this name and layer icon in the TOC and is displayed with the 

selected point symbol in the (2D) map viewer.  

 opens the (2D) Point Symbols dialog (see chapter 6.1) 

 uses the 3D point symbol as (2D) point symbol (as image).  

Note: if for the default symbology for the 3D point the property Generate 2D Point 

Symbol from 3D Point Symbol is enabled (see chapter 4.7.17), the 3D point symbol is 

automatically adapted as (2D) point symbol. 

• 3D Symbol: determines the 3D point symbol for the 3D point. The 3D point is displayed 

with this symbol in the 3D viewer. 

 opens the 3D Point Symbol dialog (see chapter 6.6) 

• Labeling: If Show Label is checked, the 3D point is labeled in the 3D viewer. You can 

then adjust the label style as follows: 

 opens the 3D Labeling dialog (see chapter 6.7). All settings you make here refer to 

the style of the 3D labeling panel. 
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 opens the (2D) Labeling dialog (see chapter 6.4). All settings you make here refer 

to the style of the text on the labeling panel. 

As label text, the name of the 3D point (from the TOC) is used by default. You can 

always enter a different text via the properties of the 3D point (see chapter 5.2.12.1). 

If Show Label is unchecked, the 3D point is not labeled in the 3D viewer (for the time 

being). 

•  Reset Symbology resets all settings in the dialog to the default symbology for the 

3D Point. 

• Set as default point symbology: if checked, the symbology set in the dialog is used as 

new default symbology for new 3D points as soon as you click Close, i.e. the current 

default symbology is overwritten with the symbology from the dialog (see chapter 

4.7.17). If unchecked, the default symbology remains unchanged. 

All changes you make in the dialog are directly applied in the 3D viewer. With Close the dialog 

is closed.  

Tips and notes: 

• In the (2D) map viewer you can also change the position of a 3D point subsequently by 

using the Graphics Edit Tool. Note that the entered height remains unchanged. This is 

relevant if an absolute height is entered (not e.g. at "0 above ground"), because the 3D 

point in 3D then usually does not lie on the terrain after moving, but moves above/ 

below the terrain surface. 

• With default setting, 3D points are added with the symbol size unit Pixel. This has the 

advantage that newly added 3D points are always visible on the screen and you are, 

for example, never "inside the point". Disadvantage is that the feeling of distance/ 

depth is lost. Via the general settings (see chapter 4.7.17) or the Add 3D Point dialog 

(see above) you can always adjust the default unit, e.g. to Scene. For more information 

on the Size Unit, see chapter 6.6.1. 

• For information on adding 3D points in VR, see chapter 8.3.4. 
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4.7.12 Add 3D Text Label 

In GAFmap Express: Graphics Toolbar 

Only available if the project contains a 3D window 

 Add 3D Text Label lets you create new 3D Text Labels (see chapter 5.2.13). Just activate 

the button and click the position in the (2D) map viewer or 3D viewer where the 3D text label 

is to be anchored. Each click creates a new 3D text label with the set default labeling style (see 

chapter 4.7.17). 

Note that in 3D the anchor point can only be placed on a surface, i.e. on DEMs, 3D models, 

three-dimensional graphic elements, or (extruded) features etc., and not into "empty space". 

If there is no 3D dataset on the screen at the clicked position, no 3D text label is created. 

If you create the 3D text label in 2D, 0 above ground is entered as Height by default. In 3D, the 

height is taken from the hit (terrain) surface and entered as absolute height. Thus, the anchor 

point always sits exactly on the hit surface. 

Via the properties of a self-created 3D text label you can adjust the height and the postion of 

the anchor point as well as the label text and style at any time (see chapter 5.2.13). 

 

4.7.13 Add View Point 

In GAFmap Express: Graphics Toolbar 

Only available if the project contains a 3D window 

 Add View Point lets you create/set new view points (see chapter 5.2.15). Activate the 

button and click at the desired target position in the (2D) map viewer or the 3D viewer. Each 

click creates a new view point.  

Note that view points in 3D can only be placed on a surface, i.e. on DEMs, 3D models, three-

dimensional graphic elements, or (extruded) features etc., and not into "empty space". If there 

is no 3D dataset on the screen at the clicked position, no view point is created. 

• If you create a view point in 3D, the height is taken from the hit surface and entered 

as absolute Height. The point then rests directly on the surface. The viewing angle is 

automatically adjusted so that your current position is in the focus of the view point, 

i.e. exactly opposite the current viewing direction.  

• Creating view points in 3D is recommended e.g. if you want to simulate the view from 

a certain point, like the view from a window. Simply position yourself at the point that 
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is to be in the focus of the view point and then place the point directly on the window 

/ facade. 

• If you create a view point in 2D, 500 above ground is entered as Height by default and 

the Viewing Angle is set to north and slightly downwards.  

• Creating view points in 2D is recommended e.g. if you want to place it above a certain 

location, because points in 3D can only be set on the surface, but not above it (see 

above).  

Via the properties of a self-created view point you can adjust its height and viewing angle at 

any time (see chapter 5.2.15.2). 

Save current view in 3D Viewer  

 Save Current View Point in the 3D Viewer toolbar lets you save your current view in the 

3D viewer (see chapter 4.6.12). A view point is then created automatically whose height and 

viewing angle exactly match your current viewing position and direction. 

Fly to View Points 

In the 3D viewer, you can fly to view points from your current position and thus restore the 

saved view at any time. This is possible in the following ways:  

• Via Alt + click on the layer name of the view point in the 3D TOC. 

• Via the command  View from Point in the context menu of the view point (see chap-

ter 5.2.15.1). 

• Via the keys 1-9, if the 3D window is active (highlighted): with 1 the topmost view point 

in the TOC is approached, with 2 the second, with 3 the third, etc.  

If necessary, click on the frame of the 3D window once, to activate it. 

• Via the  Play button in the 3D Viewer toolbar (see chapter 4.6.13) when a view point 

is selected (highlighted in blue) in the TOC. 

In all cases, a 3D flight animation is started, which takes you from your current position directly 

to the saved view. The flight can always be stopped or paused by using the corresponding 

buttons in the 3D Viewer toolbar (see chapter 4.6.13 et seqq.). 

Shortcuts, Key Commands, etc.: 

• Alt+click on a view point's layer name in the 3D TOC: start animation 

• Key 1-9, while the 3D window is aktiv: fly to 1st-9th view point in the TOC 
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• Esc while animation: cancel animation 

• I while animation: cancel streaming 

 

4.7.14 Add Viewshed Point 

In GAFmap Express: Graphics Toolbar 

 Add Viewshed Point lets you create a new 3D point that by default has the property Use 

for Viewshed = On (indicated by the  viewshed symbol next to the point symbol). Such a 

viewshed point (VSP) defines a starting point for the on-the-fly viewshed, i.e. a (view)point 

from which the visibility of the terrain is analyzed.  

For more information on the viewshed, see chapter 4.5.6 or, especially on viewshed in the 3D 

Viewer, chapter 4.6.6. 

Workflow 

VSPs can be created in the (2D) map viewer or the 3D viewer. Proceed the same way as when 

creating a "normal" 3D point (see chapter 4.7.11). 

Note especially regarding VSPs: 

• If you set a VSP in the 3D viewer, unlike as for a 3D point, not the height taken from 

the terrain is entered as absolute Height, but "height taken + eye height". You can view 

and adjust the Eye Height in the general settings under Viewing (see chapter 3.4.1.3). 

If you add the VSP in the (2D) map viewer, the entered Height is analog "eye height 

above ground" (instead of 0 above ground as for the 3D point).  

Note: If you subsequently convert 3D points to VSPs by setting the property Use for 

Viewshed to On (see chapter 5.2.12.1), the entered height remains unchanged, i.e. the 

eye height is not added. The same applies vice versa. 

• If a Click Position Offset [m] is specified in the Map properties, this is additionally ap-

plied (see chapter 5.1.7). It causes VSPs to be moved a certain, usually small distance 

away from the clicked target position opposite the current viewing direction. VSPs are 

thus slightly lifted off the (terrain) surface, which helps to avoid unwanted optical 

effects (artifacts), especially on rough terrain, (building) edges or facades.  

• You can also place VSPs in 3D on vertical surfaces such as facades, e.g. to analyze the 

visibility from a window. In this case, you can subsequently limit the Sector Angle via 

the VSP properties so you only look "forward", i.e. "out of the window" (see chapter 

5.2.12.1).  
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All VSPs are added as  Viewshed Point under the main group Graphics in the TOC. Via the 

VSP's properties, you can always adjust the assigned height and position, the viewing distance 

and sector angle, and the (2D/3D) symbology including the labeling (see chapter 5.2.12.1 or 

5.2.1.10). 

If not already active, the on-the-fly viewshed rendering is automatically enabled as soon as a 

new VSP is set. However, it can always be disabled and re-enabled through Enable/Disable 

Viewshed in the Map Viewer toolbar.  

Moving self-created Viewshed Points 

 Add Viewshed Point also lets you move self-created VSPs to another location. Simply run 

the mouse pointer over the VSP until it turns into a moving arrow. You can now grab the VSP 

with a left-click, drag the VSP to the desired position by holding down the mouse button, and 

then release it. As long as you hold down the mouse button, you can move the VPS freely to 

any position. If the on-the-fly viewshed rendering is enabled, it is updated directly while the 

VSP is moved.  

You can also move existing VSPs with the Graphics Edit Tool (see chapter 4.7.1). If you use this 

tool, the on-the-fly viewshed rendering is not updated until the VSP is finally placed (i.e. not 

while it is moved). 

Tips and Notes: 

• The property Use for Viewshed can always be switched on/off for self-created VSPs / 

3D points. This way you can, for example, exclude a VSP from the on-the-fly viewshed 

without having to delete or disable it. 

 

4.7.15 Add Sight Line 

In GAFmap Express: Graphics Toolbar 

 Add Sight Line lets you create a line graphic that allows you to see whether a particular 

target point is visible from an observer's position.  

Such a sight line is only possible if the project contains a digital elevation model marked as 

DEM (see chapter 5.3.4). 
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Workflow in 2D 

Proceed as follows to create a sight line in the (2D) map viewer: 

• Click the Add Sight Line button 

• Click on the desired start point (= observer's position) in the map viewer. As soon as 

the starting point is placed, the sight line is displayed. You can now move it in any 

direction. The visibility is then displayed on-the-fly for the current target point (= 

mouse position/head of arrow): 

 

Figure 114: Example for creating a Sight Line 

The green part is visible from the observer's position, the red part is invisible. In case 

the target position is not visible, you can easily identify where the sight obstacle is 

located on the sight line, as the arrow's color changes from green to red at this point.  

• Finalize the sight line by double-clicking the target position. The sight line is then added 

to the TOC as a Sight Line graphic. 

By default, a start height (eye elevation) of 1.75m is used for the observer when creating the 

sight line, and a target height of 0m. You can adjust the default heights in the general settings 

under Viewing (see chapter 3.4.1.3). For self-created sight lines, you can also change the 

height values via the respective layer properties (see chapter 5.2.18.1). 

Workflow in 3D 

Sight lines can also be visualized and created in the 3D viewer. Note that in 3D start point and 

end point can only be set on a surface, i.e. on DEMs, 3D models, three-dimensional graphic 
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elements, or (extruded) features etc., and not into "empty space". If there is no 3D dataset on 

the screen at the clicked position, the point is not created. 

When creating a sight line in the 3D viewer, the (terrain) height at the start point and target 

point is taken from the base elevation model. In the Sight Line properties, the following ab-

solute heights are then entered for Eye Height and Target Height: 

• Eye Height = taken terrain height + (general) Eye Height  

• Target Height = taken terrain height + (general) Target Height 

Note: When creating a sight line in 2D, the same applies. However, no terrain heights are 

taken, but relative heights are entered, i.e. (general) eye height and (general) target height 

"above ground ". 

Tips and notes: 

• Unlike the 3D viewshed (see chapter 4.6.6), for the sight line only DEMs are considered, 

even in 3D. 

 

4.7.16 Open Multimedia 

In GAFmap Express: Graphics Toolbar 

 Open Multimedia lets you open linked multimedia objects (see chapter 5.2.19) by clicking 

the respective link(s) within the map viewer. To do this, simply activate the button and click 

the link to be called up in the map viewer with the mouse pointer ("finger"). The multimedia 

object is always opened with the assigned standard program for the respective file type, e.g. 

URLs are opened with the standard internet browser or PDFs with Acrobat Reader etc. 

Alternatively, you can open a linked multimedia object via Open Multimedia in the Multi-

media context menu (see chapter 5.2.19.1). 

 

4.7.17 Symbology 

In GAFmap Express: Graphics Toolbar 

 Symbology takes you to a Properties window, where the default symbology for graphics 

can be checked and modified. If applicable, the listed predefined properties are initially 

applied to all newly created graphics. 
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This default symbology for graphics can also be set in the general settings under Viewing. 

Settings made there are automatically applied here and vice versa. For more information and 

an explanation of the indiviual Symbology properties, see chapter 3.4.1.3. 

You can always customize the symbology for Graphics subsequently via the Graphics proper-

ties. For more information, see chapter 5.2. 
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5 GAFmap Layers (Context Menus) 

Right-clicking selected (highlighted in blue) (main) groups, graphics and/or layers in the TOC 

opens a context menu containing functions and commands specifically tailored to the source 

element(s). Which functions are included depends primarily on the level in the TOC, the 

number, and the type of the selected elements. Hence, the context menu for the main group 

Graphics is different from that of a graphics group, and the context menu of a layer group 

contains different functions than that of a single raster etc.    

The following chapters cover all the functions/commands that appear in the different context 

menus.  

Selecting Elements in the TOC 

You can select an element in the TOC with a simple left-click (on the layer icon or name); it is 

then highlighted in blue. Multi-selection is possible e.g. by holding down the Ctrl or Shift key. 

Alternatively, you can select graphic elements and layers in the map viewer with Select Layer 

(see chapter 4.1.10) and graphic elements with the Graphics Edit Tool (see chapter chapter 

4.7.1). They are then also highlighted in blue in the TOC. 

Shortcuts, Key Commands, etc.: 

• Left-click on element in the TOC: select element 

• Ctrl when selecting: add selection to current selection. Already selected features are 

deselected when they are selected twice. 

• Shift when selecting: select consecutive elements (Ctrl + click on first and last element 

to be selected) 

• Ctrl+A within TOC: select all layers 

• Right-click on individual / multiple selected elements in the TOC: open context menu 

• X: toggle layer(s) selected in TOC (with multiple map windows only in the active one) 

• C: toggle layer(s) selected in TOC globally (with multiple map windows in all windows) 

• Alt + left-click on a selected layer, graphic, or group in the TOC: zoom to element 

• Alt + checking a layer, graphic, or group in the TOC: zoom to the checked element 
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5.1 Map 

5.1.1 Zoom to Full Extent 

In GAFmap Express: TOC > Context Menu Map 

 Zoom to Full Extent zooms the map extent to the full extent of all loaded datasets (see 

also chapter 4.1.6). 

Shortcuts, Key Commands, etc.: 

• Alt + left-click on selected layer(s)/group(s) in the TOC: zoom to layer(s)/group(s) 

 

5.1.2 Set Map Scale 

In GAFmap Express: TOC > Context Menu Map 

 Set Map Scale opens a dialog where you can enter a desired map scale; pre-entered is the 

current scale. If you confirm with OK, the (associated) map viewer is zoomed accordingly and 

the scale displayed in the main toolbar is adjusted. Cancel closes the dialog without further 

action. 

Tips and notes: 

• Alternatively, the map scale can be set directly via the scale field in the main toolbar 

(see also chapter 4.1.7). 

 

5.1.3 Find Layer 

In GAFmap Express: TOC > Context Menu Map 

 Find Layer lets you search the TOC for layers with a specific name or name component. 

After calling up the command, a dialog opens. Enter any character string and confirm with OK. 

All elements below the main groups that contain this character string are then selected in the 

TOC (highlighted in blue). If the search is unsuccessful, a corresponding message appears. 

The search is not case-sensitive. * serves as a placeholder/wildcard. 
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5.1.4 Collapse All / Expand All 

In GAFmap Express: TOC > Context Menu Map 

 ollapse All / Expand All lets you fully collapse/expand all groups, subgroups, and 

layers under the main groups in the TOC at once (see also chapter 2.2.2.2).  

If you only want to expand/collapse selected groups and/or layers, use the corresponding 

command at group or layer level (see chapter 5.2.1.9 or 5.3.1.6), or the forward or back arrow 

keys. 

Shortcuts, Key Commands, etc.: 

• Arrow key back (with mouse focus on TOC): collapse selected groups and/or layers in 

the TOC 

• Arrow key forward (with mouse focus on TOC): expand selected groups and/or layers 

in the TOC 

 

5.1.5 Show Project Info 

In GAFmap Express: TOC > Context Menu Map 

Only available if a project info is saved 

If a project info is available for the project, i.e. if the map property field Project Info contains 

an entry, then this info can be called directly from the map's context menu via the command 

Show Project Info. The project info is then displayed in a separate window, either as plain text 

or with (HTML) formatting, depending on the form of the entry.  

 

5.1.6 Reset Properties 

In GAFmap Express: TOC > Context Menu Map 

Only available if the project contains a 3D window 

 Reset Properties resets any map properties that you may have changed to as they are set 

in the original project (i.e. "as stored in *.cmp"). 
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5.1.7 Properties 

In GAFmap Express: TOC > Context Menu Map 

Only available if the project contains a 3D window 

 Under Properties, all essential properties of the map / 3D scene are listed.  

Many of the properties that can be set here are 3D viewer-specific and affect the visualization 

of the data in the 3D viewer in general and/or the display of the 3D viewer itself, i.e. the 

"empty space" in which the data is visualized. These properties are only available if the project 

contains a 3D window. 

Project 

Here, basic information about the project is shown. 

• Project File Path: shows the file path to the project file (*.cmp). 

  opens project file path in a textbox 

• Spatial Reference: shows the project/map spatial reference. 

 opens a window with more detailed information about the map spatial reference 

• Project Info: if available, additional information about the project can be viewed here 

(e.g. general information about the map, a project editor, data sources, etc.) 

 opens the Project Info window 

If a project info is entered, it can alternatively be called up via Show Project Info com-

mand in the map context menu (see chapter 5.1.5); texts with HTML syntax are then 

usually displayed formatted (here always as source text 

Lighting Direction 

These properties influence the position of the virtual light source ("sun"), which is used to 

calculate the (on-the-fly) shading and shadows in 2D and 3D (see chapters 4.5.4 et seq. (for 

2D) and 4.6.4 et seq. (for 3D)). 

If you use SkyBox textures as background mode (see below), the virtual light source is dis-

played as "sun in the sky" at the right position. 

• From Date/Time: determines whether the position of the virtual light source is defined 

via Date [UTC] and Time [UTC] (On), or via Azimuth and Elevation (Off). 
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• Date [UTC] (only available if From Date/Time = On): specifies the point in time for 

which the position of the sun and thus the position of the virtual light source "on site" 

is calculated. Type in the desired date or select it from the calendar. 

 opens a calendar 

Time [UTC] (only available if From Date/Time = On): specifies the time of day for which 

the position of the sun is calculated for the given date. Type in the desired time or use 

the slider. 

 opens a slider 

• Azimuth [°] (only available if From Date/Time = Off): specifies the cardinal direction 

from which the virtual light source shines. Enter the geographical angle, i.e. clockwise 

to north (0° = north, 90° = east, 180° = south and 270° = west). If you enter negative 

angles or angles >= 360°, these are converted to the value range of [0;360°[. 

 opens a slider 

Elevation [°] (only available if From Date/Time = Off): specifies the elevation of the 

virtual light source. You can enter angles from -90° (vertical from below) to 0° (on the 

horizon) to 90° (vertical from above; at the zenith). If you enter angles > |90°|, these 

are set to 90°. For actually needed angles of |90°-180°|, switch the azimuth instead! 

 opens a slider 

Tip: If you use the sliders, the lighting conditions in the map viewer are updated on-the-fly. 

Lighting 

These properties only affect the lighting in the (2D) map viewer. They influence the inten-

sity of the virtual light source. If lighting and shadows are deactivated (see chapters 4.5.4 

et seq.), these properties have no effect (i.e. they do not influence, for example, the general 

brightness in the map viewer). 

• Ambient (affects Lighting and Shadows): determines the initial brightness of the map. 

Enter values from 0 (completely dark) to 1 (maximum brightness).  

The higher the initial brightness, the brighter (less intensive) shadows are drawn. 

• Specular (only affects Lighting): determines the brightness of the light reflected by the 

surface. Enter values from 0 (completely dark) to 1 (maximum brightness).  

• Shininess (only affects Lighting): determines the reflection properties of the surface 

(albedo). Enter values from 0 (no reflection) to 100 (maximum reflection)  

• Shading Contrast (only affects Lighting): determines the contrast between shaded and 

unshaded areas. The higher the value, the greater the contrast between areas facing 

the light and areas facing away from the light. Recommended are values between 1 
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(low contrast) and 10 (high contrast). However, in areas with low relief, higher values 

may be necessary. 

3D Lighting 

Only available if the project contains a 3D window 

These properties only affect the lighting in the 3D viewer. They affect the lighting situation 

in the 3D viewer in general, i.e. the light in the "surrounding 3D space", regardless of loaded 

layers. 

• Ambient: determines the initial brightness of the scene, i.e. how bright a point without 

any illumination is displayed. The directional light of the virtual light source is added to 

the basic brightness. Values between 0 (completely dark) and 1 (maximum brightness) 

are available for ambient. The Ambient setting also affects the intensity of shadows. 

 opens a slider 

• Ambient Reflections: determines how strongly light is reflected by non-metallic, "natu-

ral" surfaces. The lower the value, the less these surfaces reflect. Areas and structures 

are then displayed more realistically without appearing unnaturally metallic. At high 

values, non-metallic surfaces also appear metallic. 

 opens a calendar 

The lower the set Roughness (see chapter 5.3.4.1), the stronger the effect. 

Tip: Use Ambient Reflection in combination with Skybox Textures (see below) to achieve 

a realistic representation of objects and surfaces in open air. 

3D Viewer 

Only available if the project contains a 3D window 

• Exaggeration: Here, you can add a vertical exaggeration, i.e. an enlargement of the 

height scale in relation to the scale of length. This is usually applied to intensify the 

stereoscopic impression of the data. 1 means that height scale and scale of length are 

equal (no exaggeration), for values > 1 the height scale is enlarged by the respective 

factor. You can add an exaggeration up to 20. 

• Background Mode: Here you can adjust the background in the 3D viewer, i.e. the 

appearance of the "empty space" in which the 3D data is located. At choice are: 

o Constant Color: The background is displayed in one color.  

Via Background Color you can then specify the color to be used. 

 opens the colour picker dialog (see chapter 6.5) 
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Via Use Fog you can determines whether the data in the 3D viewer is superim-

posed by fog (On) or not (Off). If On, specify the desired maximum viability via Fog 

Max Viability [m]. The lower the entered value, the more restricted your visibility 

is, and the more details disappear in the fog/background. The fog appears in the 

specified background color. 

o Color Gradient: The background is displayed with a grey to blue color gradient. 

o SkyBox Textures: The background is represented by a sky texture. In addition, the 

current position of the sun is simulated according to date and time of day or to 

azimuth and elevation, and a respective twilight effect is applied. The sky texture 

theme can be specified via SkyBox. 

3D Labeling 

Only available if the project contains a 3D window 

These properties affect all labels in the 3D viewer across all layers: 

• Prevent Overlaps: if On, overlapping of 3D labels / label boards in the 3D viewer is 

prevented. 3D labels are then hidden when they are covered by another 3D label that 

is closer to the current viewing position. This applies across layers and independent of 

the type of 3D labeling. 

If required, you can prioritize 3D labels differently via a Label Priority, e.g. to achieve 

that certain labels are always displayed (see e.g. chapter 5.2.1.10 or 5.3.2.5). 

Via Prevent Overlaps Delay [ms] you can then define a delay, after which the labels 

are hidden or shown again when you move in the 3D viewer, i.e. when the viewing 

position changes. The greater the entered delay, the later the labeling changes. 

Especially if you play back flight animations or record flights, a longer delay time can 

avoid, that the labeling switches too fast or too often.  

If Prevent Overlaps is turned Off, all activated 3D labels are drawn, regardless of whe-

ther they overlap or not. In this case, also covered and unreadable labels are displayed. 

Please note that it has a negative effect on the performance if many labels are dis-

played. 

Viewshed 

Only available if the project contains a 3D window 

These properties affect the 3D viewshed (see chapter 4.6.6): 

• Click Position Offset [m]: the offset specified here is always applied when a Viewshed 

Point (VSP) is newly created in the 3D viewer; it causes the VSP to be offset from the 

clicked target position by the specified distance. Usually, the click position offset is 
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used to slightly lift the VSPs off the (terrain) surface in order to minimize unwanted 

optical effects (artifacts) that can be caused by an uneven surface, especially in the 

direct surroundings of a VPS.  

The offset is always performed towards your current viewing direction. 

Stereoscopic View 

Only available if the project contains a 3D window 

Here, you can select a stereoscopic technique with which the data is visualized in the 3D 

viewer. Available are: 

• Deactivated: if selected, no stereoscopic view is used. 

• Technique Anaglyph: if selected, an anaglyph rendering is applied to the 3D viewer. In 

combination with suitable anaglyph glasses, you get a more intense three-dimensional 

impression of the data. 

The anaglyph rendering can be configured via the settings listet below (see below). 

You can also enable the anaglyph rendering via the respective button in the 3D viewer 

Toolbar (see chapter 4.6.7). 

• Technique Side by Side: if selected, a stereo image pair is output in the 3D viewer. This 

is primarily intented for the presentation via 3D-ready television screens. If you use 

this method, you should switch to full screen mode and select side-by-side in the the 

screen's menu. This method can also be used to create side-by-side videos that can be 

shown on 3D-capable devices.  

The side-by-side rendering can still be configured via various settings (see below). 

• Technique DirectX Stereo (only available if DirectX Stereo support is enabled; see chap-

ter 4.6.19): if selected, the 3D viewer is displayed on a Direct3D 11.1 Stereoscopic 

compatible screen. Prerequisite is that the respective hardware (e.g. shutter glasses/ 

emitter/display, a corresponding 3D-TV, or a stereo station) is connected and installed.  

The stereo rendering can still be configured via various settings (see below). 

You can also enable the DirectX stereo rendering via the button Enable/Disable Di-

rectX Stereo in the 3D Viewer toolbar (see chapter 4.6.8). 

• Technique Oculus Rift, SteamVR, or OpenXR (only available if the correspondig inter-

face is enabled; see chapter 4.6.19): if selected, the 3D viewer is output on the displays 

of the VR headset. Prerequisite is that a VR headset is connected and ready for opera-

tion. Always select the interface here via which your headset is actually addressed. 

The VR display can be configured via various settings (see below). 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  181 

You can also enable the the VR output via the respective button in the 3D Viewer tool-

bar (see chapter 4.6.9 et seqq.). 

The stereoscopic views mentioned above (Technique = Anagly, Side-by-Side, or DirectX 

Stereo) can be configured via the following properties: 

• Stereo Color Mode (only with Technique = Anaglyph): determines the color mode used 

for anaglyph rendering.  

• Use Virtual World Scale = On: 

o Virtual World Scale: sets the scale for the virtual world. A value of 1 (= 1:1) corres-

ponds to a real scale. A smaller scale, e.g. 1:200, causes the virtual world to appear 

smaller, which increases the stereo impression and thus makes it easier to esti-

mate relative distances and sizes. 

o Screen Offset Factor: adjusts the Virtual World Scale to the size of the monitor 

used. An adjustment is only necessary if you want to display the 3D viewer on very 

big screens or a projector. For a correct adjustment of the Screen Offset Factor, 

start with a small value and increase it as long as you can comfortably focus on 

distant objects. You can use shortcuts F3/F4 to decrease/increase the Screen Off-

set Factor. 

• Use Virtual World Scale = Off: 

o Focus Distance: determines the distance of objects that seem to be right on the 

screen surface. Smaller values virtually make the objects appear to be behind the 

screen surface, higher values make them appear in front. 

o Stereo Depth: determines the stereo depth's exaggeration. The default value of 

0.3 can usually be retained. If you use a big screen or the stereo impression seems 

to get lost, you can try a lower value to reach a better result. 

The VR views mentioned above (Technique = Oculus Rift, Steam VR, or OpenXR) can be 

configured via the following properties: 

• Resolution: shows the resolution used for the virtual reality hardware. 

When using the Oculus Rift interface, the resolution used can be adjusted via the Pixel 

Density Factor in the configuration dialog (see chapter 4.6.19). For SteamVR, the reso-

lution can be scaled via the SteamVR settings in Steam, and for Windows Mixed Reality 

(WMR) headsets, there is a corresponding setting in the Mixed Reality Portal app of 

Windows. 

• Virtual World Scale: sets the scale for the virtual world. A value of 1 (= 1:1) corresponds 

to a real scale. A smaller scale, e.g. 1:200, causes the virtual world to appear smaller, 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  182 

which increases the stereo impression and thus makes it easier to estimate relative 

distances and sizes. 

• Tracking-Positional Streaming: specifies whether the tracking position of the VR head-

set affects the streaming (On) or not (Off). Disable this option on a trial basis if you 

notice unwanted interruptions while looking around, which may be caused by reloa-

ding data. Please note that the given postion may not be displayed in the highest Level 

of Detail (LOD, see also chapter 5.3.4.1) if you have moved too far away from the 

original position. If this option is disabled, you should center your postion regularly 

(see chapter 8.2), especially when mounting the VR headset or physically moving away 

from the original position. 

For more information on Virtual Reality mode (general notes, controls, possible actions, 

etc.), see chapter 8. 

HUD / Visual Hints 

Only available if the project contains a 3D window 

These properties affect the visual hints / navigation aids in the 3D viewer (HUD = head-up-

display): 

• HUD Color: determines the color of compass band and crosshair. Info text in the top 

right or bottom right corner of the 3D viewer, e.g. on streaming or rendering, is also 

displayed in this color. 

 opens the Color Picker dialog (see chapter 6.5) 

• HUD Scaling: determines the size of compass needle, compass band and crosshair. Info 

text in the top right or bottom right corner of the 3D viewer, e.g. on streaming or ren-

dering, is also displayed with this scaling.  

 opens a slider 

• Show Compass Needle: if On, a compass needle is shown in the 3D viewer's upper left 

corner. The needle rotates and tilts with the 3D view; the red tip always points north.  

The size of the compass needle depends on the HUD Scaling. 

If Off, no compass needle is displayed. 

• Show Compass Band: if On, a compass band is shown at the 3D viewer's upper and left 

edge. The band at the upper edge shows the horizontal viewing direction, i.e. which 

cardinal direction you are currently facing. Indicated is the azimuth angle and the main 

cardinal direction (0°/N = north, 45°/NE = northeast, 90°/E = east etc.). The band at the 

left edge shows the vertical viewing direction, i.e. the inclination of the 3D view 

towards the horizon. Indicated is the angle of inclination (0° = horizontal viewing di-

rection; 90°/-90° = vertical viewing direction from above/below).  
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The color of the compass band depends on the HUD Color, the size on the HUD Scaling. 

If Off, no compass band is displayed. 

• Show Crosshair: determines whether a crosshair is displayed in the 3D viewer. Avail-

able for selection are: 

o Deactivated: no crosshair is displayed. 

o Centered Cross: a cross at the screen center of the 3D viewer is displayed. 

o Horizontal Line: a horizontal line at the horizon is displayed. On this line, the 

height of the virtual viewer "above sea level" is displayed, i.e. the height from 

which you are looking at the data in the 3D viewer. 

o Both: a centered cross and a horizontal line are displayed. This is helpful "when 

flying" / navigating, for example: if the centered cross and the horizontal line are 

aligned, you are moving exactly horizontally. 

• Show Coordinate System: if On, the 3D viewer's coordinate system of is displayed. The 

axes are colored as follows: 

o X-axis: red 

o Y-axis: green 

o Z-axis: blue 

In the coordinate system, a white vector beam indicates the direction of lighting. If you 

change the position of the virtual light source (see above), the beam moves accordingly 

If Off, no coordinate system is displayed. 

Horizontal Plane 

Only available if the project contains a 3D window 

• Show Plane: if On, a single horizontal plane is displayed in the 3D viewer. This plane 

can for example be used to simulate a certain ground or water level. 

The plane does not go to infinity in the 3D viewer. Its extent always corresponds to the 

full extent of the data in the project (not e.g. the extent loaded into the 3D viewer). If 

you want the plane to extend further than the displayed data, mark the desired extent 

in the (2D) map viewer, e.g. with point graphics. The plane is then extended according-

ly. 

The following properties can be assigned to the horizontal plane: 

o Plane Height [m]: determines the absolute height at which the plane is placed. 

 opens a slider 

o 3D Material: specifies the 3D material used to texture the plane. 
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 opens the 3D Material dialog 

Note that a realistic representation of the water texture like in the open sky can only 

be achieved if a SkyBox is used as background for the 3D viewer (see above). 

Streaming 

Only available if the project contains a 3D window 

• View Dependent Streaming (only available if VR, Viewshed, and Shadows are dis-

abled): if On, the camera's viewing direction while streaming is used (not only the ca-

mera's distance and position). This enhances the visualization quality for areas that lie 

in the user's field of view.  

 

5.2 Graphics 

In GAFmap®, graphics are simple (vector) geometries, symbols, and forms of any type that are 

located within the map by coordinates. Unlike layers (see chapter 5.3), graphics do not refer 

to an external data set, but are directly stored in the project file (*.xmp) contained in the 

Pack&Go Container (*.cmp), or, for graphics that are self-created in GAFmap® Express, in the 

sidecar file (*.cmpaux). 

Each graphic is listed individually under the main group Graphics in the TOC and thus forms 

its own "graphics layer". Compared to vector layers,  

• graphics are attribute-free, i.e. they do not have any additional information besides 

geometry and location. 

• graphics do not consist of multiple features, but always of a single geometry. 

Different from layers, you can always add new graphics to a Pack&Go project via the Graphics 

toolbar (see chapter 4.7). Subsequently added graphics, i.e. graphics that are not included in 

the original Pack&Go container, are marked with a  green star in the TOC and can be edited 

or deleted as desired. All other graphics are unchangeable. This concerns both the geometry 

and the properties 

Types of Graphics 

The following types of graphic elements can occur. Graphic types, which you can add by 

yourself to the project in GAFmap® Express are marked with a green star: 

•  AOIs (see chapter 5.2.2) 

•  Reference Points (see chapter 5.2.3) 
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•  Points,   Lines,   Rectangles,   Polygons,  Circle/Ellipses and  

Labels (see chapter 5.2.4 et seqq.) 

•  3D Points and  3D Text Labels (see chapter 5.2.12 et seq.) 

•  3D Models (see chapter 5.2.14) 

•  Viewshed Points and   Sight Lines (see chapter 5.2.17 et seq.) 

•  Flight Lines and  View Points (see chapter 5.2.15 et seq.) 

•  Images and   Multimedia Links (see chapter 5.2.10 or 5.2.19) 

•  Auxilliary Grid (see chapter 5.2.11) 

Selecting Graphics  

You can select a graphic element or graphics group in the TOC with a simple left-click (on the 

icon or name); it is then highlighted in blue. Multi-selection is possible e.g. by holding down 

the Ctrl or Shift key. 

Alternatively, you can select graphic elements in the map viewer with the Graphics Edit Tool 

(see chapter 4.7.1) or Select Layer (see chapter 4.1.10). They are then also highlighted in blue 

in the TOC.  

Context Menu 

Right-clicking the main group Graphics, selected groups or graphics in the TOC takes you to a 

context menu that provides various functions or commands specifically for the selected 

elements. The content of the context menu depends on the level, number, and type of the 

selected elements, and on whether the project contains a map viewer and/or a 3D viewer and 

whether you have created a graphic/group yourself or it is part of the original project. 

The context menu of selected graphics can also be opened by right-clicking into the map 

viewer with the Graphics Edit Tool (see also chapter 4.7.1). 

Shortcuts, Key Commands, etc.: 

• Left-click on element in the TOC: select element 

• Ctrl when selecting: add selection to current selection. Already selected features are 

deselected when they are selected twice. 

• Shift when selecting: select consecutive elements (Ctrl + click on first and last element 

to be selected) 

• Right-click on individual / multiple selected elements in the TOC: open context menu 
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• X: toggle graphic(s), layer(s), and/or group(s) selected in TOC (with multiple map win-

dows only in the active one) 

• C: toggle graphic(s), layer(s), and/or group(s) selected in TOC globally (with multiple 

map windows in all windows) 

• Alt + left-click on a selected layer, graphic, or group in the TOC: zoom to element 

• Alt + checking a layer, graphic, or group in the TOC: zoom to the checked element 

 

5.2.1 All Graphics and Graphics Groups 

In GAFmap Express: TOC > Graphics 

A right-click on one or multiple selected graphic elements or graphics groups in the TOC opens 

their context menu. The content of the context menu can differ depending on the type and 

number of selected elements, as well as whether a graphic is included in the original project 

or is self-created. 

This chapter covers all functions and commands that potentially appear in the context menu 

of all graphic elements or graphics groups (incl. the main group Graphics). Functions that are 

only available for certain graphic types, follow in the chapters 5.2.2 to 5.2.19. 

Tips and notes: 

• The context menu of selected graphics can also be opened by right-clicking into the 

map viewer with the Graphics Edit Tool (see chapter 4.7.1). 

 

5.2.1.1 Zoom To Layer / Zoom to Selected Layers 

In GAFmap Express: TOC > Graphics > Context Menu All Graphics and Graphics Groups 

 Zoom to Layer (in case of a single selected element) or Zoom to Selected Layers (in case 

of multi-selection) zooms the map to the extent of the element(s) currently selected in the 

TOC. If the selection holds only a single point, the map extent is centered on this point. 

Zoom to Selected Layers is also available if the multi-selection contains TOC elements of any 

type (i.e. graphics, layers, and/or groups). 

Zoom To Layer in the 3D Window 

If you execute the command in the 3D TOC, a flight animation to the layer is performed in the 

3D viewer. You then fly from your current view point on the shortest way to a view point from 
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which you have a complete overview of the layer. You can define the desired Zoom To Flight 

Duration in the general settings under Other (see chapter 3.4.1.8). 

Shortcuts, Key Commands, etc.: 

• Alt + left-click on a selected layer, graphic, or group in the TOC: zoom to element 

• Alt + checking a layer, graphic, or group in the TOC: zoom to the checked element 

 

5.2.1.2 Remove / Remove Selected 

In GAFmap Express: TOC > Graphics > Context Menu All Graphics and Graphics Groups 

Only available for self-created graphics and groups 

 Remove (in case of a single selected element) or Remove Selected (in case of multi-selec-

tion) removes the currently selected element(s) from the TOC/project. The process is only 

completed if it is confirmed in the following dialog box. 

Shortcuts, Key Commands, etc.: 

• Del while focus on TOC (only for self-creatd graphics and groups): remove selected 

graphics or groups 

 

5.2.1.3 Move to Top / Move to Bottom 

In GAFmap Express: TOC > Graphics > Context Menu All Graphics and Graphics Groups 

Only available for self-created graphics and groups 

 Move to Top/Bottom moves one or multiple selected graphics and/or groups within 

the main group Graphics in the TOC to the top/bottom.  

If multiple elements are selected, they are moved in the order in which they were selected. 

So if you first select element A and then element B and move them to the top, B will be at the 

very top and A in second place. 

Please note when moving groups: If the group level is selected, the entire group is moved. If 

elements below the group are selected, these are moved individually, i.e. independently of 

the group. 
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5.2.1.4 Add Graphics Group / Move to New Group  

In GAFmap Express: TOC > Graphics > Context Menu All Graphics and Graphics Groups 

 If the main group Graphics or a single graphics group is selected, then Add Graphics Group 

lets you create a new graphics group below the source group (i.e. a new subfolder). After-

wards, you can add new graphics directly to this group or drag and drop self-created graphics 

(subsequently) into it.  

After calling the command a dialog opens. Enter the name for the new group and confirm with 

OK. You can change the name at any time.  

 Alternatively, you can group selected elements below the main group Graphics with Move 

to New Group (subsequently) to a new graphics group. The command is available as soon as 

multiple graphics or groups below the main group are selected in the TOC and if the selection 

contains only self-created graphics and/or groups. 

 

5.2.1.5 Ungroup 

In GAFmap Express: TOC > Graphics > Context Menu All Graphics and Graphics Groups 

Only available for self-created groups 

 If one or multiple groups self-created are selected, you can ungroup these with Ungroup. 

Subgroups are retained. 

 

5.2.1.6 Select All Layers 

In GAFmap Express: TOC > Graphics > Context Menu All Graphics and Graphics Groups 

Only available for groups 

Select All Layers selects all graphics below the graphics group in the TOC. Graphics in sub-

groups are taken into account, groups are excluded from the selection. 
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5.2.1.7 Mutual Exclusive 

In GAFmap Express: TOC > Graphics > Context Menu All Graphics and Graphics Groups 

Only available for groups but not for the main group Graphics  

The function corresponds to Mutual Exclusive in the Layer Group context menu. For more 

information, see chapter 5.3.1.3. 

 

5.2.1.8 Check Selected / Uncheck Selected / Toggle Selected 

In GAFmap Express: TOC > Graphics > Context Menu All Graphics and Graphics Groups 

Only available if multiple graphics, layers, and/or groups are selected 

   Check Selected / Uncheck Selected lets you activate/deactivate all graphics, layers, 

and groups currently selected in the TOC at once. Checked/activated elements are visible in 

the map viewer; unchecked/deactivated elements are hidden. 

 Toggle Selected lets you switch the activation state of the selected elements so that 

checked ones are unchecked and unchecked ones are checked.  

All three commands are also available if the multi-selection contains TOC elements of any type 

(i.e. graphics, layers, and/or groups). 

Shortcuts, Key Commands, etc.: 

• X: toggle graphic(s), layer(s), and/or group(s) selected in TOC (with multiple map win-

dows only in the active one) 

• C: toggle graphic(s), layer(s), and/or group(s) selected in TOC globally (with multiple 

map windows in all windows) 

 

5.2.1.9 Collapse / Expand 

In GAFmap Express: TOC > Graphics > Context Menu All Graphics and Graphics Groups 

Only available if at least two groups and/or layers are selected 

 Collapse / Expand lets you collapse/expand selected graphics groups, layer groups, 

and/or layers in the TOC at once (see also chapter 2.2.2.2). Unselected groups and layers 

under selected groups are not collapsed or expanded. 
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The commands are only available if they are actually applicable, i.e. they are missing if all 

selected groups and layers are already fully collapsed or expanded. 

Shortcuts, Key Commands, etc.: 

• Arrow key back (with mouse focus on TOC): collapse selected groups and/or layers in 

the TOC 

• Arrow key forward (with mouse focus on TOC): expand selected groups and/or layers 

in the TOC 

 

5.2.1.10 Properties 

In GAFmap Express: TOC > Graphics > Context Menu All Graphics and Graphics Groups 

Not available for groups 

 Via Properties you reach the Properties window where all essential properties of the 

graphic selected in the TOC are listed. If multiple graphics are selected, all properties available 

for all selected graphics are displayed (= combined properties). 

For graphics that are part of the original project, the properties are grayed out and can only 

be viewed. If you have created a graphic yourself, you can adjust the properties as desired. 

Note: If multiple graphics are selected in the TOC, changes affect all selected graphics. 

In this chapter, all common graphics properties are listed, i.e. those that are available for all 

or many different types of graphics. Type-specific properties can be found under the corres-

ponding graphics types (see chapter 5.2.2 et seqq.). 

General 

• Selectable: determines whether a graphic can be selected in the map viewer with the 

Graphics Edit Tool (see chapter 4.7.1) (On) or not (Off). If a graphic is not selectable, it 

is marked in the TOC with the corresponding  overlay icon. 

A graphic can always be selected via the TOC, i.e. independently of this property. 
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• Description: here, additional information regarding the graphic can be viewed, 

modified, or added (as a simple string or in HTML syntax). 

 opens the additional information window   

Geometry 

• X-/Y-Coordinate: determines the X-/Y-Coordinate of a point in the set map coordinate 

system.  

• Length: shows the total length of a line. The unit (m or km) depends on the predefined 

length unit (see chapter 3.4.1.4). 

The measuring method corresponds to that of the Measure tool (see chapter 4.1.13.1). 

• X/Y Min: determines the X/Y-coordinate of a rectangle's lower left corner according to 

the map coordinate system.  

X/Y Max: determines the X/Y-coordinate of a rectangle's upper right corner according 

to the map coordinate system.  

• Area: shows the total area of an areal graphic. The unit (m², ha or km²) depends on the 

predefined area unit (see chapter 3.4.1.4). 

The measuring method corresponds to that of the Measure tool (see chapter 4.1.13.1). 

• Outer Perimeter: shows the outer perimeter of a polygon (= length of the outline). The 

unit (m or km) depends on the predefined length unit (see chapter 3.4.1.4). 

The measuring method corresponds to that of the Measure tool (see chapter 4.1.13.1). 

• Height [m]: determines the height (Z-coordinate) of a point.  

• Relative to Ground: if On, the height is measured relative to the ground (i.e. above the 

underlying DEM). If Off, it is measured in absolute terms. 

If the height is measured above ground but the point is not located on a DEM, 0 is used 

as reference height. 

Scale Range 

• Scale Range: determines whether a graphic activated in the TOC is only displayed in 

the map viewer if the zoom level of the map is within a certain scale range (On) or 

always, regardless of the zoom level (Off). 

If On, you can specify the valid scale range, i.e. the desired lower/upper limit, under 

Min. Scale / Max. Scale. 

If a graphic is used as a texture in the 3D viewer, it is only displayed within the valid 

scale range. The reference is then the Texture Map Scale (see chapter 5.3.4.1). 
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In contrast to vector layers (see chapter 5.3.2.5), this property affects not only the 

actual geometry of graphics, but all its components, e.g. also the labeling, the selection 

symbol, etc. 

! Please note that a graphic is not deactivated outside the valid scale range, but is set to 

transparent. This means, for example, that outside the valid scale range a selected graphic 

can still be moved with the Graphics Edit Tool (see chapter 4.7.1), although it is not visible 

in the map viewer, or that a viewshed point (see chapter 5.2.17) is not displayed, but is still 

considered in the viewshed analysis. 

Symbology  

• Point Symbol: determines the symbol used to display a point. 

 opens the Point Symbols dialog (see chapter 6.1) 

• Line Pen: determines the symbol used to display a line / a polygon's outline. 

 opens the Line Pen dialog (see chapter 6.2) 

• Fill Brush: determines how a polygon is filled. 

 opens the Fill Symbols dialog (see chapter 6.3) 

• Show Label: determines whether a graphic is labeled in the map with the Text entered 

below (On) or not (Off).  

If On, the following additional property is available:  

o Labeling: determines the label style. 

 opens the Labeling dialog (see chapter 6.4) 

• Transparency [%]:  determines the degree of transparency a graphic is displayed with 

(0 = non-transparent/opaque, 100 = fully transparent/invisible). 

 opens a slider 

• Symbol Scale: changes the size of the graphic symbol as a whole. 

 opens a slider 

• Smoothing: determines whether a spline interpolation is used when rendering a line 

or outline of a polygon (On) or not (Off). 

• Disentangle (for point graphics and text labels): If On, the point / label is displayed 

"disentangled", i.e. slightly offset from its original position (e.g. to improve the reada-

bility if points are in close proximity to each other). The original position is indicated 

by a disentangle line. For more information, see chapter 5.2.4.1. 

If you set Disentangle to Off (only possible for self-created graphics), the point/label is 

reset to its original position (= starting point of the disentangle line). 
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If On, the following additional properties are shown:  

o Disentangle Intermediate Vertex: If the disentangle line of a selected point has at 

least one vertex in addition to start point and end point, this property is set to On. 

If you switch it to Off (only possible for self-created graphics), all intermediate ver-

tices are deleted. Please note that these vertices will not be restored if you switch 

this property back to On. In that case, exactly one vertex is inserted in the middle 

of the (straight) line. 

If you manually insert intermediate vertices into the disentangle line of self-crea-

ted graphics or delete all of them, this property is automatically set accordingly. 

o Disentangle Line: determines the symbol used to display the disentangle line. 

  opens the Line Pen dialog (see chapter 6.2) 

• Reference Scale Rendering: if Off, symbol and label of a graphic are always drawn in 

the specified symbol/text size, independent of the scale. If On, the size only applies at 

the Reference Scale specified below. If you change the map scale, line symbol and label 

are scaled up/down accordingly. 

3D Symbologie 

Only visible if the project contains a 3D window 

• Symbol Size Unit: determines which measurement unit is used for the Symbol Size. 

The following are available: 

o Meter [m]: the symbol size is given in meters. This unit is recommended if the 

absolute size of the object is decisive for its display.  

o Scene [‰]: the symbol size is given in relation to the size of the entire scene. This 

unit is recommended if a visually appealing result is to be achieved quickly for very 

large or very small scenes. 

o Pixel [px]: if selected, line objects are drawn as a simple thin line. The width of the 

line cannot be changed. Note that simple lines are not three-dimensional objects, 

and therefore, Symbol Size, and Shading cannot enabled. 

 opens a drop-down list  

• Symbol Size (not available if Symbol Size Unit = Pixel): determines the size of the sight 

line symbol. Depending on the selected Symbol Size Unit the symbol sSize is displayed 

in meters [m] or in a per mille share of the entire scene [‰]. 

 opens a slider 

• 3D Labeling: if On, the graphic is labeled in the 3D viewer. The label text is taken from 

the Properties field Text. 
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For the display of the label in the 3D viewer applies:  

o You can adjust the label style (font, font size, font color, background, halo, etc.) 

via Labeling under Symbology. 

o The style of the 3D label / labeling Boards under 3D Labeling. 

 opens the 3D Labeling dialog (see chapter 6.7) 

o The label / the labeling board is always anchored to the actual 3D point object 

(horizontally and vertically). Note that the label might not be visible if the res-

pective 3D point lies far above/under the DEM. In this case, e.g. adjust the height 

of the 3D point in the 2D properties (see above). 

o The 3D labels / labeling boards always point to the front, i.e. they rotate when 

moved. 

• Label Priority Expression (only relevant if in the Map properties Prevent Overlaps = On; 

see chapter 5.1.7): By default, the label that is actually covered, i.e. the one that is 

further away from the current viewing position, is hidden if 3D labels overlap. If certain 

labels are to be displayed preferentially, this can be forced by using Label Priority. If 

3D labels with different label priority overlap, the label with lower priority is always 

hidden, even if it is in front. 

By default, all 3D labels have priority 0. If a larger/smaller value is entered, the label is 

prioritized higher or lower accordingly. 

• Shading: determines whether the graphic is displayed shaded (On) or not (Off). If On, 

areas facing the light appear brighter and areas not facing the light appear darker. This 

creates a plastic impression.  

The virtual light source is specified for the entire scene in the map properties under 

Lighting (see chapter 5.1.7). 

• Shadows / View Obstruction: if On, the graphic casts shadows and it is considered as 

view obstruction when calculating an on-the-fly viewshed in the 3D viewer.  

If Off, the graphic does not participate in the shadow and 3D viewshed at all. This 

means that it is not only not considered as light or view obstruction, but it also neither 

reflects shadows cast by other objects nor the result of the 3D viewshed. 

For more information on shadows and 3D viewshed, see chapters 4.6.5 and 4.6.6. 

Text 

• Text (only available for Text Labels or if Show Label = On): determines the text used to 

label a graphic in the map. Enter the desired labeling text. If you use the text input 

window, you can also set line breaks.  
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The wildcard [LayerName] is replaced in the map with the graphic name from the TOC. 

It can be inserted into the text as desired. 

 opens a text input window 

 

5.2.2 AOI 

In GAFmap Express: TOC > Graphics 

 An AOI ("Area of Interest") is a rectangle graphic (see chapter 5.2.6), with which 

you can mark certain areas in the map. Via the context menu of an AOI you can start various 

functions and execute them directly for the enclosed map extent, e.g. reduce/update the ex-

tent in the 3D viewer to this extent or export the enclosed section. 

Context Menu 

Right-clicking on one or multiple selected AOI(s) in the TOC or in the map viewer with the 

Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context menu. In the 

following, only graphics type-specific functions/commands and properties are explained. For 

general functions/properties, i.e. those that are available for all graphics and/or graphics 

groups irrespective of the type, see chapter 5.2.1. 

 

5.2.2.1 Start 3D Viewer 

In GAFmap Express: TOC > Graphics > Context Menu AOI 

Only available if the project contains a 3D window 

 Start 3D Viewer lets you reduce/update the map extent currently visible/loaded in the 3D 

Viewer to the extent of the AOI (see also chapter 4.1.15). 

 

5.2.2.2 Export Map 

In GAFmap Express: TOC > Graphics > Context Menu AOI 

Only available if the project contains a (2D) map window 

 Export map opens the dialog of the corresponding function in the Map Viewer toolbar. 

For more information, see chapter 4.5.12. Drag Rectangle / Extent already holds the outer-

most coordinates of the AOI so that the export is delimited to the area of the AOI by default 

(i.e. as long as not changed manually). 
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5.2.2.3 Copy to Clipboard 

In GAFmap Express: TOC > Graphics > Context Menu AOI 

Only available if the project contains a (2D) map window 

 Copy to Clipboard creates a screenshot of the map extent within the AOI and copies it to 

the (Windows) clipboard. The Screenshot can then for example be inserted in another docu-

ment with Paste / Ctrl+V. 

Unlike a screenshot taken with Export Map (see chapter 5.2.2.2 or 4.5.12), the screenshot 

copied to the clipboard has no georeferencing. 

 

5.2.2.4 Properties 

In GAFmap Express: TOC > Graphics > Context Menu AOI 

 Via Properties you reach the Properties window where all essential properties of the 

selected AOI are listed. For more information on the individual properties, see chapter 

5.2.1.10. 

 

5.2.3 Reference Point 

In GAFmap Express: TOC > Graphics 

 A Reference Point is a point graphic (see chapter 5.2.4) that is 

labeled with its position coordinates. You can use it, for example, to mark a certain location in 

the map with a georeference or to retrieve the coordinates of a certain location. 

 

Figure 115: Reference Point, Example 
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The display format of the coordinates corresponds to that in the status bar (see chapter 

2.2.1.3). It can be adjusted via the general settings under Viewing (see chapter 3.4.1.3) and is 

then adopted for all references points that are alread set.  

In addition to the X-/Y-coordinates, a reference point can contain an absolute or relative 

Height (see chapter 5.2.1.10). Note, however, that this height is taken from a DEM when set-

ting the point (see chapter 4.7.4) or is entered manually and, unlike the location coordinates, 

it is not updated if the position of a reference point subsequently changes. 

Each reference point is marked with an  over the layer icon. 

Context Menu 

Right-clicking on one or multiple selected reference point(s) in the TOC or in the map viewer 

with the Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context 

menu. In the following, only graphics type-specific functions/commands and properties are 

explained. For general functions/properties, i.e. those that are available for all graphics and/ 

or graphics groups irrespective of the type, see chapter 5.2.1. 

 

5.2.3.1 Disentangle 

In GAFmap Express: TOC > Graphics > Context Menu Reference Point 

Only available for self-created point and text label graphics  

Disentangle (On) lets you disentangle/separate (closely spaced) point graphics or labels, e.g. 

to improve their legibility. For more information, see chapter 5.2.4.1. 

Disentangle Off resets disentangled points to their original position (i.e. to the start point of 

the disentangle line). 

 

5.2.3.2 Properties 

In GAFmap Express: TOC > Graphics > Context Menu Reference Point 

 Via Properties you reach the Properties window where all essential properties of the 

selected Reference Point(s) are listed. For more information on the individual properties, see 

chapter 5.2.1.10. 
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Note for the following property especially for Reference Points: 

Geometry  

• X/Y-Coordinate: defines the X/Y-coordinate of the Reference Point. These are always 

map coordinates, even if another Coordinate Display Format is selected in the general 

settings (see chapter 3.4.1.3). This setting only affects the label of the reference point. 

 

5.2.4 Point 

In GAFmap Express: TOC > Graphics 

 A Point is a simple point vector geometry that is directly located in the map by 

X/Y-coordinates.  

Amongst others, the following special forms of point graphics can occur in GAFmap®: 

• Text Labels are anchor points for a label text; the anchor point is not displayed as 

geometry (see chapter 5.2.9). 

• 3D Points additionally contain an (absolute or relative) height and are therefore 3D ca-

pable (see chapter 5.2.12).  

• Reference Points (as special form of the 3D point) are labeled with their position coor-

dinates and thus represent a georeference in the map (see chapter 5.2.3). 

• Viewshed Points (as special form of the 3D point) form the basis for the on-the-fly 

viewshed as "viewpoint of the observer" (see chapter 5.2.17 or 4.5.6 and 4.6.6). 

• Multimedia points (as special form of the 3D point) are anchor points for links to multi-

media objects (see chapter 5.2.19). 

Context Menu 

Right-clicking on one or multiple selected point(s) in the TOC or in the map viewer with the 

Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context menu. In the 

following, only graphics type-specific functions/commands and properties are explained. For 

general functions/properties, i.e. those that are available for all graphics and/or graphics 

groups irrespective of the type, see chapter 5.2.1. 

 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  199 

5.2.4.1 Disentangle 

In GAFmap Express: TOC > Graphics > Context Menu Point 

Only available for self-created point and text label graphics  

Disentangle (On) lets you disentangle (closely spaced) self-created point graphics or text la-

bels, e.g. to improve their legibility. For this purpose, the points or labels are moved (out-

wards) in a specific arrangement, a (disentangle) line refers to the original point/label position. 

 

Figure 116: Disentangle, example: disentangled points (top) or labels (bottom) 

Select the point graphics and/or text labels to be disentangled in the TOC or in the map viewer 

with the Graphics Edit Tool (see chapter 4.7.1), and then execute the Disentangle command 

with the desired arrangement type:  

 

Figure 117: Disentangle, submenu with different arrangement types 
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The points or labels are then arranged in the selected manner: 

 

Figure 118: Disentangle, examples - from left to right: not disentangled / disentangled with arrangement type 
bottom / circular / right 

If a single element is "disentangled", it is always automatically misaligned to the right. 

Alternatively, you can disentangle individual or multiple points or labels at once by setting the 

Disentangle property to On (see chapter 5.2.4.2). The elements are then also misaligned to 

the right each (and not "arranged" on the right across all points/labels). 

Edit Disentangle Line / Position 

 You can always manually adjust the arrangement of the points via the disentangle line. To do 

this, activate the Graphics Edit Tool and then double-click a line so that its vertices become 

visible. The start point of the line marks the original position of the point (before disentang-

ling), the end point marks the position after disentangling. You can move both points as re-

quired by drag & drop; however, the position of the start point should only be changed if the 

exact original position is not relevant, e.g. for converted labels of polygons or lines. 

 

Figure 119: Adjust disentangle line / position of a disentangled point 

If necessary, you can insert additional vertices into the lines or delete or edit existing ones. 

For more information on this and the Graphics Edit Tool in general, see chapter 4.7.1. 

Intermediate vertices can be removed alternatively and for multiple disentangle lines at once 

with Disentangle Intermediate Vertex in the properties of disentangled points; the line sym-

bol can be adjusted via the Disentangle Line property (see chapter 5.2.4.2). 
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Disentangle Off 

Only available for self-created point and text label grphics and only if at least one of the selec-

ted elements is disentangled 

You can always move a point/label back to its original position by executing the Disentangle 

Off command in the point context menu or by setting Disentangle to Off in its properties (see 

chapter 5.2.4.2). 

Note that the point is moved back to the start point of the disentangle line. If you have moved 

that point manually with the Graphics Edit Tool (see above), the position of the point will no 

longer correspond to the position before disentangling! 

If you switch Disentangle off, GAFmap® remembers the last disentangle line for each point/ 

label and restores it as soon as you switch the Disentangle property back to On. However, this 

only applies during the session, i.e. until the project is closed, and only if the position of the 

point/label has not been changed in the meantime. 

Tips and notes: 

• If you are disentangling labels (see chapter 5.2.9.1), the (text) alingment MiddleCenter 

and Use Box = On is recommended for these (see chapter 5.2.9.2 or 6.4). 

• Labels can only be disentangled if they are of the graphic type text label, and not labels 

that have been activated for other graphic elements or vector layers via their proper-

ties. 

 

5.2.4.2 Properties 

In GAFmap Express: TOC > Graphics > Context Menu Point 

 Via Properties you reach the Properties window where all essential properties of the se-

lected point(s) are listed. For more information on the individual properties, see chapter 

5.2.1.10. 

Please note: if multiple elements in the TOC are selected, all changes within the Properties 

window apply to all selected elements. 
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5.2.5 Line 

In GAFmap Express: TOC > Graphics 

 A Line is a simple line vector geometry. Location and course of the line are de-

fined by individual vertices that are directly connected in a specific order, i.e. by straight line 

segments. 

You can graphically display the line vertices e.g. with the Graphics Edit Tool (see chapter 4.7.1) 

or list them via the context menu command Show Coordinates including coordinates and IDs 

(see chapter 5.2.5.1).  

Lines have a clearly defined direction, which results from the digitizing direction and is fixed 

in the vertex IDs (from the starting point with ID=0 to the end point with ID=max). It can be 

relevant with regard to certain line symbols (e.g. for arrow anchors or patterns; see chapter 

6.2 et seqq.) and can be flipped e.g. via the context menu command Flip direction (see chapter 

5.2.5.2). 

Lines can also be displayed "smoothed", i.e. rounded off at the vertices (see chapter 5.2.5.4 

or 5.2.1.10). 

Amongst others, the following special forms of line graphics can occur in GAFmap®: 

• Height Profile lines serve as base for profile sections through digital terrain models 

(see chapter 4.1.14). 

• Sight Lines are lines with only one start and one end point. They allow a quick analysis 

of whether a certain target point is visible to an observer (see chapter 5.2.18). 

• Flight Lines are smoothed lines that serve as basis for 3D flight animations (see chapter 

5.2.16). In the (2D) map viewer only a two-dimensional display of flight line is possible. 

Context Menu 

Right-clicking on one or multiple selected Line(s) in the TOC or in the map viewer with the 

Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context menu. In the 

following, only graphics type-specific functions/commands and properties are explained. For 

general functions/properties, i.e. those that are available for all graphics and/or graphics 

groups irrespective of the type, see chapter 5.2.1. 
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5.2.5.1 Show Coordinates 

In GAFmap Express: TOC > Graphics > Context Menu Line 

 Via Show Coordinates you can open a list of all the line's vertices and their coordinates, 

and edit them for newly created lines. For more information on the Coordinates window, see 

chapter 4.2.2. 

 

5.2.5.2 Flip direction 

In GAFmap Express: TOC > Graphics > Context Menu Line 

Only available for self-created lines 

 Flip direction lets you reverse the direction/orientation of a line graphic. This means, start 

point and end point of the line are inverted, and the IDs of the vertices in between are turned 

accordingly. 

The orientation of a line is relevant, for example, if you use a directional line symbol (such as 

an arrow), or if you use the line to create a height profile (because it determines the viewing 

direction). 

 

5.2.5.3 Create Height Profile 

In GAFmap Express: TOC > Graphics > Context Menu Line 

 Create Height Profile lets you visualise a height profile based on a digital elevation model 

(= single channel raster with property Use as DEM = On; see chapter 5.3.4) using an existing 

line graphic. For more information see chapter 4.1.14. 

 

5.2.5.4 Properties 

In GAFmap Express: TOC > Graphics > Context Menu Line 

 Via Properties you reach the Properties window where all essential properties of the 

selected line are listed. For more information on the individual properties, see chapter 

5.2.1.10.  

Please note: if multiple elements in the TOC are selected, all changes within the Properties 

window apply to all selected elements. 
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5.2.6 Rectangle 

In GAFmap Express: TOC > Graphics 

 A Rectangle is a simple, plane vector geometry with four right angles and 

sides that are aligned exactly horizontally and vertically. Unlike a polygon (see chapter 5.2.7), 

the position and shape of a rectangle is not defined by individual outline vertices but by edge 

coordinates (X/Y Min/Max). 

Rectangles always have only one outline/ring, which is then filled two-dimensionally. Unlike 

Polygons, they can therefore never consist of multiple geometry parts or have "holes". 

The shape of a rectangle is editable only to a limited extent. With the Graphics Edit Tool (see 

chapter 4.7.1) or by adjusting the respective properties (see chapter 5.2.6.2 or 5.2.1.10) you 

can only move a rectangle, increase/decrease its size, or change its aspect ratio. If you want 

to edit a tectangle freely, it must first be converted into a polygon (see chapter 5.2.6.1). 

Context Menu 

Right-clicking on one or multiple selected Rectangle(s) in the TOC or in the map viewer with 

the Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context menu. In 

the following, only graphics type-specific functions/commands and properties are explained. 

For general functions/properties, i.e. those that are available for all graphics and/or graphics 

groups irrespective of the type, see chapter 5.2.1. 

 

5.2.6.1 Convert to Polygon 

In GAFmap Express: TOC > Graphics > Context Menu Rectangle 

Only available for self-created rectangles 

Convert to Polygon lets you convert a rectangle into the graphic type polygon. In doing so, the 

shape of the geometry remains unchanged, but geometrical properties and edit behaviour 

alter. 

While a rectangle is defined by its maximal extent in X/Y-direction (i.e. the coordinates of the 

bottom left and top right corner), a polygon is determined by all its vertices. Therefore, a rect-

angle can only be enlarged/shrunken, contorted, or moved as such, while a polygon is editable 

at will, as vertices can randomly be inserted, deleted, or moved. But consequently, right angles 

are no longer guaranteed when working with polygons: 
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Figure 120: Example: Editing a rectangle before (left) and after (right) it is converted into a polygon 

 

5.2.6.2 Properties 

In GAFmap Express: TOC > Graphics > Context Menu Rectangle 

 Via Properties you reach the Properties window where all essential properties of the 

selected rectangle are listed. For more information on the individual properties, see chapter 

5.2.1.10. 

Please note: if multiple elements in the TOC are selected, all changes within the Properties 

window apply to all selected elements. 

 

5.2.7 Polygon 

In GAFmap Express: TOC > Graphics 

 A Polygon is a simple, plane vector geometry of any shape. Location and shape 

of the polygon are defined by a linear, closed outline/ring, which is then filled two-dimensio-

nal; the ring is defined by individual vertices.  

You can graphically display the polygon vertices e.g. with the Graphics Edit Tool (see chapter 

4.7.1) or list them via the context menu command Show Coordinates including coordinates 

and IDs (see chapter 5.2.7.1).  

Context Menu 

Right-clicking on one or multiple selected Polygon(s) in the TOC or in the map viewer with the 

Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context menu. In the 

following, only graphics type-specific functions/commands and properties are explained. For 

general functions/properties, i.e. those that are available for all graphics and/or graphics 

groups irrespective of the type, see chapter 5.2.1. 
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5.2.7.1 Show Coordinates 

In GAFmap Express: TOC > Graphics > Context Menu Polygon 

 Via Show Coordinates you can open a list of all the polygon's vertices and their coor-

dinates, and edit them for newly created polygons. For more information on the Coordinates 

window, see chapter 4.2.2. 

 

5.2.7.2 Properties 

In GAFmap Express: TOC > Graphics > Context Menu Polygon 

 Via Properties you reach the Properties window where all essential properties of the 

selected polygon are listed. For more information on the individual properties, see chapter 

5.2.1.10. 

Please note: if multiple elements in the TOC are selected, all changes within the Properties 

window apply to all selected elements. 

 

5.2.8 Ellipse 

In GAFmap Express: TOC > Graphics 

 An Ellipse is a simple, plane vector geometry. Unlike a polygon (see chapter 

5.2.7), the location and shape of an ellipse is not defined by individual outline vertices, but by 

a center point, which is located in the map with X/Y-coordinates, and a radius in X and Y 

direction (i.e. the length of the semiaxes).  

Ellipses always have only one outline/ring, which is then filled two-dimensionally. Unlike poly-

gons, they can therefore never consist of multiple geometry parts or have "holes ". 

The shape of an ellipse is editable only to a limited extent. With the Graphics Edit Tool (see 

chapter 4.7.1) or by adjusting the respective properties (see chapter 5.2.8.2 or 5.2.1.10) you 

can only move a ellipse, increase/decrease its size, or change the ratio of the semi-axes. If you 

want to edit an ellipse freely, it must first be converted into a polygon (see chapter 5.2.8.1). 

Context Menu 

Right-clicking on one or multiple selected ellipse(s) in the TOC or in the map viewer with the 

Graphics Edit Tool (see chapter 4.7.1) opens the the corresponding graphics context menu. In 

the following, only graphics type-specific functions/commands and properties are explained. 
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For general functions/properties, i.e. those that are available for all graphics and/or graphics 

groups irrespective of the type, see chapter 5.2.1. 

 

5.2.8.1 Convert to Polygon 

In GAFmap Express: TOC > Graphics > Context Menu Ellipse 

Only available for self-created circles/ellipses 

Convert to Polygon lets you convert an ellipse into the graphic type polygon. In doing so, the 

arc of the ellipse is replaced by a regular polygon outline. Depending on the graphic's size, the 

minimal number of vertices needed to make the output polygon look almost exactly like the 

original ellipse is determined automatically. 

 

Figure 121: Circle before (left) and after (right) it is converted into a polygon; middle: geometry shown without 
vertices (almost identical for both) 

While a ellipse is defined by its center coordinates and the length the radius/semiaxis in X- 

and Y-direction, a polygon is determined by its outline vertices. Therefore, a circle/ellipse can 

only be enlarged/shrunken, contorted, or moved as such, while a polygon is editable at will, 

as vertices can randomly be inserted, deleted, or moved. Consequently, a regular ellipse shape 

is no longer guaranteed when working with polygons. 

 

5.2.8.2 Properties 

In GAFmap Express: TOC > Graphics > Context Menu Ellipse 

 Via Properties you reach the Properties window where all essential properties of the 

selected ellipse are listed. For more information on the individual properties, see chapter 

5.2.1.10. 
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Also note the following properties for ellipse: 

Geometry  

• Center X/Y: determines the X/Y-coordinate of the ellipse's center according to the map 

coordinate system. 

• Radius X/Y: determines the length of the semiaxis in X/Y-direction. The unit (m or °) 

depends on the map coordinate system and the size of the graphic. 

Symbology  

• Draw Center Cross: determines whether the center cross is drawn (On) or not (Off). 

Please note: if multiple elements in the TOC are selected, all changes within the Properties 

window apply to all selected elements. 

 

5.2.9 Text Label 

In GAFmap Express: TOC > Graphics 

 A Text Label is a text element that can be placed freely (i.e. without an asso-

ciated object/feature) in the map. The location is based on the X/Y-coordinates of an anchor 

point. The label text and how it is positioned/aligned relative to the anchor point is deter-

mined in the graphics properties.  

Technically, a text label is a simple point graphic (see chapter 5.2.4), where the (anchor) point 

is not drawn. 

Context Menu 

Right-clicking on one or multiple selected text label(s) in the TOC or in the map viewer with 

the Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context menu. In 

the following, only graphics type-specific functions/commands and properties are explained. 

For general functions/properties, i.e. those that are available for all graphics and/or graphics 

groups irrespective of the type, see chapter 5.2.1. 
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5.2.9.1 Disentangle 

In GAFmap Express: TOC > Graphics > Context Menu Text Label 

Only available for self-created point and text label graphics  

Disentangle (On) lets you disentangle/separate (closely spaced) point graphics or labels, e.g. 

to improve their legibility. For more information, see chapter 5.2.4.1. 

Disentangle Off resets disentangled points to their original position (i.e. to the start point of 

the disentangle line). 

 

5.2.9.2 Properties 

In GAFmap Express: TOC > Graphics > Context Menu Text Label 

 Via Properties you reach the Properties window where all essential properties of the 

selected text label(s) are listed. For more information on the individual properties, see chapter 

5.2.1.10. 

Note for the following properties especially for text labels: 

 Geometry  

• X/Y-Coordinate: determines the X/Y-coordinate of the anchor point according to the 

map coordinate system. 

Under Labeling, you can specify the placement of the text label relative to the anchor 

point. 

Text 

• Text: determines the labelling text. Enter the desired text. If you use the text input 

window, you can also set line breaks.  

The wildcard [LayerName] is replaced in the map with the graphic name from the TOC. 

It can be inserted into the text as desired. 

  opens a text input window 

Alternatively, you can directly open the text input window by double-clicking the 

textbox in the map viewer using the Graphics Edit Tool (see chapter 4.7.1). 

Please note: if multiple elements in the TOC are selected, all changes within the Properties 

window apply to all selected elements. 
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5.2.10 Image 

In GAFmap Express: TOC > Graphics 

 An Image is a rectangle position frame within which an image is displayed. 

For this, a specific image file is linked, i.e. the image itself is not stored in the GAFmap® project 

itself. The path to the image is stored in the Image properties. If the linked Image file is sub-

sequently deleted, renamed, or moved, the Image can no longer be displayed. For GAFmap® 

Express projects, the image is usually stored in the Pack&Go container (i.e. the link refers to 

the container). 

Unlike raster layers (see chapter 5.3.3), no raster layer icon is displayed for an image in the 

TOC, but the image itself. 

Context Menu 

Right-clicking on one or multiple selected image(s) in the TOC or in the map viewer with the 

Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context menu. In the 

following, only graphics type-specific functions/commands and properties are explained. For 

general functions/properties, i.e. those that are available for all graphics and/or graphics 

groups irrespective of the type, see chapter 5.2.1. 

 

5.2.10.1 Properties 

In GAFmap Express: TOC > Graphics > Context Menu Image 

 Via Properties you reach the Properties window where all essential properties of the 

selected image are listed. For more information on the individual properties, see chapter 

5.2.1.10. 

Also note the following property for images: 

Image  

• File Path: shows the complete file path of the linked image. For GAFmap® Express 

projects, the the link usually refers to the container. 

Please note: if multiple elements in the TOC are selected, all changes within the Properties 

window apply to all selected elements. 
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5.2.11 Auxiliary Grid 

In GAFmap Express: TOC > Graphics 

 An Auxiliary Grid is a simple coordinate grid, which, unlike the on-the-fly 

coordinate grid (see chapter 4.5.10), is not only displayed on the screen but is loaded into the 

TOC as an "object" and can therefore also be used for snapping. Thus, it serves primarily as a 

tool for coordinate-accurate editing and positioning of graphics and vector features. 

Reference for the grid is always the map spatial reference. You can adjust the distance 

between the grid lines in the Auxiliary Grid properties; starting point is always the coordinate 

origin (0|0). 

Auxiliary grids can only be selected via the TOC, not in the map viewer. 

Context Menu 

Right-clicking on one or multiple selected auxiliary grid(s) in the TOC opens the corresponding 

graphics context menu. In the following, only graphics type-specific functions/commands and 

properties are explained. For general functions/properties, i.e. those that are available for all 

graphics and/or graphics groups irrespective of the type, see chapter 5.2.1. 

 

5.2.11.1 Properties 

In GAFmap Express: TOC > Graphics > Context Menu Auxiliary Grid 

 Via Properties you reach the Properties window where all essential properties of the 

selected auxiliary grid are listed. For more information on the individual properties, see chap-

ter 5.2.1.10. 

Also note the following property for auxiliary grids: 

Grid 

• Spacing in X-/Y-Direction: determines the spacing between the grid lines in X-/Y-direc-

tion. The unit depends on the map spatial reference. Please note that the grid lines 

might not be visible if the map scale is too small in relation to the defined spacing.  

• Offset in X-/Y-Direction: Without offset, i.e. with offset = 0, the grid origin is coincident 

to the origin of the map coordinate system (0|0). If the grid is not to pass through 0|0, 

you can specify the desired absolute offset in the X/Y direction here. The unit depends 

on the map spatial reference. 
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Please note: if multiple elements in the TOC are selected, all changes within the Properties 

window apply to all selected elements. 

 

5.2.12 3D Point 

In GAFmap Express: TOC > Graphics 

 A 3D Point is a 3D capable point graphic that contains an absolute or relative 

height information and therefore can be positioned differently in space, unlike a simple (2D) 

point (see chapter 5.2.4).  

Context Menu 

Right-clicking on one or multiple selected 3D Point(s) in the TOC or in the map viewer with the 

Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context menu. In the 

following, only graphics type-specific functions/commands and properties are explained. For 

point-specific functions/properties, see chapter 5.2.4, for general ones, i.e. those that are 

available for all graphics and/or graphics groups irrespective of the type, see chapter 5.2.1. 

 

5.2.12.1 Properties 

In GAFmap Express: TOC > Graphics > Context Menu 3D Point 

 Via Properties you reach the Properties window where all essential properties of the se-

lected 3D point(s) are listed. For more information on the individual properties, see chapter 

5.2.1.10. 

Also note the following properties for 3D points: 

3D Symbology 

• 3D Point Symbol: determines the symbol used to visualize the 3D point in the 3D 

viewer. 

 opens the 3D Point Symbol dialog (see chapter 6.6) 

Viewshed 

• Use for Viewshed: determines whether the 3D point is used as viewshed point for the 

on-the-fly viewshed (On) or not (Off). 

If On, you can you can make the following additional settings for the viewshed: 
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o Minimum/Maximum Sector Angle [°]: delimits the sector to be analyzed, e.g. to 

simulate a specific viewing angle. The angle from/to is specified in geographic de-

grees (i.e. north = 0°, east = 90°, etc.). If the same value is entered at Minimum 

and Maximum (e.g. 0/0), the whole circle is analyzed. 

If you enter values outside the value range of 0-360°, the angle is automatically 

converted. 

o Maximum Viewing Distance [m]: delimits the radius of the area to be analyzed. If 

the field is left empty, the analysis is performed without distance limitation. 

o Vertical Field of View [°] (only available if the project contains a 3D window and if 

the sector angle is limited): determines the vertical viewing angle in degrees. 

Possible are values from 1° to 120°. The larger the angle, the larger the field of 

view. 

  opens a slider 

As long as Use for Viewshed is enabled, the viewshed symbol ( ) is displayed next to 

the point symbol in the TOC. If you set the property to Off, the symbol is hidden. 

For more information on the viewshed, see chapter 4.5.6 (for 2D) or 4.6.6 (for 3D). 

Please note: if multiple elements in the TOC are selected, all changes within the Properties 

window apply to all selected elements. 

 

5.2.13 3D Text Label 

In GAFmap Express: TOC > Graphics 

 A 3D Text Label is a special form of the 3D point (see chapter 5.2.12) for 

which the actual point is not displayed but only serves as (non visible) anchor point for a simple 

text label graphic in 2D or a labeling panel in 3D. 

Context Menu 

Right-clicking on one or multiple selected 3D text label(s) in the TOC or in the map viewer with 

the Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context menu. It 

does not contain any graphics type-specific functions or properties. For point-specific func-

tions/properties, see chapter 5.2.4, for general ones, i.e. those that are available for all gra-

phics and/or graphics groups irrespective of the type, see chapter 5.2.1. 
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5.2.14 3D Model 

In GAFmap Express: TOC > Graphics 

 3D models describe objects/bodies as vectors in an internal, three-dimen-

sional (model) coordinate system. Usually textures are assigned to the body surfaces, so that, 

depending on type and quality, realistic images of objects, buildings, the terrain, etc. are 

created. The orientation of the model surfaces usually is clearly defined, which makes it possi-

ble to distinguish between inner and outer surfaces and to calculate shadows and viewshed. 

 

Figure 122: 3D model, example  

Tiled 3D models are a set of any number of individual "3D tiles", which are assembled into a 

complete model for visualization. The 3D tiles are stored in a spatial, hierarchical data struc-

ture, which enables precise rendering and fast streaming. Tiling means that the 3D models are 

practically unlimited in terms of (data) size. They are therefore particularly suitable for the 

storage and reproduction of spatial data with large extents / data volume.  

 

Figure 123: Tiled 3D model with Rendering Information (see chapter 5.2.14.1) 
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In the (2D) map viewer, 3D models can only be visualized to a limited extent: Depending on 

the properties set, either anchor point and data extent are displayed or a wireframe model 

projected vertically downwards (chapter 5.2.14.1). A three-dimensional visualization is only 

possible in the 3D window. 

Physically Based Rendering (PBR) 

GAFmap® (Express) supports physically based rendering (PBR). PBR describes an approach in 

computer graphics that aims to represent surfaces in a way that accurately reflects the flow 

of light in the real world. The following figure compares a model with and without PBR: 

 

Figure 124: 3D model without PBR (left) and with PBR (right) [Image source: https://sketchfab.com/ 
models/b81008d513954189a063ff901f7abfe4] 

Note that for 3D models with PBR, a realistic outdoor view can only be achieved if a SkyBox is 

used for the background of the 3D viewer (see chapter 5.1.7). 

Context Menu 

Right-clicking on one or multiple selected 3D model(s) in the TOC or in the map viewer with 

the Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context menu. In 

the following, only graphics type-specific functions/commands and properties are explained. 

For general functions/properties, i.e. those that are available for all graphics and/or graphics 

groups irrespective of the type, see chapter 5.2.1. 
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5.2.14.1 Properties 

In GAFmap Express: TOC > Graphics > Context Menu 3D Model 

 Via Properties you reach the Properties window where all essential properties of the 

selected 3D model are listed. For more information on the individual properties, see chapter 

5.2.1.10. 

Also note the following properties for 3D models: 

Model 

• Filepath: shows the complete file path and name of the 3D model. 

• Height Conversion (only displayed if Relative to Ground = Off): shows whether the 

absolute height stored in the dataset is directly adopted (None), or whether it is inter-

preted as geoidal/ellipsoidal height and converted To Ellipsoidal / To Geoidal.  

• Model Axis: shows the coordinate system that defines the orientation of the 3D mo-

del's axes.  

• Heading/Tilt/Roll: shows the rotation angle clockwise around the Z/X/Y axis of the 

model. 

• Scale X/Y/Z: shows a scaling factor (i.e. a multiplier) in X/Y/Z direction. 

Symbology 

• Draw Wireframe: if On, a wireframe of the model is drawn in the (2D) map viewer, if 

Off, the 3D model is displayed with a simple point symbol and a position frame in the 

(2D) map viewer. 

3D Symbology 

• Culling: shows the culling mode the 3D model is displayed with.  

Culling is a method of 3D computer graphics that excludes surfaces from visualization 

- e.g. surfaces facing away from the observer - depending on the relationship between 

observer and an object's surface (consisting of triangles). As a result, an additional in-

crease in performance can be achieved.  

The following modes can occur: 

o Default: the culling mode recommended from the model is used. 

o Double Sided: no culling is applied. All triangles defined as "double sided" show a 

different shading depending on the viewing side (facing away or towards the 

observer). 
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o One Sided: excludes all triangles that have a clockwise rotation direction after be-

ing projected into the screen plane. 

o Double Sided Inversed: no culling is applied. All triangles defined as "double sided" 

show an inverted shading. 

o One Sided Inversed: excludes all triangles that have an anti-clockwise rotation 

direction after being projected into the screen plane. 

• Double Sided Inconsistent: no culling is applied. All triangles defined as "double sided" 

display the same shading on each viewing side (facing away or towards the observer). 

• LOD Quality (only for tiled 3D models): shows the quality (low, medium, high) with 

which tiles that are further away from the viewer are displayed, i.e. which level of detail 

is used for tiles located e.g. at the edge of the field of view. The higher the quality level, 

the better the LOD used, but the lower the performance, especially if models with a 

very large extent are loaded. 

• Show Rendering Info (only for tiled 3D models): shows whether the blocks underlying 

the Rendering (see chapter 5.3.4.1) are displayed as transparent cubes in the 3D viewer 

(On) or not (Off). If On, the following additonal information is displayed on the bottom 

right of the 3D Viewer: 

o Loaded graphics data: amount of data [MB] 

o Layer [name as shown in the TOC]: number of triangles; number of displayed 

blocks and the achieved level of detail 

Please note: if multiple elements in the TOC are selected, all changes within the Properties 

window apply to all selected elements. 

 

5.2.15 View Point 

In GAFmap Express: TOC > Graphics 

 View Points are a special form of 3D points (see chapter 5.2.12). In addition 

to absolute or relative height information, they also contain information on the viewing 

direction. This makes it possible to save the position and angle of a viewer in space and thus 

a certain view of the data in the 3D viewer, e.g. to view/use it again during presentations ("3D 

bookmark"). 

View Points are primarily auxiliary geometries for saving views, but can also be visualized as 

three-dimensional objects in the 3D viewer, e.g. to analyze the position and viewing angle of 

the observer "from the perspective of a third party". 
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Figure 125: View Point, example: saved view (top) and visualized View Point (bottom) 

A saved view can be restored at any time by performing a flight animation from any place in 

the 3D viewer to the respective view point (see chapter 5.2.15.1). Therefore, view points can 

also be used as a basis for 3D flights. 

Context Menu 

Right-clicking on one or multiple selected view point(s) in the TOC or in the map viewer with 

the Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context menu. In 

the following, only graphics type-specific functions/commands and properties are explained. 

For point-specific functions/properties, see chapter 5.2.4, for general ones, i.e. those that are 

available for all graphics and/or graphics groups irrespective of the type, see chapter 5.2.1. 
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5.2.15.1 View from Point 

In GAFmap Express: TOC > Graphics > Context Menu View Point 

Only available if the project contains a 3D window 

 View from Point starts a flight animation to the selected view point in the 3D viewer. 

Alternatively, you can start the flight animation with the  Play button in the toolbar (see 

chapter 4.6.13). 

Shortcuts, Key Commands, etc.: 

• Alt+click on a view point's layer name in the 3D TOC: start animation 

• Key 1-9, while the 3D window is aktiv: fly to 1st-9th view point in the TOC 

• Esc while animation: cancel animation 

• I while animation: cancel streaming 

 

5.2.15.2 Properties 

In GAFmap Express: TOC > Graphics > Context Menu View Point 

 Via Properties you reach the Properties window where all essential properties of the 

selected view point are listed. For more information on the individual properties, see chapter 

5.2.1.10. 

Also note the following properties for view points: 

View Angles 

• Pitch [°]: determines the vertical viewing direction of the view point. This value always 

refers to the horizontal plane (value = 0). For values greater than 0, the viewing 

direction turns upwards from the horizontal. For negative values, the viewing direction 

turns downwards from the horizontal. You can enter values between -90 and 90.  

 opens a slider 

• Yaw [°]: determines the horizontal viewing direction (azimuth angle) of the view point. 

This value always refers to North (value = 0). For positive values greater than 0 the 

viewing direction turns from North towards East. For negative values smaller than 0, 

the viewing direction turns from North towards West. Negative values or values > 359° 

are automatically converted to the value range of 0-359°. 

 opens a slider 
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• Use IFOV: determines whether the FOV is specified below (Off) or the IFOV (On). 

• FOV (only available if Use IFOV = Off): sets the vertical field of view in degrees. Increa-

sing/decreasing the field of view causes the 3D viewer to be zoomed in or out while 

the "location" of the observer remains unchanged. 

Possible are values from 0 to 120. 45° is the default; smaller values bring the 3D view 

closer like with binoculars, larger values draw it further away like with a wide angle 

lens / fisheye (example see chapter 7.1). 

 opens a slider 

• IFOV (only available if Use IFOV = On): sets the IFOV ("Instantaneous Field of View") or 

rather the "FOV per pixel". The entered value is multiplied by the vertical resolution of 

the 3D viewer, i.e. the number of monitor pixels the 3D viewer is high. Or put the other 

way around: IFOV = FOV / height of 3D viewer in monitor pixels.  

Default is 0.05; smaller values bring the 3D view closer, larger values draw it further 

away. 

While the FOV defines via the viewing angle which section of the 3D view is visible from 

the observer's location, the IFOV defines the resolution of the 3D view, i.e. the "zoom 

step". If the (window) size of the 3D viewer changes, the FOV adjusts the resolution/ 

zoom step while the visible extent remains unchanged and the IFOV adjusts the visible 

extent while the resolution remains unchanged. 

 opens a slider 

 

5.2.16 Flight Lines / Recorded Flight 

In GAFmap Express: TOC > Graphics 

 Flight Lines are 3D-capable, smoothed line graphics. They determine the 

course of a flight and contain information about altitude, viewing direction and angle, and 

speed. They are the basis for 3D flight animations and can be started for presentation pur-

poses.  

Each flight line is defined by individual Flight Points. They correspond to the line vertices. 

Besides the location, the following information is stored for each Flight Point: 

• the time at which it is reached (measured by the total time of the flight) 

• the altitude (absolute or relative / above ground) 

• the horizontal and vertical viewing angle (absolute or relativ to the flight line) 

Between the defined flight points, the flight line is interpolated. The course is smoothed with 

a spline interpolation to ensure a harmonious flight movement when changing direction.  
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Flight lines are primarily auxiliary geometries for flight animations, but can also be visualized 

as three-dimensional objects in the 3D viewer, e.g. to analyze the course of a flight "from the 

perspective of a third party". 

 

Figure 126: Visualization of a Flight Line 

Context Menu 

Right-clicking on one or multiple selected flight line(s) in the TOC or in the map viewer with 

the Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context menu. In 

the following, only graphics type-specific functions/commands and properties are explained. 

For line-specific functions/properties, see chapter 5.2.5, for general ones, i.e. those that are 

available for all graphics and/or graphics groups irrespective of the type, see chapter 5.2.1. 

 

5.2.16.1 Start Flight 

In GAFmap Express: TOC > Graphics > Context Menu Flight Lines / Recorded Flight 

Only available if the project contains a 3D window 

 Start Flight in 3D Viewer starts the flight animation within the 3D viewer. Alternatively, 

you can start the flight animation with the  Play button in the 3D Viewer toolbar (see chap-

ter 4.6.13). 

Shortcuts, Key Commands, etc.: 

• Alt+click on a flight line's layer name in the 3D TOC: start animation 

• Ctrl+Key 1-9, while the 3D window is aktiv: start 1st-9th flight in the TOC 

• Esc: cancel animation 

• I while animation: cancel streaming 
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5.2.16.2 Set View to Start Point 

In GAFmap Express: TOC > Graphics > Context Menu Flight Lines / Recorded Flight 

Only available if the project contains a 3D window 

 Set View to Start Point lets you jump to the start point of the flight line without starting 

the flight directly. You then take exactly the view of the first flight point in the 3D viewer, 

regardless of whether the command is executed in the 3D window or in the (2D) map window. 

 

5.2.16.3 Properties 

In GAFmap Express: TOC > Graphics > Context Menu Flight Lines / Recorded Flight 

 Via Properties you reach the Properties window where all essential properties of the 

selected flight lines are listed. For more information on the individual properties, see chapter 

5.2.1.10. 

Also note the following properties for flight lines: 

3D Symbology 

• Draw Wireframe (not visible if Symbol Size Unit = Pixel): if On, the flight line line/tube 

is drawn as wireframe, i.e. only the outlines of the triangles the tube is built with are 

drawn.  

Flight Line 

• Time Scale: shows the factor with which the duration of the animation (= "flight time") 

is scaled/multiplied. For 1, the animation is replayed in real time, for values > 1 it runs 

faster, for values < 1 slower. The time steps between the individual flight points (see 

chapter 5.2.16) remain proportionally the same.  

If the flight time is scaled, it deviates from the timestamps set for the the flight points. 

Therefore, the HUD time display (in the upper right corner of the 3D viewer) always 

shows the "real" time of a flight according to the timestamps and consequently does 

not match the duration of the animation for scaled flights. 

• Scales Total Duration: shows the duration of the flight after scaling. 

• Ignore Heading: if On, you can change the camera's viewing direction during the ani-

mation interactively by using the mouse. In this case, the flight still follows the prede-

fined flight line, but the viewing direction can still be influenced, independent off the 

saved settings. If Off, the viewing direction cannot be influenced during the flight.  
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• Use Look At Location (only visible if Ignore Heading = Off): If On, the view is directed 

to the coordinate entered at Look At Point during the entire flight. If Off, no such ob-

servation point is used. 

• Animation Mode: determines whether the flight is played only once (forwards or back-

wards) or as a a loop (forwards, backwards, or forth and back).  

 

5.2.17 Viewshed Point 

In GAFmap Express: TOC > Graphics 

  A Viewshed Point (VSP) is a simple 3D point (see chapter 5.2.12). VSPs 

serve as basis for the on-the-fly viewshed by marking the viewer's locations from which the 

visibility of the terrain is analyzed (see chapter 4.5.6 (for 2D) and 4.6.6 (for 3D)). 

Whether a point is actually used as VSP or not can be controlled via the graphics property Use 

for Viewshed (see chapter 5.2.12.1). If a new VSP is added (see chapter 4.7.14), this property 

is set to On by default. However, the property can always be deactivated if the point is not to 

be used as VSP, i.e. not to be taken into account in the on-the-fly viewshed. 

Each point that is used as VSP is marked with the  viewshed icon over the layer icon. 

Context Menus 

Right-clicking on one or multiple selected VSP(s) in the TOC or in the map viewer with the 

Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context menu. For 

more information, see see chapter 5.2.12 (3D point). 

Additionally, the following function, which only appears in a 3D point's context menu if the 

Use for Viewshed property is enabled, is available: 

Tips and Notes: 

• For general information on VSPs, see chapter 4.7.14, for information on the on-the-fly 

viewhed, see chapter 4.5.6 (for 2D) or 4.6.6 (for 3D). 
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5.2.17.1 View from Point 

In GAFmap Express: TOC > Graphics > Context Menu Viewshed Point 

Only available in the 3D window 

 With View from Point you take the viewing position of the virtual viewer at the SAP. For 

this, an animated flight to the selected SAP is started in the 3D viewer. 

Shortcuts, Key Commands, etc.: 

• Alt + click on a view point's layer name in the 3D TOC: zoom to layer (not view from 

point) 

• Esc while animation: cancel animation 

• I while animation: cancel streaming 

 

5.2.18 Sight Line 

In GAFmap Express: TOC > Graphics 

 A Sight Line is a simple, straight line graphic (see chapter 5.2.5), whose posi-

tion is defined by excactly two line vertices (i.e. by start and end point). Additionally to the X-

/Y-coordinate, the height is stored for both points. 

With a sight line you can analyse whether a certain target point is visible to a viewer from a 

certain location. The sight analysis is based on a digital terrain or surface model, i.e. it can only 

be performed if a DEM is loaded and marked as such (see chapter 5.3.4). 

For more information, see chapter 4.7.15. 

Context Menus 

Right-clicking on one or multiple selected sight line(s) in the TOC or in the map viewer with 

the Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context menu. In 

the following, only graphics type-specific functions/commands and properties are explained. 

For line-specific functions/properties, see chapter 5.2.5, for general ones, i.e. those that are 

available for all graphics and/or graphics groups irrespective of the type, see chapter 5.2.1. 
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5.2.18.1 Properties 

In GAFmap Express: TOC > Graphics > Context Menu Sight Line 

 Via Properties you reach the Properties window where all essential properties of the 

selected sight line are listed. For more information on the individual properties, see chapter 

5.2.1.10. 

Especially note the following properties for sight lines: 

Geometry 

• Eye Height [m]: specifies the eye level of the observer, i.e. the start height of the sight 

line.  

• Target Height [m]: specifies the end height of the Sight Line, i.e. the height of the point 

to be seen. 

• Relative to Ground: if On, eye height and end height are measured above ground, i.e. 

above the underlying DEM. If Off, start height and end height are measured absolutely 

above sea level. 

 

5.2.19 Multimedia 

In GAFmap Express: TOC > Graphics 

 A Multimedia point is a special form of the 3D point (see chapter 5.2.12). 

Via Multimedia points, links to specific multimedia objects, e.g. URLs or multimedia files, can 

be anchored in the map. You can then open them e.g. directly from the map with Open 

Multimedia (see chapter 4.7.16) or via the Multimedia context menu (see chapter 5.2.19.1). 

Depending on the type, the link will be opened with the corresponding default programm, e.g. 

the specified default Internet browser for URLs, the default image viewer for image files, or 

Acrobat Reader for PDFs etc. 

 

Figure 127: Multimedia, example 
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Note that a link can no longer be accessed if an URL is not valid any more or the linked file has 

been subsequently deleted, moved, or renamed. 

Context Menu 

Right-clicking on one or multiple selected Multimedia point(s) in the TOC or in the map viewer 

with the Graphics Edit Tool (see chapter 4.7.1) opens the corresponding graphics context 

menu. In the following, only graphics type-specific functions/commands and properties are 

explained. For point-specific functions/properties, see chapter 5.2.4, for general ones, i.e. 

those that are available for all graphics and/or graphics groups irrespective of the type, see 

chapter 5.2.1. 

 

5.2.19.1 Open Multimedia 

In GAFmap Express: TOC > Graphics > Context Menu Multimedia 

 Open Multimedia you open the link to a multimedia object. The link is always opened 

with the assigned standard program for the respective file type, e.g. URLs are opened with the 

standard internet browser or PDFs with Acrobat Reader etc. If multiple multimedia objects are 

linked at one multimedia point, each link is listed separately in the context menu. 

Alternatively, you can open multimedia links via Open Multimedia in the Graphics Toolbar 

(see chapter 4.7.16). 

 

5.2.19.2 Properties 

In GAFmap Express: TOC > Graphics > Context Menu Multimedia 

 Via Properties you reach the Properties window where all essential properties of the 

selected Multimedia point are listed. For more information on the individual properties, see 

chapter 5.2.1.10. 

Also note the following properties for Multimedia: 

Multimedia  

• URL: shows the URL or file path to the linked multimedia object. If multiple multimedia 

objects are linked, the different URLs/paths are separated by semicolon.  

• Only Show File Name: if On, only the multimedia object's filename is displayed in the 

map viewer. If Off, the entire path is displayed. 
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5.3 Layer 

Layer in GAFmap® inlcudes all types of vector layers, raster layers, point clouds, and tables. 

Unlike graphics (see chapter 5.2), which are stored directly in the actual project file (*.xmp), 

each layer refers to an external data set. In Pack&Go projects, these data sets are usually 

stored in the container (*.cmp) next to the project file as well, but can also be linked. In the 

*.xmp file contained in the CMP then only the corresponing connection details are stored. 

Types of Graphic Elements 

The following types of layers can occur: 

• Vector Layer ( Point,   Line and  Polygon Layer) (see chapter 5.3.2 et seqq.) 

Each vector layer consists of individual point, line, or polygon features. Apart from the 

geometry displayed in the map/3D viewer, each feature has attributes. These attri-

butes can be viewed for the entire layer in the Attribute Table (see chapter 5.3.2.1) or 

be queried feature-by-feature with Show Attributes (see chapter 4.2.1). 

• Raster Layer ( multi-channel and single-channel rasters) (see chapter 5.3.3 et 

seqq.)  

For all rasters, the (image) information is stored in a uniform raster pixel by pixel. 

Rasters can have one or more channels / raster bands, up to four of which can be used 

for visualization (3 color bands + 1 alpha band). Multi-channel rasters are usually dis-

played as color image, single-channel rasters as black and white image, color ramp, or 

classification raster. 

Due to their special properties, these special types of raster layers are treated 

separately in the following: 

o Digital Elevation Models: single-channel rasters where the (terrain) height is 

stored for each pixel (see chapter 5.3.4). 

o  Raster with RPC Information: usually multi-channel rasters for which the 

exact recording geometry is stored and can thus be used for the display of side 

views in the 3D viewer (see chapter 5.3.5).  

o Mosaic Layer: virtual mosaics of multiple single- or multi-channel rasters (see 

chapter 5.3.6) 

Note: Rasters of WMS/WMTS/TMS are loaded and treated as "normal" raster layers in 

GAFmap®. 
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•  Point Clouds (see chapter 5.3.7 et seq.) 

Point clouds consist of a multitude of individually located (measurement) points in 

space. They can only be visualized in the 3D viewer (as 3D dataset) in GAFmap®, in the 

(2D) map viewer only the extent of the point cloud is displayed as rectangle. 

•  (simple) Tables (see chapter 5.3.8) 

All types of layers can only be read with GAFmap® Express and not be changed or newly added.  

Selecting Layers 

You can select a layer or layer group in the TOC with a simple left-click (on the icon or name); 

it is then highlighted in blue. Multi-selection is possible e.g. by holding down the Ctrl or Shift 

key. 

Alternatively, you can select layer in the map viewer with Select Layer (see chapter 4.1.10). 

They are then also highlighted in blue in the TOC.. 

Context Menu 

Right-clicking the main group Layer, selected groups or layers in the TOC takes you to a context 

menu that provides various functions or commands specifically for the selected elements. The 

content of the context menu depends on the level, number, and type of the selected elements 

and on whether the project contains a map viewer and/or a 3D viewer. 

The following chapters cover all functions/commands that appear in the context menus of the 

various layer types. These can be categorized as follows: 

• General layer functions, i.e. those that are available for all or most layers and layer 

groups (see chapter 5.3.1 et seqq.), 

• Layer specific functions, i.e. those that are only available specifically for vector, raster, 

point clouds or tables (see chapter 5.3.2 et seqq.) 

Shortcuts, Key Commands, etc.: 

• Left-click on element in the TOC: select element 

• Ctrl when selecting: add selection to current selection. Already selected features are 

deselected when they are selected twice. 

• Shift when selecting: select consecutive elements (Ctrl + click on first and last element 

to be selected) 

• Right-click on individual / multiple selected elements in the TOC: open context menu 
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• X: toggle graphic(s), layer(s), and/or group(s) selected in TOC (with multiple map win-

dows only in the active one) 

• C: toggle graphic(s), layer(s), and/or group(s) selected in TOC globally (with multiple 

map windows in all windows) 

• Alt + left-click on a selected layer, graphic, or group in the TOC: zoom to element 

• Alt + checking a layer, graphic, or group in the TOC: zoom to the checked element 

 

5.3.1 All Layers and Layer Groups 

In GAFmap Express: TOC > Layer 

A right-click on one or multiple selected layers in the TOC opens the graphics context menu. 

The content of the context menu depends on the type and number of selected elements. 

In the following, all potentially included, general functions of the layer context menu are 

explained. Functions that are only available for vector layers or raster layers, can be found in 

chapters 5.3.2 to 5.3.6. 

 

5.3.1.1 Zoom to Layer / Zoom to Selected Layers 

In GAFmap Express: TOC > Layer > Context Menu All Layers and Layer Groups 

 Zoom to Layer (in case of a single selected element) or Zoom to Selected Layers (in case 

of multi-selection) zooms the map to the extent of the element(s) currently selected in the 

TOC. If the selection holds only a single point, the map extent is centered on this point. 

Zoom to Selected Layers is also available if the multi-selection contains TOC elements of any 

type (i.e. graphics, layers, and/or groups). 

Zoom To Layer in the 3D Window 

If you execute the command in the 3D TOC, a flight animation to the layer is performed in the 

3D viewer. You then fly from your current view point on the shortest way to a view point from 

which you have a complete overview of the layer. You can define the desired Zoom To Flight 

Duration in the general settings under Other (see chapter 3.4.1.8). 

Shortcuts, Key Commands, etc.: 

• Alt+left-click on a selected layer, graphic or group in the TOC: zoom to element 

• Alt+checking a layer, graphic or group in the TOC: zoom to the checked element 
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Tips and notes: 

• Special case mosaic layer (see chapter 5.3.6): Note that the extent of a mosaic layer 

depends on whether or which single rasters below the mosaic layer are activated (i.e. 

checked in the TOC). If e.g. only one raster is activated, the extent corresponds to that 

of this raster, if multiple or all rasters are activated, it corresponds to the extent of all 

(activated) rasters. 

 

5.3.1.2 Select All Layers 

In GAFmap Express: TOC > Layer > Context Menu All Layers and Layer Groups 

Only available for groups 

Select All Layers selects all layers below the layer group in the TOC. Layers in subgroups are 

taken into account, groups are excluded from the selection.  

 

5.3.1.3 Mutual Exclusive 

In GAFmap Express: TOC > Layer > Context Menu All Layers and Layer Groups 

Only available for groups but not for the main group Layers 

You can activate Mutual Exclusive for a layer group by a single click on the command in the 

context menu. If activated, only one layer within this group is shown (checked/activated) at 

the same time. By default, first the uppermost layer within the layer group is activated and all 

other layers are deactivated. If you activate another layer, the first layer is automatically 

deactivated etc. The layers within the group are therefore only activated individually.  

 If Mutual Exclusive is activated for a layer group, a blue tick symbol appears in front of 

the corresponding command. The function can be deactivated at any time by simply left-

clicking the command again. The tick symbol disappears and the layers within the group can 

be selected/activated together again. 
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5.3.1.4 Check Selected / Uncheck Selected / Toggle Selected 

In GAFmap Express: TOC > Layer > Context Menu All Layers and Layer Groups 

Only available if multiple graphics, layers, and/or groups are selected 

   Check Selected / Uncheck Selected lets you activate/deactivate all graphics, layers, 

and groups currently selected in the TOC at once. Checked/activated elements are visible in 

the map viewer; unchecked/deactivated elements are hidden. 

 Toggle Selected lets you switch the activation state of the selected elements so that 

checked ones are unchecked and unchecked ones are checked.  

All three commands are also available if the multi-selection contains TOC elements of any type 

(i.e. graphics, layers, and/or groups). 

Shortcuts, Key Commands, etc.: 

• X: toggle graphic(s), layer(s), and/or group(s) selected in TOC (with multiple map win-

dows only in the active one) 

• C: toggle graphic(s), layer(s), and/or group(s) selected in TOC globally (with multiple 

map windows in all windows) 

 

5.3.1.5 Reload Data 

In GAFmap Express: TOC > Layer > Context Menu All Layers and Layer Groups 

Only available if the linked dataset is not in the Pack&Go Container 

 Reload Data lets you refresh one or multiple layer(s) without reloading the whole project.  

Reloading a layer can be necessary if the dataset behind the layer has been changed by an-

other user / in another project after loading, e.g. if a vector file has been edited in the mean-

time. This editing only becomes visible in your project if the data is reloaded. Or if a raster 

dataset is stored on a server and the network connection has been temporarily disconnected. 

Without reloading, only cached raster data can be displayed.  

If the command is executed on Layer Group level, all data below the group are updated, 

including all layers in sub-groups. If the group contains layers that cannot be reloaded, you 

receive a corresponding message. 
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Shortcuts, Key Commands, etc.: 

• Ctrl+R: Reload Data for all layers 

• Ctrl+F: Reload Data for selected layers 

 

5.3.1.6 Collapse / Expand 

In GAFmap Express: TOC > Layer > Context Menu All Layers and Layer Groups 

Only available if at least two groups and/or layers are selected 

 Collapse / Expand lets you collapse/expand selected layer groups, graphics groups, 

and/or layers in the TOC at once (see also chapter 2.2.2.2). Unselected groups and layers 

under selected groups are not collapsed or expanded. 

The commands are only available if they are actually applicable, i.e. they are missing if all 

selected groups and layers are already fully collapsed or expanded.  

Shortcuts, Key Commands, etc.: 

• Arrow key back (with mouse focus on TOC): collapse selected groups and/or layers in 

the TOC 

• Arrow key forward (with mouse focus on TOC): expand selected groups and/or layers 

in the TOC 

 

5.3.1.7 Show Layer Info 

In GAFmap Express: TOC > Layer > Context Menu All Layers and Layer Groups 

Only available if a single layer is selected for which a layer info is saved 

If a layer info is available for a layer, i.e. if the layer property field Layer Info contains an entry, 

then this info can be called directly from the layer's context menu via the command Show 

Layer Info. The layer info is then displayed in a separate window, either as plain text or with 

(HTML) formatting, depending on the form of the entry.  
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5.3.2 Vector Layer 

In GAFmap Express: TOC > Layer 

  A Vector Layer ("Feature Layer") is a layer (see chapter 5.3) that 

links to a vector dataset. It consists of any number of individual point, line, or polygon features. 

Besides the geometry displayed in the map viewer, each feature has attributes. These attri-

butes can be viewed via the Attribute Table for the entire layer (see chapter 5.3.2.1) or 

queried feature-by-feature e.g. using the Show Attributes tool (see chapter 4.2.1). 

All feature geometries are defined by individual vertices; the location in the map is done via 

X/Y-coordinates, which are stored for each vertex. Additionally, a vector layer can support Z-

coordinates; the feature geometries can then also be located in the 3D space. Whether or not 

a layer has Z-coordinates can be viewed in the layer properties under Source (see chapter 

5.3.2.5). Z-aware vector layers are also marked with a Z on the right above the layer icon in 

the TOC .  

You can display the individual feature vertices at any time, e.g. by pressing the V key in the 

map viewer or by listing them with Show Coordinates (see chapter 4.2.2). 

Geometry Types 

Vector layers are classified by geometry type as follows: 

•  Point Layers consist of any number of individual point features, which are directly 

located in the map via X/Y/(Z)-coordinates.  

•  Line Layers consist of any number of individual line features. Position and course 

of the individual lines are defined by vertices that are directly connected in a specific 

order, i.e. by straight line segments. 

•  Polygon Layers consist of any number of individual polygon features. Location and 

shape of the individual polygons are determined by linear, closed outline/rings, which 

are then filled  two-dimensional; each outline/ring is defined by individual vertices. 

Each polygon has at least one outer ring; additionally, it can have any number of inner 

rings (= "holes"). 

•  Vector data with geometry typ GeometryCollections or Unknown can contain fea-

tures of all three geometry types mentioned above. 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  234 

Independent of the geometry type, each vector layer can contain multipart features, i.e. fea-

tures whose geometry consists of multiple parts, i.e. multiple points, lines, or polygons. In all 

cases, "empty geometries", i.e. simple table entries without corresponding geometry, are also 

possible. For more information, see chapter 5.3.2.1. 

Context Menu 

Right-clicking on one or multiple selected vector layers in the TOC opens the vector layer 

context menu. In the following, only vector layer-specific functions in the context menu and 

the vector layer properties are explained. For functions/commands that are available for all 

layers irrespective of the type and layer groups, see chapter 5.3.1. 

 

5.3.2.1 Open Attribute Table 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer 

 Open Attribute Table or Ctrl+double-clicking on the layer name in the TOC opens a vector 

layer's attribute table. Here, all features of the layer including all their attributes are listed. 

 

Figure 128: Example of an attribute table  
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The attribute table is structured as follows: 

• Each row represents a feature. Each features is represented by exactly one row. Via 

the row header on the left, lines can be selected. 

• Each column represents an attribute field. The attribute field's name is shown in the 

column header. 

• Each cell contains a certain attribute value for the respective feature and the respec-

tive attribute field. 

The footer of the table shows how many features the vector layer contains, how many of them 

are selected, and whether All or only Selected Features are currently displayed. In display 

mode Selected you are additionally shown how many of the selected features are highlighted 

(see below). 

Regarding the feature count in the footer, please note the special case Filtered Data (see be-

low). 

Relation between Feature Geometry and Attribute Table 

Usually there is exactly one row in the attribute table for each feature geometry and vice ver-

sa, i.e. the number of geometries in the map viewer and the number of table entries matches. 

You can access a feature geometry in the map viewer via the attribute table by double-clicking 

the corresponding row at the row header. The map extent is then zoomed to the geometry 

or, if you hold the Alt key, centered on the geometry. If multiple rows are selected in the table, 

you can zoom to / center on all selected features with Ctrl+double-click on one of the row 

headers. 

Please note the following special cases: 

• A multipart feature has a geometry with spatially separated geometry parts; however, 

it is still a single feature (with a multipart geometry), i.e. it is represented in the 

attribute table by only one row. 

• Under certain circumstances, the attribute table can contain entries for which no geo-

metry exists. Such empty geometries can be created, for example, when the geometry 

"collapses" during certain operations, e.g. when it is buffered too far inwards or when 

all vertices are snapped to one point. 

For multipart features, the map viewer is always zoomed to / centered on all geometry parts 

when double-clicking on the row header, for empty geometries, the map extent remains un-

changed. 
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Feature Selection (in the Attribute Table) 

Features can be selected in various ways, e.g. 

• in the attribute table by clicking on a row header (see below), 

• in the map window with a selection tool (see chapter 4.2.3) or 

• with various functions like, for example, Select by Attribute or Select by Location (see 

chapter 5.3.2.1.2 et seqq.) 

If a feature is selected, the geometry is outlined in the map viewer in the set selection color 

(cyan by default) and the corresponding row in the attribute table (in display mode All) is 

highlighted in blue. This always applies, i.e. regardless of where and how the feature was se-

lected. 

 

Figure 129: Feature selection in map viewer and attribute table 

In the attribute table, a feature can be selected by clicking on the corresponding row header 

on the left (at the beginning of the line). 

 

Figure 130: Selecting a feature in the attribute table 

You can select multiple features  

• if you hold the Ctrl key and then click on multiple row headers one after the other. If 

you click an already selected feature for a second time, it is deselected again. 

• if you hold the Shift key and click on two line headers one after the other. These two 

features and all features in between are then selected. 
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• if you click on the row header of a feature, hold the mouse button, and drag the mouse 

pointer downwards/upwards on the row headers. All "passed over" features are then 

selected. 

A click in the upper left corner of the table or Ctrl+A selects all features: 

 

Figure 131: Selecting all features in the attribute table 

You can always clear the selection again, e.g. in the map window with the Clear Selection 

button (see chapter 4.2.4) or by clicking (off the headers) into the table. 

Display Mode (All/Selected) 

Via the buttons (Show) All or Selected (Features) in the table footer you can switch between 

the following two display modes: 

• All: all features of the vector layer are shown in the table. If features are selected, they 

are highlighted in blue.  

• Selected: only selected features of the vector layer are shown in the table; selected 

features are not additionally highlighted in blue.  
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Figure 132: Attribute table in display mode All (top) and in display mode Selected (bottom) 

You can tell which mode you are currently in by which button is active (highlighted in blue). 

Creating a Sub-Selection / Highlighting Features 

In display mode Selected, you can create a sub-selection of the currently selected features. To 

do this, select the corresponding rows in the table (see above); the sub-selected rows are then 

highlighted in green in the table. In the map viewer, the associated geometries are also high-

lighted (by default in green). The count of highlighted features is shown in the footer of the 

table. 

You can apply the sub-selection as a new selection by right-clicking on the row header to open 

a context menu and executing the Set New Selection command. All highlighted rows/features 

are then reselected, the others are removed from the selection. 

With the Remove From Selection command you can deselect the highlighted rows/features; 

a new selection is then created containing only the non-highlighted features. 

 

Figure 133: Creating a sub-selection in the attribute table 
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Attribute Fields / Columns 

The names of the attribute fields / columns are shown in the (column) headers. If you move 

the mouse pointer slowly over a header, the data type of the field is displayed (text, integer, 

date, etc.), and, if applicable/defined, in brackets the field length and the number of decimal 

places. 

 

Figure 134: Tooltip when moving the mouse pointer slowly over a column header: field name [data type(field 
length, number of possible decimal places)] 

You can change the order of the fields by grabbing a column with a click on the header and 

dragging it to the desired position. A changed field order can be saved in the project. 

Sorting Features by Attributes 

You can sort rows/features by a specific attribute field by left-clicking the respective column 

header:  

•   The first click sorts the features ascending, 

•   the second click sorts the features descending, and 

•   the third click discards the sorting again 

If you hold the Ctrl key, you can sort rows/features successively by multiple attributes, i.e. first 

by attribute1, then attribute2, etc. 

 

Figure 135: Sorting features in the attribute table. Example: First ascending by [SOVEREIGN], then ascending by 
[CNTRY_NAME] 
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Please note: 

• Whether the sorting of text is case sensitive depends on the layer property Case Sen-

sitive (see chapter 5.3.2.5). 

• If display names are used for a field (see below), the sorting is still always based on the 

actually entered values, not on the shown alias names. 

A changed sorting of the features can be saved in the project. 

Function in the Cell Context Menu 

In the cell context menu, which can be accessed by right-clicking into a selected cell, the 

following commands can be available, depending on the data type of the field: 

 

Figure 136: Cell context menu, using the example of a text field in edit mode 

• Copy: copies the entered attribute value to the clipboard. 

• Show Value (only for text fields): opens a text panel. Here, (longer) text is displayed as 

a whole. OK takes you back to the attribute table. 

• Open (only for text fields): If a valid path to a file or an URL is entered in the text field, 

this file/URL is opened with the default program specified for the respective (file) type 

(e.g. PDFs with Adobe Reader or URLs with the default Internet browser). Otherwise, 

you are informed that the link cannot be opened. 

• Save Content to File (only for binary fields / BLOBs): If file content is stored binary in a 

cell, the entry bytes[file size] is displayed. The stored file can then be saved again as 

an independent file via this context menu command or Ctrl+double-click into the cell. 

For this purpose, a file browser opens. Note that the file type must be known and spe-

cified when saving. 

• Open Image (only for binary fields / BLOBs): If an image ist stored binary in a cell, it can 

be opened directly via this context menu command or a double-click into the cell. 
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Special Case: Filtered Data 

If a vector dataset is filtered by deactivating unique values in the TOC (see chapter 5.3.2.5), 

the filtered out features are temporarily hidden in map viewer and attribute table. In this case, 

the footer of the attribute table additionally shows how many features there would be unfil-

tered, i.e. how many features the layer actually contains: 

 

Figure 137: Example of an attribute table with subsequently filtered data 

The number of "all" features displayed at the front in the () then refers to all features that are 

not filtered out, i.e. the features currently contained in the attribute tables. 

Please note that with filtered data the number of selected features can exceed the number of 

"all" features, e.g. if features are first selected and then the layer is filtered. In the Selected 

display mode, you then actually see all selected features (i.e. also the ones that are filtered 

out). 

The display "unfiltered" can also occur if the layer was filtered when the CMP file was created 

with GAFmap®. The layer is then marked in the TOC with a  filter icon above the layer icon. 

In this case, the filtered features are missing in the CMP and the number of unfiltered features 

therefore matches the number of all features. 

Special Case: Display Names 

If display names (alias names) have been assigned to an attribute field before creating the 

CMP file in GAFmap®, e.g. to improve the readability of coded attribute values, then the 

attribute table does not show the actual values entered, but "translated" values. The original 

values are displayed in a tooltip when you move the mouse pointer slowly over an affected 

cell. 
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Figure 138: If display names are used, the actual value entered is shown in a tooltip when you slowly move the 
mouse pointer over an affected cell. 

Note that when features are sorted by attributes (see above), they are always sorted by the 

original values and never by the display names. 

Further Table Functions under Options 

Under the button Options in the table footer you reach various functions to edit and analyze 

the attribute table. These functions are described in the following chapters. 

Shortcuts, Key Commands, etc.: 

• Left-click on row header: mark* row/feature 

• Shift when marking: mark several consecutive rows 

• Ctrl when marking: add row(s) to current marking. Already maked rows are cleared 

when they are marked twice. 

• Left-click in upper left table corner or Ctrl+A: mark all rows 

• Ctrl+left-click in upper left table corner: invert marking 

• Double-click on row header: mark row/feature and zoom map extent to corresponding 

feature geometry  

• Ctrl+double-click on row header: zoom map extent to all marked features 

• Alt(+Ctrl)+double-click on row header: center map on feature geometry/geometries 

(instead of zoom to) 

• Left-click on column header: sort features/rows by this attribute field 

• Ctrl+left-click on several column headers in a row: sort features/rows consecutively by 

these attribute fields  

• Ctrl+double-click on layer name in TOC: open attribute table 

• Arrow keys down/up with marked* line: mark next/previous line  

• Arrow keys with marked* cell: mark next/previous/right/left cell 

* In display mode All mark means select, in display mode Selected it means highlight 
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Tips and notes: 

• The attribute table is dockable. For more information, see chapter 2.2.4. 

 

5.3.2.1.1 Find 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Open Attribute Table > Options 

With Find you can find cells in the attribute table that contain a specific word/string. To do 

this, simply call up the command, enter the character string you are looking for, and confirm 

with OK. In the attribute table, the first cell / attribute value after the current (cursor) position 

in which the searched string is found is then selected/highlighted. The search can be repeated 

with F3 (not with e.g. Enter); the selection then jumps to the next hit. The search is performed 

in "reading direction", i.e. first from left to right, then from top to bottom. 

The following applies: 

• An attribute value found does not have to correspond to the character string searched 

for, it must contain it; i.e. with a, not only cells containing the value a are returned, but 

also those containing abc, for example. 

• The search is case-insensitve, i.e. upper/lower case is not taken into account. 

• Numbers and dates are not recognized as such, but are interpreted as simple alpha-

numeric characters, i.e. as individual digits from 0-9, including the formatting with 

which they are currently displayed in the table. If, for example, 1,000.1 is displayed, 

then only 1,000.1 results in a match and not, for example, 1000,1 etc. 

• If in the attribute table display names are shown (see chapter 5.3.2.1), what is currently 

visible in the attribute table is also decisive. 

• A | between characters/strings means "or"; i.e. with e.g. ab|cd all values containing 

ab or cd are returned. 

• * serves as wildcard/placeholder; i.e. a*c finds e.g. ac, abc, Acre, or Arch. 

• If you leave the input field empty, empty/unfilled cells are returned. 

Using Regex 

By default, the search is performed as described above. Alternatively, you can search with 

regex ("regular expression"). You can then perform a somewhat more complex (text) search, 

e.g. to find all values starting with an upper case letter and ending with a digit. For this, activate 

the setting Use Regex under menu Extras > Settings > Search Layers; it also affects the search 

in the attribute table.  
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Information on Regex can be found e.g. under the following links: 

• Regular expression - Wikipedia 

• RegexOne - Learn Regular Expressions - Lesson 1: An Introduction, and the ABCs 

• GitHub - ziishaned/learn-regex: Learn regex the easy way 

Please note in particular when searching in the attribute table with regex: 

•  The search is always only performed in individual cells, also with regex. 

•  Unlike the search without regex, the search with regex is case-sensitive. 

• When searching with regex, .* serves as wildcard/placeholder instead of * 

( . means "any character" in regex, * means "zero or more repetitions"; i.e. a*c finds 

e.g. c, ac, aac, aaac etc.; a.*c finds e.g. ac, abc, acre, or arch; [aA].*c finds e.g. ac, 

abc, Acre, or Arch). 

• In regex, . is a reserved character (see above). If you search for numbers with decimal 

separator . (e.g. 1.2), the escape character \ must be added before the . . To find exactly 

1.2, you must therefore search for 1\.2 

(As the . means "any character" in regex and the . in 1.2 is in fact any character, 1.2 is 

found with the search expression 1.2, but also 132, 1,2, 1n2 etc.) 

Shortcuts, Key Commands, etc.: 

• Ctrl+F: open input panel 

• Enter in input panel: confirm input / start search 

• F3: repeat search for previously entered string 

• see chapter 5.3.2.1 for more. 

Tips and Notes: 

• Use the Feature Search in the corresponding toolbar if you want to search multiple 

layers at once and/or web services for a certain character string, and/or if you want to 

search across multiple attribute fields. Using that search, all features whose attributes 

contain the searched string are selected (not individual cells). For more information, 

see chapter 4.3. 

• Alternatively, you can use Select by Attribute to find/select features with specific attri-

butes or attribute combinations within a layer. There, you can explicitly address the 

individual attribute fields, i.e. you can, for example, find features for which the charac-

ter string Arch appears specifically in the field [BuildType]. For more information, see 

chapter 5.3.2.1.2. 

https://en.wikipedia.org/wiki/Regular_expression
https://www.regexone.com/
https://github.com/ziishaned/learn-regex/tree/master
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5.3.2.1.2 Select by Attribute 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Open Attribute Table > Options 

Select by Attribute lets you select features with certain attributes within a vector layer. For 

this purpose, you can create a query condition either manually or with the help of an input 

wizard. All features that meet this condition are then selected. 

 

Figure 139: Dialog Select by Attribute 

• Layer: displays the source layer. The features of this layer are selected if they meet the 

condition specified below. 

Source layer is here always the vector layer from which the function was called. 

Selected features only: if checked, only pre-selected features of the source layer are 

considered. Else, all features are considered, regardless of any existing pre-selection. 

• Where Clause: Here, you can enter the query condition that a feature must meet to be 

selected (as a Where Clause). More information about how to create the input can be 

found below. 

You can either type the condition directly or use the button Use Wizard to open the 

Query Wizard. 

  Save/Load: saves the entered Where Clause / opens a dialog to reload a saved 

Where Clause: 
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Figure 140: List of saved Where Clauses 

o   deletes the selected Where Clause from the list 

OK transfers the selected Where Clause to the text box in the main dialog; Cancel 

closes the list without further action. If a condition has already been entered in the 

text field, it remains unchanged. 

If you want to save an entered query condition into an external text file instead of the 

list stored in the project, hold the Alt key while you click the Save button. This opens a 

file browser via which you can specify directory and filename for the text file 

(*.WhereClause). You can always reload a query condition saved as *.WhereClause by 

holding the Alt key and clicking the Load button. 

• Result: depending on the selected mode, the following applies to the result of the 

query: 

o New selection: All features that meet the condition are newly selected. An existing 

pre-selection is discarded. 

o Add to selection: All features that meet the condition are selected. The result is 

added to the existing pre-selection.  

o Remove from selection: All features that meet the condition are removed from 

the existing pre-selection, i.e. they are deselected. 

Apply sets the selection as specified, Close closes the dialog without further action. 

Where Clauses 

In the text box you can enter a query condition manually. It has to be framed as Where Clause 

in SQL syntax in the following way:    

Attribute field - Operator - Attribute value  or  Attribute field 1 - Operator - Attribute field 2 
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• Attribute field: attribute field to be searched. The field name can be put in square 

brackets or be named without brackets. The field name is case insensitive. 

• Operator: mathematical/logical condition that has to be fulfilled. Common examples 

are: 

o = ; <> ; > ; < ; >= ; <=     

mathematical operators; also applicable for text and dates 

o LIKE  / NOT LIKE 

for text only; use % as wildcard 

o IN ('value1','value2','value3') 

one of the listed values; list the searched values in round brackets, separated by 

commas 

o IS NULL / IS NOT NULL    

is empty / not empty; this operator is not followed by a value or another attribute 

field 

• Attribute value: searched attribute value(s) in the specified field. Please note: 

o Strings (= all entries in fields of the data type Text, including numbers and dates) 

have to be enclosed in single quotes.  

o Dates (= all entries in fields of the data type DateTime) have to be enclosed in 

single quotes. The date format is negligible. 

o Numbers (= all entries in fields of the data type Integer, Double etc.) have to be 

entered without quotes. 

• Different queries can be connected with AND (all conditions apply) or OR (at least one 

condition applies). If both operations are used, AND has a stronger binding. However, 

you can always influence the order of operations with brackets. 

Examples: 

• [FID] < 10 

A feature is returned if its FID is smaller than 10. 

• [SHAPE_OUTR] >= 2 

A (polygon) feature is returned if it has 2 or more outer rings, i.e. if it is a multipart 

polygon.* 
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• [Type] = 'grass' OR [Type] = 'meadow'   or   [Type] LIKE 'grass' OR [Type] 

LIKE 'meadow'   or   [Type] IN ('grass','meadow') 

A feature is returned if the attribute "Type" is "grass" or "meadow". 

• [Name_old] <> [Name_new]   or   [Name_old] NOT LIKE [Name_new] 

A feature is returned if the attributes "Name_old" and "Name_new" differ. 

• [Type] = 'river' AND [Length_KM] < 1 

A (line) feature is returned if the attribute "Type" is "river" and if it is shorter than 1 

km.* 

• [AREA_M2] > 2000 AND [Area_M2] < 5000 

A (polygon) feature is returned if its surface area is between 2000 m² und 5000 m².* 

• [Name] LIKE '%4Test%' OR [Name] LIKE '4_Test%' 

A feature is returned if the attribute "Name" contains the string "4Test" or starts with 

"4_Test". 

• [Date] < '2000-01-01'   or   [Date] < '01.01.2000'  

A feature is selected if the attribute "Date" holds a date before 01.01.2000. 

• [Type] IS NULL 

A feature is selected if the attribute field "Type" is empty. 

 

Please note:  

• * To all examples above applies: Queries regarding a feature's geometry (e.g. its length 

or surface area) refer to the respective Geometry Field. This presupposes the field is 

actually added to the table!  

• Whether text entries (strings) are case sensitive depends on the layer property Case 

Sensitive (see chapter 5.3.2.5). 

• Empty Fields are not included if you use the Operators <> or NOT LIKE. Therefore, the 

special case "empty" has to be added separately to the query if you want to select 

features with a certain attribute field e.g. not containing the value "A".  

Example: [Field] <> 'A' OR [Field] IS NULL. 
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Query Wizard 

If you need assistance with entering the Where Clause, click the Use Wizard button to open 

the Query Wizard:  

 

Figure 141: Dialog Select by Attribute > Query Wizard  

• Attribute: attribute field to be searched. All attribute fields are available in the drop-

down list. 

• Operator: mathematical/logical condition that has to be fulfilled. Depending on the 

data type of the selected field, different operators are available in the drop-down list. 

• Value: searched attribute value in the specified field. The value can either be entered 

manually, or selected from a list of all values currently existing in this field. You can 

view the list with a double-click in the field Value.  

 

Figure 142: List of all values currently existing in the searched field  

o OK or a double-click transfers the selected value to the field Value. 
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If you want to combine several conditions, add any number of rows and enter the different 

conditions.  

•  adds a row for another condition 

•  deletes the selected row/condition 

•  deletes all rows/conditions 

If multiple conditions are defined, determine via the radio buttons at the bottom if only one 

criterion must be met or all at once:  

• One criterion: only one of the criteria entered must be fulfilled (OR-operation)  

• All criteria: all criteria entered must be fulfilled (AND-operation)  

Apply "translates" the entered query in SQL syntax and transfers it as Where Clause to the 

text box in the main dialog. Here, it can still be edited as needed or discarded. Close closes the 

Query Wizard without further action. If a query condition has already been entered in the text 

field, it remains unchanged. 

The Query Wizard saves the last query until GAFmap® is closed. If the query was adjusted 

manually in the meantime or another condition (Where Clause) was entered manually, a 

corresponding error message appears when opening the wizard. 

Shortcuts, Key Commands, etc.: 

• Alt while clicking the Save (Where Clause) button: save the expression to a separate 

text file (*.WhereClause) 

• Alt while clicking the Load (Where Clause) button: Load an expression saved as 

*.WhereClause 

Tips and notes: 

• You can also reach this function directly via the context menu of the vector layer 

(context menu > Select by Attribute). 

• For general information on the topic Feature Selection, see chapter 4.2.3.1. 
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5.3.2.1.3 Select by Location 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Open Attribute Table > Options 

Select by Location lets you select all features within a vector layer that have a certain spatial 

relation to another feature. This means that you can, for example, select all features that in-

tersect, touch, contain, etc. another feature.  

 

Figure 143: Dialog Select by Location  

• Source Layer: determines the source layer(s). The features of the source layer(s) are 

selected if they meet the condition specified below.  

Source layer is here always the vector layer from which the function was called. 

Selected features only: if checked, only preselected features of the source layer are 

considered. Else, all features of the source layer are considered, regardless of any fea-

ture selection. 

Outlines only (only for polygon layers): if checked, only the outline is considered during 

intersection, not the entire polygon. The polygon layer is then treated like a line layer. 

If a polygon has multiple outer and/or inner rings, the rings of the polygon form a mul-

tipart line. 

• Location Layer: determines the layer the source layer is intersected with. All layers and 

graphics are available for selection, also the source layer.  

 opens a layer selection panel 
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Selected features only: if checked, only selected features of the location layer are con-

sidered. Else, all features of the location layer are considered, regardless of any feature 

selection. 

Exclude self (only relevant if source layer = location layer): if checked, features are not 

checked against themselves. This is usually important when you want to query spatial 

relations between the individual features of a layer, e.g. if you want to find identical, 

intersecting, overlapping, etc. features within a layer. Otherwise, always all or no featu-

res are selected, as a feature is always e.g. identical, intersecting, overlapping, etc. 

"with itself". However, unchecking this option can be appropriate if you are working 

with different preselections for source layer and location layer and the Selected featu-

res only option, meaning that the geometry set to be checked is not identical). 

Buffer [m]: if checked, all features of the location layer are buffered by the distance 

entered in the adjacent field. For the intersection, geometries that are accordingly 

enlarged outward (for positive values) or shrunken inward (for negative values) are 

then used. This lets you find, for example, source features that are located within a 

certain distance around the location features). 

Outlines only (only for polygon layers): if checked, only the outline is considered during 

intersection, not the entire polygon. The polygon layer is then treated like a line layer. 

If a polygon has multiple outer and/or inner rings, the rings of the polygon form a mul-

tipart line. 

• Union: if checked, all features of the location layer are merged before the intersection 

(temporarily in the background). The layer is then treated as if it contained only a single 

(multipart) feature. Boundaries or overlaps between individual features are therefore 

no longer relevant.  

If unchecked, the features of the location layer are considered individually.  This option 

is particularly relevant when checking spatial relations in which the geometry outlines 

are of importance, e.g. for Completely within (see below): 

 

Figure 144: Impact of the Union option with relation Completely within  

• Relation: specifies which spatial relation a feature of the source layer must have to a 

feature of the location layer to be selected. See below for more information about the 

available relations. 
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• None, Any, or All: specifies whether a feature of the source layer must not fulfill the 

spatial relation with any feature of the location layer, or whether it must fulfill it with 

any feature or with all features of the location layer, in order to be selected. Using the 

example Contains: The source feature is selected if it contains no, any, or all feature(s) 

of the location layer. 

• Result: depending on the selected mode, the following applies to the result of the 

query: 

o New selection: All features that meet the condition are newly selected. An existing 

preselection is discarded. 

o Add to selection: All features that meet the condition are selected. The result is 

added to the preselection.  

o Remove from selection: All features that meet the condition are removed from 

the preselection, i.e. they are deselected. 

Apply sets the selection as specified, Close closes the dialog without further action. 

! Please consider the notes at the end of the following section! 

 Spatial Relations 

The selection of a feature of the source layer (SL) is determined by its spatial relation to a 

feature of the location layer (LL). Depending on the geometry type of SL and LL, different rela-

tion types are available: 

• Intersects:  

Available for all geometry types without restrictions 

The SL-feature touches at least one LL-feature in at least one point. 

• Overlaps:  

Only available if SL and LL are of the same geometry type 

The SL-feature overlaps at least one LL-feature completely or partly. The following 

applies: 

o If SL/LL = polygon: the SL-feature is only selected if the polygons truly overlap, i.e. 

not only their outlines or if they are partially or (in the case of inner rings) com-

pletely congruent. 

o If SL/LL = line: corresponds to Share Line Segment (see below) 

o If SL/LL = point: corresponds to Intersects (see above) 
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• Completely Within:  

Only available if SL and LL are of the same geometry type or if LL has a higher dimension 

The SL-feature is completely within at least one LL-feature. The following applies: 

o If SL/LL = polygon: if the SL-feature (polygon or line) lies completely within a LL-

polygon and touches its outline from the inside, it is still returned as "completely 

within". If the SL-feature (line or point) lies exclusively on a LL-polygon's outline, it 

is not returned as "completely within". 

o If SL/LL = line: if the SL-feature (line) lies completely on a LL-line and touches its 

start/end point, it is still returned as "completely within". If the SL-feature (point) 

exclusively lies on a LL-line's start/end point, it is not returned as "completely 

within". 

Special case: if a LL-line forms a closed ring, the SL-feature is also returned as 

"completely within" when it crosses the start/end point (line) or exclusively lies on 

the start/end point (point). 

o If SL/LL = point: corresponds to Intersects (see above) 

• Contains:  

Only available if SL and LL are of the same geometry type or if SL has a higher dimension 

The SL-feature contains at least one LL-feature completely, i.e. at least one LL-feature 

is completely within the SL-feature (see above). 

• Equals Topologically:  

Only available if SL and LL are of the same geometry type 

The SL-feature and at least one LL-feature are coincident; this means for points that 

they lie exactly on top of each other, and for lines and polygons that all rings/lines have 

exactly the same course. In contrast to Identical (see below), the vertex IDs, the num-

bering of rings/geometry parts, and even the number of vertices can differ (as long as 

additional vertices are snapped to a line segment). 

• Identical:  

Only available if SL and LL are of the same geometry type 

The SL-feature is identical to at least one LL-feature. Identical means "identical to the 

last vertex", including exact vertex coordinates without any tolerance and vertex IDs 

(i.e. same start/end point and direction), numbering of rings/geometry parts, Z com-

ponent and Z value, etc. 
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•  Shares Line Segment:  

Only available if SL and LL are line layers and/or polygon layers 

The SL-feature shares at least one line segment with at least one LL-feature. Shared 

vertices are not required, as long as the (out)lines overlap completely or partly. If the 

(out)lines touch in only one point, the SL is not returned as "shares line segment". The 

following applies: 

o If SL and/or LL = polygon: only the outline is considered, regardless of the option 

Outlines only. 

• Parts Inside and Outside:  

Only available if LL is a polygon layer and SL is a line layer or polygon layer 

The SL-feature lies partly inside and outside of at least one LL-polygon. A LL-polygon's 

outline counts neither as inside nor outside. So, if a SL-feature lies inside or outside a 

LL-polygon, touches its outline but does not cross is, it is not returned as "parts inside 

and outside". 

• Centroid Intersects:  

Available for all geometry types without restrictions 

The centroid of the SL-feature intersects at least one LL-feature.  

The centroid of a feature can be determined independently of the geometry type. For 

points, it coincides with the point. For lines and polygons, it can be outside the feature 

geometry, depending on the shape of the geometry. For each feature exactly one 

centroid is determined, also for multipart features (= features with multiple geometry 

parts; see e.g. chapter 5.3.2.1). For multiparts the centroid is therefore usually located 

between the geometry parts. 

 

Figure 145: Select by Location - examples of centroids for lines and polygons 
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• DE-9IM Relation:  

Available for all geometry types without restrictions 

The spatial relation between the SL- and the LL-feature is defined according to the DE-

9IM model (see below).  

Enter the desired relation in the adjacent input field. 

For all relations applies:  

• ! By default (without the Union option), a SL-feature is selected as soon as it fulfills the 

given relation with a single LL-feature, also if it does not fulfill it with another LL-

feature. The latter may be relevant, for example, in relations such as Completely with-

in if one SL-feature lies completely within a LL-feature but intersects another one, or if 

certain spatial relations are explicitly excluded in the DE-9IM relation (e.g. "no inter-

section with the polygon ring"). In both cases, the mentioned feature would be selec-

ted! 

• If not stated otherwise, touching points between features do not require a shared 

vertex to be identified as such. The decisive factor is whether a point or a vertex is 

snapped to an (out)line. 

• You can also select z-aware layers as SL and/or LL. Note, however, that the height is 

ignored (exception: Identical; see above). 

DE-9IM Relation 

The DE-9IM model (Dimensionally Extended 9-Intersection Model) is a standard used to de-

fine topological relations between two geometries with regard to the three areas 

• Interior (= the entire geometry without its boundary), 

• Boundary (= the outlines/rings(s) of polygons and the endpoints of lines; points have 

no boundary), and 

• Exterior (= the area outside the geometry, including its boundaries). 
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Figure 146: DE-9IM model: Interior, boundary, and exterior of different geometry types (indicated in red) 

With the DE-9IM relation, you can specify exactly whether and with which dimension the 

three areas of the source layer feature (SF) and location layer feature (LF) must intersect in 

order for the SF to be selected. For this purpose, a matrix is used that compares all three areas 

of both features with each other: 

 

Figure 147: DE-9IM model: Intersection matrix. The numbers indicate the position in the DE-9IM expression. 

The matrix, read from top left to bottom right, is given as a simple sting with nine places: 

DE-9IM-Formel: 123 456 789 

where 1 stands for "Interior SF intersects Interior LF", 2 for "Interior SF intersects Boundary 

LF", 3 for "Interior SF intersects Exterior LF", 4 for "Boundary SF intersects Interior LF", etc. 

Whether or how the areas intersect is specified in the expression as follows: 

• T (true): the areas intersect (regardless of how)  

• F (false): the areas do not intersect  

• 0 (zero-dimensional): the areas intersect in a point 

• 1 (one-dimensional): the areas intersect in a line 

• 2 (two-dimensional): the areas intersect in an area 

• * (not specified): the relation is not checked / does not matter 

! In the expression, the relation must be defined/specified individually for each of the nine 

places (with T, F, 0, 1, 2, or *). No place may be omitted. Spaces, e.g. inserted for better 

readability, are ignored. 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  258 

Examples: 

• Example 1: All lines that enter a polygon from outside and end inside it are to be se-

lected: 

   (Line = SF, Polygon = LF) 

Lines that start inside or outside the polygon and end at the polygon ring, lie com-

pletely within the polygon, or do not intersect it at all are not to be selected. 

DE-9IM relation:  

e.g. 101 0F0 212 or *** T*T ***   

The first approach accurately describes the situation in the illustration above, while the 

second one is limited to the information that "one endpoint of the line lies within the 

polygon and the other one outside the polygon". Various other approaches are pos-

sible! 

! Note that the SF is selected as soon as it fulfills the relation with a single LF, even if it 

does not fulfill it with another one! With 101 0F0 212, the following line would also be 

selected (even though it ends at a polygon ring and "Boundary SF intersects Boundary 

LF" is explicitly exclude): 

 

If you want to exclude such lines from the selection, you can remove them in a subse-

quent step (e.g. with *** *T* *** and the Remove from selection option; see above). 

(With the Union option, different rules apply; see above.) 

• Example 2: All lines that lie completely within a polygon and whose both ends lie on 

the polygon's outline are to be selected: 

   (Line = SF, Polygon = LF) 
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Lines that are not conpletely within a polygon and/or whose both end points do not lie 

on the polygon's outline are not to be selected. 

DE-9IM relation:  

e.g. 1FF F0F 212 or TF* FT* *** 

The first approach accurately describes the situation in the illustration above, while the 

second one is limited to the information that "the line itself lies completely within the 

polygon and does not intersect the outline, the endpoints lie on the polygon's outline 

and not inside it". Various other approaches are possible! 

If "the line itself does not intersect the outline" were not explicitly required, i.e. the 

given relation would be e.g. 1*F F0F 212 or T** FT* ***, then the selection, unlike the 

one with the relation given above, would also include lines like this: 

   (Line = SF, Polygon = LF) 

(Lines that run exclusively on the polygon outline would not be included in both cases, 

as they do not meet the condition "lies within the polygon = intersects the interior of 

the polygon".) 

• Example 3: All polygons that overlap with another polygon are to be selected: 

  (Polygon = SF & LF, Exclude self = checked)  

DE-9IM relation:  

e.g. 212 101 212 or T** *** *** 

The first approach accurately describes the situation in the illustration above, while the 

second one selects features whose interior overlaps with that of another feature. 

Unlike with the first approach, the selection in the second one also includes polygons 

that are completely within another polygon or contain another polygon, or polygons 

that are topologically equal or identical. (The first one does not, because here, among 

other things, "Interior SF intersects Exterior LL in an area" and "Exterior SF intersects 

Interior LL in an area" is explicitly required.) 
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• Example 4: The lines of a line layer should cleanly end or cross each other with a single 

intersection point, but should not share a line segment in any case. Therefore, lines 

such as these are to be found/selected: 

      (Line = SF & LF, Exclude self = checked) 

DE-9IM relation:  

e.g. 1** *** *** 

All lines whose interiors intersect as a line are selected here. If only lines whose in-

teriors intersect were searched for, regardless of how, i.e. if the approach were T** 

*** ***, then the selection would also contain lines that cross each other with a single 

intersection point. 

The preentered relation T*F **F FF* is equivalent to the relation Equals Topologically, 

which can be selected from the drop-down list (see above). 

More information can be found e.g. here: https://en.wikipedia.org/wiki/DE-9IM  

 You can enter the DE-9IM relation directly or open the DE-9IM Pattern Editor using the 

button next to the input field. The editor provides the DE-9IM matrix and all possible inter-

section types: 

 

Figure 148: DE-9IM Pattern Editor (A = source layer feature, B = location layer feature) 

https://en.wikipedia.org/wiki/DE-9IM
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Select the desired intersection type for each combination from the drop-down list and confirm 

with OK. The corresponding DE-9IM relation is then created and transferred to the input field. 

I can still be edited there. 

 Tips and notes: 

• You can also reach this function directly via the context menu of the vector layer 

(context menu > Select by Location). 

• For general information on the topic feature selection, see chapter 4.2.3.1. 

 

5.3.2.1.4 Invert Selection 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Open Attribute Table > Options 

Invert Selection lets you invert the current selection. This means that selected features are 

cleared and vice versa.  

Shortcuts, Key Commands, etc.: 

• Ctrl+left-click in upper left table corner in display mode All: invert selection 

 Tips and notes: 

• Alternatively, you can also invert a layer's feature selection via its context menu (see 

chapter 5.3.2.3.4). 

• For general information on the topic feature selection, see chapter 4.2.3.1. 

 

5.3.2.1.5 Invert Highlighted Features 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Open Attribute Table > Options 

Only active in in display mode Selected (see chapter 5.3.2.1). 

Invert Highlighted Features lets you invert the current highlighting. This means that highligh-

ted features are cleared and vice versa.  

Shortcuts, Key Commands, etc.: 

• Ctrl+left-click in upper left table corner: invert highlighted features 
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5.3.2.1.6 Copy All/Selected Rows to Clipboard 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Open Attribute Table > Options 

Copy All Rows to Clipboard or Copy Selected Rows to Clipboard lets you copy all or only se-

lected rows from the attribute table to the (Windows) clipboard, e.g. to paste them into an 

Excel or OpenOfficeCalc table for further use. The table is always copied "as seen", which 

means: 

• All currently visible columns are copied in the current order, including column names. 

So it is taken into account if columns are temporarily moved (see chapter 5.3.2.1). 

• All attribute values are copied as currently displayed. This means, for example, that  

o the displayed decimal separator (i.e. comma in the German or dot in the English 

language version; see chapter 3.4.2) or 

o the displayed date format 

is taken over. 

The information about the data type is lost when copying to the clipboard. How the values are 

interpreted when they are pasted e.g. into an external table, depends on the program used. 

If you paste the rows into Excel, for example, the (Windows) language settings are relevant 

for the interpretation of decimal numbers and data in addition to the cell formatting.  

 

5.3.2.1.7 Field Statistics 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Open Attribute Table > Options 

Field Statistics lets you display a simple statistic (number of values, smallest/biggest value, 

mean value, standard deviation and sum) for numeric attribute fields and/or create a histo-

gram of the attribute values.  

First, select the field for which the statistics are to be calculated: 
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Figure 149: Field Statistics - Example 

• Field: determines the attribute field the statistics are to be calculated for. All numeric 

attribute fields are available for selection. 

 opens a drop-down list 

Selected features only: if checked, the statistics are only created for selected features. 

If unchecked, all features are considered, regardless of any existing selection. 

With Apply the statistics are calculated and displayed in the dialog (as text), Cancel closes the 

dialog without further action. 

If you want to create a histogram of the attribute values, i.e. a graphical display of the fre-

quency distribution, press the button Histogram. First, the Specify Histogram dialog opens. 

Here you can define the limits and the level of detail for the diagram: 

 

Figure 150: Dialog Specify Histogram 

• Min/Max: determines the lower/upper limit of the Histogram, i.e. the smallest/biggest 

value displayed. If the attribute field contains values that lie outside the limits, these 

are not displayed in the Histogram. 
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• Bin Count: determines the number of Bars/Bins displayed in Histogram, i.e. how 

detailed it is. Between Min and Max a corresponding number of value classes are then 

formed, into which the attribute values are grouped. The classes are always equidistant 

(= same value distance/range). Consequently, the Bars displayed in the Histogram are 

always the same width. 

If you confirm with OK, the Histogram is calculated and the Histogram window opens: 

 

Figure 151: Histogram window (attribute values Histogram)  

Diagram Viewer (1) 

In the Diagram Viewer on the right, the histogram, i.e. the frequency distribution of the 

attribute values is displayed graphically. The X-axis shows the attribute values, the Y-axis the 

number of features that fall into the displayed value classes. Limits and level of detail corres-

pond to the entries in the Specify Histogram dialog (see above).  

In the Status Bar below the diagram viewer, the X/Y-coordinates of the current mouse position 

in the diagram are displayed. 
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Table of Content (2) 

In the TOC to the left all elements contained in the diagram are listed under Diagram > Gra-

phics. The TOC can contain: 

• The coordinate axes. You can view and adjust their properties via Properties in the 

context menu of the coordinate axes (e.g. the axes labeling, step size, or position of 

the origin). 

• The folder [name original vector layer] : [name field] contains the displayed value 

classes (bins), each represented as a rectangle graphic. Next to the rectangle symbol 

the class boundaries and (behind the : ) the number of features that fall into the classes 

are displayed. Always all classes are listed, including those that are empty and 

therefore cannot be seen in the Diagram window (because the height is 0). 

Via Properties in the context menu of a rectangle you can view and adjust its properties 

(e.g. the color or labeling of the bins). For more information on this and on the func-

tions available in the context menu, see chapter 5.2.6. 

• All graphics added via the toolbar (see below). For more information on their context 

menus and properties, see chapter 5.2 et seqq. 

Toolbar (3) 

Via the toolbar on the top of the histogram window you can: 

•   Show/Hide the TOC, 

•        adjust the visible extent in the diagram viewer. Alternatively, 

you can use the common shortcuts to adjust the visible extent (see chapter 4.1.3 et 

seqq.). 

•  adjust the axis ratio stepwise or fit it to the window. 

•   Identify the layers/elements in the diagram viewer (see chapter 4.1.11), 

•   Export the Diagram (see chapter 4.5.12), 

•           add and edit various graphics (see chapter 4.7.1 

et seqq.), or  

•   gradually Undo/Redo all performed actions. Which action is undone/redone 

next, is shown in the tooltip. 
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5.3.2.1.8 Scatter Plot 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Open Attribute Table > Options 

Scatter Plot lets you create a scatter plot (also "point clouds") for a values pair from two 

attribute fields of a vector layer. First, select the two fields for which the scatter plot is to be 

created: 

 

Figure 152: Dialog Create Scatter Plot 

• X-Axis: determines from which attribute field the values for the X-axis of the scatter 

plot are read. All numeric fields and date fields are available for selection. 

 opens a drop-down list 

• Y-Axis: determines from which attribute field the values for the Y-axis of the scatter 

plot are read. All numeric fields are available for selection. 

 opens a drop-down list 

• Label: determines the attribute field the individual point graphics in the TOC of the 

diagram are named after. 

 opens a drop-down list 

• Selected features only: if checked, the scatter plot is only created for selected features. 

If unchecked, all features are considered, regardless of any existing selection. 

• Connect points: if checked, the individual points in the scatter plot are connected with 

a line along the X axis, i.e. a curve is displayed (additionally). 
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With Create the Scatter Plot is created and the Scatter Plot window is opened: 

 

Figure 153: Scatter Plot window 

Diagram Viewer (1) 

In the Diagram Viewer to the right the scatter plot is displayed graphically. X- and Y-axis map 

the two previously defined attribute fields. Each point represents a feature of the vector layer 

and is located in the coordinate system according to the value pair taken from the two fields 

(see above). Note that features, for which at least one of the two fields is empty, are missing 

in the Scatter Plot, since no value pair can be built for them. 

In the Status Bar below the diagram viewer, the X/Y-coordinates of the current mouse position 

in the diagram are displayed. 

Table of Content (2) 

In the TOC on the left all elements contained in the diagram are listed under Diagram > 

Graphics. The TOC can contain: 

• The coordinate axes. You can view and adjust their properties via Properties in the 

context menu of the coordinate axes (e.g. the axes labeling, step size, or position of 

the origin). 
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• The folder that has the same name as the original vector layer, contains a point graphic 

for each displayed value pair. Each point represents a feature of the vector layer. The 

name, i.e. the name of the points behind the point symbol, for each feature corres-

ponds to the value from the attribute field, which was previously defined in the dialog 

under Label (see above). 

The point symbol is assigned by default for each point graphic so that it corresponds 

to the original feature. If the vector layer is a point layer, the point symbol matches 

exactly, for line and polygon layers the color is adopted. 

Via Properties in the context menu of a point you can view and adjust its properties 

(e.g. the point symbol). For more information on this and on the functions available in 

the context menu, see chapter 5.2.4. 

• All graphics added via the toolbar (see below). For more information on their context 

menus and properties, see chapter 5.2 et seqq. 

Toolbar (3) 

Via the toolbar on the top of the Scatter Plot window you can: 

•   Show/Hide the TOC, 

•        adjust the visible extent in the diagram viewer. Alternatively, 

you can use the common shortcuts to adjust the visible extent (see chapter 4.1.3 et 

seqq.). 

•  adjust the axis ratio stepwise or fit it to the window. 

•   Identify the layers/elements in the diagram viewer (see chapter 4.1.11), 

•   Export the Diagram (see chapter 4.5.12), 

•           add and edit various graphics (see chapter 4.7.1 

et seqq.), or  

•   gradually Undo/Redo all performed actions. Which action is undone/redone 

next, is shown in the tooltip.  

 

5.3.2.1.9 Unique Value Count 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Open Attribute Table > Options 

Unique Value Count creates a list of all values appearing in a chosen attribute field including 

their count, regardless of a field's data type.  
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Figure 154: Count Unique Values - Example 

Note  

• that for text fields the unique value count is case sensitive. 

• that unique values deactivated in the TOC are not taken into account. 

By default, the order of the unique values in the list equals the order of their appearance in 

the attribute table (current sorting). However, you can always sort the list ascending or 

descending by Value or Count by clicking the respective column header. 

Shortcuts, Key Commands, etc.: 

• Ctrl+A: select all rows 

• Ctrl when selecting: add selection to current selection. Already selected features / rows 

will be deselected when they are selected twice 

• Shift when selecting: select several consecutive rows at once 

• Ctrl+C: Copy selected rows to the Clip Board 

 

5.3.2.1.10 Resize Columns 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Open Attribute Table > Options 

Resize Columns lets you optimize the (currently displayed) width of all columns in the attri-

bute table at once. The width of each column can be adjusted to 

• the Content, 

• the Header, or  

• to Content & Header. 

You can always adjust the width of a column in the table manually by moving the mouse 

pointer over the separator between two column headers until a move arrow appears, grab-
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bing the separator with the left mouse button, dragging it to the desired position, and releas-

ing the mouse button. Double-clicking with the move arrow active adjusts the width of the 

(left-hand) column to content and header.  

 

Figure 155: Manually adjusting the width of columns in the attribute table 

Shortcuts, Key Commands, etc.: 

• Double-click on separator between two column headers (with move arrow active): ad-

just width of (left-hand) column to content and header 

 

5.3.2.2 Close Attribute Table 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer 

Only available if an attribute table is open for at least one selected layer 

Close Attribute Table closes the attribute tables of all layers selected in the TOC. Alternatively, 

attribute tables can be closed (individually) via the X button at the top right of the table. 

 

5.3.2.3 Selection 

5.3.2.3.1 Select All Features 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Selection 

Select All Features lets you select all features of the source layer. The feature selection of 

other layers remains unchanged. 

Tips and notes: 

• In the Attribute Table (see chapter 5.3.2.1) you can select all features with a left-click 

in the upper left corner of the table or by pressing Ctrl+A. 

• For general information on the topic feature selection, see chapter 4.2.3.1. 
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5.3.2.3.2 Clear Selection 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Selection 

Only available if any features of at least one source layer are selected 

Clear Selection lets you deselect all features of the source layer(s). The feature selection of 

other layers remains unchanged. 

Tips and notes: 

• If you want to deselect all features of all layers, use for example Clear Selection  in the 

Toolbar for Features (see chapter 4.2.4). 

• For general information on the topic feature selection, see chapter 4.2.3.1. 

 

5.3.2.3.3 Clear Selection of Other Layers 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Selection 

Clear Selection of Other Layers lets you deselect all selected features of all layers but the 

source layer. Only the feature selection of the source layer is preserved. 

Tips and notes: 

• If you want to deselect all features of all layers, use for example Clear Selection  in the 

Toolbar for Features (see chapter 4.2.4). 

• For general information on the topic feature selection, see chapter 4.2.3.1. 

 

5.3.2.3.4 Invert Selection 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Selection 

Invert Selection lets you invert the current selection within the layer. That means that selected 

features are deselected and unselected features are selected. The feature selection of all 

other layers remains unchanged. 
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Tips and notes: 

• You can also invert a layer's feature selection in its Attribute Table either via Options >   

Invert Selection (see chapter 5.3.2.1.4) or with Ctrl + left-click in the upper left table 

corner. 

• For general information on the topic feature selection, see chapter 4.2.3.1. 

 

5.3.2.3.5 Select by Attribute 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Selection 

This command refers to Select by Attribute in the Attribute Table (menu Options). For more 

information, see chapter 5.3.2.1.2. 

 

5.3.2.3.6 Select by Location 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer > Selection 

This command refers to Select by Location in the Attribute Table (menu Options). For more 

information, see chapter 5.3.2.1.3. 

 

5.3.2.4 Create Height Profile 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer 

Only available for point layers, z-aware line layers, and non-z-aware line layers in combination 

with a DEM 

Create Height Profile lets you create 

• for point layers: a (height) profile for the layer and 

• for line layers: a (height) profile for a selected line. 

Simply click the corresponding command on the context menu of the layer. The (Height) 

Profile dialog opens.  

For informationen on the (Height) Profile dialog, see chapter 4.1.14. 
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Height Profile of a point layer  

For a point layer, the heights used to create the profile are read from either the Z-coordinates 

of the points or an attribute field. The following priority applies: 

• If the layer has Z-coordinates, these are used to create the profile.  

• If the layer has no Z-coordinates, the attribute field Height is used. 

• If neither Z-coordinates nor a field Height exists, it is queried which attribute field 

should be used instead. All numeric fields are then available for selection. 

For the height profile, the points are virtually connected to form a line. The order in which the 

points are connected always results from the current sorting of the features in the attribute 

table (first point is the topmost in the table, second the second topmost, etc.): 

 

Figure 156: Height Profile of a point layer, example. The points are colored according to their height (color range 
from dark blue=deep to yellow=high) and are labeled with their FID (order in the tables ascending by FID) 

If at least two points are selected, the selection is taken into account, i.e. the profile is then 

only created for selected features. Here, too, the point order results from the current sorting 

of the attribute table. 

Height Profile of a Selected Line Feature 

If a single line is selected for a line layer, a Height Profile can be created for this line. The 

prerequisite is that either 

• the line vertices have Z-coordinates or  

• the line intersects a digital elevation model (DEM, see chapter 5.3.4), from which the 

heights underlying the vertices can be taken.  

The profile displays the elevation course of the individual line vertices (order corresponds to 

the ID of the vertices; see chapter 4.2.2).  
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Figure 157: Height Profile of a line feature, example: Height Profile of a line without Z-coordinates with heights 
from DEM (direction of editing line from left to right) 

If no height information is available for the line features and/or a single line feature is not 

selected, the command is not available in the context menu of the layer. 

Tips and Notes: 

• If you want to use an existing line to create a terrain section across a DEM, in which 

the heights are taken and displayed along the entire line and not only at the vertices, 

use a line graphic (see chapter 5.2.5.3).  

 

5.3.2.5 Properties 

In GAFmap Express: TOC > Layer > Context Menu Vector Layer 

 Via Properties you reach the Properties window where all essential properties of the 

selected vector layer are listed.  

For vector layers, all properties are read-only (i.e. all properties are grayed out). 

In the following, all properties of vector layers are listed. Which properties are actually dis-

played depends significantly on the underlying dataset, especially on the geometry type, and 

whether the project contains a (2D) map viewer and/or a 3D Viewer. If multiple layers are 

selected, only properties available for all selected layers are displayed (combined properties).  

Source 

• Layer: shows the name of the connected vector dataset / feature table. 
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• Load Condition (only visible if a load condition was specified when adding the vector 

dataset): shows the used load condition. The project then only contains features that 

meet this condition. 

• Z-aware: shows whether the vector layer supports Z-coordinates (On) or not (Off). 

 If a vector layer is z-aware, this is indicated in the TOC with a Z to the right above 

the layer icon. 

• Measured: shows whether the vector layer suppoert M-coordinates (On) or not (Off). 

• On-the-fly Projection: shows whether the dataset is reprojected on-the-fly (i.e. tempo-

rarily in the background) in the map viewer (On) or not (Off). A reprojection is neces-

sary if the layer spatial reference differs from the map spatial reference. 

• Editable: shows whether the connected vector dataset is editable (On) or not (Off). 

Note that with GAFmap® Express, vector layers are never editable. 

• Spatial Reference: shows the layer spatial reference. 

 opens a window with more detailed information on the layer spatial reference  

• Layer Info: if available, additional information about the layer can be viewed here (e.g. 

a legend, the data source, other metadata, etc.) 

 opens the Layer Info window 

If a layer info is entered, it can alternatively be called up via Show Layer Info command 

in the layer context menu (see chapter 5.3.1.7); texts with HTML syntax are then usu-

ally displayed formatted (here always as source text). 

Case Sensitive 

• Case Sensitive: shows whether upper/lower case is considered for Definition Query 

(see below), Select by Attribute (see chapter 5.3.2.1.2), and sorting in the Attribute 

Table (see chapter 5.3.2.1) (On) or not (Off). 

Definition Query 

• Query Condition: shows whether certain features of the vector layer have been 

filtered out spatially and/or by attribute. If a condition is displayed here, only features 

that meet this condition are contained in the project. 

You can identify filtered layers (in the TOC) by the  filter icon above the layer icon 

and in the attribute table by the additional information "number of unfiltered fea-

tures" in the footer. 
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Selection 

• Features Selectable: if On, the features of this layer are selectable with the tools Select 

Feature or Select with Polygon (see chapter 4.2.3). If Off, the features cannot be selec-

ted with these tools. The layer is then be marked accordingly in the TOC: 

 

Via the attribute table (see chapter 5.3.2.1) or the submenu Selection (see chapter 

5.3.2.3) features can always be selected, regardless of these properties 

Scale Range 

• Scale Range: determines whether a vector layer activated in the TOC is only displayed 

in the map viewer if the zoom level of the map is within a certain scale range (On) or 

always, regardless of the zoom level (Off). 

If On, you can specify the valid scale range, i.e. the desired lower/upper limit, under 

Min. Scale / Max. Scale. 

If the vector layer is used as a texture in the 3D viewer, it is only displayed within the 

valid scale range. The reference is then the Texture Map Scale (see chapter 5.3.4.1). 

Labeling 

• Show Label: if On, the features of this layer are labeled in the (2D) map viewer. Various 

properties regarding the labeling style are then displayed, e.g. 

o (Other) Labeling: shows the label style, i.e. font, text size, color, etc. 

Note: If the renderer types UniqueValue or ClassBreaks are used (see below), the 

label style is set individually for each defined value or class. In this case, the style 

set here only applies to all "other" values. 

o Label Field: shows the attribute field the features are labeled with.  

Instead of an attribute field in [square brackets], an expression of any complexity 

in C# syntax can be entered, e.g. if features are labeled with multiple attribute 

fields or with attribute fields + free text, or if features with different attributes are 

to be treated differently. 

o Labeling per Class/Unique Value (only for renderer type = Unique Value or Class 

Breaks): shows whether all features of the layer are labeled with the same label 

style, namely the one specified above at Labeling (Off), or whether the label style 

is set individually for each unique value / class (On). 
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o One Label per Feature: shows whether for multipart features all geometry parts 

are labeled (Off) or always only the largest geometry part (On) 

o Allow Label Shifting: shows whether the labels are offset for better readability if 

necessary (On) or not (Off). 

o Label Placement Mode: shows how the label is placed along lines or inside poly-

gons. 

o Label Scale Range: shows whether the labels are displayed only within a certain 

scale range (On) or scale-independent (Off), and if On, which scale range is valid. 

etc. 

Symbology 

• (Other) Point Symbol / Line Pen / Fill Brush: shows which symbol is used to display the 

features in the (2D) map viewer. 

If the renderer types Unique Value or Class Breaks are used (see below), the symbol 

set here is only used for "other" features, i.e. for features for which no unique value is 

defined or which are not covered by any of the defined classes. 

• Symbol Scale: shows with which factor the features are scaled in the (2D) map viewer. 

At 1, the symbols are drawn in the set original size/width, at values > 1 / < 1, they are 

enlarged / reduced by the corresponding factor. 

• Transparency [%]: shows the degree of transparency the layer is displayed with in the 

map viewer (0 = non-transparent/opaque, 100 = fully transparent/invisible). 

• Composite Transparency: shows whether (with a specified transparency) the indivi-

dual features of a vector layer are drawn transparently (Off), or the layer as a whole 

(On). If Off, features in the background shine through in case of overlaps, otherwise 

they do not. 

 

Figure 158: Example: Transparent polygons without and with enabled Composite Transparency 
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• Renderer Type: shows which method is used to display the features. They can either 

all be drawn the same way (with the symbol set above) or differently depending on 

their attributes (with individually set symbols). Possible are: 

o Normal: if displayed, all features are displayed with the same (point/line/fill) 

symbol set above, regardless of their attributes. 

o UniqueValue: if displayed, the (point/line/fill) symbol is set individually for each 

feature, depending on one or multiple attributes, i.e. different feature classes/ 

subtypes have been formed which are displayed differently. The attribute(s) 

according to which the distinction is made can be taken from the property field 

Renderer Field(s) or the TOC (above the unique values), the number of unique 

values from the property field Unique Value Symbols.  

The unique values are displayed in the TOC when the vector layer is expanded: 

  

Features that do not fall into any of the specified classes are represented with the 

symbol specified at the top of the Properties window at Other Point Symbol / Line 

Pen / Fill Brush. 

Drawing Order by Unique Values shows whether the sorting of the unique values 

in the TOC dictates the drawing order of the features in the map viewer (On) or 

not (Off), i.e. whether features with unique values that are on top in the TOC are 

drawn over features with unique values that are on bottom in the TOC. 

In the TOC you can activate/deactivate unique values individually by checking/ 

unchecking them. If you deactivate one or multiple unique values, the respective 

features are filtered out and are therefore also missing in the attribute table. 

You can identify filtered layers (in the TOC) by the  filter icon above the layer icon 

and in the attribute table by the additional information "number of unfiltered fea-

tures" in the footer. 
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o ClassBreaks: if displayed, the values entered in a certain attribute field are 

grouped into classes. Then, to each class an individual symbol is assigned. The 

attribute field used for classification can be taken from the property field Renderer 

Field or from the TOC (above the classes), the number of classes from the property 

field Class Break Symbols.  

The classes are displayed in the TOC when the vector layer is expanded: 

 

Features that do not fall into any of the specified classes are represented with the 

symbol specified at the top of the Properties window at Other Point Symbol / Line 

Pen / Fill Brush. 

In the TOC you can activate/deactivate the classes individually by checking/un-

checking them. If you deactivate one or multiple classes, the respective features 

are filtered out and are therefore also missing in the attribute table. 

You can identify filtered layers (in the TOC) by the  filter icon above the layer icon 

and in the attribute table by the additional information "number of unfiltered fea-

tures" in the footer. 

o Shift Vector (only for point layers): if displayed, a shift vector is attached to the 

defined Point Symbol, whose length and direction depends on the pair of numbers 

in the two attribute fields entered at Shift Vector-X/-Y Field. 

Instead of numeric attribute fields in [square brackets], an expression of any 

complexity in C# syntax can be entered, e.g. if features with different attributes 

are to be treated differently or if non-numeric attribute fields are used as source. 

The (length) unit of the values depends on the map's spatial reference; the actual 

length of the vector depends on the Scale Factor with which the read values are 

multiplied. At Vector Line the line symbol used to draw the vector line is shown. 

o Ellipse (only for point layers): if displayed, an ellipse is drawn around each point, 

whose two half-axes and rotation depend on a triple of numbers in the three 

attribute fields entered at Ellipse X-/Y-Axis Field and Ellipse Rotation Field. 
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Instead of numeric attribute fields in [square brackets], an expression of any 

complexity in C# syntax can be entered, e.g. if features with different attributes 

are to be treated differently or if non-numeric attribute fields are used as source. 

The (length) unit of the values depends on the map's spatial reference; the actual 

length of the half-axes depends on the Scale Factor with which the read values are 

multiplied. At Vector Line the line symbol used to draw the ellipse line is shown. 

• Additional Scaling (only for point and line layers): shows whether the size/width with 

which the individual points/lines of a layer are displayed in 2D is determined 

individually for each feature, e.g. by using a numeric attribute field. If Off, the symbols 

are not scaled additionally, otherwise the higher the entered value, the larger/wider 

the symbol. 

The following modes can occur: 

o Absolute Size: if displayed, each feature is drawn with the absolute size or width 

that is read from the attribute field entered at Additional Scaling Field (in meters, 

regardless of the map coordinate system).  

o Relative Scaling: if displayed, the size or width the symbols are drawn with is 

calculated by multiplying the original symbol size with the factor that is read from 

the attribute field entered at Additional Scaling Field.  

o Defined Scaling: if displayed, the symbol size is scaled linearly between the 

smallest and biggest found value in the attribute field entered at Additional 

Scaling Field. Features with the smallest value are scaled with factor 1, i.e. are 

displayed with the original symbol size, features with a biggest value with "symbol 

size times Max. Scale Factor" 

Instead of a numeric attribute field in [square brackets], an expression of any comple-

xity in C# syntax can be entered, e.g. if features with different attributes are to be trea-

ted differently or if non-numeric attribute fields are used as source. 

• Additional Rotation: (only for point layers): shows whether the specified point symbol 

is rotated by a certain angle for each feature in 2D (On) or not (Off). If On, the rotation 

angle is read from the attribute field entered at Additional Rotation Field. The speci-

fied angle is interpreted geographically, i.e. 0° = north, 90° = east, etc. 

Instead of a numeric attribute field in [square brackets], an expression of any comple-

xity in C# syntax can be entered, e.g. if features with different attributes are to be trea-

ted differently or if non-numeric attribute fields are used as source. 

• Reference Scale Rendering: if Off, the defined layer symbols and labels are always 

drawn in the specified symbol/text size in the (2D) map viewer, independent of the 
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map scale. If On, the size only applies at the Reference Scale specified below. If you 

change the map scale, symbols and labels are scaled up/down accordingly. 

3D Height Mode 

Only available if the project contains a 3D window 

• Base Height Mode: shows, which heights are used for the vertical location of the fea-

tures in 3D space.  

The following modes can occur: 

o Vertex Z Values: if displayed, the Z-coordinates of the vertices/points are used as 

height. Each vertex/point then has its individual base height. 

o Feature Min Z Value / Feature Max Z Value: if displayed, the smallest/largest Z-

coordinate of each feature is used as its height. Each feature then has its individual 

base height; the individual features lie flat/horizontally in 3D space. 

o Default Value: if displayed, all features are set to the entered Default Height. All 

features then have the same base height. The whole layer lies flat/horizontally in 

3D space. 

o Attribute Value: if displayed, the height to which the features are set is deter-

mined by feature attributes. Each feature then has its individual base height and 

lies flat/horizontally in 3D space.  

The attribute field from which the height is read is entered at Base Height Attri-

bute. Instead of a numeric attribute field in [square brackets], an expression of 

any complexity in C# syntax can be entered, e.g. if features with different attri-

butes are to be treated differently or if non-numeric attribute fields are used as 

height source. Features for which no height value is found are set to the Default 

Height. 

• Height Offset Attribute (only for line and polygon layers): If an attribute field is entered 

here, the value read is added to the vertex Z value. In case of positive values, the 

vertices are then offset upwards by the corresponding value starting from their Z-

coordinate, in case of negative values they are offset downwards. 

Instead of a numeric attribute field in [square brackets], an expression of any com-

plexity in C# syntax can be entered, e.g. if features with different attributes are to be 

treated differently or if non-numeric attribute fields are used as source. 

• Extrusion Height Mode (only for line and polygon layers): If an entry ≠ Off is shown 

here, the features are extruded vertically, i.e. stretched perpendicularly upwards or 
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downwards from the baseline. Vertical extrusion turns lines into (dimensionless) ver-

tical plains and polygons into simple blocks.  

The following modes can occur: 

o Feature Z Range: if displayed, each feature is stretched vertically up from the 

baseline by the difference of its Z-values (i.e. largest Z-coordinate - smallest Z-

coordinate). Each feature then has an individual extrusion height. 

o Default Value: if displayed, all features are stretched by the value entered at 

Default Extrusion Height. All features then have the same extrusion height. 

o Attribute Value: if displayed, the value by which each line is stretched is deter-

mined by feature attributes. Each feature then has an individual extrusion height. 

The attribute field from which the extrusion height is read is entered at Extrusion 

Height Attribute. Instead of a numeric attribute field in [square brackets], an 

expression of any complexity in C# syntax can be entered, e.g. if features with 

different attributes are to be treated differently or if non-numeric attribute fields 

are used as source. Features for which no value is found are stretched by the 

Default Extrusion Height. 

• Extrusion Width Mode (only for line layers): If an entry ≠ Off is shown here, the 

features are extruded horizontally, i.e. stretched/buffered perpendicularly outwards 

from the baseline. Horizontal extrusion turns lines into (dimensionless) horizontal 

planes.  

The following modes can occur: 

o Default Value: if displayed, all features are stretched by the value entered at 

Default Extrusion Width. All features then have the same extrusion width. 

o Attribute Value: if displayed, the value by which each line is stretched is deter-

mined by feature attributes. Each feature then has an individual extrusion height. 

The attribute field from which the extrusion width is read is entered at Extrusion 

Width Attribute. Instead of a numeric attribute field in [square brackets], an ex-

pression of any complexity in C# syntax can be entered, e.g. if features with diffe-

rent attributes are to be treated differently or if non-numeric attribute fields are 

used as source. Features for which no value is found are stretched by the Default 

Extrusion Width. 

Lines can be extruded both vertically and horizontally. If this is the case, they are displayed 

(like vertically extruded polygons) as three-dimensional objects. 
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3D Symbology 

Only available if the project contains a 3D window 

• (Other) 3D Point Symbol (only for point layers and points): shows the symbol with 

which the points are drawn in the 3D viewer. The symbol can be a simple solid (e.g. 

sphere, cylinder, pyramid, etc.) or a 3D model of any complexity. 

• (Other) 3D Line Symbol (only for line layers and lines): shows the symbol with which 

the lines are drawn in the 3D viewer. The symbol can be a simple line with a width of 

one pixel or a three-dimensional tube. 

• (Other) 3D Top Material (only for polygon layers and horizontally extruded line layers): 

shows with which surface material the top faces of the polygons or horizontally 

extruded lines are visualized in the 3D viewer. Available are simple colors or image 

textures as well as complex material textures. 

By default, the selected top material is applied to the top surfaces of all features with 

an alignment due north. Via Align Top Material Mode, it can be aligned individually for 

each feature according to an attribute field, expression, and/or the first line segment 

of the feature geometry. 

• (Other) 3D Side Material (only for polygon layers and horizontally extruded line layers): 

shows with which surface material the side faces of the extruded polygons or lines are 

visualized in the 3D viewer. Available are simple colors or image textures as well as 

complex material textures. 

Please note: For the renderer types Unique Value and Class Breaks (see above), the symbol 

/material is set individually for each value/class. The symbol/material indicated here is then 

only valid for "other" values. 

• Additional Scaling (only for point layers and points as well as line layers and lines): 

Here, up to three attribute fields can be specified, which contain either an absolute 

size or a scaling factor in X, Y, and/or Z direction for each feature. The length, width, 

and/or height of the set 3D point/line symbol is then brought to the read-out (abso-

lute) size for each feature or multiplied by the entered scaling factor. 

The following modes can occur: 

o Off: if displayed, the symbol is not scaled additionally. 

o Relative Scaling: if displayed, the points or lines are scaled by a certain factor. The 

scaling factor is read from an attribute field for each feature. The individual point 

size or line width is then obtained by multiplying the original symbol size by the 

scaling factor. 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  284 

Lines are always scaled in one direction only (in width), for points the scaling factor 

is set separately in X, Y, and Z direction. 

The attribute field from which the scaling factor is read is entered at Scale (X/Y/Z) 

Attribute. Instead of a numeric attribute field in [square brackets], an expression 

of any complexity in C# syntax can be entered, e.g. if features with different 

attributes are to be treated differently or if non-numeric attribute fields are used 

as source.  

o Absolute Height (only for points): if displayed, the set 3D point symbol is indi-

vidually enlarged or reduced for each feature so that it is displayed with a certain 

absolute height. The original aspect ratio of the 3D point symbol is retained. The 

absolute height is read from an attribute field. 

The attribute field from which the scaling factor is read is entered at Size Z Attri-

bute. Instead of a numeric attribute field in [square brackets], an expression of 

any complexity in C# syntax can be entered, e.g. if features with different attri-

butes are to be treated differently or if non-numeric attribute fields are used as 

source.  

The unit in which the height is measured is specified at Absolute Unit. 

o Absolute Size (only for points): if displayed, the set 3D point symbol is individually 

enlarged or reduced for each feature so that it is displayed with a certain absolute 

length, width, and/or height. The original aspect ratio of the 3D point symbol is 

usually not retained, as the symbol is brought to an absolute size in X, Y, and Z 

direction, and therefore usually has to be compressed or stretched. The target size 

in X-/Y-/Z-direction is read from an attribute field or determined by an expression 

(analogous to Absolute Height). 

• Additional Rotation (only for points): Here, up to three attribute fields can be specified, 

which contain a rotation angle around the X, Y, and/or Z axis for each feature. The set 

3D point symbol is then rotated by the entered value for each feature on the corres-

ponding axes. 

The angle for the rotation around the X/Y/Z axis is read from the attribute fields speci-

fied at Rotate X/Y/Z Attribute. If no attribute field is specified for an axis, the original 

rotation angle is applied there. 

Instead of numeric attribute fields in [square brackets], expressions of any complexity 

in C# syntax can be entered, e.g. if features with different attributes are to be treated 

differently or if non-numeric attribute fields are used as source. 

• Draw Lines (only for polygon and extruded line layers): if On, the polygon outlines are 

drawn or, in case of horizontally extruded lines, additional (center) lines (both as 3D 
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lines). For vertically extruded polygons/lines, outlines/lines are drawn both at the top 

and at the bottom; alternatively, the outlines/lines can be displayed at the Top Only 

or the Bottom Only. 

For the enabled lines, the same properties are available under category 3D Symbology 

as for non-extruded line layers. 

• Draw Points (only for line and polygon layers): If On, the vertices of the polygons or 

lines are drawn (as 3D points). For vertically extruded polygons/lines, the vertices are 

drawn both at the top and at the bottom; alternatively, they can be displayed at the 

Top Only or the Bottom Only. 

For the enabled vertices/points, the same properties are available under category 3D 

Symbology as for point layers. 

3D Labeling 

Only available if the project contains a 3D window 

• Show 3D Label: if On, the features are labeled in the 3D viewer. The label text is read 

from the Label Field under category Labeling (see above). 

The following applies to the display of the labels in the 3D viewer: 

o The style of the 3D labels / label boards is indicated at 3D Labeling, the style of the 

text on the board corresponds to that of the 2D labels (see category Labeling 

above). 

o The label boards are always anchored centrally to the features (horizontally and 

vertically). Note that a label may not be visible if the associated feature lies far 

above/below the DEM. 

o For the renderer types Unique Value and Class Breaks (see above), the 3D labeling 

style can be set individually for each value/class. The 3D labeling style indicated 

here is then only valid for "other" values. 

• Label Priority Expression (only relevant if in the Map properties Prevent Overlaps = On; 

see chapter 5.1.7): By default, the label that is actually covered, i.e. the one that is 

further away from the current viewing position, is hidden if 3D labels overlap. This 

applies both within a layer and across layers. If certain labels are to be displayed prefer-

entially, this can be forced by using Label Priority. If 3D labels with different label 

priority overlap, the label with lower priority is always hidden, even if it is in front. 

By default, all 3D labels have priority 0. If a larger/smaller value is entered, the label is 

prioritized higher or lower accordingly. 

For vector layers, instead of a number an expression of any complexity in C# syntax can 

be entered, e.g. if features with different attributes are to be prioritized differently. 
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Shadows/View Obstruction 

Only available if the project contains a 3D window 

• Shadows/View Obstruction: If On, this layer casts shadows and it is considered as view 

obstruction when calculating an on-the-fly viewshed in the 3D viewer.  

Note that layers for which Shadows/View Obstruction is disabled do not participate in 

the shadow and 3D viewshed at all. This means that they are not only not considered 

as light or view obstruction, but they also neither reflect shadows cast by other objects 

nor the result of the 3D viewshed. 

For more information on shadows and 3D viewshed, see chapter 4.6.5 et seq. 

Timeline 

• Use for Time Line: shows whether the layer is enabled for the time line (see chapter 

4.4.5) (On) or not (Off). If On, further properties about for specified Time Stamp are 

shown. 

• Time Stamp Type: specifies where/how the time information is stored. Possible are 

Attribute or Layer: 

o Attribute: The time information is stored in an attribute field separately for each 

feature. When operating the time line, the features of the layer is shown in chro-

nologically order according to their time attribute. Time Stamp Field shows, from 

with attribute field the time information ist taken. 

o Layer: A fixed Time Stamp is set for the entire vector layer. When operating the 

time line, the whole layer is shown when this time stamp is reached. 

Please note that all times are interpreted as UTC as long as no other information is 

stored (in the dataset). 

 

5.3.3 Raster Layer 

In GAFmap Express: TOC > Layer 

 A Raster Layer is a layer (see chapter 5.3) that links to a raster 

dataset. For raster datassets, the (image) information is stored in a matrix, i.e. in a regular grid 
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of rows and columns; each grid cell (= pixel) is given an individual numerical value, which is 

used for the visualization of the raster on the screen. 

Typical examples of raster data are: 

• scanned/digital (landscape) maps  

• digital imagery of any kind, e.g. aerial or satellite images.  

Here, the pixel values represent reflected or emitted radiation values recorded in a 

specific spectral range. 

• digital elevation models (DEMs) or other gradient rasters (e.g. for temperature, atmos-

pheric pressure, population density, etc.). 

Here, the pixel values represent a certain quantity that changes continuously or gradu-

ally over a certain area, e.g. terrain elevation, temperature, population density, etc. 

• classification rasters, which e.g. show the land use or soil types and that resulted e.g. 

from analysis/processing of other raster or vector data. 

Here, each pixel value represents a certain unique value / a certain category, e.g. a land 

use class or a soil type. 

The position of each pixel inside the raster is defined by the row and column in which it is 

located. The raster forms a cartesian coordinate system with the rows parallel to the X-axis 

and the columns parallel to the Y-axis; the origin is located in the bottom left corner. Row and 

column width, i.e. width and height of the pixels, are stored in the dataset (= resolution in X/Y 

direction). 

Geographically, rasters are located by control points whose position coordinates are known 

and which can be uniquely identified in the raster. The position of georeferenced rasters is 

defined by edge coordinates (= X/Y Min/Max), starting from the bottom left corner. 

The value of individual pixels can e.g. be queried with Pixel Info (see chapter 4.1.12). 

Single and multi-channel rasters 

Raster datasets can have one or multiple channels / raster bands.  

•  Single-channel rasters contain exactly one numeric value matrix. Typical examples 

are black and white images of all kind as e.g. panchromatic aerial or satellite imagery, 

gradient rasters as e.g. DEMs, and classification rasters.  

•  Multi-channel rasters contain multiple layers of congruent and identically con-

structed numeric value matrices. This allows multiple values to be assigned to each 

pixel, e.g. one radiation value each in the red, green, and blue spectral range. Many 
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satellite images have multiple bands, each representing a particular part of the electro-

magnetic spectrum. 

Rasters can have any number of channels / raster bands, but only up to four channels 

can be used for the visualization at once (3 colour bands + 1 alpha band; see Band 

Mapping, chapter 5.3.3.6).  

Basic Raster Properties 

Besides the number of the channels/bands, rasters are basically defined by the following 

properties: 

• The size of the pixels defines the resolution of the raster: the smaller, the higher the 

resolution / detail of the (image) content.  

• The pixel type (the bit number) defines the possible value range of the pixels (e.g. bi-

nary, integer, or floating point numbers): the bigger, the bigger / more precise the 

value range. It also determines whether only positive or also negative values are pos-

sible (signed/unsigned). 

If the raster contains areas for which no data is available (= NoData areas), e.g. at the edge 

due to the rectangular shape, these are marked with the NoData value and drawn fully trans-

parent by default.  

All parameters mentioned are stored directly in the dataset. For more information on the 

raster properties, see chapter 5.3.3.6. 

Raster Pyramids - Special Features / Method in GAFmap® 

For performance reasons, GAFmap® always works with pyramids for rasters above a certain 

size, regardless of whether they physically exist or not. Pyramid level 1 always has half the 

resolution of level 0 (= full resolution), level 2 has half the resolution of level 1, etc. Pyramids 

are created up to the level at which both edge lengths are smaller than the block size, i.e. 

usually 256 pixels (depending on the pixel type). Usually, pyramids are created/calculated in 

GAFmap® as soon as one raster edge exceeds 3602 pixels. 

Physically existing pyramid levels can usually be used directly. If ( single) levels are missing, 

they are calculated on-the-fly from the next higher existing level (in the last instance from the 

full resolution). On-the-fly pyramids are also used in special cases where physically existing 

pyramid levels are not created with a resolution factor of 2. 

Physically existing pyramid levels are shown in the raster properties under Metadata (see 

chapter 5.3.3.6). Please note that the numbering of the pyramid levels in GAFmap® does not 
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necessarily match the physically existing ones for the above-mentioned reason (e.g. if level 1 

does not exist). 

Context Menu 

Right-clicking on one or multiple selected raster layer(s) in the TOC opens the raster layer 

context menu. In the following, only the functions that appear exclusively in the context menu 

of raster layers/groups are explained. For (general) functions that are available for all layers 

and layer groups irrespective of their type, see chapter 5.3.1. 

 

5.3.3.1 Zoom to Actual Pixels (Full Raster) 

In GAFmap Express: TOC  > Layer > Context Menu Raster Layer  

 Zoom to Actual Pixels (Full Raster) zooms the map to the scale at which the raster's pixels 

are displayed 1:1 on the screen. This results in the raster dataset to be displayed with the best 

possible resolution on the screen. Interpolation artefacts are avoided, the drawing speed is 

increased. 

Shortcuts, Key Commands, etc.: 

• Ctrl when starting the command: zooms the map to the upper left corner of the data-

set. 

Tips and notes: 

• If a raster has a pixel size of 1 m, it is displayed with a scale of 1 : 3,780 at full resolution. 

In the calculation, a screen resolution of 96 dpi at 100% DPI scaling under Windows is 

presumed (0.0254:96 corresponds to approx. 1:3780). 

 

5.3.3.2 Zoom to Current Pyramid Level (x) 

In GAFmap Express: TOC  > Layer > Context Menu Raster Layer  

 Zoom to Current Pyramid Level (x) zooms the map to the scale at which the pixels of the 

nearest pyramid level (shown in brackets) are displayed 1:1 on the screen. This results in the 

respective raster pyramid to be displayed with the best possible resolution on the screen. 

Interpolation artefacts are avoided, the drawing speed is increased. 
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The command is only available if the raster has different pyramid levels and if the nearest 

pyramid level is not level 0 (= full resolution). 

Shortcuts, Key Commands, etc.: 

• Ctrl when starting the command: zooms the map to the upper left corner of the data-

set. 

 

5.3.3.3 Zoom to Specified Pyramid Level 

In GAFmap Express: TOC  > Layer > Context Menu Raster Layer  

 Zoom to Specific Pyramid Level zooms the map to the scale at which a specific pyramid 

level of the raster is displayed in the best possible resolution. The pyramid level to be displayed 

is queried after calling up the command: 

 

Figure 159: Dialog Pyramid Level 

Enter the desired pyramid level and confirm with OK. If you enter a non-existent level, the 

map is zoomed to the nearest existing level. 

Please note that the pyramid levels in GAFmap® can differ from any physically existing pyramid 

levels. In GAFmap® , pyramid level 1 always has half the resolution of level 0 (= full resolution), 

level 2 has half the resolution of level 1, etc. For more information, see chapter 5.3.3. 

Tips and Notes: 

• If a very low Pyramid Level Quality is used (see chapter 5.3.3.6) this command is not 

usable and therefore grayed out. 
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5.3.3.4 Download TMS Cache 

In GAFmap Express: TOC  > Layer > Context Menu Raster Layer  

Only available for WMS, TMS or WMTS raster layers 

Download TMS Cache lets you download data of the web service for a selected area, store it 

locally, and thus make it available offline for later purposes.  

 

Figure 160: Dialog Download TMS Cache 

• TMS Level: specifies the zoom/pyramid level the tiles are to be downloaded for. 0 

represents the highest resolution. All tiles of zoom levels with a lower resolution are 

downloaded as well. 

• Cell Size: shows the cell size of the raster in the selected level. The unit of the given 

value depends on the layer's spatial reference. 

• Extent: Here, you can limit the area for which the map tiles are downloaded by drag-

ging a rectangle, manually entering the outermost coordinates, drawing a polygone (= 

extent of this polygon), or selecting a  layer (= extent of this layer). The downloaded 

dataset then contains all map tiles that intersect the defined rectangle. Preentered is 

the extent of the extent currently visible in the map viewer. If the map service does 

not cover the set area, the entire extent of the service is used instead. 

• Tile Count: shows how many tiles are downloaded based on the current settings. 
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• Raster Size: shows the resulting number of pixels for the specified area and TMS level. 

OK starts the download. The data is stored as tiles in the Temp Directory (see chapter 3.4.1.8). 

 

5.3.3.5 Show Histogram 

In GAFmap Express: TOC  > Layer > Context Menu Raster Layer  

 Show Histogram lets you display the histogram of the raster, i.e. a graphical represen-

tation of the pixel value distribution, per raster band.  

 

Figure 161: Histogram window 
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In the dialog, the histograms of all loaded raster bands are displayed below each other. The 

following can be seen:  

• In the Diagram Field: the distribution of the original pixel values (light blue curve) 

The X-axis represents the pixel values of the raster. For the histogram, the values are 

classified equidistantly, i.e. columns/bins of equal width are formed. The height of a 

column indicates how many pixels fall into these value classes (Y-axis). 

• Below the Diagram Field: the Band Statistics  

o Mean: mean value 

o StdDev: standard deviation 

o Min/Max: minimum/maximum value 

o NoData-Count: count of NoData values 

• Above the Diagram Field: the values at the current mouse position in the histogram.  

o Value: value range of the class / bin at the current mouse position  

o Count: the number of pixels that fall into this class / bin  

If Cumulativ is checked, the pixels are added up. I.e. not the absolute number of pixels per 

value class/bin are displayed, as described above, but the number of pixels up to a certain 

value. 

You can adjust the display of the histogram in the toolbar at the top of the dialog: 

•        adjust the visible extent. Alternatively, you can use the 

common shortcuts to adjust the visible extent (see chapter 4.1.3 et seqq.). 

•    Increase/Decrease/Define Width: compressing/extending the X-axis in 

steps or to a certain value range. 

•    Increase/Decrease Exaggeration 

•    Increase/Reduce the height for all diagram fields  

Tips and notes: 

• Special case mosaic layer (see chapter 5.3.6): note that for the histogram of a mosaic 

layer only activated rasters within the mosaic layer are considered (i.e. those checked 

in the TOC). Not activated rasters are not considered. 
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5.3.3.6 Properties 

In GAFmap Express: TOC  > Layer > Context Menu Raster Layer  

 Via Properties you reach the Properties window where all essential properties of the se-

lected raster layer are listed.  

For raster layers, the properties are in general read-only (i.e. all properties are grayed out). 

In the following, all properties of raster layers are listed. Which properties are actually dis-

played depends significantly on the underlying dataset and whether the project contains a 

(2D) map viewer and/or a 3D viewer. If multiple layers are selected, only properties available 

for all selected layers are displayed (common properties).  

Source 

• Width/Height: shows the number of columns/rows. 

• Cell Size X/Y: shows the width/height of the pixels in the layer spatial reference. For a 

geographic coordinate system like WGS84 the relation is: 1 = 1°. For a metric coordi-

nate system like UTM the relation is: 1 = 1m. 

• Band Count: shows the number of bands available. In case the layer has two or more 

bands they can be combined individually for the raster's representation (see below 

Band Mapping). 

• Pixel Type: shows the bit depth of the raster. 

• NoData Value: shows the raster value representing areas without valid data. 

• On-the-fly Projection: shows whether the dataset is reprojected on-the-fly (i.e. tempo-

rarily in the background) in the map viewer (On) or not (Off). A reprojection is neces-

sary if the layer spatial reference differs from the map spatial reference. 

• Spatial Reference: shows the layer spatial reference. 

 opens a window with detailed information on the layer spatial reference  

• Metadata: shows further meta information, mainly information that is stored in the 

dataset itself (e.g. in the header or enclosed XMLs, e.g. DMAP XMLs).  

Which information is shown depends on the dataset. Possible are e.g.: resolution, phy-

sical pyramid level, date of creation, type of compression, block size, etc. 

 opens the Metadata window 

• Layer Info: : if available, additional information about the layer can be viewed here 

(e.g. a legend, the data source, other metadata, etc.) 
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 opens the Layer Info window 

If a layer info is entered, it can alternatively be called up via Show Layer Info command 

in the layer context menu (see chapter 5.3.1.7); texts with HTML syntax are then usu-

ally displayed formatted (here always as source text). 

Extent 

• X/Y Min and X/Y Max: shows the extent of the raster in the set map coordinate system.  

Scale Range 

• Scale Range: determines whether a raster layer activated in the TOC is only displayed 

in the map viewer if the zoom level of the map is within a certain scale range (On) or 

always, regardless of the zoom level (Off). 

If On, you can specify the valid scale range, i.e. the desired lower/upper limit, under 

Min. Scale / Max. Scale. 

If the raster layer is used as a texture in the 3D viewer, it is only displayed within the 

valid scale range. The reference is then the Texture Map Scale (see chapter 5.3.4.1). 

Band Mapping 

Only available for multi-channel rasters 

• Red/Green/Blue/Alpha Channel: shows which raster bands are used for dislaying the 

raster. 

Symbology 

• Transparency [%]: shows the degree of transparency the layer is displayed with in the 

map viewer (0 = non-transparent/opaque, 100 = fully transparent/invisible). 

• Renderer Type: shows the method with which the pixels of a raster are rendered 

according to their values, i.e. according to which logic a raster is visualized. Possible 

are: 

o Direct: if displayed, the original pixel values of the raster are used for visualization 

and are distributed over the 8-bit value range of the screen. For single-channel 

rasters, you obtain a black/white image; the value of a pixel directly determines 

its gray-scale value. For multi-channel rasters, a composite color image is created 

(e.g. RGB or NRG).  

o Color Ramp: if displayed, a predefined color ramp is used to visualize the raster. 

The result is an image with a continuous color gradient from the lowest to the 

highest pixel value.  
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The color ramp including the smallest and largest value is also displayed in the TOC 

when the raster layer is expanded: 

 

o Class Breaks: if displayed, the raster pixels are grouped into the number of value 

classes displayed at Class Breaks and are then usually visualized with a predefined 

color ramp. The result is an image with graduated colors from the lowest to the 

highest pixel value. Alternatively, each class can be assigned an individual color.  

The individual classes are displayed in the TOC when the raster layer is expanded: 

 

o Unique Value: if displayed, each pixel value of the raster is assigned an individual 

color. This mode is usually only used for classification rasters.  

The unique values are displayed in the TOC when the raster layer is expanded: 

 

o Contour Levels: this renderer type is designed for the visualization of digital 

elevation models (DEMs). It corresponds to the renderer type Class Breaks (see 

above), with the difference that predefined height classes are used. 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  297 

o Slope Levels: this renderer type is designed for the visualization of digital elevation 

models (DEMs). If displayed, the (terrain) slope [%] of each raster pixel is calcu-

lated in the background. The calculated slope values are then grouped into slope 

classes (see Class Breaks above). 

• Stretch Type (only available if Renderer Type = Direct or Color Ramp): shows if and how 

a raster is stretched to the 8bit value range of the screen. Possible are: 

o None: if displayed, no stretching is applied. The pixel values of the raster are used 

directly for the display on the screen. Pixel values that are not within the 8bit range 

are clamped to these values for screen display ("clamp"), i.e. negative pixel values 

are set to 0, values > 255 to 255. 

o Standard Deviation: if displayed, the standard deviation of all pixel values of the 

raster is determined to determine the limits for stretching excluding extreme 

values. Within this interval, the values are then stretched linear. Pixel values which 

are below or above the interval, are displayed as 0 or 255. If the limit values are 

below/above the minimum/maximum, the minimum/maximum is used as the 

limit value.  

Additionally the sub-properties Standard Deviation Factor, Gamma and Stretch 

Statistics Type are displayed. 

o MinMax: if displayed, the lowest or highest pixel value of the raster is used as 

lower and upper limit for the stretch, linear interpolation is performed inbetween. 

Additionally the sub-properties Gamma and Stretch Statistics Type are displayed. 

o Custom: if displayed, an individual transfer function is used for the stretch.  

• Background Value: here, a particular raster value can be set as background value for a 

raster layer (usually only relevant if the NoData value is not or incorrectly set). All pixels 

with a Background Value +- the Background Tolerance are then displayed with the 

NoData Color (usually fully transparent, see below).  

• NoData Color: shows the color used for NoData pixel and/or pixels with Background 

Value +- Background Tolerance (usually fully transparent). 

• Interpolation Mode: shows the interpolation method used for drawing the raster layer 

on the screen.  

• Use Dynamic Pyramid Levels (only for on-the-fly projected rasters (see above) and only 

relevant for very large rasters, e.g. worldwide TMS): shows whether the pyramid level 

to be used is determined dynamically, i.e. individually for each tile of the target raster 

(On), or once for the entire target raster (Off).  
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Using dynamic pyramid levels reduces the amount of (downloaded) data and signifi-

cantly increases the performance when displaying the raster, but can lead to breaks in 

content if the content of the raster pyramids is not the same. 

• Pyramid Level Quality: shows at which priority the available pyramid levels are used 

for rendering the current display of the raster layer. Available are:  

o High: the raster's visualization is always downsampled from the higher resolution 

pyramid level (best resolution but can be slow). 

o Normal: the visualization is usually downsampled from the higher resolution pyra-

mid level. However, the lower level is upsampled if the scale is close to that level. 

o Low: the visualization is always upsampled from the lower resolution pyramid 

level. 

o Very Low: the visualization is usually upsampled from the lower resolution pyra-

mid level. However, if the scale approaches that level, the next lower level is used 

(resolution is correspondingly worse, but very performant). 

• Minimal Pyramid Level: shows which pyramid level of the raster is displayed at best. 

At 0 the raster is displayed in full resolution (if the scale is high enough), at 1 at best 

the first pyramid level, at 2 the second, etc. 

• Selection Line: defines with which line symbol a raster is framed/highlighted in the 

map viewer if it is selected (highlighted in blue) in the TOC. 

• Use Specific Diagram Symbol: if On, the spectral curve of the raster in the spectral 

diagram (see chapter 4.4.5) is always plotted with the line symbol shown at Specific 

Diagram Symbol. If Off, a default line symbol is used; the color of the line/curve chan-

ges with each click into the raster. 

RPC 

Only visible for raster layers with RPC parameters 

• Use RPC: if On, the RPC parameters are used for the on-the-fly orthorectification. 

• DEM: A digital elevation model specified here is used for the RPC based orthorecti-

fication in order to additionally eliminate the terrain's effect on the exact location of 

the satellite data. 

• DEM is geoidal: if On, the heights of the elevation model are converted from geoidal 

to ellipsoidal. If Off, the (ellipsoidal) heights are used directly. 

• Line Shift/Row Shift: If values ≠ 0 are entered here, the raster is shifted on-the-fly by 

the corresponding number of pixels in X/Y direction. This may be necessary, for 

example, to improve the absolute position of the raster or its position relative to the 

DEM and/or the relative position of the raster to other (raster) data. 
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 Rasters with RPC parameters can be identified in the TOC by the R above the raster 

icon. 

For more information on raster with RPC parameters ("RPC Textures"), see chapter 5.3.5. 

DEM 

Only available for single-channel raster layers 

• Use as DEM: if On, the raster is marked as digital elevation model ("DEM"); its pixel 

values are the interpreted as (terrain) heights. 

  Raster layers marked as DEM are represented with the DEM symbol in the TOC. 

DEMs are used as height sources for various functions, e.g. for Create Profil (see chap-

ter 4.1.14) or for a Viewshed (see chapter 4.5.6). 

If multiple single-channel rasters are marked as DEMs, they are virtually mosaicked to 

form a (continuous) base DEM/terrain (see chapter 5.3.4). 

If Off, the raster is not interpreted as DEM, but as (black and white) image. 

 Single-channel rasters not marked as DEM (incl. 3D surfaces) can be recognized in 

the TOC by the simple b/w raster symbol. 

• Use As 3D Surface (only if the project contains a 3D window and if Use as DEM  = Off): 

if On, the raster is not interpreted as DEM, but recognized as elevation model in the 

3D Viwer and displayed as 3D surface (independent from the base terrain). If Off, the 

raster is not interpreted as an elevation model even in 3D. 

For more information on digital elevation models and special 3D properties only available 

for DEMs and 3D surfaces, see chapter 5.3.4. 

Common DEM Texture 

Only for DEMs and if the project contains a 3D window 

For information on the properties in this category, see chapter 5.3.4. 

Common DEM Properties / 3D Surfaces Properties 

Only for DEMs or 3D surfaces and if the project contains a 3D window 

For information on the properties in this category, see chapter 5.3.4. 

GCPs 

Only available for rasters with stored GCPs (Ground Control Points)  
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• Has GCPs = On indicates that GCPs (= Ground Control Points) are stored in the dataset 

for the raster layer. These are then automatically used for a georeferenced screen 

display (i.e. for on-the-fly georeferencing).  

TMS Caching 

Only for WMS-, WMTS, or TMS 

• Use TMS Caching: if On, the tiles required for the currently displayed map section are 

downloaded and saved in the temporary TMS directory (see chapter 3.4.1.8). If a 

cached map section is called up again, the data is no longer requested from the server 

each time, but is taken directly from the directory and displayed. Only tiles that are 

called up for the first time are then loaded from the server. This usually results in a 

better performance when displaying web services.  

If Off, the data is not cached. 

• Use Offline Mode: if On, data is prevented from being requested from the server. In 

this case only already cached data will be displayed. 

WMS Rendering 

Only for WMS-, WMTS or TMS 

• Prefer Direct WMS Mode: if On, the direct WMS mode is used whenever possible. In 

direct mode, a separate request is sent to the server for each map extent, exactly for 

the current extent with the current resolution. If Off or if direct mode is not possible, 

tile by tile a fix raster/pyramid structure is filled/retrieved. 

Timeline 

• Use for Time Line: shows whether the layer is enabled for the time line (see chapter 

4.4.5) (On) or not (Off). If On, further properties about for specified Time Stamp are 

shown: 

• Time Stamp Type: shows the format the time information is available in. 

o Layer: A fixed Time Stamp is set for the entire raster layer. When operating the 

time line, the layer is shown when this time stamp is reached. 

o Band: A time stamp is assigned to each raster band individually. At Time Stamp, 

the time stamp for band 1 is shown. For all other bands, it is determined auto-

matically with a constant time interval. The time interval is specified at Band Time 

Interval and Band Time Interval Unit. When operating the time line, the raster 

bands are shown one after the other in ascending order with this time interval. 
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o Source: The time information is stored in a (non-visible) source file. The layer or 

bands are then displayed during the timeline animation according to the time in-

formation stored there.  

Please note that all times are interpreted as UTC as long as no other information is 

stored (in the dataset). 

 

5.3.4 Raster Layer - Special Case "Digital Elevation Models" 

In GAFmap Express: TOC > Layer 

A digital elevation model is a single-channel raster in which each pixel represents a specific 

height. In 3D, this height information can be used directly for a 2.5D display of the raster: 

 

Figure 162: Digital Elevation Model - (2D) map viewer (left) and 3D Viewer (right) 

For a single-channel raster to be interpreted as digital elevation model in GAFmap®, it has to 

be marked as DEM or 3D surface (see also chapter 5.3.4.1): 

• If the raster property Use as DEM is On, a single-channel raster serves as the DEM. The 

pixel values are then interpreted as (terrain) heights. 

 Raster layers marked as DEM are represented with the DEM symbol in the TOC. 

DEMs serve as a height source for various functions, e.g. for various on-the-fly analysis 

functions such as a Viewshed (see chapter 4.5.6) or Create Profil (see chapter 4.1.14). 

Any number of single-channel rasters can be marked as DEMs. The individual DEMs are 

then virtually mosaicked in the background. If DEMs border on each other without gaps 

or overlap, a continuous DEM mosaic is created (= "base DEM" or "base terrain"). In 
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case of overlaps, the sorting of the rasters in the TOC is decisive: the height information 

is always derived from the raster on top in the TOC; NoData areas are excluded. 

! In 2D, always all DEMs are included, i.e. regardless of whether they are checked in 

the TOC and therefore visible in the map viewer or not. In 3D, only those DEMs that 

are checked in the TOC are included. 

In 2D, you can see/check the base DEM if you uncheck the Map in the TOC and then 

enable the on-the-fly lighting/shading (see chapter 4.5.4): 

 

Figure 163: 2D base DEM 

 Single-channel rasters not marked as DEM (incl. 3D surfaces) can be recognized in 

the TOC by the simple b/w raster symbol. 

• If the raster property Use As 3D Surface is On (only possible if the project contains a 

3D window and if Use as DEM  = Off), a single-channel raster is also recognized as digital 

elevation model. However, it does not serve as a height source for other functions then 

and is always considered "individually", i.e. it is not integrated into the DEM mosaic. 

This makes it possible, for example, to compare different digital elevation models in 

the 3D viewer. 
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Context Menu 

 A right-click on one or multiple selected digital elevation models in the TOC 

opens the respective context menu. The context menu of a digital elevation model corres-

ponds to that of a "normal" raster layer. Only if the project contains a 3D window, the pro-

perties have special 3D features. Information on all functions in a DEMs context menu and 

non-3D-specific properties can be found in chapter 5.3.1 et seqq. (for across layers) or chapter 

5.3.3 et seqq. (for raster specific). 

 

5.3.4.1 Properties 

In GAFmap Express: TOC > Layer > Context Menu Raster Layer - Special Case "Digital Elevation Models" 

 Via Properties you reach the Properties window where all essential properties of the 

selected digital elevation model are listed. They correspond in large parts to those of a simple 

raster layer (see chapter 5.3.3.6). In the following, only properties are listed that are displayed 

only for digital elevation models, i.e. for bei DEMs and 3D Surfaces. All of these properties are 

only visible if the project contains a 3D window and refer exclusively to the 3D viewer. 

For general information on digital elevation models, i.e. DEMs and 3D surfaces, see chapter 

5.3.4. 

Common DEM Texture 

Only for DEMs and if the project contains a 3D window 

All properties under this category exclusively refer to the 3D viewer. 

• (Auto) Texture Resolution: The Texture Resolution defines the resolution [m] with 

which textures placed in the DEM are displayed in the 3D viewer. If Auto Texture Re-

solution is On, it is determined dynamically and optimally in terms of quality, perfor-

mance, and memory consumption; if it is Off, the displayed texture resolution is fixed. 

• Symbol Scale: shows the factor with which the symbols, that are defined for the (2D) 

visualization of vector geometries, are scaled in the 3D viewer when they used are 

there as texture. 

Note: the (2D) symbol size of vector geometries is given in pixels (see chapter 5.2.1.10 

or 5.3.2.5). In the 3D viewer, the size refers to the texture pixels. The size/width of the 

symbols therefore depends directly on the Texture Resolution. 

• Texture Map Scale: shows the current texture map scale, i.e. the "reference scale" in 

2D. This information is relevant, for example, if the Scale Range in which a layer is 
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displayed is restricted (see e.g. chapter 5.2.1.10, 5.3.2.5, or 5.3.3.6) or, if vector textu-

res are used, for the symbol size/width. 

• Draw Selection: shows whether features are only highlighted in the (2D) map viewer 

(Off) or the feature selection is also drawn in the 3D viewer (On) if vector layers are 

used as texture.  

Features that are displayed as 3D objects are always highlighted in the 3D viewer if 

they are selected, i.e. independent off this property. 

For information on the difference between 3D data/objects and textures, see chapter 

2.2.3.2. 

• Combine Texture: shows whether areas of the DEM that are loaded but are not co-

vered by the texture are displayed in the 3D viewer (On) or not (Off). If On, all loaded 

areas of the DEM are fully displayed independent of the activation status of the 

textures. If textures cover parts of the DEM, the DEM is combined with and without 

texture. If Off, the DEM itself is only displayed if no texture is activated. As soon as one 

ore more textures are checked in the TOC, only the texture "with terrain" can be seen 

in the 3D viewer. 

 

Figure 164: Combine Textures = On (left) and Off (right). 

• Only Show one RPC Texture (only visible if at least 2 RPC textures are activated): shows 

the rendering method that is used to texture the DEM:  

If Off, for each pixel of the DEM, i.e. for each screen pixel of the 3D viewer, the best 

RPC texture is determined on-the-fly by comparing the acquisition angles of the images 

and the slope of the terrain. The contents of the individual images are then mixed 

accordingly. 

If On, the DEM is always textured with a single raster, using the one whose acquisition 

angle best fits the current viewing angle. If the viewing angle changes sufficiently, the 

displayed texture switches. 

For general information on RPC textures, see chapter 5.3.5. 
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• Top Texture Threshold (only visible if at least two (RPC) textures are activated and Only 

Show one RPC Texture = Off): shows up to which terrain slope the Top Texture is drawn.  

For general information on RPC Textures, see chapter 5.3.5. 

Common DEM Settings 

Only for DEMs and if the project contains a 3D window 

All properties under this category refer to the display of the virtual DEM mosaic in the 3D 

viewer, i.e. they are the same for all loaded DEMs. They all refer exclusively to the 3D vie-

wer. 

You can find the same properties in the category 3D Surface Settings. They then always 

refer to a single 3D surface only. 

• Shading: shows whether the DEM is displayed shaded (On) or not (Off). If On, areas 

facing the light appear lighter and areas not facing the light appear darker. This creates 

a plastic impression. 

The virtual light source is specified for the entire scene in the Map properties (see 

chapter 5.1.7). 

A shading for DEMs can also be turned on/off via the button Enable/Disable DEM 

Shading in the 3D Viewer toolbar (see chapter 4.6.4). 

• Contrast: shows the brightness contrast in the elevation model, i.e. the difference bet-

ween the brightest and the darkest point. The higher the value, the higher the contrast. 

• Roughness: shows the roughness the elevation model is displayed with. The higher the 

value, the duller and rougher the surface looks. 

• Metallic: shows how metallic the surface of the DEM is displayed. The higher the value, 

the more clearly it "reflects" for example the sky. 

• Shadows/View Obstruction: if On, the elevation model casts shadows and it is con-

sidered as view obstruction when calculating an on-the-fly viewshed in the 3D viewer. 

Note that layers for which Shadows/View Obstruction is disabled do not participate in 

the shadow and 3D viewshed at all. This means that they are not only not considered 

as light or view obstruction, but they also neither reflect shadows cast by other objects 

nor the result of the 3D viewshed. 

For more information on shadows and 3D viewshed, see chapters 4.6.5 or 4.6.6. 
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• Color Mode: shows which method is used to colorize the DEM in the 3D viewer. Pos-

sible are: 

o Konstante Farbe: if displayed, the DEM is displayed single-colored. The color used 

is shown at Color. 

Especially for this setting, it is recommended to enable Shading for the DEM (see 

chapter 4.6.4), as otherwise, the terrain is hardly visible. 

o Color Ramp: if displayed, the DEM is displayed with a color ramp. The color ramp 

used is defined under Color Ramp. 

If Use Custom Transfer Function is set to On, a Stretch Function for the color ramp 

has been defined when creating the project.  

The property Color Mode is hidden if the DEM is not visible because it is completely 

overlaid by the texture. 

• Isoline Mode: if On, isolines are displayed on all elevation models (DEMs). Two modes 

can occur: 

o Single Line: One isoline is displayed at a specific height. You can find the height in 

the property field Isoline Value. 

o Multiple Lines: Isolines are displayed on a predefined height interval. You can find 

the height in the property field Isoline Step [m]. 

Isoline Color/Isoline Width displays the color/width the isoline(s) is/are drawn with. 

Note that isolines are not visible if the DEM is covered by a texture.  

• Transparency [%]: shows the degree of transparency all elevation models (DEMs) are 

displayed with in the 3D viewer (0 = non-transparent/opaque, 100 = fully transparent/ 

invisible). 

• Level of Detail: shows the level of detail with which the DEM is drawn in the 3D viewer. 

The smaller the selected pyramid level, the higher the level of detail. At Pyramid Level 

0 the DEM is rendered with maximum level of detail. If Dynamic LOD is displayed, it is 

determined dynamically and optimally (depending on the hardware used). 

Note that a higher level of detail is associated with high graphics memory requirements 

and high computing power. If too high a level of detail has been selected, only part of 

the DEM can be loaded and drawn. Rendering blocks (see below) in the foreground 

closer to the viewer are prioritized. The DEM loading stops when the limit is reached. 

With a higher pyramid level selected, a larger area can be rendered but at a lower 

resolution. 
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For Dynamic LOD always the entire area is drawn, with the difference that blocks in 

the foreground closer to the viewer are drawn with the highest or high resolution and 

blocks in the background are drawn with a lower resolution. 

 

Figure 165: example: left: Pyramid Level 0 (full resolution) and right: Dynamic LOD. 

• Simplify Mesh: shows whether the triangle mesh of the DEM is simplified depending 

on the tolerance value set, i.e. whether triangles are combined (On), or not (Off). 

o Simplification Tolerance [m]: shows the vertical tolerance for the simplification of 

the highest pyramid level. It should be approximately equal to the vertical 

accuracy of the DEM.  

o Simplifaction Tolerance Exponent: shows the factor the Simplification Tolerance 

is multiplied with for higher levels. 

If Auto  Simplify Mesh is set to On, the tolerance values for the mesh simplification are 

automatically optimally determined, otherwise they have been entered manually by 

the creator of the project. 

• Culling Mode: shows the culling mode the DEM is displayed with.  

Culling is a method of 3D computer graphics that excludes surfaces from visualization 

- e.g. surfaces facing away from the observer - depending on the relationship between 

observer and an object's surface (consisting of triangles). As a result, an additional in-

crease in performance can be achieved.  

The following modes can occur: 

o Double Sided: No culling is applied. All triangles defined as "double sided" show a 

different shading depending on the viewing side (facing away or towards the ob-

server). Since the virtual light source is above the DEM, the bottom is less brightly 

illuminated than the top when using this mode. 

o One Sided: Excludes all triangles that have a clockwise rotation direction after be-

ing projected into the screen plane. Therefore, only the top of the DEM is dis-

played. This setting is recommended if you want to increase performance. 
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o Double Sided Inconsistent: No culling is applied. All triangles defined as "double 

sided" display the same shading on each viewing side (facing away or towards the 

observer). 

• Show Rendering Info: if On, the blocks used for rendering are displayed as transparent 

cubes within the 3D viewer. In the viewer's lower right corner, you can find information 

on the number of triangles and tiles that are used. 

 

Figure 166: Render Info, example for DEM with Level of Detail = Dynamic LOD. 

3D Surface Settings 

Only for 3D surfaces and if the project contains a 3D window 

The properties in the category 3D Surface Settings correspond to those under Common 

DEM Settings (see above), but they always only refer to a single 3D surface, i.e. to a single 

single-channel raster. 

 

5.3.5 Raster Layer - Special Case " RPC Texture" 

In GAFmap Express: TOC > Layer 

! For information on digital elevation models (DEMs), see chapter 5.3.4, for information on 

textures in the 3D viewer, see chapter 2.2.3.2. 

Usually, layer textures are applied as simple top textures to the base terrain / DEM in the 3D 

viewer, i.e. they are placed vertically from above on the DEM. If, for example, a satellite image 

is used as texture, it is displayed 1:1 in areas where the surface is exactly horizontal and flat; 

if the terrain is inclined and/or reliefed, the raster for texturing is distorted accordingly. For 

vertically sloping walls (e.g. building facades), the raster pixels are "pulled down" vertically. 
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 In addition to simple layer textures, GAFmap® supports RPC textures. They are marked 

with an R in the TOC. This refers to satellite images, for which an *.rpc or *.rpb file is available 

that contains the information from which position and which angle the image has been 

acquired. Based on this exact information about the acquisition geometry, RPC textures can 

be applied to the terrain exactly opposite to the direction of acquisition. This way, even verti-

cally sloping side surfaces, such as e.g. building facades, can be textured if the acquisition angle 

is sufficiently inclined ("RPC-based side views"): 

 

Figure 167: left: Side view with a nadir image / right: RPC-based side textures with nadir image and two side 
images (north, south). (© GAF AG, contains Airbus DS-Material) 

If the views are to be displayed for all viewing directions, i.e. "on all sides", five textures from 

five different shooting directions are required. Ideally these are: 

• 4 side views, taken from four cardinal points with the most inclined angle possible. The 

side views must be RPC textures. 

• 1 top texture / nadir image, showing the view from above.  This can be either   

o another RPC texture for which the property Is Top RPC is On, or 

o one or multiple simple layer textures, which are then (automatically) combined to 

one top texture. Layer textures have a higher priority than Top RPCs, i.e. they are 

drawn in the 3D viewer even if they are listed below an RPC texture in the TOC. 

If less side views are displayed or if the constellation is less favorable, the sides are textured 

"distorted" with less suitable image content for certain viewing angles and the result appears 

less realistic.  
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Only a maximum of five different RPC/raster textures can be displayed: either 5 RPC textures 

or 4 RPC textures + any number of simple layer textures.  

Rendering 

Usually, it is calculated on-the-fly which RPC texture is best suited for this pixel for each 

location of the DEM, i.e. for each individual screen pixel of the 3D viewer, it is calculated on-

the-fly which RPC texture is best suited for this pixel. This is done by comparing the acquisition 

angles of the images and the inclination of the terrain.  

Since the appropriate texture is determined individually for each pixel, the image contents are 

mixed more or less strongly depending on the situation. The smaller the differences between 

the textures as well as between texture and DEM, the smoother the overall image appears. 

Exception: if the DEM property Only Show one RPC texture is On (see chapter 5.3.4.1), the 

DEM is then textured with only a single raster, the one with the best acquisition geometry for 

the current viewing direction. Note that with this setting, the texture may "skip" clearly visible 

in transition areas even if the viewing direction is only slightly changed. 

Context Menu 

 A right-click on one or multiple selected RPC Textures in the TOC opens 

the respective context menu. It corresponds in large parts to that of a "normal" raster layer. 

In the following chapters only functions and properties that are either RPC texture specific or 

for which special features are to be considered in regards to RPC textures are discussed. 

Information on all other functions and properties can be found in chapter 5.3.1 et seqq. (for 

across layers) or chapter 5.3.3 et seqq. (for raster specific). 

Tips and notes:  

• Since the use of RPC textures makes high demands on the hardware, the PC used 

should have a current CPU, a fast data storage (preferably SSD), sufficient RAM (at least 

16GB) and especially a very good graphics card (GPU) with dedicated memory. 

• RPC information available for satellite images can be used not only for displaying side 

views in the 3D viewer, but also for an on-the-fly orthorectification in the (2D) map 

viewer. 
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5.3.5.1 Align View by Shooting Angle 

In GAFmap Express: TOC > Layer > Context Menu Raster Layer - Special Case " RPC Texture" 

Only available if the project contains a 3D window 

Align View by Shooting Angle changes the viewing angle in such a way that it matches the 

acquisition angle of the RPC texture, i.e. the "optimal viewing angle" is used for the image. 

For general information on satellite images with RPC parameters ("RPC Textures"), see chapter 

5.3.5. 

Shortcuts, Key Commands, etc.: 

• Alt + click on a RPC texture's layer name in the 3D TOC: Align View by Shooting Angle 

 

5.3.5.2 Properties 

In GAFmap Express: TOC > Layer > Context Menu Raster Layer - Special Case " RPC Texture" 

 Via Properties you reach the Properties window where all essential properties of the 

selected RPC Texture are listed. They correspond in large parts to those of a simple raster layer 

(see chapter 5.3.3.6). In the following, only properties are listed that are displayed for RPC 

Textures. 

For general information on satellite images with RPC parameters ("RPC Textures"), see chapter 

5.3.5. 

RPC 

The properties in this category affect both the display of the satellite images in the 3D 

viewer and in the (2D) map viewer: 

• Use RPC / DEM: if On, the RPC parameters are used for an on-the-fly orthorectification 

of the satellite imagein the (2D) map viewer. If for DEM a digital elevartion model is 

specified, additionally the influence of the terrain on the display and position of the 

satellite image data is taken into account. If the specified DEM does not have an 

ellipsoidal but a geoidal height reference, the flag DEM is geoidal is set to On. 

Note: If a *.rpc/*.rpb file is available for a satellite image, the image is always identified 

as an RPC texture and used as such. The (2D) property Use RPC has no influence here. 

• DEM is geoidal: Both the on-the-fly orthorectification in the (2D) map viewer (see 

above) as well as the calculation of RPC textures in the 3D viewer (see chapter 5.3.5) 
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require a DEM with ellipsoidal height reference. If the DEM used does have a geoidal 

height reference, this flag is set to On. The heights are then converted in the back-

ground. 

• Is Top RPC (only visible if the project contains a 3D window): if On, this RPC texture is 

used to texturize terrain with a slope equal to or flatter than the Top Texture Thres-

hold specified for the DEM (see chapter 5.3.4.1).  

• RPC-Textur Priorität (only visible if the project contains a 3D window): specifies 

whether this RPC texture is prioritized relative to all other activated RPC textures, e.g. 

if it is qualitatively better or more up-to-date. In the area between RPC textures, this 

texture is then "longer" displayed, i.e. up to a certain degree even if another RPC tex-

ture is more suitable for the viewing direction compared to the acquisition geometry 

(see chapter 5.3.5). 

By default, all RPC textures have the same priority (value 0). With a value > 0 the 

texture has a higher priority, with a value < 0 a lower priority. Always the difference of 

values between the textures are decisive. 

• Line Shift/Row Shift: Depending on the initial positional accuracy of a RPC texture, it 

may be necessary to make adjustments to improve the absolute position or position 

to the DEM and/or the relative position to other (RPC) textures. Enter the necessary 

shift in X/Y direction at Line Shift/Row Shift. With 0 the initial position of the RPC 

texture remains unchanged, with positive values it is shifted to the right/up by the 

corresponding number of pixels, with negative values to the left/down. 

 

5.3.6 Raster Layer - Special Case "Mosaic Layer" 

In GAFmap Express: TOC > Layer 

 A Mosaic Layer consists of any number of individual rasters that are 

displayed on-the-fly in the map viewer as virtually mosaicked image. The individual rasters are 

bundled within the project and treated as one (total) raster. The individual rasters are still 

accessible; they are listed under the mosaic layer. 

Individual rasters that lie on top in the TOC also lie on top in the map viewer. You can always 

activate/deactivate individual rasters by checking/unchecking them, e.g. to make an under-

lying raster visible. 
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For the display of the mosaic layer, a common stretch statistic is calculated across all activated 

single rasters and applied to them. This creates a consistent overall image - depending on the 

data basis without disruptive transitions between the individual images: 

 

Figure 168: Example left: 6 DEMs individually loaded (with individually determined stretch statistic) and right: 
the same DEMS loaded as mosaic layer (with common stretch statistic) 

Whether and how well the individual rasters can be combined into a homogeneous ("optically 

pleasing") mosaic, essentially depends on the data basis. Here, for example, the following 

factors are decisive: 

• sensor type 

• acquisition time (daily or seasonal differences) 

• acquisition angle 

• differences in content (e.g. disappearing objects, new buildings, different crops, etc.) 

For some mosaic layers, the border between the single rasters was edited manually. The exact 

course of the border is then comprehensible with a cut-line layer. This is a vector layer, which 

contains one polygon each for all or individual rasters of the mosaic layer; polygon and raster 

are linked via the attribute field RelPath. If the cut-line layer contains a polygon for a raster, 

the raster is only displayed inside of the polygon, external areas are (virtually) cut off. 

If a cutline layer is used, it is entered in the mosaic layer properties under Cut Lines (see 

chapter 5.3.6.6). You can then find the layer itself in the TOC. 

Note: In GAFmap® Express the individual rasters for a mosaic layer are not contained in the 

Pack&Go Container (*.cmp), but are always only linked. If the original raster files have been 

deleted, moved or renamed, the mosaic can consequently not be displayed any more. 

Context Menu 

A right-click on a mosaic layer in the TOC opens the respective context menu. It corresponds 

in large parts to that of a "normal" raster layer. In the following chapters only functions and 
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properties that are either mosaic layer specific or for which special features are to be consi-

dered in regards to mosaic layers are discussed. Information on all other functions and 

properties can be found in chapter 5.3.1 et seqq. (for across layers) or chapter 5.3.3 et seqq. 

(for raster specific). 

 

5.3.6.1 Zoom to Mosaic Layer 

In GAFmap Express: TOC > Layer > Context Menu Raster Layer - Special Case "Mosaic Layer" 

Only available if the mosaic is selected 

 Zoom to Mosaic Layer always zooms the map to the extent of the whole mosaic layer, 

irrespective of the activation state of the individual rasters. 

 

5.3.6.2 Activate Raster in Current View Extent 

In GAFmap Express: TOC > Layer > Context Menu Raster Layer - Special Case "Mosaic Layer" 

Only available if the mosaic is selected 

 Activate Raster in Current View Extent activates (checks) all rasters of the mosaic layer 

that lie completely or partially within the currently visible map extent; already activated 

rasters that do not lie within the visible map extent are deactivated. 

For performance reasons, it is recommended to first zoom to the desired map extent and then 

activate all rasters for the current view. This ensures that only data that is actually needed is 

loaded. 

 

5.3.6.3 Deactivate all Rasters 

In GAFmap Express: TOC > Layer > Context Menu Raster Layer - Special Case "Mosaic Layer" 

Only available if the mosaic is selected 

 Deactivate all Rasters deactivates (unchecks) all rasters under the mosaic layer. 
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5.3.6.4 Zoom to Cut Line 

In GAFmap Express: TOC > Layer > Context Menu Raster Layer - Special Case "Mosaic Layer" 

Only available if a single mosaic raster is selected and a cut line feature is linked 

 Zoom to Cut Line zooms the map to the extent of the cut line polygon linked with the 

raster. The command is only available if a Cut Lines Layer is defined, i.e. if the boundary 

between the individual rasters was edited manually when creating the mosaic layer (see 

chapter 5.3.6). 

 

5.3.6.5 Select Cut Line Feature 

In GAFmap Express: TOC > Layer > Context Menu Raster Layer - Special Case "Mosaic Layer" 

Only available if a single mosaic raster is selected and a cut line feature is linked 

 Select Cut Line Feature selects the cut line polygon linked with the raster. The command 

is only available if a Cut Lines Layer is defined, i.e. if the boundary between the individual 

rasters was edited manually when creating the mosaic layer (see chapter 5.3.6). 

 

5.3.6.6 Properties (Mosaic Level) 

In GAFmap Express: TOC > Layer > Context Menu Raster Layer - Special Case "Mosaic Layer" 

 Via Properties you reach the Properties window where all essential properties of the 

selected mosaic layer are listed. They correspond in large parts to those of a simple raster 

layer. In the following, only properties that are either mosaic layer specific or have special 

features regarding mosaic layers are listed. For information on all others, see chapter 5.3.3.6: 

Extent 

• X/Y Min / X/Y Max: shows the layer's extent in the map coordinate system. Please 

note that the extent of a mosaic layer depends on which individual rasters are acti-

vated (i.e. checked in the TOC). 

Geometry 

• Cut Lines: shows whether a Cut Line Layer has been used to manually edit the cutlines 

between the individual rasters of the mosaic layer. If a layer is specified, its polygons 

define the extent of the corresponding single rasters. 
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• Only Use Rasters with Cut Lines (only visible if a Cut Lines Layer is entered above): 

shows whether rasters for which the above specified Cut Line Layer does not contain 

a cut line polygon are treated as "non-existent" (On) or as "uncut" (Off). 

• Feathering Pixels [px] (effect only visible where individual rasters overlap): if a value > 

0 is entered, the transitions between the individual rasters of the mosaic layer are 

softened by mixing/blending the pixels at the edge of overlaps. The blend area extends 

from the edge of the overlap area inwards by the specified number of pixels.  

Catalog 

• Pixel Type: shows the (target) pixel type for the mosaic layer.  

• Target Min/Max: shows the target range used for the stretch.  

• NoData Value: shows the NoData value of the mosaic layer.  

• Override Cell Size: if a value is entered here, the mosaic Layer has this resolution. 

Otherwise, the mosaic layer has the resolution of the activated single raster with the 

highest resolution. In both cases the pixels of single rasters with different resolution 

are resampled accordingly. 

• Override Anchor Point: if a value is entered here, it is interpreted as anchor coordinate 

on which the mosaic raster is aligned. 0, for example, is read as 0|0 (origin), 0.5 as 

0.5|0.5, etc. 

Symbology 

• Stretch Type: shows how the pixel values of the mosaic layer are stretched over the 

8bit value range of the screen. This stretching is applied in addition to the stretching, 

scaling, and/or offset at the level of the individual rasters (see chapter 5.3.6.7). 

 

5.3.6.7 Properties (Single Raster Level) 

In GAFmap Express: TOC > Layer > Raster Layer - Special Case "Mosaic Layer" 

 On the level of a single mosaic raster, more properties are displayed from which can be 

read how the respective raster is fitted and/or stretched into the mosaic: 

Source 

• File Path: shows the connection parameters to the connected raster dataset. This can 

be e.g. a file path or an URL. 
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Adjustments 

• Custom Value Transfer: if On, an individual transfer function for the raster has been 

specified in order to better fit it into the mosaic.  

If Custom Transfer is switched to Off, no individual stretching is specified for the raster, 

but it might be fitted better into the mosaic using the following properties: 

o Scale Factor: shows the factor by which the original pixel values are multiplied.  

o Offset:  shows the value added to the original pixel value.  

The following then applies: New pixel value = original pixel value * scale factor + offset. 

 

5.3.7 Point Clouds 

In GAFmap Express: TOC > Layer 

A point cloud consists of a multitude of (measurement) points individually located in space. 

They are obtained e.g. by (laser) scanning objects or terrain.  

 

Figure 169: Point cloud, displayed as individual points 

Point clouds in GAFmap® can only be visualized in the 3D viewer (as 3D dataset), in the (2D) 

map viewer only the exten of the point cloud is displayed as rectangle.  

Context Menu 

A right-click on one or mutiple selected point clouds in the TOC takes you 

to the corresponding layer context menu. It does not contain any point cloud specific func-

tions/commands, only those that are available for all layers irrespective of the type. For more 

information, see chapter 5.3.1. You can find information on the point cloud properties in 

chapter 5.3.7.1. 
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5.3.7.1 Properties 

In GAFmap Express: TOC > Layer > Context Menu Point Clouds 

 Via Properties you reach the Properties window where all essential properties of the 

selected point cloud are listed. 

For point clouds, the properties are in general only viewable and cannot be adjusted (i.e. all 

properties are grayed out). 

If multiple layers are selected, only properties that are available for all selected layers (com-

mon properties) are displayed.  

Source 

• Number of Points: shows the total number of points the point cloud contains. 

• Spatial Reference: shows the layer spatial reference. 

 opens a window with detailed information on the layer spatial reference  

• Metadata: shows further meta information that is stored in the dataset itself. 

 opens the Metadata window 

• Layer Info: : if available, additional information about the layer can be viewed here 

(e.g. a legend, the data source, other metadata, etc.) 

 opens the Layer Info window 

If a layer info is entered, it can alternatively be called up via Show Layer Info command 

in the layer context menu (see chapter 5.3.1.7); texts with HTML syntax are then usu-

ally displayed formatted (here always as source text). 

Extent 

• X/Y Min: shows the X-/Y-coordinate of the bottom left edge of the (rectangular) full 

extent of the point cloud in the map coordinate system. 

• X/Y Max: shows the X-/Y-coordinate of the top right edge of the (rectangular) full 

extent of the point cloud in the map coordinate system. 

• Z Min/Max: shows the smallest/largest height of the point cloud. 

Scale Range 

• Scale Range: determines whether a point cloud activated in the TOC is only displayed 

in the map viewer if the zoom level of the map is within a certain scale range (On) or 

always, regardless of the zoom level (Off). 
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If On, you can specify the valid scale range, i.e. the desired lower/upper limit, under 

Min. Scale / Max. Scale. 

Symbology 

The properties in this category affect how the rectangular placeholder that indicates the 

extent of the point cloud in the (2D) map viewer is displayed. They correspond to the 

Symbology properties of rectangle graphics. For more information, see chapter 5.2.6.2 or 

5.2.1.10. 

3D Symbology 

• Level of Detail: shows how much the number of displayed points is thinned out. Es-

pecially for larger amounts of data a reduced level of detail can noticeably increase the 

performance. 

A level of detail = 0 displays all points. The higher the specified value, the more the 

number of displayed points is thinned out. The reduction of the point density is not the 

same for all blocks. In the blocks further away from the observer, more thinning is 

taking place than in blocks that are directly in the field of vision. 

• Point Symbol: shows the symbol used to display the points in the 3D viewer. Depen-

ding on your choice, the points are either displayed as three-dimensional objects (Box 

or Sphere) or as simple markings (Point, Cross, or Quad). 

• Eye Dome Lighting (only visible if Point Type = Quad): if On, a light-independent on-

the-fly hillshade to the point cloud is activated. Compared to the hillshade that relates 

to a virtual light source, Eye Dome Lighting uses a depth buffer. This causes pixels to 

be colored darker when their neighboring pixels have a smaller depth, i.e. when they 

are closer to the observer. The greater the difference in depth, the darker they appear. 

In addition, the EDL Contrast is then displayed. It defines the brightness contrast, i.e. 

the difference in between the brightest and darkest points of an image. 

• Shading (only visible if Point Type = Box or Sphere): if On, an on-the-fly shading to the 

points is applied. Shading causes all surfaces that face the light source to appear 

lighter, and all surfaces that are turned away from the light source to appear darker. 

This enhances the spatial impression.  

The virtual light source is specified for the entire scene in the Map properties (see 

chapter 5.1.7). 

• Shadows/View Obstruction (only visible if Point Type = Box or Sphere): if On, the point 

cloud casts shadows and it is considered as view obstruction when calculating an on-

the-fly viewshed in the 3D viewer. 
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Note that layers for which Shadows/View Obstruction is disabled do not participate in 

the shadow and 3D viewshed at all. This means that they are not only not considered 

as light or view obstruction, but they also neither reflect shadows cast by other objects 

nor the result of the 3D viewshed. 

For more information on shadows and 3D viewshed, see chapters 4.6.5 and 4.6.6. 

• Symbol Size Unit (only visible if Point Type ≠ Point): shows which measurement unit is 

used for (re)sizing the Symbol Size. Available are: 

o Meter [m]: the symbol size is given in meters. This unit is recommended if the 

absolute size of the object is decisive for its display. 

o Scene [‰]: the symbol size is given in relation to the size of the entire scene. This 

unit is recommended if a visually appealing result is to be achieved quickly for very 

large or very small scenes. 

• Symbol Size (only visible if Point Type ≠ Point): shows the size of the point symbol. 

Depending on the selected Symbol Size Unit it is displayed in meters [m] or in a per 

mille share of the entire scene [‰].  

• LOD-Größenskalierung (only visible if Point Type ≠ Point and Level of Detail ≠ 0/-1): 

shows the factor with which the size of the points in blocks with a lower Level of Detail 

(see above) is adjusted. In blocks with a full level of detail, the size is not adjusted.  

Especially when working with a lower level of detail due to performance reasons, a 

more homogeneous display of the point cloud can be achieved on the screen by ad-

justing the LOD Size Scaling.  

With LOD Size Scaling = 0 the size of the points is not adjusted, for a value > 0 the point 

size is adjusted according to the level of detail of a block. The lower the level of detail 

of a block, the larger the points are displayed. 

• Color Mode: which method is used to colorize the point cloud in the 3D viewer. The 

following modes can occur: 

o Source Colors: the colors stored in the source file are used.  

o Height Color Ramp: the color ramp displayed below based on the points' z-values 

is applied. Additionally a Stretch Function can be specified. 

o Class Colors: the points' classification as stored in the source file is used for the 

color representation. You can view the number of classes in the property field 

Class Colors. 

• Show Rendering Info: if On, the blocks used for the rendering are displayed as trans-

parent cubes in the 3D viewer. Blocks with the same level of detail are displayed in the 

same color.  
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At the bottom right of the 3D viewer, the following additional information is displayed: 

o Loaded graphics data: amount of data [MB]. 

o Layer [name as shown in the TOC]: number of displayed blocks; number of points. 

 

5.3.8 Tables 

In GAFmap Express: TOC > Layer 

 Simple Tables (incl. individually loaded attribute tables of vector layers) are trea-

ted like a vector layer without geometry (type) in GAFmap®, i.e. just like the attribute table of 

a loaded vector layer. 

For more information about attribute tables, see chapter 5.3.2.1. 

Context Menu and Properties 

Right-clicking on one or multiple selected tables in the TOC opens the table context menu. It 

contains almost exclusively commands/functions as well as properties that are also contained 

in the context menu of vector layers. For more information, see chapters 5.3 et seqq. (for 

cross-layer functions), 5.3.2 et seqq. (for vector-specific functions) and 5.3.2.5 (for available 

(vector) properties).  
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6 GAFmap® Symbology 

In the following chapters, the Symbols dialogs are described, i.e. the dialogs where you can 

customize the symbols used to display points, lines, and polygons, or to adjust the label style. 

You can reach a symbols dialog e.g. via  

• the settings of self-created graphics,  

• double-clicking on the layer icon in the TOC for self-created graphics, or  

• several general settings (e.g. for editing/selection geometries). 

 

Figure 170: Open Symbols dialog, example 
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Symbols Dialog - Structure 

All Symbols dialogs are structured as follows: 

 

Figure 171: Dialog Point Symbols 

• Section 1: Predefined Symbols 

On the left side of the dialog some predefined symbols are listed. Via the tabs on the 

left, you can select predefined symbols from different categories. 

By clicking on one of the predefined symbols, all settings on the right side of the dialog 

are adopted automatically from this symbol. If desired, you can adjust the symbol in 

the right part of the dialog (e.g. its size or color; see below). 
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• Section 2: Combining Symbols (2) 

(missing for Labeling) 

In case of simple (i.e. non-composite) symbols, exactly one symbol and its Properties 

(3) are displayed here:  

 

Figure 172: Simple point symbol, example 

 With the plus button you can add symbols. All symbols are then combined 

to one (composite) symbol in the order in which they appear in the list. The Properties 

(3) of the individual symbols can be adjusted individually. The resulting composite 

symbol is previewed under Current Symbol (4). 

 

Figure 173: Combined (composite) point symbol (left) and line symbol (right), example 

  removes the selected single symbol from the list. 

  moves the selected single symbol stepwise up or down in the list. 

• Section 3: Symbol Properties 

Here, you can view and adjust the properties of the (single) symbol selected above. 

The properties displayed depend on the (geometry) type of the symbol. They are 
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individually listed and explained in the corresponding subchapters (see chapter 6.1 et 

seqq.). 

• Section 4: Current Symbol 

Here, the resulting (composite) symbol is previewed in its original size (see example 

above).  

Shortcuts, Key Commands, etc.: 

• Double-clicking on a layer icon in the TOC: opens the dialog for the respective symbol 

type (Point, Line or Fill Symbol) 

• Alt+Double-clicking on a polygon icon in the TOC: opens the Line Pen dialog 

Tips and Notes: 

• If you want to enlarge or shrink a composite symbol, you can either adjust the size of 

the single symbols individually or scale the symbol as a whole (see chapter 5.2.1.10). 

In this case all single symbols are enlarged or shrunken at once and in proportion. 

• If a symbol is to contain transparencies, e.g. the filling of a point and/or its surrounding 

ring is to be (semi-)transparent, you can specify a (semi-)transparent fill or frame color 

for all or individual elements directly in the Color Picker dialog (see chapter 6.5). 

Alternatively, you can apply transparencies to the entire symbol afterwards (see 

chapter 5.2.1.10). 
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6.1 Point Symbols 

With e.g. a double-click a point icon in the TOC or via Point Symbol  in a Properties window, 

you are taken to the Point Symbol dialog: 

 

Figure 174: Dialog Point Symbol 

In the following, only point symbol specific functions/properties are explained. For general 

information on the dialog and its structure, see chapter 6. 

Select or Create Point Symbols 

You can select, create, and/or edit a point symbol by  

• clicking on a symbol in the List of Predefined Symbols on the left side. All settings to 

the right of the dialog are then automatically adopted by this symbol. You can either 

keep the selected symbol unchanged or edit it beforehand. 
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• creating a custom symbol on the right side of the dialog. 

 Clicking the plus button adds a new point symbol. You can then choose bet-

ween the following kinds of point symbols:  

o Simple = a simple geometry (see chapter 6.1.1) 

o Symbol = a default Windows symbol (see chapter 6.1.2) 

If you add multiple point symbols of any kind, all symbols are listed individually and 

combined to a composite symbol. 

 You can always delete individual symbols with the minus button or adjust 

their order (top/bottom) with the arrow buttons. 

For more information about composite symbols see chapter 6. 

Under Current Symbol you can preview the currently selected or created (composite) symbol. 

The crossing point of the red lines marks the actual point object. 

With OK or Apply the current point symbol is taken over. Cancel closes the dialog without 

further action. 

 

6.1.1 Point Symbol "Simple" 

The point symbol Simple is a simple geometry. You can specify the shape of the geometry 

under Symbol Type and choose between Circle, Rectangle, Regular Polygon, and Cross. De-

pending on the selected Symbol Type, you can adjust the following properties: 

• Width/Height or Size [px]: determines the size of the symbol. 

 opens a slider 

• Vertex Count (applies only to Regular Polygon): determines the number of corners of 

the (always regular) polygon. 

 opens a slider 

• Fill Brush: determines how the Point Symbol is filled. 

 opens the Fill Symbols dialog (see chapter 6.3) 

• Line Pen: determines the line symbol the symbol / surrounding ring of the symbol is 

displayed with. 

 opens the Line Pen dialog (see chapter 6.2) 
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• Hot Spot X/Y: determines how the symbol is positioned relative to the point object. By 

changing the value, the symbol is moved accordingly in X/Y direction. The value speci-

fies the position of the symbol on the actual point object:  

o At 0|0 the lower left corner of the symbol lies on the point object  

o At 1|1 the upper right corner lies on the point object 

o At 0,5|0,5 the symbol center lies on the point object  

o For values < 0 and > 1, the symbol is shifted by the corresponding amount in the 

X/Y direction to the point object 

  opens a slider 

• Rotation [°]: determines the rotation angle of the symbol. 

 opens a slider 

 

6.1.2 Point Symbol "Symbol" 

The point symbol Symbol is a default Windows symbol. If you select this point symbol type, 

the following dialog opens: 

 

Figure 175: Dialog Select Symbol, Example 
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Which symbols are available, depends on the version of Windows that is being used. Note that 

(uncommon) symbols may not be displayed correctly on other computers if the corresponding 

character set is not installed. 

Select the desired symbol and confirm with OK. You can then adjust the symbol properties: 

• Symbol: determines the Windows symbol. 

 opens the Select Symbol dialog (see above) 

• Font Size [px]: determines the symbol size. 

 opens a slider 

• Color: determines the symbol color. 

 opens the Color Picker dialog (see chapter 6.5) 

• Font Style: determines the font style for the symbol. 

 opens a drop-down list 

• Hot Spot X/Y: determines how the symbol is positioned relative to the point object. By 

changing the value, the symbol is moved accordingly in X/Y direction. The value speci-

fies the position of the symbol on the actual point object:  

o At 0|0 the lower left corner of the symbol lies on the point object  

o At 1|1 the upper right corner lies on the point object 

o At 0,5|0,5 the symbol center lies on the point object  

o For values < 0 and > 1, the symbol is shifted by the corresponding amount in the 

X/Y direction to the point object 

 opens a slider 

• Rotation [°]: determines the rotation angle of the symbol. 

 opens a slider 
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6.2 Line Symbols 

With e.g. a double-click on a point icon in the TOC or via Line Pen  in a properties window, 

you are taken to the Line Pen dialog: 

 

Figure 176: Dialog Line Pen 

In the following, only line symbol specific functions/properties are explained. For general in-

formation on the dialog and its structure, see chapter 6. 

Select or Create Line Symbols 

You can select, create, and/or edit a line symbol by 

• clicking on a symbol in the List of Predefined Symbols on the left side. All settings to 

the right of the dialog are then automatically adopted from this symbol. You can either 

keep the selected symbol unchanged or edit it beforehand. 
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• creating a custom symbol on the right side of the dialog. 

 Clicking the plus button adds new line symbol. By default, a line of the type 

Simple is created, but you can always change the Line Type via the properties below. 

There, you can choose between: 

o Simple: a simple continuous or dashed line (see chapter 6.2.1) 

o Pattern: a line with a complex, user-defined pattern (see chapter 6.2.2) 

o Point Symbol: lined up point symbols (see chapter 6.2.3) 

If you add multiple line symbols of any type, all symbols are listed individually and 

combined to a composite symbol. 

 You can always delete individual symbols with the minus button or adjust 

their order (top/bottom) with the arrow buttons. 

For more information about composite symbols see chapter 6. 

Under Current Symbol you can preview the currently selected or created (composite) symbol. 

With OK or Apply the current line symbol is taken over. Cancel closes the dialog without fur-

ther action. 

 

6.2.1 Line Type "Simple" 

With Line Type Simple you can create single solid or dashed lines. The display can be adjusted 

using the following specifications: 

• Color: determines the color of the line symbol. 

 opens the Color Picker dialog (see chapter 6.5) 

• Width [px]: determines the width of the line symbol. 

 opens a slider 

• Dash Style: determines whether the line is displayed as a solid line or as a line with a 

certain (dash-dot) pattern.  

 opens a drop-down list. Available for selection are: 

o Solid: shows the line symbol as a solid line 

o Dash: shows the line symbol as a dashed line 

o Dot: shows the line symbol as a dotted line 

o DashDot / DashDotDot: shows the line symbol as a dashed-dotted line 
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o Custom: if selected, you can manually create a custom dash pattern 

 opens the Dash Pattern dialog: 

         

         Figure 177: Dash Pattern dialog for Dash Style Custom (top) and example line (bottom) 

You can create a new dash pattern by adding areas to the line with the left mouse 

button or removing areas from the line with the right mouse button. Black marks 

drawn areas (dashes), white marks spaces. The red bar marks the start of the dash 

pattern. Drag the dialog bigger if the red bar is not visible. You can grab the bar 

with the right mouse button and move it to the right or to the left as you like. Note 

that you can only edit the pattern on the left of it (before the start point). 

Click OK to accept the dash pattern. It is then entered as number sequence for 

Dash Pattern and a preview is displayed under Current Symbol. 

Alternatively, you can enter the pattern directly as number sequence at Dash 

Pattern. The individual numbers must be separated by semicolon and define 

alternately the length of the dashes and the spaces in between. The first number 

defines the first dash and must always be > 0. Then any number of (positive) num-

bers can be entered. 

Possible number sequence using the example above: 1;0,5;3;6    

 

• Dash Offset (not available for Dash Style Solid): determines the gap between the start 

of the line and the start of the dash pattern. I.e. the pattern is moved along the line, 

but remains unchanged otherwise. 

 opens a slider 

• Dash Cap (not available for Dash Style Solid): determines how for dashed lines the end 

caps of the individual dashes are displayed (flat, round, or triangle).  
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 opens a drop-down list 

• Start Cap: determines how the beginning of the (entire) line is displayed.  

 opens a drop-down list 

• End Cap: determines how the end of the (entire) line is displayed. 

 opens a drop-down list 

• Compound Array: determines whether a compound array is displayed instead of a 

single line. A compound array consists of several parallel lines and spaces with different 

widths. 

By default, this field is empty and a single line with the Width specified above is 

displayed. You can, however, manually determine a (cross section) line pattern for the 

compound array.   

 opens the Dash Pattern dialog: 

 

Figure 178: Compound Array > Dash Pattern dialog (top) and example line (bottom) 

You can create a new compound array pattern by adding areas to the line with the left 

mouse button or removing areas from the line with the right mouse button. Black 

marks areas that are drawn (dashes), white marks spaces. The total width of the 

compound array displayed always corresponds to the Width determined for the line 

symbol. 

Click OK to accept the compound array pattern. It is then entered as number sequence 

at Compound Array and a preview is displayed under Current Symbol.  

Alternatively, you can enter the pattern directly as number sequence at Compound 

Array. The individual numbers must then be separated by semicolon and define the 
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width of the drawn lines and of the spaces in between. Indicated one after the other 

are: start first line; end first line; start second line; end second line; (…).  

Start and end of the lines are given relative to the total width, which is always set to 1. 

I.e. the numbers must lie between 0 and 1 and rise. Since start and end must be 

determined for each line, the number of the entered numbers must be even. 

Possible number sequence using the example above: 0;0,25;0,5;1 

  
 

6.2.2 Line Type "Pattern" 

With Line Type Pattern you can create a line with a manually entered line pattern. The display 

can be adjusted using the following specifications:  

• Color: determines the color of the line symbol. 

 opens the Color Picker dialog (see chapter 6.5) 

• Width [px]: determines the width of the line symbol. 

 opens a slider 
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• Pattern: here you can create a custom line pattern. 

 opens the Line Pattern dialog: 

 

Figure 179: Line Pen dialog > Line Pattern (top) and example line (bottom) 

You can create a new pattern by adding individual squares with the left mouse button 

or removing them with the right mouse button. Areas marked black are drawn, areas 

marked white are not. The designed pattern is then constantly repeated along the line. 

o Width: determines how many squares the pattern is wide. 

o Height: determines how many squares the pattern is high. The height over all 

squares corresponds to the Width specified for the line symbol. 

o Clear/Fill: clears/fills all squares, thus sets them to white/black. 

Click OK to accept the line pattern. It is then displayed as preview under Current Sym-

bol.  

• Start Cap: determines how the beginning of the (entire) line is displayed. 

 opens a drop-down list 
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• End Cap: determines how the end of the (entire) line is displayed. 

 opens a drop-down list 

 

6.2.3 Line Type "Point Symbol" 

With Line Type Point Symbol you can create a line formed by a sequence of point symbols. 

  

Figure 180: Line Symbols, Line Type Point Symbol Example 

You can adjust the following specifications: 

• Symbol: determines the symbol with which the points that form the line are displayed. 

You can use any point symbol. 

 opens the Point Symbol dialog (see chapter 6.1) 

• Anchor at Start/End: determines whether the point symbol is displayed only at the 

start and/or end of the line (On) or is distributed over the entire line with the selected 

Point Symbol Distance (see below) (Off). 

• Point Symbol Distance [px]: determines the distance between the individual point 

symbols. Measurement is taken from the actual point (usually the center of the point 

symbol).  

• Point Symbol Offset [px]: determines the distance between the beginning of the line 

and the first drawn point symbol. The offset never exceeds the point symbol distance, 

even if a larger value is entered. 

• Symbol Rotation Mode: determines whether the point symbols are rotated perpen-

dicular to the line and if so, whether the digitizing direction of the line is to be taken 

into account (Rotated) or not (Rotated Upright). 

 opens a drop-down list 

• Clip Line (only relevant for combined lines, see chapter 6): determines whether all lines 

above the point symbols are clipped (On) or not (Off). If On, top lines are not drawn 

through the point symbols, but are interrupted. The point symbols then stand out 
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more clearly and are easier to recognize. You can define the size of the interruption at 

the point symbols at Clip Border (specified in pixels). 

 

6.3 Fill Symbols 

With e.g. a double-click on a polygon icon in the TOC or via Fill Brush  in a properties win-

dow, you are taken to the Fill Symbols dialog: 

 

Figure 181: Dialog Fill Symbols 

In the following, only Fill Symbols specific functions/properties will be explained. For general 

information on the dialog and its structure, see chapter 6. 
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Select or Create Fill Symbols 

You can select, create and/or edit Fill Symbols by  

• clicking on a symbol in the List of Predefined Symbols on the left side. All settings to 

the right of the dialog are then automatically adopted from this symbol. You can either 

keep the selected symbol unchanged or edit it beforehand.  

• creating a custom symbol on the right side of the dialog. 

 Clicking the plus button adds new fill symbol. By default, a fill symbol of the 

type Solid is created, but you can always change the fill type via the properties below. 

There, you can choose between:  

o Solid: a continuous, single color filling (see chapter 6.3.1) 

o Hatched: a filling with a simple, predefined dot or line pattern (see chapter 6.3.2) 

o Texture: a filling with an image texture (see chapter 6.3.3) 

o Symbol: a uniform and regular filling with any point symbols (see chapter 6.3.4) 

If you add multiple fill symbols of any type, all symbols are listed individually and 

combined to a composite symbol. 

 You can always delete individual symbols with the minus button or adjust 

their order (top/bottom) with the arrow buttons. 

For more information about composite symbols see chapter 6. 

Under Current Symbol you can preview the currently selected or created symbol. 

With OK or Apply the current fill symbol is taken over. Cancel closes the dialog without further 

action. 

 

6.3.1 Fillbrush Type "Solid" 

If you select the Fillbrush Type Solid, the polygon area is filled evenly and with a single color. 

You can adjust the following properties: 

• Color: determines the color of the filling. 

 opens the Color Picker dialog (see chapter 6.5) 
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6.3.2 Fillbrush Type "Hatched" 

If you select the Fillbrush Type Hatched, the polygon area is filled with a predefined line or 

point pattern, e.g. a hatching. You can adjust the following properties: 

• Hatch Style: determines the pattern of the filling.  

 opens a drop-down list 

• Fore Color: determines the color of the pattern, i.e. of the lines or points in the front. 

 opens the Color Picker dialog (see chapter 6.5) 

• Back Color: determines the color of the background. 

 opens the Color Picker dialog (see chapter 6.5) 

• Rotation: rotates the filling by the entered value in degrees clockwise (for values > 0) 

or counterclockwise (for values < 0). At 0 the filling is not rotated. 

 opens a slider 

 

6.3.3 Fillbrush Type "Texture" 

If you select the Fillbrush Type Texture, the polygon area is filled with an image texture (e.g. 

with a vegetation pattern). Any image in a common image file format (*.bmp, *.jpg, *.png, 

etc.) can be selected as the texture. You can adjust the following properties: 

• Image DPI: determines the resolution of the image on the screen / the printed map in 

DPI. 

• Wrap Mode: determines the way the polygon area is filled with the image. 

 opens a drop-down list 

o If you select Clamp, the image is inserted only once and cut off at the polygon 

edges. This setting usually only makes sense if the selected image is larger than 

the displayed polygon area. 

o If you select Tile, the image is repeated in X/Y direction until the polygon area is 

completely filled. With Tile Flip X, the image is mirrored on the Y-axis with every 

repetition in the X-direction, with Tile Flip Y, it is mirrored on the X-axis with every 

repetition in the Y-direction; if you select Tile Flip XY, both occurs. 
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Note: The area is always filled starting from the upper left corner of the polygon extent. 

• Replace Colors: if On, two colors in the texture are replaced by another color each. 

You can specify yourself which colors are replaced and how: 

o Replace Color 1: specifies the color that is replaced by New Color 1 

o New Color 1: specifies with which color Replace Color 1 is replaced 

o Replace Color 2: specifies the color that is replaced by New Color 2 

o New Color 2: specifies with which color Replace Color 2 is replaced 

 opens the Color Picker dialog (see chapter 6.5) 

 

Figure 182: Dialog Fill Symbols 

If you want to replace colors in the texture, the exact color value of the replace color(s) 

must be known and specified accordingly in the Color Picker. Always both colors are 

replaced. If only one color is to be replaced, select a value for the other replace color 

that does not appear in the texture. 

You can also replace a color with fully or semi-transparent colors. 

Replacing colors is only recommended for textures without mixed pixels, i.e. only for 

color-invariant image formats such as *.png or *.bmp 

• Rotation: rotates the filling by the entered value in degrees clockwise (for values > 0) 

or counterclockwise (for values < 0). At 0 the filling is not rotated. 

 opens a slider 
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6.3.4 Fillbrush Type "Symbol" 

If you select the Fillbrush Type Symbol, the polygon area is filled regularly with any point 

symbol. You can adjust the following properties: 

• Symbol: specifies the point symbol used to fill the the polygon area. How the area is 

filled with the symbol can be determined at Wrap Mode. 

 opens the Point Sysmbol dialog (see chapter 6.1) 

• Margin [px]: determines the distance between the individual point symbols. 

• Back Color: determines the the background color. 

 opens the Color Picker dialog (see chapter 6.5) 

• Wrap Mode: determines the way the polygon area is filled with the point symbols. For 

more information, see chapter 6.3.3. 

 opens a drop-down list 

• Rotation: rotates the filling by the entered value in degrees clockwise (for values > 0) 

or counterclockwise (for values < 0). At 0 the filling is not rotated. 

 opens a slider 
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6.4 Labeling 

E.g. with a double-click on a Text Label icon in the TOC or via Labeling  in a Properties 

window, you are taken to the Labeling dialog: 

 

Figure 183: Labeling Dialog 

In the following, only Labeling specific functions/properties will be explained. For general 

information on the dialog and its structure, see chapter 6. 

Select or Create Label Styles 

You can select, create and/or edit a Label by  

• clicking on a label in the List of Predefined Labels on the left. All settings to the right 

of the dialog are then automatically adopted from this label. You can either keep the 

selected style unchanged or edit it beforehand. 
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• creating a custom label style on the right. 

Under Current Symbol you can preview the currently selected or created label. The crossing 

point of the red lines marks the anchor point of the label. 

With OK or Apply the current label style is taken over. Cancel closes the dialog without further 

action.  

Labeling Properties 

You can adjust the following properties: 

• Font: determines the font type. 

 opens the (windows) Font dialog. There, all fonts installed on the computer are 

available for selection. 

• Color: determines the color of the label.  

 opens the Color Picker dialog (see chapter 6.5) 

• Use Halo: determines whether the label is highlighted by a colored silhouette (On) or 

not (Off). 

Halo Color: determines the color of the silhouette. 

 opens the Color Picker dialog (see chapter 6.5) 

Halo Width [px]: determines the width of the shilouette. Enter the desired value 

directly into the field. 

• Alignment: determines how the label/text box is positioned relative to the anchor 

point (top right, middle centered, bottom left, etc.).  

 opens a drop-down. There, you can specify the desired position via buttons: 

 

Note that this property has no relevance for polygons, because the position of the label 

is defined by the Label Placement Mode in the layer properties (see chapter 5.3.2.5). 

• Offset in X/Y: determines the offset of the label/text box relative to the anchor point 

in X/Y direction. For 0, the label is not offset, i.e., the corner or edge defined under 

Alignment is then placed directly on the anchor point. Positive values offset the label 

to the right or top, negative values to the left or bottom.  
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• Text Alignment: determines how the text is aligned within the label box for multiline 

labelss. Additionally to Left-Justified, Right-Justified and Centered, Auto is available. 

Here the alignment of the text is selected automatically depending on the Alignment 

of the label: for left/right placed labels the text is aligned right/left, for centered labels 

the text is also centered. 

 opens a drop-down list 

• Use Box: determines whether the label is given a rectangular colored background (On) 

or not (Off).  

Box Color: determines the color of the rectangular background. 

 opens the Color Picker dialog (see chapter 6.5) 

Box Border Color: determines the color used for the border of the rectangular back-

ground including the Handle (see below). 

 opens the Color Picker dialog (see chapter 6.5) 

Use Handle (only for points and lines): determines whether a handle is displayed from 

the labeling panel to the (anchor) point (On) or not (Off) 

• Rotation [°]: determines the rotation angle of the label (in geographical degrees, i.e. 

clockwise). 

 opens a slider 
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6.5 Color Picker 

The Color Picker dialog appears whenever a color is to be set. You are taken to the dialog e.g. 

via Color  in a Properties window: 

 

Figure 184: Color Picker Dialog 

• Base Colors and Defined Colors: Here, you can select from various premixed colors. All 

settings under Custom Color are then automatically adopted from the selected color. 

You can either keep the selected color unchanged or edit it beforehand. 

• Custom Color: Here, you can mix a custom color by setting the following values 

manually: 

o HEX (hexadecimal color definition according to the scheme RRGGBB), 

o Hue, Saturation, and Brightness (HSV color space), or 

o Red, Green, and Blue values (RGB color space), and 

o Alpha 

Brightness (from 0 = maximum light to 100 = maximum dark / black) and Alpha (from 

0 = opaque to 255 = fully transparent / invisible) can also be set using the sliders on the 

right edge. The values in the input fields are then adjusted accordingly. 
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Alternatively, you can select a custom color by clicking directly onto the desired color 

in the color wheel or by clicking in the color wheel, holding the mouse button and 

moving the mouse pointer to the desired color. 

Each selected/mixed color is marked with a small black square in the color wheel and pre-

viewed at Color. This preview is updated on-the-fly. 

OK or Apply confirms the selection/settings and the color is applied, Cancel closes the dialog 

without further action. 
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6.6 3D Point Symbols 

Only available if the project contains a 3D window 

With e.g. a double-click a 3D point icon in the TOC or via 3D Point Symbol  in a Properties 

window, you are taken to the 3D Point Symbol dialog: 

 

Figure 185: 3D Point Symbol dialog 

In the following, only 3D point symbol specific functions/properties are explained. For general 

information on the dialog and its structure, see chapter 6. 
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Select or Create 3D Point Symbols 

You can select, create, and/or edit a point symbol by 

• clicking on a symbol in the List of Predefined Symbols on the left. All settings to the 

right of the dialog are then automatically adopted by this symbol. You can either keep 

the selected symbol unchanged or edit it beforehand. 

•  creating a custom symbol with the Plus Button (see above). 

If you add multiple point symbols of any kind, all symbols are listed individually and 

combined to a composit symbol (see chapter 6). 

Under Current Symbol a preview of the currently selected or created (composite) symbol is 

displayed. 

 

Figure 186: 3D Point Symbol dialog - Current Symbol 

• Under Symbol Size length, width, and height of the "finished" symbol/model are dis-

played, i.e. the measurements correspond to the size/scale, stretch, and unit set in the 

Symbol Properties (3). Using the color scheme, you can assign the sizes to the cor-

responding symbol/model axes in the preview (X = yellow, Y = cyan, Z = magenta). The 

Bounding Box of the symbol/model is drawn, i.e. the box minimally surrounding it 

(independent of the rotation angle) from which the model axes result. 

In addition to the model axes, the coordinate axes of the 3D Viewer (X = red, Y = green, 

Z = blue) are displayed in the preview. This helps you in the orientation of the sym-

bol/model in the 3D space, especially if you move it in X/Y/Z direction or change its 

rotation angle. The intersection point of the coordinate axes marks the actual 3D point 

object. 

If you uncheck Show Hints, the orientation aids are hidden. 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  349 

With the sliders at the edge, you can rotate the symbol/model and view it from all 

sides. The lower slider changes the azimuth angle of the preview (= rotation on vertical 

axis), the right slider changes the elevation angle (= rotation on horizontal axis). 

With OK or Apply or double-click on the symbol under Predefined Symbols (1) the current/ 

selected symbol is applied to the point object(s). Cancel closes the dialog without further 

action. 

 

6.6.1 3D Point Symbol "Simple" 

The 3D point symbol Simple is a simple solid. You can customize the following properties: 

• Point Type: determines the shape of the symbol. 

 opens a drop-down list 

• Color: determines the symbol color. 

 opens the Color Picker dialog (see chapter 6.5)  

• Roughness: determines how rough the surface of the symbol is displayed. The higher 

the value, the duller and rougher the surface looks. The lower the value, the greater 

the effect of the factor set under Metallic. 

 opens a slider 

• Metallic: determines how metallic the surface of the symbol is displayed. The higher 

the value, the more metallic the surface shines and the more clearly it "reflects" for 

example the sky. 

 opens a slider 

The smoother the surface, i.e. the lower the set Roughness, the stronger the effect. 

• Offset X/Y/Z: moves the symbol along its X/Y/Z axis (before rotation). The shift is rela-

tive to the actual 3D point object. 

 opens a slider 

• Stretch in X/Y/Z: stretches/compresses the symbol along its X/Y/Z axis (before rota-

tion). The stretching factor is specified for each case. The entered value is taken into 

account for Scale [m] or Size [‰]/[px] below. 

 opens a slider 

• Heading/Tilt/Roll: determines the rotation angle of the symbol clockwise around the 

X/Y/Z axis of the 3D viewer. 

 opens a slider 



GAFmap® Express - Manual  Version 3.2 - in Arbeit 

  350 

A rotation has no effect on the bounding box of the symbol (see above at Current Sym-

bol) and therefore no effect on Stretch in X/Y/Z or Scale [m] or Size [‰]/[px].  

• Scale/Size Unit: determines the scale/size unit of the symbol.  

 opens a drop-down list. Available for selection are: 

o Meter: the symbol size is given in meters. This unit is recommended if the absolute 

size of the object is decisive for its display. 

With Scale [m] you can then specify the size of the symbol in the X/Y/Z direction 

with Stretch = 1 ("original size"). For example, if Scale [m] = 10 and Stretch in 

X/Y/Z = 1, the symbol is 10 m long/wide/high. For Stretch in X/Y/Z = 2.5, its 

length/width/height is 25 m, etc.   

 opens a slider 

o Scene: the symbol size is given in relation to the size of the entire scene (in ‰). 

This unit is recommended if a visually appealing result is to be achieved quickly for 

very large or very small scenes. 

With Size [‰] you can then specify how many per mille of the total scene the 

longest side of the symbol should occupy. The factor entered above for Stretch in 

X/Y/Z is taken into account. 

Note that objects with symbol size unit Scene are not considered for the 3D view-

shed. 

 opens a slider 

o Pixel: the symbol size is given in (screen) pixels. This unit is recommended if the 

point symbol should always be displayed in the same size on the screen, regardless 

of its position in 3D space / distance. 

With Size [px] you can then specify how many pixels the longest side of the symbol 

should be. The factor entered above for Stretch in X/Y/Z is taken into account. 

Note that objects with symbol size unit Pixel are not considered for the 3D view-

shed. 

 opens a slider 

The aspect ratio of the symbol is retained in all settings you make here. The bounding 

box is always considered (see above at Current Symbol). 

• Minimum/Maximum Distance [m]: determines the minimum/maximum distance to 

which the symbol is visible to the observer. Symbols that are further / less far away in 

the 3D space are hidden. 

 opens a slider 
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A value of 0 means that the function is deactivated and the symbols are not shown/ 

hidden depending on the distance. 

• Shading: determines whether the symbol is displayed with shading (On) or not (Off). If 

On, areas facing the light appear brighter and areas not facing the light appear darker. 

This creates a plastic impression. 

The virtual light source is specified for the entire scene in the map properties under 

Lighting (see chapter 5.1.7). 

 opens a drop-down list 

 

6.6.2 3D Point Symbol "Model" 

The 3D point symbol Model is a 3D model. They cannot be newly created, but can be selected 

from the list of predefined symbols. You can then customize the following properties: 

• Offset X/Y/Z: moves the model along its X/Y/Z axis (before rotation). The shift is rela-

tive to the actual 3D point object. 

 opens a slider 

• Stretch in X/Y/Z: stretches/compresses the model along its X/Y/Z axis (before rota-

tion). The stretching factor is specified for each case. The entered value is taken into 

account for Scale [m] or Size [‰]/[px] below. 

 opens a slider 

• Heading/Tilt/Roll: determines the rotation angle of the model clockwise around the 

X/Y/Z axis of the 3D Viewer. 

 opens a slider 

A rotation has no effect on the bounding box of the model (see above at Current 

Symbol) and therefore no effect on Stretch in X/Y/Z or Scale [m] or Size [‰]/[px]. 

• Scale/Size Unit: determines the scale/size unit of the model. 

 opens a drop-down list. Available for selection are: 

o Meter: the model size is given in meters. This unit is recommended if the absolute 

size of the object is decisive for its display. 

For Scale [m] you can then specify a factor with which the model is scaled. This 

factor is applied to the (supplied) original size of the model. Note that the stretch 

factor entered for Stretch in X/Y/Z is also applied. 

 opens a slider 
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o Scene: the model size is given in relation to the size of the entire 3D scene (in ‰). 

This unit is recommended if a visually appealing result is to be achieved quickly for 

very large or very small scenes. 

With Size [‰] you can then specify how many per mille of the total scene the 

longest side of the model should occupy. The factor entered above for Stretch in 

X/Y/Z is taken into account. 

Note that objects with symbol size unit Scene are not considered for the 3D view-

shed. 

 opens a slider 

o Pixel: the model size is given in (screen) pixels. This unit is recommended if the 

model should always be displayed in the same size on the screen, regardless of its 

position in 3D space / distance. 

With Size [px] you can then specify how many pixels the longest side of the model 

should be. The factor entered above for Stretch in X/Y/Z is taken into account. 

Note that objects with symbol size unit Pixel are not considered for the 3D view-

shed. 

 opens a slider 

The aspect ratio of the model is retained in all settings you make here. The bounding 

box is always considered (see above at Current Symbol). 

• Minimum/Maximum Distance [m]: determines the minimum/maximum distance to 

which the model is visible to the observer. Models that are further/less far away in the 

3D space are hidden. 

 opens a slider 

A value of 0 means that the function is deactivated and the 3D models are not shown/ 

hidden depending on the distance. 

• Shading: determines whether the 3D model is displayed with shading (On) or not (Off). 

If On, areas facing the light appear brighter and areas not facing the light appear dar-

ker. This creates a plastic impression . 

The virtual light source is specified for the entire scene in the map properties under 

Lighting (see chapter 5.1.7). 

 opens a drop-down list 
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6.7 3D Labeling 

Via e.g. 3D Labeling  in the properties of a 3D Text Label or a 3D Point you are taken to the 

3D Labeling dialog: 

 

Figure 187: 3D Labeling dialog 

In the following, only 3D Labeling specific functions/properties are explained. For general 

information on the dialog and its structure, see chapter 6. 

Note that any settings you make in the 3D Labeling dialog affects the appearance of the 3D 

labels / labeling board. The style of the lettering on the board is determined by the graphics 

property Labeling under the category Symbology (see chapter 5.2.1.10 or 6.4).  
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Select or Create 3D Label Styles 

You can select, create, and/or edit a label style for the display of the 3D label / board by 

• clicking on a 3D label style in the List of Predefined Labels on the left. All settings to 

the right of the dialog are then automatically adopted from this 3D label. You can either 

keep the selected 3D label unchanged or edit it beforehand. 

• creating a custom 3D label style on the right. 

Under Current Symbol you can preview the currently selected or created 3D label. The 

crossing point of the red lines marks the anchor point of the label. The preview also takes into 

account the labeling style for the lettering on the board specified under Labeling. 

With OK or Apply the current 3D label style is applied, with Cancel the dialog is closed without 

further action. 

3D Labeling Properties 

You can adjust the following properties: 

• Type: determines the type of the 3D Labeling. 

 opens a drop-down list: 

o None: no label is displayed.  

o Icon: only the 2D point symbol is displayed on the label board. For 3D points this 

corresponds to the point symbol that is used for the representation of the points 

in the (2D) map viewer.  

o Text: only the label text is displayed on the labeling board. 

o Icon and Text: label text and 2D point symbol are displayed on the labeling board. 

• Vertical Offset Unit: determines the unit in which the vertical offset is specified. 

 opens a drop-down list 

• Vertical Offset [m]/[‰]/[px]: determines the vertical position height of the label 

above the anchor point. Depending on the unit selected above, the offset is given in 

meters [m], a per mille share [‰] of the entire scene, or in (screen) pixels [px]. 

For negative values, the label is displayed below the anchor point (useful e.g. for air-

borne points or geological applications). 

 opens a slider 

• Horizontal Alignment: determines whether the label is displayed to the left/to the 

right of the object or centered on it. 
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 opens a drop-down list 

• Monitor Aligned: determines whether the label is aligned according to the monitor 

level. 

 opens a drop-down list. Available for selection are: 

o Automatic: The alignment of the labels is automatically adjusted for optimal dis-

play in the 3D Viewer or Virtual Reality mode. 

o On: the label is aligned according to the monitor level. This mode is recommended 

for the display in the 3D Viewer. 

o Off: the label is not aligned according to monitor level. This mode is recommended 

for an optimal display in Virtual Reality mode. 

• Size Unit: determines the unit in which the size of the label is scaled. 

 opens a drop-down list 

• Scale Factor: determines the factor with which the label is scaled, and thus influences 

the size of the label. Depending on the Size Unit selected, the following applies: 

o For Meter [m], the factor is given in meters per pixel. For example, at 10m/px a 15 

pixel label will be 150m high. 

 opens a slider 

o For Scene [‰], the factor is given in per mille of the total scene per pixel. For 

example, for 1‰/px, a 15 pixel label 15‰ of the entire scene is high.  

 opens a slider 

o For Pixel [px], the factor is applied directly to the label size/pixel. 

 opens a slider 

• Restrict Minimum/Maximum Size (only for Size Unit =[m]/[‰]): determines whether 

the label is limited to a certain minimum/maximum font size or hidden above a certain 

minimum/maximum font size.  

 opens a drop-down list. Available for selection are: 

o Off: The label is neither limited to a certain font size nor hidden above a certain 

font size. 

o Restrict: the label never falls below/exceeds a certain minimum/maximum font 

size, regardless of how far away it is. 

o Hide: the label is hidden above a certain minimum/maximum font size. 
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With Minimum/Maximum Size Factor: you can specify which font size should not be 

undercut/overcut. For example, if you enter 3 here, the label will never fall below or 

exceed three times the set font size. 

 opens a slider 

• Minimum/Maximum Distance [m]: determines the minimum/maximum distance to 

which the 3D labels are visible to the observer. Labels that are further/less far away in 

the 3D space are hidden. 

 opens a slider 

A value of 0 means that the function is deactivated and the 3D labels are not shown/ 

hidden depending on the distance. 

• Show Board: if On, the label is displayed on a board. For the board the following 

additional settings are then available: 

o Background Color: determines the background color of the board. 

 opens the Color Picker dialog (see chapter 6.5) 

o Border Color: determines the border color of the board. 

 opens the Color Picker dialog (see chapter 6.5) 

o Show Handle: determines whether the board is displayed with a handle towards 

the anchor point (On) or without a handle (Off). 

• Depth Test: if On, 3D text labels that are covered by terrain or 3D objects are hidden. 

If Off, covered 3D text labels are drawn in front of the terrain or 3D object. 
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7 3D Viewer Controls 

There are several ways to navigate within the 3D Viewer: 

• by mouse 

• by  3D mouse 

• by keyboard 

• by X-Input controller 

• by gestures (only for touchscreens) 

• by VR touch controllers (only with VR headset), see chapter 8.2 

If you use a 3D mouse, please refer to its manufacturer's manual. 

 

7.1 Mouse Controls: Zoom/Move Mode 

 If the Toggle First Person Mode button in the 3D Viewer toolbar is deactivated (see chap-

ter 4.6.20), you are in Zoom/Move Mode. You can then perform the following actions with 

the mouse in the 3D viewer: 

• Move 3D view: right mouse button 

Grab a 3D dataset by pressing and holding the right mouse button and move it in the 

desired direction.  

If the viewing angle is steep (> 20°), the 3D view is then shifted horizontally in the cor-

responding direction to the right/left or back/front 

 

Figure 188: Moving the 3D view at steep viewing angle with the right mouse button 

If the viewing angle is flat (≤ 20°), the 3D view is shifted to the right/left when moving 

sideways, and to the top/bottom when moving up/down. 
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Figure 189: Moving the 3D view at flat viewing angle with the right mouse button 

Note that the 3D view is only moved if you grab a 3D dataset and not if you click off a 

dataset in the "empty space" 

• Rotate 3D view: pressed mouse wheel and (rotation) movement 

First, define the rotation point by clicking on a 3D dataset at any position with the 

mouse wheel. As long as you hold the mouse wheel, you can freely rotate/tilt the 3D 

view in all directions around the rotation point by executing the corresponding rota-

tional movement with the mouse. 

 

Figure 190: Rotating the 3D view with pressed mouse wheel 

Note that the 3D view is only rotated if the rotation point is placed on a 3D dataset and 

not if you click off a dataset in the "empty space". 
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You can adjust the turn speed in the input configuration dialog (see chapter 4.6.18) or 

alternatively with Ctrl + mouse wheel; while you turn the mouse wheel, the current 

speed is displayed in the status bar: 

 

• Move to / away from mouse position: turned mouse wheel 

Place the mouse pointer at the position you want to move to and turn the mouse wheel 

forward/up; you then move towards the targeted position. If you turn the mouse 

wheel backwards/down, you move away relative to the mouse pointer. 

 

Figure 191: Rotating the 3D view with pressed mouse wheel 

The speed at which you move depends on how close you are to the targeted object/ 

terrain: the closer you are, the slower the forward movement. This has the effect that 

you get progressively closer to the object/terrain, but do not push through it. The move 

speed, which you can adjust in the in configuration dialog or with Shift + mouse wheel, 

has no effect here (only on the possibly additional keyboard controls; see chapter 7.3). 

The logic of the mouse wheel (forward/backward) can be inverted in the general set-

tings (with Mouse Wheel Up is Zoom In; see chapter 3.4.1.8). 

• Change field of view (FOV): Alt + turned mouse wheel 

If you turn the mouse wheel while pressing the Alt key, you zoom the 3D view towards 

or away from you while keeping the same location. If you turn the mouse wheel for-

wards/up, you reduce your field of view and thus enlarge the view like with binoculars 
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or a zoom lens; if you turn it backwards/down, you enlarge your field of view like with 

a wide angle lens. 

 

Figure 192: Changing the field of view with Alt + mouse wheel (left: 3D viewer; right: (2D) map viewer) 

The logic of the mouse wheel (forward/backward) can be inverted in the general set-

tings (with Mouse Wheel Up is Zoom In; see chapter 3.4.1.8). While you adjust the 

field of view / FOV, the viewing angle is displayed in the status bar: 

 

The mouse controls can always be combined/complemented with keyboard controls. For 

more information on keyboard controls, see chapter 7.3. 
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Tips and notes: 

• The activation status of the Toggle First Person Mode button is saved in your user pro-

file. 

•  Via Show Controls in the 3D Viewer toolbar you can display a list of all keyboard 

and mouse commands (for controls) in the 3D view (see chapter 4.6.17). 

• With the left mouse button you can perform various other actions - depending on whe-

ther or which tool is currently active (e.g. add graphics, select features, query raster 

pixels, etc.). 

 

7.2 Mouse Controls: First Person Mode 

 If the Toggle First Person Mode button in the 3D Viewer toolbar is deactivated (see chap-

ter 4.6.20), you are in First Person Mode. The mouse controls are mainly used to supplement 

the keyboard controls (see chapter 7.3). The mouse is mainly used for rotation, while the key-

board is used for flighing/moving. 

In the 3D viewer, you can perform the following actions with the mouse: 

• Rotate 3D view (around a set rotation point): pressed mouse wheel and (rotation) 

movement 

First, define the rotation point by clicking on a 3D dataset at any position with the 

mouse wheel. As long as you hold the mouse wheel, you can freely rotate/tilt the 3D 

view in all directions around the rotation point by executing the corresponding rota-

tional movement with the mouse. 

Note that the 3D view is only rotated if the rotation point is placed on a 3D dataset and 

not if you click off a dataset in the "empty space". 

You can adjust the turn speed in the input configuration dialog (see chapter 4.6.18) or 

alternatively with Ctrl + mouse wheel; while you turn the mouse wheel, the current 

speed is displayed in the status bar. 

The behavior is the same as in zoom/move mode (see chapter 7.1). 

• Rotate 3D view (around your current position): right mouse button and (rotation) 

movement 

Grab the 3D view by clicking into the 3D viewer at any position with the right mouse 

button. As long as you hold the button, you can freely rotate/tilt the view around your 

current location by making the corresponding rotational movement with the mouse. 
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You can adjust the turn speed in the input configuration dialog (see chapter 4.6.18) or 

alternatively with Ctrl + mouse wheel; while you turn the mouse wheel, the current 

speed is displayed in the status bar. 

• Change field of view: Alt + turned mouse wheel 

If you turn the mouse wheel while pressing the Alt key, you zoom the 3D view towards 

or away from you while keeping the same location. If you turn the mouse wheel for-

wards/up, you reduce your field of view and thus enlarge the view like with binoculars 

or a zoom lens; if you turn it backwards/down, you enlarge your field of view like with 

a wide angle lens. 

The logic of the mouse wheel (forward/backward) can be inverted in the general set-

tings (with Mouse Wheel Up is Zoom In; see GAFmap® manual, chapter 3.5.1.12). 

The behavior is the same as in zoom/move mode (see chapter 7.1). 

• Adjust move speed: turned mouse wheel 

By turning the mouse wheel, you can adjust the speed at which flight movements are 

executed (via the keyboard) at any time. If you change the movement speed during a 

flight, it is directly accelerated or slowed down. 

While you turn the mouse wheel, the current speed is displayed in the status bar: 

 

You can also adjust the move speed in the input configuration dialog (see chapter 

4.6.18) 

Tips and notes: 

• The activation status of the Toggle First Person Mode button is saved in your user pro-

file. 

•  Via Show Controls in the 3D Viewer toolbar you can display a list of all keyboard 

and mouse commands (for controls) in the 3D view (see chapter 4.6.17). 

• With the left mouse button you can perform various other actions - depending on whe-

ther or which tool is currently active (e.g. add graphics, select features, query raster 

pixels, etc.). 
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7.3 Keyboard Controls 

When controlling with the keyboard, you can perform the following actions in the 3D viewer:  

• Move horizontally to the right/to the left: arrow keys right/left or A/D 

• Move horizontally forwards/backwards: arrow keys up/down 

• Move vertically up/down: page keys up/down 

• Move forwards/backwards in viewing direction: W/S 

• Move up/down in its viewing direction: Space / <> 

• Turn to the right/to the left: Q/E 

• Turn upwards/downwards: R/F 

• Zoom to Full Extent: Home 

• Go to Last Extent: Back 

• Go to Next Extent: Insert 

• Horizontal View: C 

• Align North: N 

 

Figure 193: Keyboard Controls in the 3D Viewer 

The keyboard controls can always be combined/complemented with the mouse controls. For 

more information on mouse controls, see chapter 7.1 et seq. 
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Tips and notes: 

•  Via Show Controls in the 3D Viewer toolbar you can display a list of all keyboard 

and mouse commands (for controls) in the 3D view (see chapter 4.6.17). 

 

7.4 X-Input Controller  

If an X-Input controller is connected to your PC and ready for operation, you can perform the 

following actions in the 3D viewer : 

 

Figure 194: Controls using an X-Input Controller, e.g. the XBox One Wireless Controller (Source: 
https://www3.oculus.com/en-us/rift/)  

• Move horizontally to the right/to the left: left stick right/left 

• Move horizontally forwards/backwards: left stick up/down 

• Move vertically up/down: right/left trigger 

• Change viewing direction: right stick 

• The viewing direction is turned in the direction in which you press the stick. If you press 

the stick forward/backward, this results in turning the viewing direction upward/ 

downward 

• Adjust move speed: A/B 

• Adjust turn speed: R/F 

• Center world: View button (only relevant in VR mode; see chapter 8) 

In the input configuration dialog you can adjust the controller controls (see chapter 4.6.18). 
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7.5 Gesture Controls: Zoom/Move Mode  

When using a touchscreen, you can enable the gesture controls by tapping into the 3D viewer 

once. In the Zoom/Move Mode the following actions are then possible: 

1-Finger Gestures: if you tap with one finger into the 3D viewer area and drag it over the 

screen, you move the view (pan). Depending on the viewing angle: 

• you move it horizontally in the corresponding direction (for a steep viewing angle > 

20°) 

• you move it at the screen level to the left/right and up/down (for a flat viewing angle 

<= 20°) 

2-Finger Gestures: 

• Zoom: Tap into the 3D viewer with two fingers simultaneously and pull them apart or 

together. As you pull apart, the camera position approaches the data, as you pull them 

together, the camera position moves away from the data (both to and from the center 

point of the gesture). 

• Turn: Tap with two fingers simultaneously on any layer in the 3D viewer and perform 

a circular motion. This will rotate the view horizontally around the center point of the 

gesture. 

• Adjust Viewing Angle: Tap with two fingers at a time into the 3D viewer and drag them 

up or down to adjust the vertical angle. 

Whether the Zoom/Move Mode or the First Person Mode is active, can be controlled via the 

button Toggle First Person Mode (see chapter 4.6.20). 

 

7.6 Gesture Controls: First Person Mode  

When using a touchscreen, you can enable the gesture controls by tapping into the 3D viewer 

once. In the First Person Mode the following actions are then possible: 

1-Finger Gestures: if you tap with one finger into the 3D viewer area and drag it over the 

screen, the coordinate system rotates according to your finger movements. 

• A horizontal finger movement rotates the coordinate system horizontally. Thus, the 

geographic direction (azimuth) you are looking at is changing. 

• A vertical finger movement rotates the coordinate system vertically. Thus, your line of 

sight bends up or down. You can also recognize this by the moving horizon line. 

• A diagonal finger movement combines both aforementioned effects. 
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2-Finger Gestures: The three gestures below allow you to modify the view on your data, i.e. 

the camera position can be adjusted by panning, zooming and rotating without changing the 

coordinate system's position itself. 

• Pan: Tap into the 3D viewer with two fingers simultaneously and drag them to any 

direction. The camera position is moved accordingly. 

• Zoom: Tap with two fingers simultaneously into the 3D viewer and then drag them 

apart or pull them together. As you pull apart, the camera position approaches the 

data, as you pull them together, the camera position moves away from the data (along 

the current viewing direction). 

• Turn: Tap with two fingers simultaneously on any layer in the 3D viewer and perform 

a circular motion. This will rotate the view horizontally around the center point of the 

gesture. 

Whether the Zoom/Move Mode or the First Person Mode is active, can be controlled via the 

button Toggle First Person Mode (see chapter 4.6.20). 

 

7.7 Controls with Virtual Reality Controllers  

For information on Controls with Virtual Reality Controllers, see chapter 8.2. 
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8 Virtual Reality Mode 

GAFmap® supports the Oculus Rift and SteamVR as well as the OpenXR interface (see chapter 

4.6.19), so that virtually all VR headsets that can be connected to the PC can also be used with 

GAFmap®. These include Oculus Rift (S), Meta Quest with Meta Link cable, HTC Vive (Pro) as 

well as Pimax Crystal (Light/Super) or Pimax Dream Air (SE). 

For more information on how to start the VR mode, see chapters 4.6.9 et seqq. or 5.1.7. 

 

8.1 Virtual Reality Requirements 

Hardware requirements: For more information concerning hardware requirements for the VR 

systems, follow the recommendations of the hardware manufacturers. 

Required frame rate: For an optimal VR experience, you should first make sure that an image 

rate of > 90 frames per second is achieved while moving around in the 3D viewer. You can 

check this using the option Show frames per second in the configuration dialog (see chapter 

4.6.19). 

Guardian system: For safety reasons (risk of injury) and especially when using touch con-

trollers, please make sure that you have sufficient space to move. The manufacturer's tutorial 

generally addresses this topic when setting up the VR environment, and shows you how to set 

up a gaming area (guardian system). This area can also be defined later or redefined at any 

time. As soon as you use the VR headset, the defined area is displayed as a light blue 

translucent grid in the VR world. This grid is displayed as soon as you, your hand or your VR 

touch controller get too close to the edge of the defined gaming area's boundary. If you 

correct your physical position in such a way that you are completely within the gaming area 

again, the grid automatically turns off. 

Simulation sickness: VR applications can lead to the known phenomenons dizziness and slight 

nausea. The main reason for this is the different information that your eyes and inner ears 

transmit to the brain as soon as you immerse yourself in the VR world. However, whether or 

not and how strongly a person is affected by sickness is very individual. If you start feeling 

dizzy, we recommend taking a seated position and avoiding rotating/reverse movements as 

well as accelerating moves in the VR world. 
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8.2 Actions with Virtual Reality Controllers 

 

Figure 195: Navigation using VR controllers, e.g. Oculus Touch (source: screenshot from www.oculus.com). 

If a VR headset is connected and ready for use, you can perform the following actions in the 

virtual reality world using the controllers: 

• Centering the world: simultaneously pressing both menu buttons (with HTC Vive the 

trigger and the thumb button of the left controller) 

• Holding and moving the world: pressing a trigger or a grip button and moving the con-

troller 

The effect is best visible when you are close to an object. 

• Rotating, moving and scaling the world: simultaneously pressing both triggers and 

moving the controller 

By pressing the triggers simultaneously, you grab the world at two points. If you now 

move the controllers in parallel to the right or left, you rotate and move the VR world. 

By moving the controllers towards / away from each other, you can reduce/enlarge 

the Virtual World Scale (see chapter 5.1.7). 

• Flying: moving the right thumbstick forward 

A red beam indicates your moving direction as soon as you press the stick forward. 

Now point the controller in the direction you want to move. You can adjust the move-

ment speed by pressing the right trigger (the stronger, the faster). 
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• Rotating: moving the left thumbstick left or right 

By default, you rotate stepwise to the left or right (snap-turn). By pressing the left 

thumbstick, you can activate and deactivate a smooth rotating motion. 

• Enable/disable view beam: pressing the right thumbstick 

With the (white) view beam you can, for example, point to objects to show them to 

other people. This is particularly useful during a multi user session (see chapter 9). The 

view beam is displayed both in the VR headset and on the screen, so it can also be seen 

by people standing next to you, for example. 

If other functions such as the overview map (see chapter 8.3.2) are activated, the color 

of the beam changes to magenta. 

Tip: You can also point in a multi user session without VR. To do this, simply press the 

P key. Your mouse pointer is then displayed as crosshairs for all to see.. 

• Create Sight Line: 

Proceed as follows to create a Sight Line in VR: 

o Activate the button Add Sight Line in the Graphics toolbar (see chapter 4.7.15) 

before you put on the headset. 

o Put on the VR headset and press the right thumbstick to enable the view beam. 

o Press the A button (or the upper button of the right controller with HTC Vive) to 

define the start point of the sight line. Press the button again to set the target 

point and finish the Sight Line. 

For more information on sight lines, see chapter 5.2.18. 

• Teleport to Eye Height: simultaneously pressing the left grip button and the X button 

(or the upper button of the left controller with HTC Vive). 

The vertical viewing position in VR is then adjusted to correspond to your real viewing 

position as if you were standing on the ground.  

Tips: 

o The Eye Height can be displayed and adjusted in the general settings under Extras 

> Settings > Viewing > Viewshed (see chapter 3.4.1.3)  

o The Virtual World Scale (see chapter 5.1.7) is considered. Set it to 1 (= 1:1) if you 

want to simulate your view and the size ratio of your surroundings as realistically 

as possible. 
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8.3 Actions in the Virtual Reality Menu 

In virtual reality (VR) mode a continuous menu with multiple functions is available. Press the 

X/Y button (or the upper button of the left controller with HTC Vive) to access this menu. If 

you press the button multiple times, you can "scroll" through different functions of the menu. 

 

8.3.1 Orientation 

The North Arrow displays your current viewing direction. The Virtual World Scale (see chapter 

5.1.7) illustrates your size compared to the viewed data. 

 

8.3.2 Overview Map 

On the overview map, you can see a yellow-blue arrow that displays your current viewing 

direction. The map extent displayed in the overview map corresponds to that loaded into the 

3D Viewer. 

Within the overview map, you can teleport to other locations. This puts you directly in another 

location without having to move there actively. This may be useful if you are in a large area or 

have problems with dizziness in the VR Mode. 

Proceed as follows to teleport to another location: 

• Activate the overview map.  

• Point with the view beam (see chapter 8.2) in the overview map to the place you want 

to teleport to. 

• Press the A button (or the upper button of the right controller with HTC Vive). 

You are then teleported to the clicked position. Your current height above ground is main-

tained. 

If you also want to set the viewing direction for the new location, hold down the A button (or 

the upper button of the right controller with HTC Vive). Another, smaller arrow showing the 

viewing direction appears. Adjust the orientation of the direction arrow with the white view-

ing beam and release the button. 

In Multi User Mode you can also see the positions and names of the other participants in the 

overview map (shown as an arrow) if for them Visible and Show Name is activated in the 

Multi-User Participant List (see chapter 9.2.3). 
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8.3.3 3D TOC and 3D Viewer Toolbar 

Via the TOC of the 3D window, you can activate and deactivate (i.e. check or uncheck) layers 

by directing the view beam (see chapter 8.2) to the corresponding checkbox and pressing the 

A button once (or the upper button of the right controller with HTC Vive).  

If you want to select multiple layers, hold down the grip button of the right controller and then 

select any number of layers by pressing the A button (or the upper button of the right con-

troller with HTC Vive). 

By double-clicking on the layer icon, you can perform the following actions: 

• View Point: teleports you directly to the view point. 

• Flight Line: starts the flight animation. By clicking on the icon again, you can pause/ 

resume the flight animation, and by double-clicking it again, you can stop it. 

• Other layers: changes your position so that the entire layer is centered in your field of 

view.  

To the left of the TOC you can find a part of the 3D Viewer toolbar. It contains the following 

functions: 

• Enable/Disable DEM Shading (see chapter 4.6.4) 

• Enable/Disable Shadows (see chapter 4.6.5) 

• Enable/Disable Viewshed (see chapter 4.6.6) 

• Save Current View Point (see chapter 4.6.12) 

• Start/Pause Animation, Jump Forward/Backward, and Stop Animation (see chapter 

4.6.13 et seqq.) 

You can click/activate the buttons in the same way as the checkboxes in the TOC, i.e. by direc-

ting the view beam to the corresponding button and then pressing the A button (or the upper 

button of the right controller with HTC Vive). 

 

8.3.4 Add 3D Point 

If the dialog Add 3D Point is displayed, you can create a new 3D Point by directing the view 

beam (see chapter 8.2) to the desired position in the dataset and pressing the A button (or 

the upper button of the right controller with HTC Vive). You can then adjust the symbology of 

the 3D point via the dialog. For more information, see chapter 4.7.11. 
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Unlike outside VR mode, the 3D Point is not created directly, but only when you click the Add 

button in the dialog. Until then you can still adjust the position of the 3D Point by clicking into 

the dataset as described above. 

Tips and notes: 

• You can select predefined 3D symbols and label styles in VR, but you cannot customize 

them. You can apply predefined symbols directly by double-clicking them. 

 

8.3.5 Multi User Participant List 

Only available in Multi User Mode 

The Multi User Participant List lists all participants in the current session. To make adjust-

ments, use the white beam (see chapter 8.2) and point to the desired function in the Partici-

pant List and confirm with the A button (or the upper button of the right controller with HTC 

Vive). Double-clicking on the avatar or name of another participant teleports you to their 

current position. For more information and settings, see chapter 9.2.3. 
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9 Multi User Mode 

Only available if the project contains a 3D window 

The multi user mode of the 3D viewer allows individuals in physically separated workplaces 

or different working locations to connect via a simple multi user communication server and 

interact in a common 3D environment. The multi user mode supports the following three 

scenarios: 

• All participants use the 3D viewer, without virtual reality (VR) mode. 

• All participants use the 3D viewer with VR mode. 

• Some participants use the 3D viewer with, others without the VR mode. 

It makes no difference whether the participants of a Multi User session use GAFmap® Desktop 

or GAFmap® Express. 

 

9.1 Multi User Requirements 

Joint Project 

Ideally all participants of a shared multi user session use the same GAFmap project (*.cmp or 

*.xmp), and therefore the same coordinate system, data and 3D visualization. However, the 

same coordinate system is the basic requirement for the multi user session. 

Participants not necessarily have to access the same project file (*.cmp or * .xmp). The project 

file may be located and used on a joint network shared drive. It is also possible that the project 

file is located as a copy on each individual user's PC. 

Shared Multi User Session 

For a multi user session, a simple communication server is created and used that exchanges 

the following information between all participating computers in the background. 

• Information on the project, e.g. coordinate system, project name, 

• Information on participants, e.g. appearance for an avatar's head and possibly the 

hands, position, line of sight, 

• Information on actions, e.g. user leaves multi user session or a user sends graphics to 

other users. 
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This communication server, referred to as a multi user server, is a so-called dedicated server. 

Therefore, the GAFmap clients do not communicate directly with each other, but always via 

the multi user server. Communication takes place via UDP ports. 

Two operating modes of the Multi User client-server architecture are available. 

Mode 1: 

A multi user server and a multi user session can easily be created by one of the participants 

via a button function in the GAFmap® 3D Viewer. After the first participant created the server 

and session, all other participants can connect to the multi user server and the created session. 

 

Figure 196: Client-Server architecture with Multi User server on PC. 

For more information on creating and connecting to a multi user server, see chapter 9.2. 

Mode 2: 

A multi user server is created via the GAF.View3D.MultiUser.Server.exe on a Windows server 

(in Mode 1 the GAF.View3D.MultiUser.Server.exe is automatically launched). All participants 

can now connect to the multi user server and the created session. 
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Figure 197: Client-Server architecture with Multi User server on a Windows server. 

To create a Multi User server on a Windows server, just copy the folder from 

[…]\GAFmap_*\Extensions\MultiUserServer to the desired location on the server and run it 

for example via the Windows command line. The command line argument --help 

(GAF.View3D.MultiUser.Server.exe --help) lists the available commands during launch. 

 

Figure 198: Commands for GAF.View3D.MultiUser.Server.exe. 

For information on connecting to a Multi User server, see chapter 9.2.1. 

Note: For the communication server certain UDP Ports (User Datagram Protocol) may have to 

be enabled for Windows and/or Firewalls. By default, the communication server uses the UDP 

Ports 9050 and 9051. 
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9.2 Multi User Actions 

In GAFmap Express: 3D Viewer Toolbar 

 Multi User lets you create a multi user server on your own or connect to a multi user 

server of other users.  

If you are already connected to a multi user server (session), a dialog with a Participation List 

of the current session opens (see chapter 9.2.3). 

All relevant information or interactions with the other participants in a session are displayed 

in the status bar in the 3D viewer or when using VR, as messages in the center of the field of 

view. 

 

9.2.1 Connect to a Multi User Server 

In GAFmap Express: 3D Viewer Toolbar 

As long as you are not connected to a multi user server,  Multi User opens a dialog that 

lets you create a Multi User server on your own or connect to a multi user server of other 

users. 

If there are already existing multi user servers that you can connect to, they are displayed in 

the Dialog List. If you want to connect to one of these servers, select it in the list and click the 

button Connect. 

As soon as you click the button Connect, the dialog opens with the Participant List of the 

session. See chapter 9.2.3 for more details. 
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Figure 199: Dialog Connect Multi-User. 

Settings in the Multi User Dialog: 

• Server Port: defines the UDP port used for the multi user mode. Adjust the port if you 

know that existing multi user servers are communicating via a different port. The 

server table displays all multi user servers communicating via the set UDP port.  

 refreshes the server table for the set port 

• Server Table: lists all visible active server/sessions. Depending on which Internet 

Protocol Version is utilized; an IPv4 and/or IPv6 entry will appear for the server. If one 

server, using different protocols, is detected, both entries will lead to the same server. 

o IP: shows the IP adress of the Server. Either in IPv4 or IPv6 format. 

o Session Name: shows the name of the session. 

o Project (only visible if at least one client is connected to the server): shows the 

name of the currently used GAFmap project (* .xmp) in the server as well as the 

coordinate system used. If no project is loaded, only the coordinate system of the 

session is displayed. 

o User Count: shows the current user count of the session.  

• Automatic Client Port: if enabled, clients will automatically be assigned to a port. If 

disabled, a specific port can be assigned manually with Client Port. 

Note: Manual assigned ports are necessary if a restrictive firewall only allows certain 

client ports and thus an explicit released port has to be used. 
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• NAT Hole Punching: if enabled, NAT Hole Punching is used when connecting to a ser-

ver. Hole Punching is a technique that is used to establish a UDP connection between 

two computers, even though both are behind restrictive firewalls. For this, however, 

certain conditions must be met. If disabled, no NAT Hole Punching is used. 

• Connect to IP: specifies the IP address to connect to. By clicking on an existing session 

in the server table, the server IP address is automatically entered here. In addition, it 

is also possible to connect with a manually entered address or a domain name. 

 opens the Multi User Settings (see chapter 9.2.4) 

• Connect: connects you to the currently selected session/project in the server table or 

the manually entered IP address or domain name. 

 

9.2.2 Create Multi User Server 

In GAFmap Express: 3D Viewer Toolbar > Multi-User 

As long as you are not connected to a multi user server,  Multi User opens a dialog that 

lets you create a multi user server on your own or connect to a multi user server of another 

user. 

If you want to create a multi user server on your own, click on the button Create Server. In 

the following dialog, you can then specify the settings for your multi user server: 

 

Figure 200: Dialog Create Server. 

• Session Name: specifies the name of the session. 

• Server Port: specifies the port to be used for the multi user server. To be able to con-

nect to a server all participants have to use the same port. 
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• Visible: if checked, the created server appears in the Server Table of the other users. 

If unchecked, the server does not appear in the list. 

• NAT Hole Punching: if checked, NAT Hole Punching is used for the created server. Hole 

Punching is a technique that is used to establish a UDP connection between two com-

puters, even though both are behind restrictive firewalls. For this, however, certain 

conditions must be met. If disabled, no NAT Hole Punching is used. 

Click Start to confirm your settings and create the server. The local GAFmap client automati-

cally connects to this server. Therefore, a server window is opened in the background of 

GAFmap® (see chapter 9.1). The server could also be kept open explicitly when the creator 

closes GAFmap®. This is a possibility to make your computer available to other users as a ser-

ver even without a copy of GAFmap® running. The server window remains until you close it 

manually. 

When the Start button is pressed, the server starts and the GAFmap® client opens the session 

showing the Participant List (see chapter 9.2.3). 

 

9.2.3 Multi-User Participant List 

In GAFmap Express: 3D Viewer Toolbar > Multi-User 

As soon as you connect to a multi user server, the Participant List of the current session opens. 

 

Figure 201: Dialog Multi User. 
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• Visible: determines whether the avatar, name, and view beam of the respective 

participant are visible to you in the 3D viewer / VR (checked) or not (unchecked). 

• Avatar: shows which avatar the respective participant is currently using. You can alter 

your own avatar via Multi User Settings.  

• Name: shows which name the respective participant is currently using. You can change 

your own name via Multi User Settings.  

• Show Name: if checked, the name of the respective participant is diplayed above the 

avatar and in the overview map. 

• Double click on Avatar or Name: By double-clicking on the avatar or name of another 

participant, you can teleport to its location. The viewing direction and the Virtual 

World Scale (see chapter 5.1.7) are then adopted from this participant.  

• View: if checked, the viewing direction of the respective participant is displayed as a 

visual beam in the 3D viewer / in VR. You can then follow exactly in which direction the 

other participant is facing. If, e.g. after teleporting, you are at the exact same position 

as a participant, his or her viewing beam is shown as a point in the 3D viewer. 

• Automatically hide avatar when too close: if activated, the avatars of the other parti-

cipants will be hidden as soon as they are too close to your own position. This prevents 

occlusion of avatar models that can interrupt the immersion in virtual reality mode. 

•  opens the Multi User Settings (see chapter 9.2.4) 

• Disconnect: disconnects the connection to the server. You can always reconnect with 

the server via Multi User Mode, unless the server is already shut down. This is also 

possible if you created the server yourself, as the server is independent of the 

GAFmap® client. 
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9.2.4 Multi User Settings 

In GAFmap Express: 3D Viewer Toolbar > Multi-User > Multi User Settings 

In the Multi User Settings, you can customize your username and avatar: 

 

Figure 202: Dialog Multi User Settings. 

• User Name: specifies your username, which is displayed for the other participants. 

• Head: specifies the head used for your avatar. 

• Right Hand (only if VR is enabled): specifies the right hand used for your avatar. 

• Left Hand (only if VR is enabled): specifies the left hand used for your avatar. 

• Own Avatar Scale (only if VR is disabled): specifies the scale of the avatar in the 3D 

viewer or the virtual world. A value of 1 (1: 1) corresponds to a natural scale. For a 

correct display it is useful to adjust the scale according to the data's resolution and size 

of the scene. Larger values let the data appear smaller in the 3D viewer or the virtual 
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world. If you use the multi user mode in combination with virtual reality, the Avatar 

Scale depends on the currently used Virtual World Scale (see chapter 5.1.7). 

Ok confirms the settings. Cancel closes the dialog without further action. 
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